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Using this guide
The purpose of this guide is to introduce you to the standard reports available in Axiom Budgeting and
Performance Reporting and how to work with them. This guide assumes that you are familiar with the
basic concepts related to using Axiom Budgeting and Performance Reporting. If you are new to Axiom
software in general, we recommend that you first review the Getting Started section in the online help.

NOTE: Some of the reports listed here are optional, meaning they are available for purchase outside
of the standard reports included with the software. These are called out in this document. Also, your
Axiom role profile will determine what reports you have access to, so not all of the reports listed
here may be available to you.

TIP: Online help offers these topics and many more, including multiple training videos related to
how to use the Axiom Budgeting and Performance Reporting. You can access online help by
navigating to the Help ribbon tab, click Online Help, and then click Budgeting and Performance
Reporting.

1
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Intelligence Center
The Intelligence Center is a centralized hub where you can view any report that you have access to in
the Axiom Reports Library—including web reports, Axiom forms, visualization reports, and spreadsheet
reports.

Using the Intelligence Center, you can:
l View any report you have access to, regardless of the report type
l Create new web reports (all clients) and visualization reports (clients with certain product

licenses)
l Open reports for editing, in the appropriate editor for the report type
l Export and share web reports
l Perform other report management activities, such as creating and deleting folders, copying and

deleting reports, and editing report names and descriptions

Example Intelligence Center

2
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� Accessing the Intelligence Center
All users can access the Intelligence Center in the Web Client browser:

l Click the Syntellis icon in the Navigation bar. From the Area menu, select Intelligence Center.

In the Desktop Client, you can open the Intelligence Center from the Reportsmenu. By default this
menu is present on the Axiom tab. If your system has installed products, it may be available to you on
theMain tab.

Intelligence Center on the default Reports menu

� Opening reports
You can open any report that displays in the Intelligence Center. The Intelligence Center is automatically
filtered to only show the reports that you have access to.

To open a report from the Intelligence Center:
1. In the left-hand panel, select the Reports tab if it is not already selected.

2. Do one of the following to locate the report that you want to open:
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l Use the folder tree in the left-hand panel to navigate to the folder where the report is
located.

OR

l Use the Search box to search for the report by name.

For more information on how to search, filter, and sort the Intelligence Center, see Intelligence
Center overview.

3. Once the report displays in the Intelligence Center grid, click on the report name to open it.
l Web reports open in the same browser tab.

l Other web-enabled reports open in a new browser tab. This applies to Axiom forms,
visualization reports, and deprecated web reports.

l If the report is a spreadsheet report, Axiom Budgeting and Performance Reporting
attempts to launch the Axiom Desktop Client and open the report. This works as follows:

o The launch routine uses the Axiom Windows Client by default.

o If an Axiom Budgeting and Performance Reporting client is already open, the launch
routine is skipped and the report is opened in that client—regardless of whether the
open client is the Excel Client or the Windows Client. Therefore, if you want to open
reports in the Excel Client, you must launch the Excel Client first using the Quick
Launch menu, then you can open spreadsheet reports from the Intelligence Center.

NOTE: You must have the appropriate security permissions to use the Axiom Budgeting
and Performance Reporting Desktop Client in order to open a spreadsheet report. If
you do not have either theWindows Client Access permission or the Excel Client
Access permission, then spreadsheet reports are hidden in the Intelligence Center
because you cannot launch the client to view them.

If other types of files are present in the Reports Library—such as PDF, Word, or PowerPoint—these files
can also be opened from the Intelligence Center if you have a program capable of reading the file type.
Axiom Budgeting and Performance Reporting attempts to open the file using the same routine that
opens the Axiom Desktop Client.

� Creating new reports
Using the Create button at the top right of the Intelligence Center, you can create new reports and new
fixed row structures for use in web reports. This button is context-sensitive, depending on what area
you have selected from the left-hand panel.

To create a new report, select the Reports area from the left-hand panel, then click the Create button.
Select one of the following:

l Create web report: This option opens the web Report Builder so that you can create a new web
report from scratch. For more information, see Creating new web reports.
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l Create web report from template: This option creates a new web report using a template
provided by an installed product. See Creating new web reports from template.

l Create new visualization: This option creates a new visualization report. This option is only
available in systems where visualization reporting is licensed and enabled.

Example Create button to create a new report

To create a new fixed row structure, select the Row Structures area from the left-hand panel and then
click Create. For more information, see Creating fixed row structures.

� Other Intelligence Center actions
In the Intelligence Center, you can use the Actions menu to perform other report and folder
management activities. To view the available actions, navigate to the item that you want to work with,
then hover your cursor over the three dots icon in the right-hand side of the Name column. Actions are
available for report files, report folders, and fixed row structures.

Example Actions menu
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The following actions are available:

Action Description More Information

Info Opens the Settings panel for the current
item, displaying the item name and
description.

l Changing folder names and
descriptions

l Changing report names and
descriptions

l Changing fixed row structure
names and descriptions

Edit Opens the current item in the appropriate
editor.

l Editing reports
l Editing fixed row structures

Share Share the current report with other users
via email. Only available for web reports.

l Sharing a web report via email

Export Export the current report as a PDF, Excel,
or Delimited file. Only available for web
reports.

l Exporting grid data in a web
report to a delimited file

l Exporting grid data in a web
report to Excel

l Exporting a PDF copy of a web
report

Copy Generates a copy of the current item. Only
available for fixed row structures and web
reports.

l Copying web reports
l Copying fixed row structures

Delete Deletes the current item. l Deleting reports
l Deleting folders
l Deleting fixed row structures

You can also create new folders by clicking Create > Create new folder while you are in the Reports
area.

Intelligence Center overview
The Intelligence Center is organized into two main areas. To view an area, select the area name from the
left-hand panel:

l The Reports area, which contains the Reports Library folder tree and yourMy Documents folder
(if you have access to it). You can click on folders in this section to navigate through the folder
tree. Once a folder is selected, the contents of that folder display in the report grid. You can click
on a subfolder name to open that subfolder, or you can click on a report name to open that
report.
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l The Row Structures section, which contains fixed row structures for use in web reports. This
section does not have subfolders. You can click on the parent Fixed Row Structures folder to view
the available fixed row structures, and click on a name to open that structure.

As you navigate, a breadcrumb displays at the top of the report grid. You can click on a folder name in
the breadcrumb to move to that folder location.

Navigating the Intelligence Center

� Searching the Intelligence Center
You can use the Search box at the top right of the Intelligence Center to find a report or a fixed row
structure. The search matches on name only. The search box is context-sensitive as follows:

l If the currently selected area is Reports, then the search can be used to find reports in the
Reports Library and your My Documents folder.

l If the currently selected area is Row Structures, then the search can be used to find fixed row
structures.

To search for an item by name:
l Type your search text into the Search box, and then click the magnifying glass or hit the Enter key

to search.

The grid updates to show a list of all reports or fixed row structures that match your search text. You can
open an item or perform other actions using this list. You can also filter and sort this list as described in
the following sections.
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To clear a search:
l Click the X icon in the right side of the Search box.

Your search text is cleared, and you are returned to the folder location that you were viewing when you
started the search.

� Filtering the grid
When you are viewing a folder in the Intelligence Center (or when viewing search results), you can filter
the contents by any column in the grid. For example, you can filter to show all reports of a certain type,
or to show all reports created after a certain date.

To filter the grid based on a column:
1. Click the filter icon in the column header to show the filter options.

2. Set the filter options as desired. You can set up to two filter options, combined with either
AND or OR.

3. Click Filter.

The grid updates to only show items that meet the filter. Additionally, a green dot displays by the filter
icon in the column header to indicate that the grid is filtered by this column.

Example Intelligence Center column with a defined filter

If multiple columns are filtered, the filters are combined using AND—meaning the grid only shows items
that match all of the filters.

The column filter is retained until you clear it, or until you navigate to a new folder location. If you have
filtered the search results, clearing the search results also clears the filter.
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To clear a filter:
1. Click the filter icon in the column header to show the filter options.

2. Click Clear.

The grid updates to clear the filter.

� Sorting the grid
When you are viewing a folder in the Intelligence Center (or when viewing search results), you can sort
the list by any column in the grid.

To sort the grid by a column, click on the column header. Each click toggles between ascending sort,
descending sort, and no sort. If the grid is currently sorted by a column, the sort direction is indicated by
an arrow on the column header (up for ascending, down for descending).

The sort is reset when you move to a new folder location. If you have sorted the search results, clearing
the search results also clears the sort.

NOTE: The grid can only be sorted by one column at a time. If you have sorted by a column and then
you click the column header of a different column, the sort on the original column is cleared and
replaced by the new column sort.

Managing report files in the Intelligence Center
Using the Intelligence Center, you can create, edit, copy, and delete reports in the Reports Library. You
can also edit report names and descriptions.

� Creating new reports
Using the Create button at the top right of the Intelligence Center, you can create new reports and new
fixed row structures for use in web reports. This button is context-sensitive, depending on what area
you have selected from the left-hand panel.

To create a new report, select the Reports area from the left-hand panel, then click the Create button.
Select one of the following:

l Create web report: This option opens the web Report Builder so that you can create a new web
report from scratch. For more information, see Creating new web reports.

l Create web report from template: This option creates a new web report using a template
provided by an installed product. See Creating new web reports from template.

l Create new visualization: This option creates a new visualization report. This option is only
available in systems where visualization reporting is licensed and enabled.
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Example Create button

To create a new fixed row structure, select the Row Structures area from the left-hand panel and then
click Create. For more information, see Creating fixed row structures.

Different security permissions are required to create new web reports versus visualization reports.
These security requirements are noted in the relevant topics.

� Copying reports
In the Intelligence Center, you can copy existing reports to create new reports. Currently, this
functionality is only available for web reports, and only web reports that were created in the Report
Builder. Web reports created from template cannot be copied.

In order to copy a web report, you must be an administrator or have the Create Web Reports security
permission. You must also have read/write access to the current folder, because the copy is created in
the current folder.

To copy a report from the Intelligence Center:
1. In the Intelligence Center, locate the web report that you want to copy. You can use folder

navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Copy from the menu.
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If the Copy action is present but disabled, then you cannot copy this report because you do not
have the appropriate security permissions.

3. In the Copy Report dialog, enter a name for the copy. By default, the name is Copy of
OriginalReportName.

4. Click OK.

The copy is created in the current folder, with the specified name.

� Editing reports
You can open a report for editing from the Intelligence Center if the report is eligible to be edited, and
you have read/write permissions to the report.

To edit a report from the Intelligence Center:
1. In the Intelligence Center, locate the report that you want to edit. You can use folder navigation

to find the report, or use the Search box at the top of the page.
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2. Once the report displays in the Intelligence Center grid, hover your cursor over the Name column
to make the three-dots icon visible. Click the icon then select Edit from the menu.

3. The report is opened for editing as follows, depending on its file type:
l Web reports are opened in the Report Builder, in the current browser tab.
l Visualization reports are opened in the Visualization Report Editor, in a new browser tab.
l Spreadsheet reports and Axiom forms are opened in the Axiom Desktop Client, as

spreadsheet report files. This works as follows:

o The launch routine uses the Axiom Windows Client by default.

o If an Axiom Budgeting and Performance Reporting client is already open, the launch
routine is skipped and the report is opened in that client—regardless of whether the
open client is the Excel Client or the Windows Client. Therefore, if you want to open
reports in the Excel Client, you must launch the Excel Client first using the Quick
Launch menu, then you can open spreadsheet reports from the Intelligence Center.

NOTE: You must have the appropriate security permissions to use the Axiom Budgeting
and Performance Reporting Desktop Client in order to open a spreadsheet report. If
you do not have either theWindows Client Access permission or the Excel Client
Access permission, then spreadsheet reports are hidden in the Intelligence Center
because you cannot launch the client to view them.

Why is the Edit action missing for some reports?
The following report types cannot be opened for editing from the Intelligence Center. The Edit action
does not display for these files:

l Web reports built from template: If a web report is built from a template, the report is tied to
that template and cannot be separately edited. For more information, see Creating new web
reports from template.
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l Deprecated web reports: The prior implementation of web reporting is deprecated. To edit a
deprecated web report, click the file name to open the report, then click the wrench icon in the
toolbar to open the legacy web report editor.

l Other non-report file types: The Reports Library can be used to store other non-report, non-
Axiom file types, such as PDF, DOC, PPT, JPG, and others. These file types cannot be edited in
Axiom Budgeting and Performance Reporting.

Why is the Edit action disabled for some reports?
If the Edit action is present but disabled, this means that although the report type is eligible to be
edited, it is not possible for you to edit this particular report. One of the following reasons may apply:

l You do not have edit permissions (Read/Write access) to the file.
l The file is product-controlled and therefore cannot be edited.
l The file is configured to prevent editing (applies to certain visualization reports).

� Changing report names and descriptions
If you have read/write access to a report, then you can rename the report or change its description.

NOTES:
l In systems with installed products, the names and descriptions of product-controlled reports

cannot be edited.
l If you have read/write access to a report file, but read-only access to its folder, then you

cannot edit the report name.

To change a report name and/or description:
1. In the Intelligence Center, locate the report that you want to edit. You can use folder navigation

to find the report, or use the Search box at the top of the page.
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2. Once the report displays in the Intelligence Center grid, hover your cursor over the Name column
to make the three-dots icon visible. Click the icon then select Info from the menu.

The Settings panel opens along the right-hand side of the page.

3. In the Settings panel, edit the report Name or Description as needed, then click Save.

The name can be up to 250 characters, and the description can be up to 2000 characters.

Example Settings panel

If the report name and description cannot be edited, then the Apply button is not available. This
may occur because you do not have the necessary permissions, or because the report belongs to
an installed product.
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� Deleting reports
If a report is no longer needed, you can delete it using the Intelligence Center. In order to delete a
report (or any other file that resides in the Reports Library), you must have read-write access to the file
and to the folder it resides in.

NOTE: In systems with installed products, product-controlled reports cannot be deleted.

To delete a report:
1. In the Intelligence Center, locate the report that you want to delete. You can use folder

navigation to find the report, or use the Search box at the top of the page.

2. Hover your cursor over the row with the report, hover your cursor over the Name column to
make the three-dots icon visible. Click the icon then select Delete from the menu.

If the report cannot be deleted, the Delete action is disabled. This may occur because you do not
have the necessary permissions to delete the report, or because the report belongs to an
installed product.

3. When you are prompted to confirm that you want to delete the report, click OK.

The report is deleted from the system and no longer displays in the Intelligence Center. If the report was
deleted in error, an administrator may be able to restore the report using the Restore Deleted Files
feature in the Desktop Client.

Managing folders in the Intelligence Center
Using the Intelligence Center, you can create, rename, and delete folders in the Reports Library.
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� Creating new folders
You can create new folders as needed in the Intelligence Center. In order to create a folder, you must
have read-write access to the parent folder.

To create a folder:
1. In the Intelligence Center, navigate to the folder location where you want to create a new folder.

For example, if you want to create a new top-level folder in the Reports Library, select the
Reports Library. If you want to create a new subfolder within a folder, then select that folder.

2. Click Create > Create new folder.

3. In the Create new folder dialog, enter a name for the new folder, then click OK.

The new folder is created in the current location.

� Changing folder names and descriptions
If you have read/write access to a folder, then you can rename the folder or change its description.

NOTE: In systems with installed products, the names and descriptions of product-controlled folders
cannot be edited.

To change a folder name and/or description:
1. In the Intelligence Center, navigate to the parent folder of the folder that you want to rename, so

that the folder you want to rename displays in the Intelligence Center grid.

2. Hover your cursor over the row with the folder, so that the three dots icon is visible the Name
column. Click the icon then select Info from the menu.

The Settings panel opens along the right-hand side of the page.

3. In the Settings panel, edit the folder Name or Description as needed, then click Apply.

The name can be up to 250 characters, and the description can be up to 2000 characters.

If the folder name and description cannot be edited, then the Apply button is not available. This
may occur because you do not have the necessary permissions, or because the folder belongs to
an installed product.
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� Deleting folders
If a folder is no longer needed, you can delete it using the Intelligence Center. In order to delete a folder,
the folder must be empty and you must have read-write access to the folder.

NOTE: In systems with installed products, product-controlled folders cannot be deleted.

To delete a folder:
1. In the Intelligence Center, navigate to the parent folder of the folder that you want to delete, so

that the folder you want to delete displays in the Intelligence Center grid.

2. Hover your cursor over the row with the folder, so that the three dots icon is visible the Name
column. Click the icon then select Delete from the menu.

If the folder cannot be deleted, the Delete action is disabled. This may occur because you do not
have the necessary permissions to delete the folder, or because the folder belongs to an installed
product.

The folder is deleted from the system and no longer displays in the Intelligence Center. There is no
confirmation dialog before deleting an empty folder. If the empty folder was deleted in error, you can
create a new folder with the same name.
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Web Reports
Axiom web reports provide a fully browser-based reporting option for Axiom Budgeting and
Performance Reporting data. You can create, edit, and view web reports all within the Axiom Budgeting
and Performance Reporting Web Client.

Web reports are designed to be intuitive for report designers to build, and easy for report viewers to
use. The Intelligence Center provides a centralized hub to create new web reports and to view any
report that you have access to.

Web reports support two different ways to display reporting data in a grid:
l Dynamic rows: Dynamically display data rows based on a specified dimension or grouping.
l Fixed rows: Use predefined fixed row structures to organize data rows into sections with headers,

totals, and subtotals.

Web reports can be created from scratch using the Report Builder, or you can create them from
templates provided by installed Axiom Budgeting and Performance Reporting products.

ManagingWeb Reports
Using the Intelligence Center in the Axiom Budgeting and Performance Reporting Web Client, you can
create, edit, copy, and delete web reports as needed. Web reports are designed to be intuitive for
report builders to create, and easy for report viewers to use.

� Creating new web reports
To create a new web report, select the Reports area from the left-hand panel of the Intelligence Center,
then click Create. From the Create menu, select one of the following:

l New web report: This option opens the Report Builder so that you can create a new web report
from scratch.

l New web report from template: This option creates a new web report based on a template
provided by an installed product.

If you want to create a web report that uses a fixed row structure, the fixed row structure must be
defined separately and then assigned to the report. Using the Intelligence Center, you can create, edit,
and delete fixed row structures. For more information, see Managing Fixed Row Structures.

3

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 24



In order to create a web report, you must be an administrator or have the Create Web Reports security
permission. You must also have read/write access to at least one folder in the Reports Library or My
Documents.

� Copying web reports
In the Intelligence Center, you can copy existing web reports to create new reports. In order to copy a
web report, you must be an administrator or have the Create Web Reports security permission. You
must also have read/write access to the current folder, because the copy is created in the current folder.

NOTE: Only web reports created in the Report Builder can be copied. Web reports created from
template cannot be copied.

To copy a web report from the Intelligence Center:
1. In the Intelligence Center, locate the web report that you want to copy. You can use folder

navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Copy from the menu.

If the Copy action is present but disabled, then you cannot copy this report because you do not
have the appropriate security permissions.

3. In the Copy Report dialog, enter a name for the copy. By default, the name is Copy of
OriginalReportName.

4. Click OK.

The copy is created in the current folder, with the specified name. If you want to save a copy in a
different folder, then you can Edit the report instead and use Save As within the Report Builder.
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� Editing web reports
You can open a web report for editing from the Intelligence Center if the report is eligible to be edited,
and you have read/write permission to the report.

NOTE: Only web reports created in the Report Builder can be edited. Web reports created from
template cannot be edited.

Only one user at a time can open a web report for editing in the Report Builder. However, other users
can continue to view the report as normal.

To edit a web report from the Intelligence Center:
1. In the Intelligence Center, locate the web report that you want to edit. You can use folder

navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Edit from the menu.

If the Edit action is present but disabled, then you cannot edit this report. This may be because
the report belongs to an installed product and cannot be edited, or because you do not have
read/write access to the report, or because the report was created from template.

The report opens in the Report Builder, in the current browser tab. You can now edit it as needed. For
more information, see Using the Report Builder.

Alternatively, when viewing a web report, an Edit button is present in the top right-hand corner if the
report is eligible to be edited, and you have read/write permission to the report. You can click the Edit
button to open the report in the Report Builder, make and save your changes, then click the Back button
on your browser to return to the report.
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Example Edit button to open the current report in the Report Builder

� Changing web report names and descriptions
If you have read/write access to a web report, then you can rename the report or change its description.

NOTES:
l In systems with installed products, the names and descriptions of product-controlled reports

cannot be edited.
l If you have read/write access to a report file, but read-only access to its folder, then you

cannot edit the name or description.

To change a web report name and/or description:
1. In the Intelligence Center, locate the web report that you want to edit. You can use folder

navigation to find the report, or use the Search box at the top of the page.
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2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Info from the menu.

The Settings panel opens along the right-hand side of the page.

3. In the Settings panel, edit the web report Name or Description as needed, then click Save.

The name can be up to 250 characters, and the description can be up to 2000 characters.

Example Settings panel

If the web report name and description cannot be edited, then the Save button is not available.
This may occur because you do not have the necessary permissions, or because the report
belongs to an installed product.
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� Deleting web reports
You can delete a client-created web report if it is no longer needed. You must have read/write access to
the report and its folder in order to delete a report. Product-controlled web reports cannot be deleted.

TIP: If a report is deleted in error, an administrator may be able to restore the report using the
Restore Deleted Files feature in the Axiom Budgeting and Performance Reporting Desktop Client.

To delete a web report from the Intelligence Center:
1. In the Intelligence Center, locate the web report that you want to delete. You can use folder

navigation to find the report, or use the Search box at the top of the page.

2. Once the web report displays in the Intelligence Center grid, hover your cursor over the Name
column to make the three-dots icon visible. Click the icon then select Delete from the menu.

If the report cannot be deleted, the Delete action is disabled. This may occur because you do not
have the necessary permissions to delete the report, or because the report belongs to an
installed product.

3. When you are prompted to confirm that you want to delete the report, click OK.

The report is deleted from the system and no longer displays in the Intelligence Center.

TIP: You can also delete a web report in the Desktop Client, using Axiom Explorer or the Explorer
task pane.

Creating newweb reports
Using the Intelligence Center, you can create new web reports from scratch so that you can build the
report as needed.
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In order to create a web report, you must be an administrator or have the Create Web Reports security
permission. In order to save the new report you must have read/write access to at least one folder in
the Reports Library or access to the My Documents folder. If you do not have permission to create web
reports, then the option to create a new web report will not be available from the Create button in the
Intelligence Center.

To create a new web report:
1. In the Intelligence Center, click Create > Create web report.

NOTE: The Reports area must be selected in the left-hand panel of the Intelligence Center in
order to create a new web report.

The Report Builder opens in the current browser tab, displaying a new blank report.

2. In the Select Table dialog, select a primary table to determine the data context for the report,
then click OK.

The data context determines the overall pool of data that is eligible to be included in the report.
The selected primary table determines which other tables are eligible for inclusion in the report,
based on lookup relationships and shared dimensions. All table columns and filters used in the
report must be compatible in the context of the primary table.

You can select a table from the drop-down list directly, or type into the box to search for a table
name. The search uses "contains" matching to return any tables that contain the search text
within the table name. Tables that start with the search text are listed first, followed by tables
that contain the search text anywhere in the table name. In the following screenshot, the text
2022 has been used to search for tables with the year 2022 in the name.
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Selecting a primary table for the data context

Once a table is selected for the data context, you can work with the report in the Report Builder.
The Build tab of the Report Builder is where most of the report creation occurs. The Build tab is
organized into three main areas as follows:

l The Data Panel on the left side is where you select the data to include in your report.

l The Report Canvas in the middle is where you build the report. Columns can be dragged
and dropped from the Data Panel to the Report Canvas. You can also create calculations to
display in the report columns, and define column groups.

l The Configuration Panel on the right side is where you define properties for the report,
the data grid, and the individual columns. You can configure properties such as report
titles, drilling options, and column formatting.

For more information on using the Report Builder, see Using the Report Builder.

3. At the top of the Report Canvas, click inside the title boxes and define the title text as desired.
You can also optionally edit the title text within the Report Configuration panel. For more
information, see Defining report titles and other web report properties.
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Defining titles for the report

4. Define the rows of the report by doing one of the following, depending on whether you want to
generate the rows dynamically or use a fixed row structure:

l Dynamic rows: In the Data Panel, locate the table column that you want to use as the row
dimension. Drag and drop the column to the Row Dimensions box in the Report Canvas.
For more information, see Specifying the row dimension for a web report.

Dragging and dropping a column to use as the row dimension
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l Fixed rows: Select the grid placeholder text in the Report Canvas so that the Grid
Configuration properties load into the Configuration Panel. On the General tab, enable
Use fixed rows then select an existing Fixed row structure. For more information, see
Specifying the fixed row structure for a web report.

Specifying a fixed row structure to define the rows

5. Use the Data Panel to locate the data columns that you want to display in the report, then drag
and drop those columns out to the Column Definitions box in the Report Canvas. Once the
columns are added to the grid, you can configure data and display properties for each column.

For more information, see Adding data columns and calculated columns to a web report and
Configuring column properties for a web report.
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Adding and configuring data columns

NOTE: To populate the grid with data after adding columns to the Column Definitions box,
click the Refresh Data button. By default, the Report Builder uses live data, but you must
manually refresh in order to see the result of any data changes. For more information, see
Changing data display options for the Report Builder.

6. Select the grid in the report canvas so that the configuration panel changes to show the Grid
Configuration settings. Define the grid settings as needed, such as to enable the total row or
enable drilling options. For more information, see Configuring grid properties in a web report.

In the following example, the total row was enabled for the grid.
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Configuring grid properties

7. Click the Filters tab along the top of the page to define report-level filters as needed, to limit the
data shown in the report. For more information, see Filtering data in web reports.

In the following example, a general filter was added to exclude the Corporate world region value
from the report and to only show data for revenue accounts.
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Defining a report-level filter to limit data in the report

8. Return to the Build tab, then use the plus icon at the top right of the Column Definitions box to
add calculated columns to the grid as needed. For more information, see Adding data columns
and calculated columns to a web report.

Click the plus icon to add a calculated column
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In the following example, two calculated columns have been added to calculate the difference
between actuals and budget for each quarter.

Adding and configuring calculated columns

9. Use the plus icon at the top right of the Column Definitions box to add column groups to the grid
as needed. Using column groups, you can display multiple columns grouped underneath a
header. For more information, see Defining column groups for a web report.
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Click the plus icon to add a column group

In the following example, two column groups have been added for Q1 and Q2.

Adding and configuring column groups
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10. Optional. If you want the report to dynamically change data based on user selections, then click
the Parameters tab to add report parameters to the report. For more information, see Using
report parameters in web reports.

11. Click Save to save the report.

12. In the Save Report As dialog, complete the following fields and then click Save:

Item Description

File name The name of the report file. This is the name that users will see in the
Intelligence Center.

Description Optional. A description of the report. Currently, descriptions do not
display in the Intelligence Center, but they can be viewed in the
Axiom Budgeting and Performance Reporting Desktop Client using
Axiom Explorer.

Save to folder The folder in the Axiom repository where you want to save the
report.

l Click the folder icon to the right of the field.
l In the Choose output folder dialog, select a folder in the Reports

Library. You can only select folders where you have read/write
access to the folder. If a folder name displays with a lock icon, this
means you have read-only access to that folder and therefore
cannot save a new report there.
NOTE: If you have access to the My Documents folder, then you
can also save reports to that location for your personal use.

l Click OK to choose the folder and return to the save dialog.
The path to your selected folder now displays in the field.

If you use a file name that already exists in the target folder, you will be prompted to choose
whether or not to overwrite the existing file. If you choose not to overwrite, the save operation is
canceled and you are returned to the Report Builder.

Keep in mind that many of these steps can be done in any order. You can configure the grid settings
before defining report titles, and so on. The main dependency is that you must select a primary table for
the data context before you can begin adding columns to the report.

Creating newweb reports from template
Using the Intelligence Center, you can create new web reports from a template. Currently, templates
are only provided by installed Axiom Budgeting and Performance Reporting products. For more
information about any templates provided by your installed products, see the separate product
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documentation.

Some report templates require a fixed row structure to define the row dimensions and sections of the
report. If you want to create a new web report from a template that requires a fixed row structure, this
row structure must already exist so that you can assign it to the report when you create it. For more
information, see Managing Fixed Row Structures.

Web reports created from template remain linked to that template. If a template changes, that change
is automatically available in all reports created from that template.

In order to create a web report, you must be an administrator or have the Create Web Reports security
permission. In order to save the new report you must have read/write access to at least one folder in
the Reports Library or access to the My Documents folder. If you do not have permission to create web
reports, then the option to create a new web report from template will not be available from the Create
button in the Intelligence Center.

To create a new web report from template:
1. In the Intelligence Center, click Create > Create web report from template.

NOTE: If your system does not have any product-delivered templates available, then this
option will not be present on the Createmenu.

The Create New Web Report from Template dialog opens to walk you through the report
creation process.

2. On the template screen, select the template that you want to use to create the report, and then
click Next.
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Example template screen showing product-delivered templates

3. On the fixed row structure screen, select the fixed row structure to use in the report, and then
click Next. If the template you selected does not use a fixed row structure, then this screen does
not display and you can skip to step 4.
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Example screen showing fixed row structures

NOTE: If no fixed row structures are listed, then your system does not have any available
fixed row structures. You must create one before you can create a web report using the
selected template. You can click Back to select a different template, or you can click Cancel to
exit the dialog and return to the Intelligence Center. For more information, see Managing
Fixed Row Structures.

4. On the final screen, complete the following fields to save the new report, and then click Create.

Item Description

Name The name of the report file.

Description Optional. A description for the report.
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Item Description

Save report in The folder in the Axiom repository where you want to save the
report.

l Click the folder icon to the right of the field.
l In the Choose output folder dialog, select a folder in the Reports

Library. You can only select folders where you have read/write
access to the folder. If a folder name displays with a lock icon, this
means you have read-only access to that folder and therefore
cannot save a new report there.
NOTE: If you have access to the My Documents folder, then you
can also save reports to that location for your personal use.

l Click OK to choose the folder and return to the save dialog.
The path to your selected folder now displays in the field.

The report is opened in the current browser tab. You can now review the data using a variety of tools
available to web reports, such as sorting, filtering, and drilling. For more information, see Viewing and
exploring data in web reports.

Once a report is created from template, it cannot be edited—for example, to choose a different fixed
row structure. If you want to use a different fixed row structure, create a new report from template
again. Remember that any changes to the template or to the fixed row structure will automatically flow
through to all reports that use the template or the fixed row structure.

Using the Report Builder
Using the Report Builder, you can create and edit web reports using a drag-and-drop interface. Web
reports are intended to be intuitive for report builders to create and easy for report viewers to use.

Web reports support two different ways to display reporting data in a grid:
l Dynamic rows: Dynamically display data rows based on a specified dimension or grouping.
l Fixed rows: Use predefined fixed row structures to organize data rows into sections with headers,

totals, and subtotals.

The Report Builder opens when you do either of the following:
l Create a new web report from the Intelligence Center.
l Edit an existing web report from the Intelligence Center or from the report viewer.
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� Overview of the Report Builder
The Report Builder is organized into three tabs:

l Build: Use this tab to design the report data and configure report properties. This is the default
tab.

l Parameters: Use this tab to enable and configure interactivity for the report. Report users can
dynamically change the data that displays in the report using report parameters.

l Filters: Use this tab to define report-level filters, to limit the data shown in the report.

In the Build tab, the Report Builder has three main areas:
l The Data Panel on the left side is where you select the data to include in your report.

l The Report Canvas in the middle is where you build the report. Columns can be dragged and
dropped from the Data Panel to the Report Canvas. You can also create calculations to display in
the report columns, and define column groups.

l The Configuration Panel on the right side is where you define properties for the report, the data
grid, and the individual columns. You can configure properties such as report titles, drilling
options, and column formatting.

Overview of the Report Builder

As you build and configure the report, a preview of the grid displays in the Report Canvas area. Several
options are available to control how data is shown in this grid. For more information, see Changing data
display options for the Report Builder.
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� Building a report in the Report Builder
The following is an overview of how to build a report in the Report Builder:

l Define a data context: Each report must have a specified primary table to determine the data
context for the report. Once the data context is defined, you can build the report using columns
from the primary table and from related tables.

l Define report titles: You can define report title text and an optional report description.

l Define the grid rows: Web reports can use dynamically generated rows based on a dimension, or
they can use a fixed row structure. Do one of the following depending on the type of report that
you want to make:

o For dynamic rows, add a row dimension to the grid by dragging and dropping a table
column.

o For fixed rows, specify a fixed row structure by modifying the grid properties.

l Add data columns and calculated columns: Drag and drop table columns out to the grid to define
the data columns for the report, and define calculated columns as needed. You can also define
column groups to create grouped headers in the report.

l Configure grid properties: Configure grid properties such as the total row and user interaction
options, including enabling and configuring drilling options as needed. You can also adjust the
default formats for various column types.

l Configure column properties: Configure properties for each column such as alignment, width,
number format, and column filters.

l Define report filters: You can define general and table-specific filters to limit the data shown in
the report grid.

l Define report parameters: You can optionally create and configure report parameters to allow
end users to dynamically change the data shown in the report.

� Changing data display options for the Report Builder
As you build and configure the report, a sample of the grid data displays in the Report Canvas area. You
can choose how data displays in the sample grid as you build the report.

NOTE: The sample grid is intended to give you an idea of how the report data will display to report
viewers, but it is not intended to be an exact representation of the final report. To see the report as
it will appear to report viewers, use the Preview feature.

To change how data displays in the Report Builder:
1. On the Build tab of the Report Builder, click the gear button at the top of the page to load the

Report Configuration properties.
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2. Select one of the following options for Report data:

l Live data with manual refresh (default): Live data is shown in the grid, however, you must
manually refresh the data after making configuration changes that affect the data shown.
This is for performance reasons, so that you do not have to wait for data queries to
complete in order to continue working on your report. When using this option, data
updates are handled as follows:

o If you add a new column, or make a configuration change that would affect the data
shown in the column, the column will be blank. To populate the grid for data in this
column, click the Refresh Data button.

o If you make a configuration change that would affect the data shown in the entire
grid, the grid will be blank. To populate the grid with the current data, click the
Refresh Data button.

The Refresh Data button is only available when using this option.

l Live data with automatic refresh: Live data is shown in the grid, and the data
automatically updates after you make any configuration changes. Generally speaking, this
option should only be used when the report queries a small set of data so that updates will
be quick, or when you do not expect to be making many configuration changes that affect
data.

l Mock data: Mock data is shown in the grid. When using this option, you can get a basic
idea of how the report columns and format will display to the user, without viewing actual
data. This is a good option if you do not need to made configuration changes that affect
the data, or if you do not need to view the data while you are making these changes.
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Data display options for the Report Builder

Even if you are viewing live data, keep in mind that the grid shown in the Report Canvas is simply meant
as a guide to help you build the report—it is not intended to be a fully functional representation of the
report. If you want to see how the report will display to report viewers, click the Preview button.

NOTE: The Report data option is not saved in the report, and your selection is not saved for future
Report Builder sessions. Every Report Builder session defaults to using live data with manual refresh.

� Previewing a report
The sample grid in the Report Canvas accurately reflects some report configuration details such as
column headers and number format. However, other configuration details are not reflected in the
sample grid. For example:

l Column width may not be accurately reflected in the sample grid. Initially, the grid will expand to
fit the available space. Once there are enough columns to fill the space, the column width will be
honored.

l The sample grid only shows up to ten rows of data (when using dynamic rows) and does not
display paging options.

l Drilling options are not available in the sample grid.

l Report viewer options to sort and filter column data are not available in the sample grid

l Report parameters cannot be used on the sample grid.
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If you want to see how the report will display to end users in the report viewer, including all user
interaction options for the report, click the Preview button at the top of the Report Builder.

The report preview opens in a separate dialog that overlays the Report Builder. Using this preview, you
can view the report data and try out end-user features like sorting, filtering, and drilling the report.
When you are done viewing the preview, click Close at the bottom of the dialog to return to the Report
Builder (or click the X in the top right corner).

The report preview does have a few limitations. Export and share options are not available in the report
preview. Additionally, if hyperlinks are used in the report, the hyperlinks will always open in a new tab,
even if they are configured to open in the same tab—this is done so that clicking a hyperlink will not
close the Report Builder.

� Saving a report
Use the Save button at the top of the Report Builder to save the report. If the report is a brand new
report, you will be prompted to define a name and folder location for the report. Otherwise, the existing
report is saved.

If you have opened an existing report for editing and you want to save a copy of it with a new name,
click the down arrow to the right of the Save button and select Save As.

Save button with Save As option
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NOTE: The Create Web Reports security permission is required in order to use Save As.

If you have made changes to the report but have not yet saved, you will be prompted to save when you
attempt to close the browser tab or navigate to a new location.

Defining the data context for a web report
The data context for a web report determines the overall pool of data that is eligible to be included in
the report. To define the data context, you select a primary table as the "base" table for the report. This
primary table then determines which other tables are eligible for inclusion in the report, based on
lookup relationships. All table columns used in the report must be compatible in the context of the
primary table.

In the Report Builder, the primary table for the data context is specified on the Build tab, in the left-
hand Data Panel. You must select the primary table before you can drag and drop any table columns out
to the grid.

To select a primary table for the data context:
There are two ways to select a primary table for the data context.
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l When you create a brand new report, you are automatically prompted to select a primary table
for the data context.

You can select a table from the drop-down list directly, or type into the box to search for a table
name. The search uses "contains" matching to return any tables that contain the search text
within the table name. Tables that start with the search text are listed first, followed by tables
that contain the search text anywhere in the table name. In the following screenshot, the text
2022 has been used to search for tables with the year 2022 in the name.

Example Select Table prompt when creating a new report
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l If you are already in the Report Builder, then you can define or change the primary table using
the Data Context box at the top of the Data Panel. Click the Edit icon to open the Select Table
dialog (as shown in the previous screenshot).

Once you have selected a table, that table name is shown in the Data Context box, and the Data Panel
populates to show a table tree in three expandable/collapsible sections:

l TableName: The selected table and its columns. This table is the primary table.

l Dimension Tables: Reference tables that the primary table looks up to. If the reference tables
have lookups to other reference tables, these multi-level reference tables are accessible through
the first-level reference tables.

l Related Tables: The contents of this section depend on the type of table selected as the primary
table.

o If the primary table is a data table, then this section contains other tables that look up to
one or more of the same reference tables as the primary table.

o If the primary table is a reference table, then this section contains tables that look up to
the reference table.

You can expand these tables to view the columns, and then drag and drop columns out to the Report
Canvas area so that they can be used as row dimensions or data columns.
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Expanded table tree

In this example, we have selected GL2022 as the primary table. GL2022 is a data table that looks up to
reference tables Dept and Acct. The table tree is populated as follows:

l GL2022: This node contains all columns in GL2022, as well as columns in the lookup tables Dept
and Acct.

l Dimension Tables: This node contains the lookup reference tables Dept and Acct. If the reference
tables look up to other downstream reference tables (multi-level lookups), those downstream
reference tables can be used through these tables.

l Related Tables: This node contains other tables that also look up to Dept or Acct (or to a multi-
level lookup through Dept or Acct). This may include tables such as GL2021, BGT2021, and
BGT2022.
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When you save the report, the data context is saved for that report and will be reloaded into the Data
Panel whenever the report is opened in the Report Builder.

NOTES:
l When choosing the data context, the list of tables is automatically filtered to only show tables

that you have access to. If you have the Administer Tables security permission, all tables will
be shown. This means it can be possible to select a primary table where you do not have
access to any of the data in the table. You can build the report but it will not populate with
data.

l Certain tables can be restricted from showing the in the Report Builder using the system
configuration setting TablesRestrictedFromReportWriter. If a table that you have access to is
not available, it has likely been restricted using this setting.

� Changing the data context
You can change the data context freely until you have done either of the following:

l Dragged and dropped columns out to the grid setup boxes in the Report Canvas
l Selected a fixed row structure for use with the report (when using the Use fixed rows option in

the Grid Configuration properties)

You can still change the data context if needed, but any newly selected primary table must be
compatible with the table columns you have already added to the grid, and with the fixed row structure
you have selected (if applicable). If the newly selected primary table is not compatible, an error will
occur when the Report Builder tries to refresh the grid in the Report Canvas. At this point you have the
choice of selecting a different primary table that is compatible (which may mean returning to the
original primary table), or removing the incompatible columns from the grid, or choosing a different
fixed row structure.

Other settings that must be compatible with the primary table include columns selected as drilling
columns for a Directed drilling configuration. If you change the primary table and any of these settings
are incompatible with the new primary table, an error will occur.

If you change the data context and save the report, the new primary table is now saved for the report
and will be reloaded into the Data Panel whenever the report is opened in the Report Builder.

Specifying the row dimension for a web report
The row dimension for a web report defines the summation level for the row data. For example, you
may want the rows in your grid to show data by department, region, entity, account, or some
combination of dimensions. You specify a table column to use as the row dimension, and then the rows
in the grid are dynamically generated based on the unique values in that column.
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NOTE: If you want your report to use a static row structure with multiple sections instead of
dynamically generating the rows, then use a fixed row structure instead of a row dimension.

The row dimension for the report is placed in the left-hand box at the top of the Report Canvas, known
as the Row Dimensions box. The report grid cannot render until you specify either a row dimension or a
fixed row structure.

Row Dimensions box at the top of the Report Canvas

Web reports can have multiple row dimensions. If two or more row dimensions are specified, then each
row in the report represents a unique combination of the dimensions. For example, if the row
dimension is just Dept, then each row shows data for a department. If the row dimension is Dept and
Acct, then each row shows data by the unique combinations of department and account.

To specify a row dimension for a web report:
1. On the Build tab of the Report Builder, in the Data Panel, expand the table tree until you locate

the column that you want to use as a row dimension.

If the Data Panel is empty, this means you must select a primary table first.

2. Drag and drop the column to the Row Dimensions box at the top of the Report Canvas.

3. Select the column name in the Row Dimensions box, and then use the Column Configuration
panel to configure display properties such as column width, alignment, header text, and
formatting. For more information, see Configuring column properties for a web report.

4. If multiple columns are present in the Row Dimensions box, you can drag and drop them within
the box so that they display in the desired order within the grid.

Once a row dimension is specified, the Data Panel updates to remove any tables that are incompatible
with the specified row dimension. You can now build out the data columns of the report by dragging and
dropping columns from the Data Panel, and by creating calculated columns. For more information, see
Adding data columns and calculated columns to a web report.
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Defining a row dimension for a web report

NOTES:
l If you drag and drop a validated column from a data table to use as the row dimension, such

as GL2022.Dept, this column reference is automatically "elevated" to point to the lookup
table instead, meaning Dept.Dept. This is done so that the column reference is compatible
with other data tables that reference the same lookup table. This elevation only occurs if the
validated column looks up to a shared dimension table.

l Calculated fields from the database cannot be added as row dimensions.

� Using a dynamic column for the row dimension
You may want to design a report where the row dimension is dynamic based on user input. Users can
choose the grouping level that they want to see the rows summarized by.

To configure a report to use a dynamic row dimension, you must:
l Create a Column List report parameter, and configure the parameter to use the columns that you

want users to be able to choose as the row dimension.
l Add a Dynamic column to the Row Dimensions box, and configure that column to use the Column

List report parameter.
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When a report user opens the report, they can use the Report Parameters panel to choose the column
that they want to use as the row dimension. The report then refreshes to show the data grouped by that
column. For more information, see Using report parameters in web reports and Using Column List
report parameters.

� Displaying descriptions for the row dimension
In many cases your row dimension will be a code, such as a department code or an account code, and
you want to display the description for the code next to it. By default, any column with an associated
description is automatically enabled to show the descriptions appended to the column value. If desired,
you can specify a different display format for the descriptions, or you can disable showing descriptions.

This behavior applies to any column with descriptions used in the report, but the most common use
case is for the row dimension columns.
To configure the description display formats for row dimensions:

1. On the Build tab of the Report Builder, select the row dimension column in the Row Dimensions
box.

2. In the Column Configuration settings, on the General tab, enable or disable Show description as
needed.

3. If descriptions are enabled, then select the desired display format from the Description display
format list.

In the following example, the Dept column has been configured to show descriptions using the Value -
Description format. If you select a format that shows descriptions first, such as Description (Value),
then the rows will be sorted by the descriptions instead of the underlying values.

Example row dimension column configured to show descriptions
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� Filtering the row dimension
In some cases you want the report to display a subset of values from the row dimension column, instead
of all values. To filter the row dimension values, use the Filters tab to define a general filter for the
report.

For example, if the row dimension is Dept but you want the report to only display departments that
belong to a specific entity, define a general filter such as Dept.Entity='Entity 1'. This will filter
the grid so that it only shows data that belongs to Entity 1, including the row dimension values.
Department codes that do not belong to Entity 1 will not be included in the data query.

� Changing the row dimension
You can change the row dimension at any time by dragging and dropping additional columns to the Row
Dimensions box, or by removing existing row dimensions.

To remove a row dimension, click the three-dots icon to the right side of the column name and then
select Delete Column. If you remove the only row dimension, the grid in the Report Canvas cannot be
rendered until you specify a new one.

If you change the row dimension after adding data columns and calculated columns, or if you change
the primary table after specifying a row dimension, it is possible that some of the selections may be
incompatible with each other. In this case, an error will display when the Report Builder attempts to
refresh the data in the Report Canvas. You may have to remove incompatible columns, change the row
dimension, or change the primary table in order to restore a valid grid configuration.

If you decide that you want to change the report to use a fixed row structure instead of a row
dimension, use the Grid Configuration properties to enable fixed rows and then choose a fixed row
structure. For more information, see Specifying the fixed row structure for a web report. Any columns
currently placed in the Row Dimensions box will be ignored while fixed rows are enabled for the report.

Using upstream grouping columns as row dimensions in web reports

Under normal circumstances, row dimension columns can be columns on the primary table for the data
context, or columns on lookup dimension tables. However, when the primary table for the web report is
a reference table, you can also optionally use columns from related tables as row dimensions. This type
of configuration is referred to as upstream grouping columns.

Upstream grouping columns can be useful for reporting in certain Axiom Budgeting and Performance
Reporting products that hold important data in reference tables. For example, the Enterprise Decision
Support (EDS) product needs to report on data in the Encounter table, which is a reference table. For
some reports, they want to group this data using a related table such as the EncounterPayor table, yet
still bring in columns from other related tables that look up to the Encounter table (such as CostDetail).
Columns from the EncounterPayor table are considered upstream grouping columns because
EncounterPayor looks up to Encounter instead of the other way around.
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� Identifying upstream grouping columns
A row dimension column is considered an upstream grouping column if both of the following are true:

l The primary table for the data context is a reference table. Reference tables are a particular type
of table classification in Axiom Budgeting and Performance Reporting that can only have one key
column, and can serve as the lookup source for a validated column. Reference tables are also
often referred to as dimension tables, as many reference tables are used to define dimensional
data such as department, account, or entity.

l The row dimension column is from a related table instead of from a dimension table or the
primary table.

� Design considerations and limitations when using upstream grouping columns
When upstream grouping columns are used in a report, the data query uses different syntax than when
using standard row dimensions. This special syntax causes the following design considerations and
limitations:

l Aggregations: Average and Distinct Count aggregation types cannot be used in the report.

l Data impact: When rendering the report, any data from the primary table that is not referenced
by the upstream grouping column is omitted from the report. For example, imagine that the
primary table is Encounter, and you are grouping by a column in the upstream EncounterPayor
table. If there are records in the Encounter table that the EncounterPayor table does not
reference, those records are omitted from the report.

l Total row: When the current row dimension is an upstream grouping column, the totals shown in
the total row may not match the sum of all the displayed rows. This is because multiple values in
the upstream grouping column may reference the same record in the primary table, causing that
record to be included multiple times. The total row displays the total as if each record from the
primary table is only included once. When this situation occurs, a warning icon displays on the
total row, with an explanation of this effect in the tooltip.

For example, imagine that the primary table is Encounter, and you are grouping by a column in
the upstream EncounterPayor table. Payor A and Payor B both reference Encounter 100, so
values associated with Encounter 100 are included in both payor rows in the report. Rather than
double-count the values from Encounter 100, the total row only counts the values once.

Specifying the fixed row structure for a web report
Web reports can optionally use fixed row structures to define the data sections in the report. Instead of
dynamically generating the rows based on a table column, fixed row structures individually define each
row of data, including section headers, subtotals, and totals.
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Fixed row structures are defined separately so that you can reuse them in different web reports, and so
that you can update the row structure in one place and have the changes propagate to all reports that
reference the fixed row structure. The fixed row structure that you want to use in the web report must
already exist—they cannot be created or edited in the Web Report Builder. For more information, see
Managing Fixed Row Structures.

The fixed row structure is specified in the Configuration Panel, using the Grid Configuration properties.
The grid in the Report Canvas cannot render until you specify either a fixed row structure or a row
dimension.

To specify a fixed row structure for a web report:
1. On the Build tab of the Report Builder, in the Report Canvas, click the grid area below the column

setup boxes. This area displays with placeholder text until either a row dimension or a fixed row
structure is specified.

2. In the Grid Configuration properties, enable Use fixed rows.

3. From the Fixed row structure drop-down list, select an existing fixed row structure. You can type
into the box to filter the list by name.
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After selecting a fixed row structure, the Report Canvas area updates as follows:
l The Row Dimensions box updates to show a placeholder column named Fixed Row Header

Column. This column is the column that holds the section titles and data row labels as defined in
the fixed row structure. You can select this placeholder column in order to configure certain
display details about this column within the web report.

l Once you have dragged and dropped at least one data column to the Column Definitions box, you
can use Refresh Data to update the grid and show the sections and rows as defined in the fixed
row structure.
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Example web report using a fixed row structure

NOTES:
l If you want to make changes to the fixed row structure, you must edit the structure in the

separate fixed row structure editor. Any changes made to the row structure will automatically
apply to any web report that uses the fixed row structure.

l The option to Add Dynamic Column above the Row Dimensions box is not available when
using a fixed row structure. Dynamic columns are only available for use when using row
dimensions to generate the rows of the report.

l If you decide that you want to use dynamically generated rows instead of a fixed row
structure, you can simply disable Use fixed rows and then drag a column to the Row
Dimension setup box. For more information see Specifying the row dimension for a web
report.

� Impact on Grid Configuration options
When Use fixed rows is enabled for the grid, multiple grid configuration options become unavailable
because they do not apply to web reports that use fixed row structures. If these options were
configured before fixed rows were enabled for the grid, the configuration will be ignored.

l Enable column filters: Report viewers cannot filter columns when using fixed rows.
l Multi-column sorting: Report viewers cannot sort columns when using fixed rows.
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l Include total row (and related settings): This option does not apply because fixed row structures
have their own defined subtotal and total rows.

l Suppress zero rows: This option does not apply to fixed row structures; all configured rows will
display regardless of whether they return all zero data.

l Grid sort order: This option does not apply to fixed row structures.

� Configuring the Fixed Row Header Column
Most of the display details for the Fixed Row Header Column are configured within the fixed row
structure and therefore cannot be changed within the web report. However, if you select the Fixed Row
Header Column item in the Row Dimension setup box, you can configure the following:

Item Description

Column width The column width of the column in the grid, in pixels. Enter the desired
column width as a whole integer between 30 and 600.

The default width of the Fixed Row Header Column is 400.

Adding data columns and calculated columns to a web report
When creating a web report, you can add as many columns as needed to define the data that you want
to display in the report. You can also define calculated columns, such as to show the difference between
two columns.

The data columns and calculated columns for the grid are placed in the right-hand box at the top of the
Report Canvas, known as the Column Definitions box. This box defines the columns to display in the
report. Although it is possible to add columns and calculated columns to the Column Definitions box
before specifying a row dimension or a fixed row structure, the grid in the Report Canvas will not
populate until the rows are defined.

Column Definitions box at the top of the Report Canvas
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� Adding data columns
To display data in the report, you can drag and drop table columns from the Data Panel to the Column
Definitions box in the Report Canvas. The Data Panel displays the tables and columns that are eligible to
be included in the report, based on the selected data context (primary table) and the specified row
dimension.

To add a data column to a web report:
1. On the Build tab of the Report Builder, in the Data Panel, expand the table tree until you locate

the column that you want to add to your report. You can also use the search boxes at the top of
the panel to find a particular table or column by name.

2. Drag and drop the column to the Column Definitions box at the top of the Report Canvas.

NOTE: When using the default behavior, the new column will render as blank in the report
until you click Refresh Data.

3. If the column is not in the desired location within the grid, drag and drop it within the Column
Definitions box to reorder the columns.

4. Use the Column Settings in the Configuration Panel to configure display properties for the
column, such as column width, alignment, header text, and formatting. For more information, see
Configuring column properties for a web report.

By default, when you drag and drop a column to the grid, that column is selected and its column
properties display in the Configuration Panel. You can return to the column properties at any time
by clicking the column name in the Column Definitions box.
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Example web report after adding data columns

NOTE: If Use fixed rows is enabled for the grid, currently the Report Builder does not dynamically
update the tables listed in the Data Panel based on the specified fixed row structure. If you drag and
drop a column from a table that is not valid in the context of the fixed row structure, a generic error
will occur when the Report Builder attempts to populate the grid.

� Adding calculated columns
Calculated columns can be used to display totals, differences, percentages, and other calculations within
a column of the report. Calculations can be based on columns from related tables that are eligible to be
included in the report.

To add a calculated column to a web report:
1. On the Build tab of the Report Builder, in the Report Canvas, click the plus sign in the top right

corner of the Column Definitions box, and then click Add Calculated Column.
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2. At the top of the Add Calculated Column dialog, define the following properties:
l Header: Enter the column header text for the calculated column. This is effectively the

name of the calculated column. By default, the header text is "Calculation".

l Numeric type: Select the desired numeric type for the calculated column. If this is left at
Default, the default numeric type for calculated columns is Currency.

You can change these properties later using the Column Configuration properties in the
Configuration Panel.

3. To create the calculation, drag and drop columns from the table tree on the left to the calculation
canvas. See Defining calculations for more information.

4. When you are finished creating the calculated column, click OK.

The calculated column is added to the Column Definition box. By default, the new column is blank
until you click Refresh Data.
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5. If the calculated column is not in the desired location within the grid, drag and drop it within the
Column Definition box to reorder the columns.

6. Use the Column Configuration properties in the Configuration Panel to configure display
properties for the column, such as column width and alignment. For more information, see
Configuring column properties for a web report.

By default, when you define a calculated column, that column is selected and its column
properties display in the Configuration Panel. You can return to the column properties at any time
by clicking the column name in the Column Definitions box.

Example web report after creating a calculated column

� Defining calculations
Using the Add Calculated Column dialog, you can build a calculation based on columns from related
tables that are eligible to be included in the report. The column does not have to be present in the grid
in order to be used in a calculation. Numeric values can also be used in the calculation.

The left-hand side of the dialog lists a table tree of available columns, while the right-hand side of the
dialog—the calculation "canvas"—is where you build the calculation. To start the calculation:

l Drag and drop two columns out to the canvas. The two columns are separated by an operator
selector.

l Select the desired operator.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 66



You can continue building the calculation by dragging and dropping additional columns and selecting the
operator. You can also do the following:

l Numeric values: To add a numeric value to the calculation, click the plus icon at the top right of
the dialog. You can then move, reorder, or delete the numeric value just like columns.

l Reorder items: To change the order of columns in the calculation, drag and drop them on the
canvas.

l Parentheses: To add parentheses to a part of the calculation, select Add Parentheses from the
operator selector. The two columns affected by the operator will become enclosed in
parentheses.

l Delete items: To delete an item, hover your cursor over the column and then click the trash can
icon.

Example calculation in the calculation editor

Calculations can use the following operators: addition (+), subtraction (-), multiplication (*), and division
(/). Use parentheses to determine calculation order, such as: (GL2022.Q1-
BGT2022.Q1)/BGT2022.Q1.

Calculations can use the following columns:
l Numeric columns from the primary table, whether or not those columns are also in the grid.
l Numeric columns from related tables, whether or not those columns are also in the grid.
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l Numeric columns from the grid, including other calculated columns. Grid columns display using
the header text defined for the column.

If you use a table column from the grid instead of from the table itself, then the calculation will
use the column as it is configured to display in the grid. For example, if the grid column has a
column filter or uses an alternate aggregation, the calculation will be based on that modified
version of the column.

NOTES:
l If you drag and drop a column from the primary table or a related table, it displays on the

canvas using the column name only—such as M1. You can hover your cursor over the column
box to see a tooltip with the full table.column name—such as GL2022.M1. If you drag and
drop the column from the Grid Columns node, then it will display using the defined header
text for the column.

l If you use a grid column in the calculation, then the grid column cannot be deleted from the
grid because deleting it would cause the calculation to become invalid. An error message will
display if you attempt to delete a referenced column from the grid. To resolve the issue, you
can do one of the following: edit the calculation to remove the reference, delete the
calculated column, or configure the grid column as hidden so that it can still be referenced in
the calculation but not display in the report.

� Editing calculated columns
You can edit an existing calculated column to change the calculation.

To edit a calculated column in a web report:
1. On the Build tab of the Report Builder, in the Report Canvas, click the calculated column in the

Column Definitions box.

2. On the General tab of the Column Configuration properties, click the Edit icon to the right of
the Calculation box.

3. In the Edit Calculated Column dialog, edit the calculation as needed, then click OK.
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� Pre-aggregation in calculated columns
You can pre-aggregate calculations in a calculated column. A pre-aggregate calculation is applied to data
rows in the query before those rows are aggregated by the row dimension.

In this example, the sum of columns Q1 through Q4 have been summed up and presented in a new
calculated column, Total Yearly Budget and the Pre-Aggregation Calculation button is selected.

se of pre-aggregation calculations impacts the total row, if it is enabled. Behavior is as follows:

l Post-aggregation calculations: The calculation is performed on the total row values of the source
columns.

l Pre-aggregation calculations: The values in the calculated column are summed for presentation
on the total row.

l Pre-aggregation calculations can use alternate aggregations if desired. The field is unhidden for
the calculated column when pre-aggregation is enabled. If an alternate aggregation is set and
then pre-aggregation is disabled, the alternate aggregation field is re-hidden and ignored.

� Additional column actions
Once data columns and calculated columns have been added to the grid, you can further adjust them as
follows:

l Reorder columns: To reorder a column in the grid, drag and drop it to any location in the Column
Definitions box. Note that you cannot drag and drop a column from the Column Definitions box to
the Row Definitions box. If you accidentally dragged a column to the wrong box, you must
remove the column and then drag and drop it again from the Data Panel.
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l Remove columns: To remove a column from the grid, click the three-dots icon to the right of the
column name and then select Delete Column. Use caution before removing a calculated
column—if you later decide you want to re-add the column, you will need to re-create the
calculation from scratch.

l Copy columns: To copy a column in the grid, click the three-dots icon to the right of the column
name and then select Clone Column. A copy of the column is created to the right of the original
column. The new column has the same properties as the original column, except that the text
(Copy) is appended to the header text. You can modify the new column as needed in order to
differentiate it from the original, such as to define a filter for the column, or to modify the
calculation.

NOTE: If you copy a table column in the grid (as opposed to a calculated column), it is not
possible to point the column to a different table column. The purpose of copying a table
column is to display multiple instances of the same table column, but using different filters or
different aggregation types.

l Group columns: If you want a set of columns to display under a group header, you can define a
column group and then add the columns to that group. For more information, see Defining
column groups for a web report.

l Configure columns: To configure display properties for a column, select the column name in the
Column Definitions box, then use the Column Configuration properties in the Configuration
Panel. For more information, see Configuring column properties for a web report.

Defining column groups for a web report
You can define column groups in web reports so that certain columns can display together under a
group header. For example, your report might have several actuals columns followed by several budget
columns, and you want these columns to display under the group headers "Actuals" and "Budget".

To define a column group, first you add the group "container" to the Column Definitions box of the grid,
then you add table columns to the group container.

To define a column group:
1. On the Build tab of the Report Builder, in the Report Canvas, click the plus sign in the top right

corner of the Column Definitions box, and then click Add Column Group.
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A new empty column group is added to the Column Definitions box.

2. Drag and drop the desired columns into the column group. You can drag and drop columns that
are already in the Column Definitions box, or you can drag and drop columns from the Data Panel
directly to the group.

3. Select the column group box, and use the Column Group Configuration panel to define the
header text and other properties. See the following section for more information on the available
properties.

The column group displays in the grid with its child columns underneath.
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Example web report with column groups

Once a column group has been created, you can work with it as follows:
l Reordering groups: To reorder a column group, drag and drop the group to another location

within the Column Definitions box.

l Deleting groups: To delete a column group, click the three-dots icon in the top right corner of the
group box and then select Delete Group. However, if you still want to use the columns in the
group, you should drag and drop the columns out of the group before deleting the group. If you
delete the group with columns in it, all of the columns will be deleted as well.

l Copying groups: To copy a column group, click the three-dots icon in the top right corner of the
group box and then select Clone Group. A copy of the group is created to the right of the original
group, including copies of the child columns within the group. The new group has the same
properties as the original group, except that the text (Copy) is appended to the header text. You
can modify the new group as needed in order to differentiate it from the original, such as to
define a filter for the group, or to populate the group with different child columns.

NOTE: If a calculation in the column group references another column in the group, then
when the group is cloned the calculation in the new group is updated to point to the
corresponding column in the new group.
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l Configuring groups: To configure display properties for a column group, select the group in the
Column Definitions box, then use the Column Group Configuration properties in the
Configuration Panel.

l Nested groups: Currently, nested groups are not allowed. You cannot drag and drop a group
within another group.

You can work with columns within the group as follows:
l Adding columns: You can continue to add columns by dragging and dropping them into the group

box. You can also copy columns within the group.

l Removing columns: You can drag and drop columns out of the column group box to remove
them from the group. If you don't want the column to be in the report at all, you can delete the
column as normal.

l Reordering columns: You can reorder columns in the group by dragging and dropping them
within the group box.

l Configuring columns: Columns in a column group can be configured as normal. Select the column
box within the group box to bring up the Column Configuration properties in the Configuration
Panel.

� Column group properties
The following column group properties are available for web reports on the General tab of the Column
Group Configuration panel:

Item Description

Header The header text to display on the group header. Enter the desired header
text.

Hide column Specifies whether the column group is hidden in the report:
l If enabled, then the group is hidden in the report. The group remains

visible in the Column Definitions box so that you can continue to
configure the group as needed.

l If disabled (default), then the group is visible.

Autowrap header text Specifies whether header text wraps:
l If enabled, then header text that exceeds the group width will wrap.
l If disabled (default), then header text that exceeds the group width is

truncated. The user can resize the group wider to view the full header
text.

Header alignment The alignment of the header text over the columns in the group. Select
one of the following: Default, Left, Right, Center. Group headers use
center alignment by default.
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Item Description

Data filter Optional. Defines a filter to limit the data shown in the columns within this
group. This is equivalent to defining the same data filter at the column
level for each column in the group. For more information, see Using group
filters.

� Using group filters
The Data filter property can be used to filter the data coming into the columns within a particular group.
This filter only impacts the data in the group columns; it has no impact on the rest of the report.

To filter the data in a group:
1. On the Build tab of the Report Builder, in the Report Canvas, select the group that you want to

filter.

2. In the Column Group Configuration panel, click the Edit link over the Data filter box to open the
Filter Wizard.

3. In the Filter Wizard, create the filter as needed. For more information on how to use the Filter
Wizard to create a filter, see Using the Filter Wizard in the Report Builder.

The tables available in the Filter Wizard depend on whether the current group consists of
columns from a single table or multiple tables, and the primary table specified as the Data
Context of the report:

l If the group consists of columns from a single table, the Filter Wizard shows that table and
its dimension tables.

l If the group consists of columns from multiple tables, the Filter Wizard shows the following
tables:

o If the group uses columns from multiple tables, and the primary table is a data
table, the Filter Wizard shows the common dimension tables for the tables involved
in the calculation.

EXCEPTION: If the group includes a column from a dimension table, then the Filter
Wizard shows the common dimension tables for all related tables used in the
report, regardless of whether the related table is used in this particular group.

o If the group uses columns from multiple tables, and the primary table is a reference
table, the Filter Wizard shows the primary table and its dimension tables.

EXCEPTION: If the group only consists of columns from related tables (no columns
from the primary table or its dimension tables), then the Filter Wizard shows the
common dimension tables for all related tables used in the group.

If the group contains a calculated column, the columns used in the calculation are considered as
part of the group.
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You can create a filter using any column on the available tables. If you choose to use a predefined
global filter from the Filter Library, the global filter must be based on the same eligible table
columns.

4. Once the filter statement is complete, click OK to close the Filter Wizard and add the filter to the
Data filter box.

Once a filter has been defined for a group, you can modify it as follows:
l To edit the filter, click the Edit link over the Data filter box again and change the filter within the

Filter Wizard.

l To delete the filter, click the Clear link over the Data filter box.

Data filters defined at the group level are combined with any filters defined at the column level. If the
group contains calculated columns, the group filter is applied to all columns referenced in the
calculation. If the calculated column references grid columns, the group filter is combined with any
other filters applied to the grid columns (either at the column level or at the group level, if the column
belongs to a different group). Additionally, if a data filter is defined at the report level, it is also applied.
All relevant filters are combined using AND to determine the data that can display in a particular
column.

If a group has a defined filter, then a filter icon displays next to the group name in the sample grid of the
Report Canvas. This icon is intended to let report builders know about the group filter at-a-glance. The
icon does not display in the report viewer.

Defining report titles and other web report properties
Using the Report Configuration panel in the Report Builder, you can define titles for web reports and
configure other web report properties.
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Example Report Configuration panel

� Defining report titles
Each web report can have a defined title, subtitle, and secondary title. You can also define an optional
report description.
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Example titles as they display in a rendered report

To configure report titles for a web report:
l On the Builder tab of the Report Builder, in the Report Canvas, click on the box for the title text

that you want to edit, then type the desired title text. Once you are finished, you can press Enter
to exit the box (or press Tab, or click outside of the box).

The Title, Secondary Title, and Subtitle are all defined in separate boxes that roughly correspond
to where the titles display in the rendered report.

Click on the title boxes to edit the report titles

When you click on a report title box to make it active, the Report Configuration properties load in the
right-hand Configuration Panel. The titles defined for the report also display in this panel, and can also
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be edited here. Any edits made in the title boxes are reflected in the Report Configuration properties,
and vice versa. An optional Report description can be defined in this panel, or you can define it when
saving the report.

NOTE: Currently, it is not possible to use variables in web report titles.

� Report Configuration properties
Using the Report Configuration panel, you can define a variety of properties for the web report, such as
to associate the report with a file group or to configure database properties for the report. The following
table provides a reference for each property in the panel.

To access the Report Configuration panel, select the Build tab in the Report Builder and then click the
gear button in the top right. The panel is organized into two tabs, General and Advanced.

General report configuration properties

Item Description

Title The main title for the report. This text displays at the top of the report,
over the grid.
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Item Description

Secondary title Optional. The secondary title for the report. If defined, this text displays in
the same line as the main title, separated by a horizontal pipe character.
For example:

Title | Secondary Title

Subtitle Optional. The subtitle for the report. This text displays in smaller font
underneath the main title.

Description Optional. A description for the report.

File group context Optional. The file group associated with the report. The file group context
can be used to report on process management information, or to
generate hyperlinks to plan files in the file group.

Report data Specifies the data display behavior for the Report Builder. This option only
applies to the current Report Builder session, and is not saved in the
report.

NOTE: If you created a web report using the Report Builder in version 2021.2 or 2021.3, that report
may have had one or more Report Filters defined in the Report Configuration properties. These
filters are now defined on the Filters tab. Your existing filters have been migrated to this new
location.

Advanced report configuration properties
The Advanced tab is only visible to administrators and support users.

Item Description

Current Data
Required

This setting is for a pre-release feature that is not yet generally available.

Filtering data in web reports
You can define report-level filters to limit the data shown in a web report. There are three different
types of report filters:

l General filters: General filters are based on reference tables, and impact all tables in the report
that look up to the reference tables used in the filter.

l Table-specific filters: Table-specific filters only impact a single specific table used in the report.
For example, if a report has data from GL2022 and BGT2022, you can define a table-specific filter
that only filters one of those tables.
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l Column value filters: Column-specific filters only impact a single specific table used in the report.
A Filter field displays in the Column Value Configuration area. This filter only works for columns
with a static source type. Column filters are ignored if the column source type is changed to
dynamic.

Report-level filters are defined on the Filters tab of the Report Builder. Any existing filters are displayed
in the left-hand pane. You can select a filter to view and edit its properties in the right-hand pane.

Filters tab of Report Builder

NOTE: Filters cannot be reordered in the Filters tab. Filters are listed in the order they are created.
The order has no impact in how the filters are applied.

Filters can also be defined at the individual column level and group level. In this case, the filter only
applies to the data in the affected column or group. For more information, see Using column filters and
Using group filters.

� Creating report filters for a web report
You can create as many filters as needed for your web report.
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To create a report filter:
1. On the Filters tab of the Report Builder, click the Add button and then select the type of filter

that you want to create:

l General Filter: Define a filter that is based on one or more dimension tables, to filter all
tables in the report that look up to the dimension tables.

l Table-Specific Filter: Define a filter that only impacts a specific table used in the report.
Select the table from the fly-out menu. This menu only lists non-dimension tables that are
used in the report. The primary table is only listed if it is a data table.

Creating a report-level filter

The Filter Wizard opens automatically after you make your selection.

2. In the Filter Wizard, create the filter as needed. For more information on how to use the Filter
Wizard to create a filter, see Using the Filter Wizard in the Report Builder.

The tables available in the Filter Wizard depend on the type of filter you are creating, and the
primary table specified as the Data Context of the report:

l If you are defining a general filter, the Filter Wizard shows the following tables:
o If the primary table is a data table, the Filter Wizard only shows the dimension

tables for the report.

o If the primary table is a reference table, the Filter Wizard shows the primary table of
the report and the dimension tables for the report.

l If you are defining a table-specific filter, the Filter Wizard shows the table that you selected
from the menu and its dimension tables.

Additionally, if the report is configured to report on Process Management columns, then these
columns are also available to define general or table-specific filters. For more information, see
Reporting on process information in web reports.
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You can create a filter using any column on the available tables or on the Process Management
columns (if present). If you choose to use a predefined global filter from the Filter Library, the
global filter must be based on the same eligible table columns.

3. Once the filter statement is complete, click OK to close the Filter Wizard and add the filter to the
Filters tab.

4. Optional. Edit the filter properties as desired. You can give the filter a specific name, define an
optional filter description, and toggle the filter as enabled or disabled. By default, the newly
created filter is enabled and will filter the report data. See the following section for more
information on editing the filter properties.

� Editing existing filters
You can edit all filter properties except for the filter type. It is not possible to convert a general filter to a
table-specific filter or vice versa.

To edit an existing filter:
1. On the Filters tab of the Report Builder, in the left-hand pane, select the filter box for the filter

that you want to edit.

The properties for the selected filter display in the right-hand pane.

2. Edit the filter properties as needed.

Filter properties

Item Description

Name The name of the filter. By default, the name is set as follows:
l General filters use the name General Report Filter.
l Table-specific filters use the name TableName Filter.

You can change this name to something more descriptive as needed. Filter
names only display in the Report Builder.

Description Optional. If desired, you can define a description to document the
purpose and scope of the filter.
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Item Description

Enabled Specifies whether the filter is enabled. By default, filters are enabled and
will impact the data shown in the report.

If desired, you can toggle the filter to disabled in order to keep the filter in
the report properties for future use, but temporarily disable it. When you
are ready to use the filter again, you can toggle it back to enabled.

While the filter is disabled, the filter box in the left-hand pane is grayed
out. The filter will not be applied to the data queries in the report.
However, you can continue to edit the other filter properties while the
filter is disabled.

Filter Criteria The filter criteria statement for the filter. Click Edit to edit the filter within
the Filter Wizard.

If you only want to edit the filter criteria statement, you can hover your cursor over the top right corner
of the box, and click the Edit icon to open the Filter Wizard directly.

� Deleting existing filters
You can delete a report filter if it is no longer needed. Remember that you can disable the filter instead,
if you want to temporarily remove the filter without deleting it from the report.

To delete an existing filter:
1. On the Filters tab of the Report Builder, in the left-hand pane, locate the filter that you want to

delete.

2. Hover your cursor over the top right corner of the box, then click the Delete icon to delete the
filter.

The filter is deleted from the report.
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� Filter notes
General filters and table-specific filters have certain setup and behavior differences.

General filters
General filters are based on reference tables:

l If the primary table is a data table, you can define a general filter using any reference table that
the primary table looks up to. Basically, this means the tables listed in the Dimension Tables node
of the report.

l If the primary table is a reference table, you can define a general filter using the primary table
itself, or using any reference table that the primary table looks up to.

When creating the filter, you can use any column on the reference table, including multi-level lookups
through the reference table. For example, if the primary table looks up to Dept, the filter could be
Dept.Dept=24000 or Dept.Region='West' or Dept.Region.RegionType=1.

The general filter applies to all tables in the report that look up to the reference table (as well as the
reference table itself). For example, imagine that you have a report that compares GL2022 to BGT2022.
You want to define a filter so that the report only shows data for the West Region. In this case you can
define a general filter on the Dept table of Dept.Region='West'. Since both tables look up to the
Dept table, the general filter will apply to both tables and limit the data in the report.

NOTES:
l If the primary data table looks up to multiple reference tables, the general filter can be a

compound filter that uses multiple reference tables. In this case, the filter will only apply to
data tables that look up to both reference tables. For example, imagine you define a general
filter of Dept.Region='West' and Acct.Category='Revenue'. If the report contains a
table that only looks up to the Acct table but not the Dept table, then the filter will not apply
to that table and no error will occur.

l If you define a general filter and then change the primary table of the report to a table that
has different dimension tables, the filter will not cause an error. If the existing filter does not
apply to any tables in the report, it will simply be ignored.

l If the report uses process management columns, you can create a general filter with these
columns.

Table-specific filters
Table-specific filters apply only to the selected table for the filter. All other tables are unaffected by the
filter.

The table-specific filter can use any column in the table or its dimension tables. For example, if the
selected table is BGT2020, the filter could be BGT2020.m1<>0 or
BGT2020.Acct.Category='Revenue' or Dept.Region='West'.
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Table-specific filters can be defined on any table used in the report, except for the following tables.
General filters can be defined for these tables instead.

l Reference tables that are Dimension Tables for the report.

l The primary table, if the primary table is a reference table.

NOTE: If you define a table-specific filter and then later edit the report configuration so that the
table no longer has any columns in the report, the filter will not cause an error. It will simply be
ignored.

Create limit filters
You can use the new limit filter to broaden your ability to view data from any table in your organization.
This powerful new filter lets you generate data sets in a single filter that wasn't possible before.

Axiom has two types of tables:

l Data tables contain transactional or budget data, such general ledger or budget tables.

l Reference tables (also called lookup or dimension tables) are single-key tables with values that
point to other values.

An example of a reference table is the DEPT table, which contains keys for department-related data,
such as department name, department description, and locations, such as WorldRegion and Country.
Data tables contain data that is linked to a key.

A key in a dimension table can point to many data tables.

When you create a report, the tables you can use in the report are listed on the left side:
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You can create a report based on the EDS Encounter table, but without any filters.

Report without filters

For this report, you can view information about a specific population group, such as patients who have
had a total hip replacement.

For a limit report, select the General Filter option, which lets you limit data from any table.
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Filter selection dialog

Here we define the population group of patients who've had total hip replacements:

Selecting value for PopulationName
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After you finish creating the filter, review how the results have changed:

Completed limit filter report

The previous example uses a simple limit filter; however, filters can be as complex and detailed
required.

Notes to remember about filters:

l You cannot directly edit the SQL statement; instead use the filter and selection tools.

l Make sure the data context for your report is a dimension table, so that your report can pull data
from multiple tables. If you use data table as context, the report can only contain data from that
data table.

l Always use the General Filter option when creating a limit filter.

Using report parameters in web reports
Using report parameters, you can enable end users to dynamically change the data showing in the
report. The advantages of using report parameters include:

l You can more efficiently cover your reporting needs using fewer reports, which means less time
needed to develop and maintain reports.

l Report users are more in control over the data they want to see in the report.
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� What can report parameters impact in the report?
Report parameters can be used to dynamically impact the following items in the report:

l The row dimensions used in the report can change dynamically by using Column List report
parameters. For example, the user can dynamically change the row dimension to show data by
different groupings such as department, account, region, entity, and so on.

l The data in the report can be dynamically filtered by using Column Value report parameters. For
example, the user can select one or more values in a column—such as departments, accounts, or
entities—and the report is dynamically filtered to show only the data for the selected values.

Reports can use either or both types of parameters as needed to provide the desired level of
interactivity.

� How are report parameters defined?
Report parameters are defined in the Report Builder using the Parameters tab. Using this tab, you can
create, configure, and delete parameters as needed. When configuring parameters, you define
properties such as:

l The type of parameter, Column List or Column Value
l The name of the parameter and the display text to use when presenting parameters to report

users
l Whether the parameter is optional or required—if required, then the report does not display

data until the user makes a selection
l For Column List parameters, the list of table columns to associate with the parameter, and an

optional default column selection
l For Column Value parameters, the column to associate with the parameter:

o You can select a specific column or you can tie the Column Value parameter to a Column
List parameter, so that Column Value parameter dynamically uses the selected column

o You can specify whether users can select a single value in the column or multiple values
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Example Parameters tab to define report parameters in the Report Builder

� How do users interact with report parameters?
When users view a report with report parameters, the parameters display in a panel along the left-hand
side of the report. Users can make selections and apply them to dynamically refresh the report with
data that meets their selections. If a parameter is required, then the user must interact with the report
parameter panel before the report shows any data.

Example web report using report parameters
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Managing report parameters

Using the Parameters tab in the Report Builder, you can add, edit, reorder, and delete report
parameters. Report parameters enable reports to update dynamically based on selections made by
report users.

When you select the Parameters tab in a report, any existing parameters display in the All Parameters
panel along the left-hand side. You can select a parameter box to view the properties for that
parameter.

Example Parameters tab in the Report Builder

This topic describes the basic features available to manage report parameters in a report. For more
information on how to configure and use specific parameter types, see the following topics:

l Using Column List report parameters
l Using Column Value report parameters

� Adding report parameters
You can add as many report parameters as needed to provide the desired interactivity for the report.
Keep in mind that all report parameters in the report are active and will display to end users.
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To add a report parameter:
l On the Parameters tab of the Report Builder, click Add, then select the type of parameter to

create.

o Column List: Define a list of columns that report users can select from. The selected
column can be used as dynamic row dimension in the report, or as the column for a
Column Value parameter.

o Column Value: Select a column that report users can select values from. The selected
values are then applied to the report as a report filter.

The new parameter is added to the All Parameters panel along the left-hand side. You can now
configure the properties for the parameter, which display in the main area to the right.

General parameter properties

Item Description

Name The name of the parameter. By default, this is set to Report Parameter
(Type). You can edit this name as needed.

The parameter name does not display to report users; it is solely for use in
the Report Builder. You should give the parameter a name that indicates
its purpose.

Display prompt The prompt text to display to report users in the Report Parameters panel.
By default, this is set to Report Parameter (Type). You can edit this name
as needed.

You should define display prompt text that helps users understand the
purpose of the parameter. For example, "Select a department".
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Item Description

Required Specifies whether the parameter is required.
l If enabled, then the report does not refresh with data until this

parameter has a value. The message "Waiting for input" displays in the
report grid until all required parameters have a value.
In the Report Parameters panel, the Apply button does not become
available until all required parameters have a value. Additionally,
required parameters cannot be cleared.

l If disabled (default), then users can optionally leave this parameter
blank (unset) when applying parameter values. The report can refresh
data without this parameter.

Parameter-specific properties
The remaining parameter properties depend on the parameter type. For more information, see:

l Using Column Value report parameters

l Using Column List report parameters

� Editing report parameters
You can edit existing report parameters as needed.

To edit a report parameter:
l On the Parameters tab of the Report Builder, select the parameter that you want to edit in the

All Parameters panel.

The current configuration for the parameter displays in the main area. You can edit the parameter
properties as needed.

� Reordering report parameters
When users view a report with parameters, the parameters are listed in the Report Parameters panel in
the order that they display in the Report Builder. You can reorder the parameters as needed to change
how they display to report users.

To reorder report parameters:
l On the Parameters tab of the Report Builder, select the parameter box that you want to move,

then drag and drop the box to a new location in the list.

NOTE: If you have a Column Value parameter that is dependent on a Column List parameter, the
Column List parameter should be located before (above) the Column Value parameter.
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� Deleting report parameters
You can delete existing report parameters if they are no longer needed. Remember that all parameters
are active and will display to report users, so if a parameter is not needed the only option to hide it from
report users is to delete it.

To delete a report parameter:
l On the Parameters tab of the Report Builder, in the All Parameters panel, click the X icon in the

right-hand corner of the parameter that you want to delete.

Using Column List report parameters

When you use a Column List report parameter, you define a list of table columns to allow the report
user to select a column. The user's selected column can then be applied to the report in one of the
following ways:

l The selected column can be applied to the report as a row dimension. This allows the report user
to dynamically change the row dimension for the report, so that the same report can be used to
view data by different dimensional groupings such as department, region, or entity. In order to do
this, you must configure the report with a dynamic column for the row dimension, and then link
the dynamic column to the Column List report parameter.

l The selected column can be applied to a Column Value parameter. This allows the report user to
select a value or values from the column to be dynamically applied as a report filter and change
the data shown in the report. In order to do this, you must configure the report with a Column
Value parameter, then link the Column Value parameter to the Column List parameter.

When a user views the report with a Column List report parameter, the list of columns is displayed in a
drop-down list, using the header text as defined for the column.

Example Column List parameter in the Report Parameters panel

� Defining a Column List report parameter
Column List report parameters are defined on the Parameters tab of the Report Builder. You can define
as many Column List parameters as needed for the report.

To create a Column List parameter:
1. In the Report Builder, select the Parameters tab.
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2. Click Add > Column List.

The new parameter is added to the All Parameters panel along the left-hand side. The properties
for the parameter now display in the main area.

3. Complete the following general properties for the parameter:

Item Description

Name The name of the parameter. By default, this is set to Report
Parameter (Type). You can edit this name as needed.

The parameter name does not display to report users; it is solely for
use in the Report Builder. You should give the parameter a name that
indicates its purpose.

Display prompt The prompt text to display to report users in the Report Parameters
panel. By default, this is set to Report Parameter (Type). You can edit
this name as needed.

You should define display prompt text that helps users understand
the purpose of the parameter. For example, "Select a department".

Required Specifies whether the parameter is required.
l If enabled, then the report does not refresh with data until this

parameter has a value. The message "Waiting for input" displays
in the report grid until all required parameters have a value.
In the Report Parameters panel, the Apply button does not
become available until all required parameters have a value.
Additionally, required parameters cannot be cleared.

l If disabled (default), then users can optionally leave this
parameter blank (unset) when applying parameter values. The
report can refresh data without this parameter.

NOTE: If the Column List parameter is linked to a dynamic column, the parameter must have
a value in order to refresh data, regardless of whether the parameter is configured as
required.

4. In the Column List Configuration section, complete the following parameter-specific properties:
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Item Description

Selected columns The selected columns for the parameter. Click Edit to select columns
in the Select Columns dialog.
l Use the table treeview in the left-hand panel of the dialog to

locate the columns that you want to use. You can select any
column from the primary table, a dimension table, or a related
table. You can use the search boxes at the top of the panel to
search by table names or by column names.

l Once you locate a column that you want to use, drag the column
to the middle Selected Columns panel.

l For each selected column, define Header text in the right-hand
Column Properties panel. This header text is displayed in the
Column List drop-down when users select a column from the list.
If the Column List parameter is linked to a dynamic column, this
text is also used as the header text for the dynamic column within
the report grid.

l When the columns are presented to report users in a drop-down
list, they will be displayed in the order listed here (top to bottom).
To reorder columns, click on the drag handle in the left-hand side
of the column box, and then drag and drop the column to a new
location within the list.

l After selecting and configuring the columns, click OK to return to
the Report Builder. The selected columns now display in the
Selected columns box.

NOTE: If the primary table is a data table, and a selected column
looks up to a dimension table for the primary table, the column
reference is automatically "elevated" so that it uses the lookup
dimension table instead of the source table. For example, if the
primary table is GL2021, and you select either GL2021.Acct or
BGT2021.Acct, the column reference is elevated to Acct.Acct. This
elevation is done so that the column is valid for use as a row
dimension, and so that any filter resulting from the column is applied
as a general filter affecting all tables that look up to the dimension
table.

Default value Optional. The default value for the parameter. When a report user
opens the report, the parameter will use this value by default.

You can select any of the columns in the Selected columns list to use
as the default value, or you can leave it blank to have no default
value.
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IMPORTANT: The columns selected for the Column List parameter must be valid within the
context of how you intend to use the parameter. If the parameter will be used with a dynamic
column, then all of the selected columns must be valid as row dimensions within the report
configuration. If the parameter will be used with a Column Value parameter, then all of the
selected columns must be valid to be used as filters within the report configuration. If a
column in the list is not valid for use as a row dimension or a filter, an error message will
display when the user attempts to apply that parameter selection to the report. As the report
designer, you should test your parameters to verify that they work as intended within the
report.

Example Column List parameter with a list of columns and a specified default value

� Using a Column List parameter with a dynamic column
In order to use a Column List parameter to dynamically change the row dimension of the report, you
must:

l Add a dynamic column as a row dimension for the report
l Link the Column List parameter to the dynamic column

This configuration is only possible when using row dimensions, meaning the report rows are dynamically
generated based on the row dimension columns. If you are using a fixed row structure in the report,
then the option to add a dynamic column is not available.
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Web reports can use one or more row dimension columns. When using dynamic columns, all of the row
dimensions can be dynamic, or you can have a mix of dynamic and fixed row dimensions.

To define a dynamic column:
1. In the Report Builder, select the Build tab.

2. Click the plus icon over the Row Dimensions box, then select Add Dynamic Column.

A column box labeled Dynamic is added to the Row Dimensions box.

3. In the right-hand Column Configuration panel, from the Dynamic column parameter list, select
the Column List parameter to use with the dynamic column. Parameters are listed by name as
defined on the Parameters tab.
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By default, Axiom Budgeting and Performance Reporting automatically selects the first available
Column List parameter and uses the default value defined for that parameter. If the parameter
does not have a defined default value, the Report Builder uses the first column in the list of
columns defined for the parameter. This is because the Report Builder must be able to associate
the dynamic column with an actual table column in order to refresh data.

If no Column List parameters are defined, or if the Column List parameter does not have a
defined list of columns, then the report cannot be refreshed with data until this issue is resolved.

4. Complete the remaining Column Configuration properties as needed. Note the following:
l The Header property and the related header properties on the Advanced tab are not

available for dynamic columns. The column header text for each column in the column list
is defined when configuring the Column List parameter.

l You can optionally enable Show description and select a Description display format for
the dynamic column. These options will apply if the selected column for the Column List
parameter has an associated description column.

The following example shows a web report configured with a dynamic row dimension column, linked to
a Column List report parameter. The grid is refreshed with data using the default column specified for
the report parameter.
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Example Report Builder with dynamic row dimension

NOTE: In the Report Canvas, the dynamic column displays in the grid using the header text Dynamic.
This only occurs in the Report Builder, so that you know which column is the dynamic column. When
previewing or viewing the report, the dynamic column uses the header text defined for the currently
selected column, as defined in the Column List parameter configuration.

In this example the Column List report parameter lets the user select from three different grouping
levels—Dept.Dept, Dept.WorldRegion, or Dept.VP. The report will refresh with data and use the
selected column as the row dimension.
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Example Column List parameter providing column options for the dynamic row dimension

Example end user experience to select and change the row dimension
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Design considerations for the report user experience
When using a dynamic column with a Column List parameter, you must decide whether you want the
report to refresh using a default column selection, or if you want to require the user to make a selection
before the report refreshes with data.

l If the Column List parameter does not have a specified default column, then when a user opens
the report, it will not refresh with data and instead displays the message "Waiting for input". The
user must select a value for the Column List parameter and apply before the report is refreshed
with data.

l If the Column List parameter has a specified default column, then when a user opens the report,
it refreshes with data using the default column. The user can then optionally change the selected
column in order to refresh the report using a different row dimension.

NOTE: If the Column List parameter that drives the dynamic column does not have a default value,
then the report cannot be exported or shared because it does not have a column to use as the row
dimension. Although report parameter selections made by users are not honored when exporting or
sharing web reports, the default value is honored for the dynamic column when exporting or sharing
the report.

Design considerations for drilling
If you want to use a dynamic column and also enable directed drilling for the report, you must be careful
to ensure that all of the drill columns are compatible with the Column List columns. If the user can select
a column for the Column List parameter that is not compatible with the drill columns, an error will occur
when the user attempts to drill the report.

Alternatively, you can enable drilling and use key column drilling, which will continue to work as long as
all of the columns defined the Column List parameter are valid as row dimension columns.

� Using DateParts in a Column List parameter
You can use DateParts when setting parameters for a ColumnList. Click Parameters from your report
and click Add to add a Column List.

In the Column List Configuration section, click Edit to select a column and then drag the column name to
the Selected columns section. Then use the Date part to retrievemenu to select a date part and click
OK.

� Using a Column List parameter with a Column Value parameter
In order to use a Column List parameter to populate the source column for a Column Value parameter,
you must:

l Define a Column Value parameter
l Configure the parameter as dynamic and select the Column List parameter as the source

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 102



In the following example, the Column Value parameter is configured to use the FilterCols Column List
parameter. First the user will select a column from the Column List parameter, then the user will select a
value or values in that column from the Column Value parameter.

Example Column Value parameter using a Column List parameter to provide the source column
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Example end user experience to choose the filter column and values

For more information on how to configure Column Value parameters and how the selected values are
applied as report filters, see Using Column Value report parameters.

Design considerations for the report user experience
When a Column Value parameter is linked to a Column List parameter, the Column Value parameter is
automatically dependent on the other parameter. This means that the Column Value parameter will not
become active in the Report Parameters panel until a value has been selected for the Column List
parameter. The Column Value parameter will then become active and allow the user to select a value or
values from the column selected for the Column List parameter.

NOTE: Because of this automatic dependency, you should make sure that the Column List parameter
is ordered before (above) the Column Value parameter.

Additionally, you must decide whether you want the Column Value parameter to start with a default
column or not:

l If the Column List parameter does not have a specified default column, then the Column Value
parameter will be disabled until a value is selected for the Column List parameter.

l If the Column List parameter has a specified default column, the Column Value parameter is
enabled and uses the default column. The user can optionally select a different value for the
Column List parameter to change the column used by the Column Value parameter.
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Using Column Value report parameters

When you use a Column Value report parameter, you specify a column from which the user can select
one or more values. The user's selected values for the column are then applied to the report as a report
filter. This allows the user to dynamically change the data shown in the report.

For example, you may design a report that is intended to display financial results for a selected
department or entity. You can create a Column Value report parameter that uses the department or
entity column. The user can select the departments or entities that they want to view, and then apply
the parameter values to refresh the report with the selected data.

When users view the report with a Column Value report parameter, the column values are displayed in a
drop-down list:

l Column values are displayed with descriptions if applicable.
l Users can type text into the drop-down list to filter the list and find a specific value.
l Users can select one value from the list, or multiple values, depending on the parameter

configuration.

Example Column Value parameter in the Report Parameters panel

� Defining a Column Value report parameter
Column Value report parameters are defined on the Parameters tab of the Report Builder. You can
define as many Column Value parameters as needed for the report.

To create a Column List parameter:
1. In the Report Builder, select the Parameters tab.

2. Click Add > Column Value.

The new parameter is added to the All Parameters panel along the left-hand side. The properties
for the parameter now display in the main area.

3. Complete the following general properties for the parameter:
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Item Description

Name The name of the parameter. By default, this is set to Report
Parameter (Type). You can edit this name as needed.

The parameter name does not display to report users; it is solely for
use in the Report Builder. You should give the parameter a name that
indicates its purpose.

Display prompt The prompt text to display to report users in the Report Parameters
panel. By default, this is set to Report Parameter (Type). You can edit
this name as needed.

You should define display prompt text that helps users understand
the purpose of the parameter. For example, "Select a department".

Required Specifies whether the parameter is required.
l If enabled, then the report does not refresh with data until this

parameter has a value. The message "Waiting for input" displays
in the report grid until all required parameters have a value.
In the Report Parameters panel, the Apply button does not
become available until all required parameters have a value.
Additionally, required parameters cannot be cleared.

l If disabled (default), then users can optionally leave this
parameter blank (unset) when applying parameter values. The
report can refresh data without this parameter.

4. In the Column List Configuration section, complete the following parameter-specific properties:

Item Description

Source column type Select one of the following to determine the source of the column for
the Column Value parameter:
l Static column: Select this option if you want to select a specific

column to use as the source column.
l Dynamic column: Select this option if you want to dynamically

use the selected column for a Column List parameter as the
source column.
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Item Description

Selected column If the specified Source column type is Static column, click the Edit
link to select a column from the Select Column dialog.
l Use the table treeview in the left-hand panel to locate the column

that you want to use. You can select any column from the primary
table, a dimension table, or a related table. You can use the
search boxes at the top of the panel to search by table names or
by column names.

l Once you locate a column that you want to use, select it and then
click OK. The selected column name now displays under the
Selected column header.

NOTE: If the primary table is a data table and the selected column
looks up to a dimension table for the primary table, the column
reference is automatically "elevated" so that it uses the lookup
dimension table instead of the source table. For example, if the
primary table is GL2021, and you select either GL2021.Acct or
BGT2021.Acct, the column reference is elevated to Acct.Acct. This
elevation is done so that the column is applied as a general filter
affecting all tables that look up to the dimension table.

Selected parameter
(dynamic column
source)

If the specified Source column type is Dynamic column, then select
the desired Column List parameter to use as the source.

This means that the user will first select a column from the
designated Column List parameter, then the user can select one or
more values from that column using the Column Value parameter.
The Column Value parameter will not be active until the Column List
parameter has a selected value. If the Column List parameter has an
assigned default value, this value will be used as the initial source
column for the Column Value parameter when the report is opened.

Allow multi-select Specifies whether the parameter allows selecting multiple values
from the column. By default, this is disabled, which means users can
only select a single value at a time.

Description display
format

The display format to use for the column values in the drop-down
list. By default, this is set to Description only.

This setting applies when the column used by the Column Value
parameter has an associated description column. If the column used
by the parameter does not have an associated description column,
then this setting is ignored and the column values will display as is.
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IMPORTANT: The column used by the Column Value parameter must be valid as a filter
column for the current report configuration. If a column in the list is not valid for use as a
filter column, then an error message will display when the user attempts to apply the
parameter selection to the report. As the report designer, you should test your parameters to
verify that they work as intended within the report.

Example Column Value parameter allowing report users to filter the report by the source column

� Using DateParts with ColumnValue parameters
You can use DateParts when setting parameters for a ColumnValue. Click Parameters from your report
and click Add to add a Column Value.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 108



Parameters view

In the Column Value Configuration section, select Static column. In the Selected Column section, click
Edit and the select the column you want to use. Then, select which date part to use, such as Full Date.
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Specifying column and date part

When you view the report, you can select a date to apply to the results of the report.

Report with column value drop-down list
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� Using a Column List parameter with a Column Value parameter
In order to use a Column List parameter as the source for a Column Value parameter, you must:

l Create and configure a Column List parameter
l Configure the Column Value parameter as dynamic and select the Column List parameter as the

source

In the following example, the Column Value parameter is configured to use the FilterCols Column List
parameter. First the user will select a column from the Column List parameter, then the user will select a
value or values in that column from the Column Value parameter.

Example Column Value parameter using a Column List parameter to provide the source column
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Example end user experience to choose the filter column and values

For more information on how to configure Column List parameters, see Using Column List report
parameters.

Design considerations for the report user experience
When a Column Value parameter is linked to a Column List parameter, the Column Value parameter is
automatically dependent on the other parameter. This means that the Column Value parameter will not
become active in the Report Parameters panel until a value has been selected for the Column List
parameter. The Column Value parameter will then become active and allow the user to select a value or
values from the column selected for the Column List parameter.

NOTE: Because of this automatic dependency, you should make sure that the Column List parameter
is ordered before (above) the Column Value parameter.

Additionally, you must decide whether you want the Column Value parameter to start with a default
column or not:

l If the Column List parameter does not have a specified default column, then the Column Value
parameter will be disabled until a value is selected for the Column List parameter.

l If the Column List parameter has a specified default column, the Column Value parameter is
enabled and uses the default column. The user can optionally select a different value for the
Column List parameter to change the column used by the Column Value parameter.
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� How Column Value parameter selections are applied as filters
When a Column Value parameter selection is applied to the report, the filter is applied as follows:

l If the source column is from a related table, or if the source column is from the primary table
when the primary table is a data table, then the filter is applied as a table-specific filter.

l Otherwise, the filter is applied as a general report filter.

NOTE: Because columns that look up to dimension tables are automatically "elevated" to the
dimension table when the primary table is a data table, it is not possible to apply table-specific filters
with these columns when using a Column Value parameter. For example, it's not possible to use
BGT2021.Acct in a Column Value parameter, because the column reference is always elevated to
Acct.Acct and therefore applied as a general filter. In the majority of use cases involving columns
that look up to dimension tables, the general filter is the intended filter.

The filters resulting from Column Value parameter selections are applied in the same way as report-level
filters defined in the Report Configuration panel. For more information on the difference between table-
specific filters and general report filters, see Filtering data in web reports.

The syntax used for filters depends on whether the parameter allows single selection or multiple
selection. For example, if the source column is Dept.Dept, filters are created as follows:

l Single selection: A filter will be created such as Dept.Dept=20000.

l Multiple selection: A filter will be created such as Dept.Dept IN (20000,21000,45000).

To make your variable narrow the list displayed to only the departments used in a single table (for
example, GL 2020), enter GL2020.Dept.Dept.

This filter statement is not visible to report users—the users only see their selected value(s) for the
column.

Keep in mind the following:
l It is possible that the source column used by the Column Value parameter is not valid as a filter

column for the report, depending on the report configuration. In this case an error will occur
when the user attempts to apply the parameter.

l It is possible that the Column Value parameter uses a source column that is valid as a filter
column for the report, however, the filter has no effect. For example, if the column is applied as a
table-specific filter but the report does not use any columns from that table, then the table-
specific filter will have no effect and no error will occur.

All report parameters should be tested by the report designer to ensure that they are working as
intended, before rolling out the report to end users.
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Configuring grid properties in a web report
The grid properties define the available features and the overall presentation of data in a web report.
Using the grid properties, you can configure:

l User interaction properties such as whether users can filter columns, sort columns, and reorder
columns

l Display properties such as whether the grid has a total row and whether rows with all zero values
display

l Drilling properties such as what type of drilling is enabled and configuration for directed drilling

In the Report Builder, the grid properties are defined in the right-hand Configuration Panel.

To configure grid properties for a web report:
1. On the Build tab of the Report Builder, in the Report Canvas, click the grid that displays below the

column setup boxes.

2. In the right-hand Configuration Panel, complete the Grid Configuration properties as needed.

Example Grid Configuration properties

The grid configuration properties are separated into two tabs:
l General: Basic grid properties that should be reviewed and configured for all web reports.
l Advanced: Advanced grid properties such as default column formats for the grid.
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� General grid properties
The following grid properties are available for web reports on the General tab of the Grid Configuration
panel:

Column Properties

Item Description

Enable column filters Specifies whether users can filter columns in the grid. Only applies to grids
with dynamic rows; users cannot filter columns in grids where Use fixed
rows is enabled.
l If enabled (default), then filter icons display on columns where Enable

filter is enabled in the column configuration properties. Report users
can use these icons to filter the data shown in the column. If Enable
filter is disabled on a column, the filter icon is not available for that
column.

l If disabled, then filter icons do not display on any columns, regardless
of whether Enable filter is enabled for the column.

Multi column sorting Specifies whether users can sort by multiple columns in the grid. Only
applies to grids with dynamic rows; users cannot filter columns in grids
where Use fixed rows is enabled.
l If enabled, then users can sort the grid by multiple columns. If the grid

is already sorted by a column and a user clicks another column to sort,
then the grid is first sorted by the most recent column and then sorted
by the original column. Columns will remain sorted until the user
toggles the sort disabled for that column.

l If disabled (default), then users can sort the grid by a single column. If
the grid is already sorted by a column and a user clicks another column
to sort, then the sort is disabled on the original column and the grid
becomes sorted by the most recent column.

Users can sort columns by clicking on the column header. Each click
toggles through sort ascending, sort descending, and no sort.

NOTE: The ability to clear the sort is only available if multi-column sorting
is enabled. Otherwise, clicking a column header will toggle between sort
ascending and sort descending. You can click a different column header to
sort by that column, but you cannot clear the sort.

Enable reordering
columns

Specifies whether users can reorder columns in the grid.
l If enabled (default), then users can drag and drop columns within the

grid to temporarily reorder them.
l If disabled, then users cannot reorder columns in the grid.
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Grid Properties

Item Description

Use fixed rows Specifies whether the grid uses dynamic rows or a fixed row structure.
l If enabled, then the grid uses a fixed row structure to define the rows.

Select the structure using the Fixed row structure field. For more
information, see Specifying the fixed row structure for a web report.

l If disabled (default), then the grid dynamically generates rows based
on a table column specified as the row dimension. The row dimension
is specified by dragging and dropping the desired table column into the
Row Dimensions box at the top of the Report Canvas. For more
information, see Specifying the row dimension for a web report.

Fixed row structure Specifies the fixed row structure to use in the grid. Only applies when Use
fixed rows is enabled.

Select an existing fixed row structure to define the rows of the grid. You
can type into the box to filter the list of fixed row structures by name.

Fixed row structures can be created from the Intelligence Center. For
more information on creating fixed row structures, see Managing Fixed
Row Structures.

Include total row Specifies whether a total row is present on the grid. Only applies to grids
with dynamic rows; if Use fixed rows is enabled then the grid uses
subtotal and total rows as defined in the fixed row structure.

l If enabled, then a total row displays at the bottom of the grid. If the
grid data is paged, the total row shows the total of all rows across all
pages.
Use the Total row header label field to define label text for the total
row, such as "Total". This text displays in the last row dimension
column.
Columns displaying numeric, non-dimensional data are included in the
total row by default. If desired, you can exclude a numeric column
from the total row using the column configuration properties.

l If disabled (default), then the grid does not have a total row.
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Item Description

Suppress zero rows Optional. Specifies whether data rows with all zeros are suppressed from
showing in the grid. Only applies to grids with dynamic rows; all zero rows
cannot be suppressed in grids where Use fixed rows is enabled.

Non-key columns that meet both of the following criteria are evaluated to
determine whether a row should be hidden:
l The column data type is Integer (all types) or Numeric.
l The column is from the primary table or an additional data table.

If the primary table is a data table, Integer and Numeric columns on
lookup reference tables are ignored—meaning these columns may have
values, but the row is still suppressed if all applicable data table columns
have zero values. There is one exception: reference table columns are
considered if the column classification is Values and the numeric type is
Currency.

Calculated columns defined in the grid are not evaluated for this purpose
and do not prevent a row from being suppressed.

Enable drilling Specifies whether users can drill down rows in the grid to view the
underlying data.

l If enabled, then users can drill rows in the grid. Use the Drilling type
property to specify what type of drilling options are present:
o Key columns (default): Users can drill down to the key column level

of the data. These drilling options are automatically generated
based on the validated key columns of the primary table. No
additional setup is required.

o Directed: Users can drill down predefined drilling paths. Use the
View/Edit Configuration link underneath the Directed option to
configure the drilling paths.

For more information, see Configuring drilling for web reports.
l If disabled (default), then users cannot drill rows in the grid.
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Item Description

Grid sort order Specifies the sort order for data in the grid.
l Default: Data is sorted by the row dimension columns specified for the

grid, in ascending order. If multiple row dimension columns are
present, the first row dimension column is the primary sort column,
followed by the second row dimension column, and so on.

l Custom: Specify one or more columns to sort the grid data, in either
ascending or descending order. Use the View/Edit Configuration link
underneath the Custom option to select the drill columns.
o The Edit Sorting Configuration dialog lists all columns in the grid. It

is not currently possible to sort by a column that is not present in
the grid. If necessary, you can add a column to the grid in order to
sort by that column, then configure the column as hidden so that it
does not show in the grid.

o To add a column to the sorting configuration, drag the column from
the left-hand panel to the right-hand panel, and then select Asc
(default) or Desc for the sort order. To remove a column from the
sorting configuration, click the X icon on the right-hand side of the
column box.

o If multiple columns are added to the sorting configuration, the top-
most column is the primary sort column, followed by the next
column, and so on. You can reorder the columns in the list by
clicking the drag handle on the left-hand side of the column box
and then dragging and dropping it to a new location.

If a custom sort is specified but no columns are added to the sorting
configuration, the grid will revert to using the default sort order.

NOTES:
l IfMulti column sorting is not enabled for the grid, the grid will still

honor a multi-column sort configuration when the report is initially
rendered. However, if a user sorts by any column, the grid reverts to
single-column sorting with no way to return to the previous sort
configuration other than by reloading the report.

l Process columns cannot be added as custom sort columns.
l If a dynamic column is added to the sort configuration, it displays in

the list with its assigned Column List report parameter name in
parenthesis. If you hover your cursor over the column name in the sort
configuration, the current column used by the dynamic column is
shown in the tooltip.
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NOTE: If you created a web report using the Report Builder in version 2021.1, that report may have
had a defined Data Filter in the Grid Configuration properties. These filters are now defined at the
report level, on the Filters tab. Any existing grid filter will be automatically converted to a general
report filter. In rare cases, this conversion may result in report errors if the grid-level filter is not
valid as a general report filter. If this occurs, you can delete the converted filter and re-create it as a
table-specific filter.

� Advanced grid properties
Using the properties on the Advanced tab of the Grid Configuration panel, you can view and edit
Default column formats for columns in the current report. Select a column Data type that you want to
configure, and this section will populate with the properties for the selected data type.

All columns added to the report will inherit the settings defined here. By default, columns will continue
to inherit any changes made to the default column formats unless the format has been overridden at
the column level.

For example, the default alignment for String columns is Left. When String columns are added to the
grid, they are configured to use the Default alignment, meaning Left. If desired, you can change the
default alignment for String columns to Center, and all String columns in the grid that are using the
Default alignment will now update to use Center alignment. However, if you have manually configured a
particular String column to use Right alignment instead of the Default alignment, that column will
continue to use its configured alignment of Right.
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Item Description

Data type Select a column data type to view and edit the default column formats for
that type. The following data types are available:
l String: Columns containing text or alphanumeric values. Includes table

columns using the String data type.
l Date: Columns containing dates. Includes table columns using the Date

data type.
l DateTime: Columns containing date-time values. Includes table

columns using the DateTime data type.
l Boolean: Columns containing True or False values. Includes table

columns using the Boolean data type.
l Dimension: Columns containing numeric dimension codes. Includes

table columns using Numeric, Integer, or Identity data types, where
the Column Classification is Dimension.

l Decimal: Columns containing decimal numeric values. Includes table
columns using the Numeric data type, where the column has a
Numeric Type of Number.

l Number: Columns containing whole integer numeric values. Includes
table columns using Integer or Identity data types, where the Column
Classification is Value.

l Currency: Columns containing currency numeric values. Includes table
columns using the Numeric or Integer data types, where the column
has a Numeric Type of Currency.

l Percent: Columns containing percent numeric values. Includes table
columns using the Numeric or Integer data types, where the column
has a Numeric Type of Percent.

Additionally, when you create a calculated column, you can specify its
data type as one of the numeric data types. The column will then use the
default column formats for that data type. The default data type for
calculated columns is Currency.

NOTE: Columns that would normally be treated as Number data type are
treated as Dimension data type if they are used as row dimension columns
or drill columns.
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Item Description

Column width The default column width for the selected Data Type, in pixels. Enter the
desired column width as a whole integer between 30 and 600.

The default width for each data type is as follows:
l Currency, Decimal, Percent, Date, Boolean: 120
l Number: 150
l DateTime, String, Dimension: 200

Alignment The default alignment of the column values for the selected Data Type. If
you want to change the default alignment for a data type, select one of
the following: Left, Right, Center.

The default alignment for each data type is as follows:
l String, Date, DateTime, Boolean, Dimension: Left
l Decimal, Number, Currency, Percent: Right

Numeric default properties
The following default properties only display if the selected Data type is a numeric data type. These
properties can be used to define the default numeric format by column data type.

For example, the default number format for the Currency data type uses 0 decimal places, with a
thousands separator, and a negative number format of red parentheses. When a Currency column is
added to the grid, the contents automatically display using this number format. If desired, you can
change the default number format for Currency so that it uses 2 decimal places, and all Currency
columns in the grid will now update to show 2 decimal places. This applies to columns that use the
Currency number format by default, as well as columns that you have manually configured to use the
Currency format. However, if you have manually configured a particular Currency column so that it now
uses a Custom number format instead of the Currency number format, then it will continue to use its
custom configuration.

Item Description

Decimal places The number of decimal places used by the selected Data Type. Enter any
whole number from 0 to 10. You can also use the arrow keys to move the
number up or down.
The default number of decimal places for each numeric data type is as
follows:
l Currency: 0
l Decimal, Percent: 2

The Number data type does not use decimals.
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Item Description

Use 1000's separator Specifies whether the selected Data Type uses a thousands separator:
l If enabled (default), numbers show with a thousands separator, such

as 1,000.
l If disabled, numbers do not use a thousands separator, such as 1000.

Negative number
format

The format used by the selected Data Type to display negative numbers.
Select the desired format from the drop-down list. Available formats use
the minus sign, or parentheses, or red text (or a combination of these
formats).

The default negative number format for each numeric data type is as
follows:
l Decimal, Number, Percent: Minus sign
l Currency: Red text in parentheses

Date and Date Time default properties
The following default properties only display if the selected Data type is a date data type. These
properties can be used to define the default date format by column data type.

For example, the default format for Date columns is Month/Day/Year (such as "10/152022"). When a
Date column is added to the grid, the contents automatically display using this format. If desired, you
can change the default format for Date so that it displays as "October 15, 2022" instead, and all Date
columns in the grid will now update to use this format. However, if you have manually configured a
particular Date column so that it uses a different date format instead of the default format, then it will
continue to use its custom configuration.

Item Description

Date format

or

Date Time format

The format used by the selected Data Type to display date or date-time
values. You can select any of the "full date" formats supported by Date
and DateTime columns, including custom formats. By default, the formats
are:
l Date: 10/15/2020
l Date Time: 10/15/2020 13:25

NOTE: Only "full date" formats are supported as the default format. If you
configure an individual Date or DateTime column to use a different date
part, such as Year or Quarter, then the default date format no longer
applies, and the column is treated as a Dimension data type.

Custom Date format

or

Custom Date Time
format

Use this field to define the custom date or date-time format, if Custom is
specified as the Date format or Date Time format. For more information
on the syntax to define custom date and date-time formats, see Custom
formats.
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� Frequently asked questions
Can I disable paging for a dynamic row grid?
Currently, if the grid uses dynamic rows then the grid is automatically paged if it exceeds 25 rows. This
paging cannot be disabled.

How do I define a grid-level filter to limit the data in the report?
If you want to filter the data in the grid, you can define a report-level filter. Select the Filters tab of the
Report Builder to define one or more report-level filters.

Configuring column properties for a web report
The column properties define the presentation of each column in the grid. Using the column properties,
you can configure:

l Display properties such as header text, column width, alignment, and number formatting
l Data properties such as column filters, alternate aggregation, and display formats for data
l Grid behavior properties such as inclusion in the total row, and whether end users can sort and

filter using the column

In the Report Builder, the column properties are defined in the right-hand Configuration Panel. The
column properties can be defined for both table columns and calculated columns.

To configure column properties for a column in a web report:
1. On the Build tab of the Report Builder, in the Report Canvas, click a column name in either the

Row Dimensions box or the Column Definitions box to select that column.

2. Complete the Column Configuration properties that display in the Configuration Panel.
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The column configuration properties are separated into two tabs:
l General: Basic column properties that should be reviewed and configured for all columns in the

grid.
l Advanced: Advanced column properties to be configured as needed.

� General column properties
The following column properties are available for web reports on the General tab of the Column
Configuration panel. These properties apply to table columns, calculated columns, and dynamic
columns.
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Item Description

Column

or

Calculation

or

Default Column

The following information displays at the top of the panel to identify the
column:
l Column: If the column is a table column, the full Table.Column path

displays for your reference.

l Calculation: If the column is a calculated column, a text representation
of the calculation displays for your reference. You can click the Edit
icon to the right of the box to open the Edit Calculated Column dialog
and edit the calculation as needed.

l Default column: If the column is a dynamic column, the currently used
Table.Column path displays for your reference. This column is
determined by the configuration for the Column List parameter that is
associated with the dynamic column.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 125



Item Description

Dynamic column
parameter

The Column List report parameter to associate with the dynamic column.
Only applies when the current column is a dynamic column.

For more information, see Using Column List report parameters.

Header The header text to display on the column header. Enter the desired
header text.
l If the column is a table column, the column name is used as the header

text by default.
l If the column is a calculated column, the text "Calculation" is used as

the header text by default.

If the column is a dynamic column, the header text is defined in the
Column List parameter settings, for each column that is available to be
selected. Within the Report Canvas only, the dynamic column displays
using the header Dynamic.

Column width The width of the column in the grid, in pixels. Enter the desired column
width as a whole integer between 30 and 600.

The default width depends on the column data type, and is configured at
the grid level. If you do not enter a custom width, then the default width
displays in the Column width box in gray text. If you leave this default
width and the grid-level defaults are changed, then column will update to
use the new default width. For more information, see Configuring grid
properties in a web report.

Alignment The alignment of the column values. Select one of the following: Default,
Left, Right, Center.

The default alignment depends on the column data type, and is configured
at the grid level. If a column is set to use Default and the grid-level
defaults are changed, the column will update to use the new default
alignment. For more information, see Configuring grid properties in a web
report.
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Item Description

Number Format Select Formatting Properties to work with number formats. The number
format used by the column. Only applies to columns that hold numeric
data. Select one of the following:
l Default: The column uses the default number format as defined for the

column's data type at the grid level. If a column is set to use Default
and the grid-level defaults are changed, the column will update to use
the new default number format. For more information, see Numeric
default properties.

l Currency, Decimal, Number, Percent, or Dimension: The column uses
the default number format as defined for the selected data type. For
example, you may have a column that is natively a Decimal column,
but you want it to display using Currency format in a particular report.
If a column is assigned to a different number format, it will also inherit
the default column width and alignment set for the associated data
type, if the column is using the default column with and alignment.

l Custom: The column uses a custom number format as defined in the
column properties. Click Override default formatting to work with
custom number formats.
When Custom is selected, then several additional properties become
available to configure the number format. In this case, the column is
no longer tied to any particular default number format.
o Decimal places: Specify the number of decimal places to display,

from 0 to 10.
o Use 1000's separator: Specify whether the number uses a

thousands separator or not.
o Negative number format: Specify the format to use for negative

numbers.

This option is not available for use with dynamic columns.

Aggregation Select Data Properties to configure Aggregation. The aggregation type
used to aggregate data queried from the database column. Does not apply
to calculated columns or to columns used as row dimensions.

If you want to override the default aggregation type for a database
column, select an aggregation type.

Data filter Select Data Properties to configure the optional Data filter. Defines a filter
to limit the data shown in this column. The column-level data filter should
be used instead of a grid-level data filter when you want the filter to
impact just this column. For more information, see Using column filters.
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Item Description

Enable filter Specifies whether report viewers can filter the report based on the
column contents.
l If enabled (default), and if Enable Column Filters is enabled in the Grid

Configuration properties, then a filter icon is available on the column in
the rendered report. Report viewers can use this column to filter the
grid based on the column contents.

l If disabled, then the filter icon is not available on the column.

This property does not apply to any column in the grid if Use fixed rows is
enabled in the Grid Configuration properties. Fixed row reports do not
support end-user column filtering.

Hide column Specifies whether the column is hidden in the report. Does not apply to
columns used as row dimensions.
l If enabled, then the column is hidden. The column remains visible in

the Report Builder so that you can continue to configure the column as
needed.

l If disabled (default), then the column is visible.

Show description Select Display Properties to work with configure the description text.

Specifies whether you want descriptions to display for dimension values.
This option only applies to key columns, alternate key columns, and
validated columns that have an associated description column.
l If enabled (default), then descriptions display alongside the dimension

values or instead of the dimension values. For example, if the column
is Acct then you likely want the account descriptions to display along
with the account codes.
When this option is enabled, the Description display format field
becomes available. Select the desired display format from this list. By
default, the format Description (Value) is used.

l If disabled, then only the dimension values display. For example, if the
column is Acct then only the account codes will display.

NOTE: If the dimension table has multiple description columns (meaning
columns where Describes Key is True), then the first description column is
used.

If the column is a dynamic column, then this option will be applied when
the currently selected column has a description column, and ignored
when it does not.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 128



Item Description

Include in total row Specifies whether the column is included in the total row, if a total row is
enabled in the Grid Configuration properties. Does not apply to columns
used as row dimensions.

Select one of the following:
l Default: The column is included or not based on its data type. All

numeric columns are included by default unless they are the
Dimension data type. All other non-numeric columns are not included
by default, unless you change the aggregation so that the column
returns a number (such as using Count aggregation on a String
column).

l Include: Override the default behavior and include the column in the
total row.

l Exclude: Override the default behavior and exclude the column from
the total row.

If a column is included in the total row, it is treated as follows:
l Table columns use their default or configured aggregation in the total

row. For example, if a numeric column uses the default aggregation of
sum, the column will be summed in the total row.

l Calculated columns apply their calculation to the total row.

This option does not apply if Use fixed rows is enabled in the Grid
Configuration properties. Columns will be included or excluded in subtotal
or total rows using the default behavior.

Date part to retrieve Specifies the date or date-time part to retrieve, if the column is a Date or
Date Time column. For example, you can return the full date value, or just
the year or month, or the fiscal year or month. For more information, see
Date part and format options.

Date format Specifies the format to display the date values, if the column is a Date or
Date Time column. The available format options depend on the specified
Date part to retrieve. For more information, see Date part and format
options.

The label and visibility of this setting varies depending on the selected
date part. For example, if you selectMonth as the date part, then the
label for this setting isMonth format. If you select a date part that does
not have any formatting options, such as Year, then this setting is hidden.
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� Advanced column properties
The following column configuration properties are available for web reports on the Advanced tab of the
Column Configuration panel. These properties apply to table columns and calculated columns. Dynamic
columns do not use these properties.

Header Properties

Item Description

Header text (row 1) The header text to display on the column header. Enter the desired
header text.

NOTES:
l This is the same property that displays on the General tab as Header.

The header text can be edited from either tab.
l The (row 1) label only displays ifMulti-row header has been enabled.

In this case, the property defines the header text for the top row of the
multi-row header.

Header text (row 2) The header text to display on the second row of the column header. Enter
the desired header text.

This property is only available ifMulti-row header has been enabled.

Multi-row header Specifies whether the column header has multiple rows:
l If enabled, then the header text property updates so that there are

two properties: Header text (row 1) and Header text (row 2). The
default header text populates row 1. You can define additional text to
display on row 2.

l If disabled (default), then only one row of header text can be defined.

Keep in mind that enabling a multi-row header is different than wrapping
header text. If you enable multi-row headers, then you can define two
separate rows of header text. A line break separates each row. If
autowrap is enabled, then each row of header text wraps individually.

If you just want a single row of header text that wraps, you can leave this
option disabled and then enable Autowrap header text.

Autowrap header text Specifies whether header text wraps:
l If enabled, then header text that exceeds the column width will wrap.

IfMulti-row header is enabled, both rows of header text will wrap
individually.

l If disabled (default), then header text that exceeds the column width is
truncated. The user can resize the column wider to view the full
header text.
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Item Description

Header alignment The alignment of the header text. Select one of the following: Default,
Left, Right, Center. All column headers use Default alignment by default.

By default, the header text uses the same alignment as the column
contents (as determined by the Alignment property on the General tab).
If you leave the header alignment set to Default, then the header
alignment will adjust to match the column alignment. If, however, you
want the header alignment to be different than the column alignment,
you can configure this property.

Link Properties
For more information on using hyperlink columns in web reports, see Displaying hyperlinks in web
reports.

Item Description

Enable
link

Specifies whether the column displays hyperlinks. Select this option if you want each
row of this column to contain a hyperlink that dynamically incorporates the current
column value.
If this option is enabled, then the additional link properties in this section become
available; otherwise they are hidden.

Link
type

Specifies the type of link to display in the column:
l Custom: You specify the relative URL for the hyperlink, including using variables to

dynamically incorporate the current column value in the URL.
l Plan file: Axiom Budgeting and Performance Reporting dynamically generates a

hyperlink to the plan file associated with each row. In order to use this option, the
report must have a specified File group context in the Report Configuration
properties, and the row dimension must be the key column of the plan code table
for that file group.

NOTE: This option only displays if the report meets the requirements to support plan
file links. Otherwise, all links are custom links by default, and this option does not
display.
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Item Description

URL Specifies the URL to use in the hyperlink column. Enter a relative location in the Axiom
Budgeting and Performance Reporting system. The URL can use variables as needed so
that the URL value is dynamic per row of the report.

For example, imagine that the report contains the key column of a plan code table (such
as Dept), and you want each plan code to link to the Process Routing page for a
particular plan file process. The full URL to the Process Routing page uses the following
syntax:

https://mycompany.axiom.cloud/process/
processdefinitionID/planfile?planvalue=plancode

The process definition ID will be constant for the URL, but the plan code value needs to
be the current row's department value. The {value} variable can be used for this
purpose. The following relative URL with a variable would be entered into the URL field:

/process/16682/planfile?planvalue={value}

NOTE: The relative URL can be entered with or without the beginning forward
slash.

When the report is viewed, the column will resolve to use the full URL with the current
column value. For example, the row showing Dept 22000 will have the following URL:

https://mycompany.axiom.cloud/process/16682/planfile?planval
ue=22000

When the user clicks on the hyperlink in this row, they will be taken to the Process
Routing page for Dept 22000, for the plan file process associated with process definition
ID 16682.

NOTE: The URL property only displays if the specified link type is custom, or if the Link
type option is not present because all links in the report are custom. When using the
plan file link type, the URL to the plan file is automatically generated by Axiom
Budgeting and Performance Reporting.
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Item Description

Link text Specifies the display text for the hyperlink column. Enter the desired text, using
variables as needed. Keep in mind the following:
l If you want the link text to be the column value—meaning the same value that

would display in the column if the column was not enabled as a link column—then
you can leave this field blank. The current column value is automatically used as the
link text.

l The variable {value} displays the raw column value from the database. For
example, if the column is a numeric column, the value will not have numeric
formatting and will show all decimal places.

l The variable {formattedvalue} displays the column value with formatting—such
as default formatting based on the column type, or applied formatting in the Column
Configuration properties. It is only necessary to use the {formattedvalue}
variable if you want to display the formatted column value along with other link
text. If you just want to display the formatted value by itself, you can leave the field
blank as previously noted.

Link
tooltip

Specifies the tooltip to show when a user hovers the cursor over the hyperlink. Enter
the desired text, using variables as needed. The same variable behavior noted
previously for the Link text property also applies to this property.

Open
link in
new tab

Specifies whether the hyperlink opens in the same tab (replacing the report) or in a new
tab. By default, the hyperlink opens in the same tab. Enable this option if you want the
hyperlink to open in a new tab.

� Using column filters
The Data filter property can be used to filter the data coming into a particular column. This filter only
impacts the data in the current column; it has no impact on the rest of the report.

To filter the data in the current column:
1. Click the Edit link over the Data filter box to open the Filter Wizard.

2. In the Filter Wizard, create the filter as needed. For more information on how to use the Filter
Wizard to create a filter, see Using the Filter Wizard in the Report Builder.

The tables available in the Filter Wizard depend on whether the current column is a table column
or a calculation, and the primary table specified as the Data Context of the report:

l If the current column is a table column, the Filter Wizard shows that table and its
dimension tables.

l If the current column is a calculated column, the Filter Wizard shows the following tables:
o If the calculated column only uses columns from a single table, the Filter Wizard

shows that table and its dimension tables.
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o If the calculated column uses columns from multiple tables, and the primary table is
a data table, the Filter Wizard shows the common dimension tables for the tables
involved in the calculation.

EXCEPTION: If the calculation includes a column from a dimension table, then the
Filter Wizard shows the common dimension tables for all related tables used in the
report, regardless of whether the related table is used in this particular calculation.

o If the calculated column uses columns from multiple tables, and the primary table is
a reference, the Filter Wizard shows the primary table and its dimension tables.

EXCEPTION: If the calculation only consists of columns from related tables (no
columns from the primary table or dimension tables), then the Filter Wizard shows
the common dimension tables for all related tables used in the calculation.

You can create a filter using any column on the available tables. If you choose to use a predefined
global filter from the Filter Library, the global filter must be based on the same eligible table
columns.

3. Once the filter statement is complete, click OK to close the Filter Wizard and add the filter to the
Data filter box.

Once a filter has been defined for a column, you can modify it as follows:
l To edit the filter, click the Edit link over the Data filter box again and change the filter within the

Filter Wizard.

l To delete the filter, click the Clear link over the Data filter box.

Data filters defined at the column level are combined with any filters defined at the column group level
and at the grid level. All relevant filters are combined using AND to determine the data that can display
in a particular column.

If a column has a defined filter, then a filter icon displays next to the column name in the sample grid of
the Report Canvas. This icon is intended to let report builders know about the column filter at-a-glance.
The icon does not display in the report viewer.

NOTES:
l If a data filter is defined for a calculation, the filter is applied to the columns referenced in the

calculation, then the calculation occurs.
l Column-level data filters cannot be defined for columns used as row dimensions. To limit the

rows shown in the grid, use a report-level filter in the Report Configuration properties.
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� Frequently asked questions
I defined a column filter but it isn't impacting the grid data as I expected—why do I still see rows that
don't match the column filter?
A column filter only filters the data coming into that specific column. If you want to define a filter that
impacts the entire report, including the row data, then you should define a filter at the report level.
Select the report title and then use the Report Configuration properties to define one or more Report
filters.

To illustrate the difference, imagine the following uses of a filter to only show data from the West
region:

l Report: When the general filter Dept.Region='West' is defined for the report, the entire grid
is filtered to only show data from the West region. Row dimension values (such as departments)
will only display if they belong to the West region, and column data is limited to only show data
for the West region.

l Column: When the filter Dept.Region='West' is defined on a column, that single column is
filtered to only show data from the West region. Other columns and row dimension values are
not limited by this filter. You might do this if you want to create a report that shows the different
region data in different columns, such as to compare data from the West, East, North, and South
regions side-by-side.

Configuring drilling for web reports
You can enable two types of drilling for web reports:

l Key columns: Users can drill to view the underlying data based on the key columns of the table
specified as the Data Context. This option provides limited "out-of-the-box" drilling functionality
that does not require any further setup.

l Directed: Users can drill to view the underlying data based on predefined drilling paths. The
report designer defines the available drilling paths and can configure certain display attributes for
the drill.

To enable either drilling option:
1. On the Build tab of the Report Builder, in the Report Canvas, select the grid so that the Grid

Configuration properties display in the Configuration Panel.

2. On the General tab of the Grid Configuration properties, enable Enable Drilling.

3. For Drilling type, select either Key columns or Directed.

4. If you selected Directed, click the View/Edit Configuration link to define the directed drilling
paths.
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Example drill options enabled for the grid

� Configuring directed drilling paths
Use the Edit Drilling Configuration dialog to define the drilling paths for directed drilling.

To define drilling paths:
1. In the Grid Configuration properties, click the View/Edit Configuration link under the Directed

drilling option.

2. Drag and drop columns from the table tree to the Drill Columns area in the middle of the dialog.
The available columns for drilling depend on the table specified as the primary table for the data
context:

l If the primary table is a data table, then you can use any column on the primary table or on
a lookup reference table (the Dimension Tables).
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l If the primary table is a reference table, then you can use either of the following:
o Any column on the primary table, including multiple-level lookup references to the

dimension tables.

o Any column on a table that looks up to the primary table (the Related Tables). This
option is not available if the report uses a fixed row structure.

NOTE: If you use a column from a related table, you are effectively using
upstream grouping columns in your drilling path. This means that any special
considerations and limitations that apply to upstream grouping columns also
apply to the drill results. For more information, see Using upstream grouping
columns as row dimensions in web reports.

3. Place the drill columns in the desired order for the directed drilling. Users can drill from the
column at the top of the list down to the column at the bottom of the list. Generally speaking, the
lowest level of detail should be at the bottom—for example: VP > Director > Manager > Dept.

l To reorder columns, click the handle on the left side of the column box to drag and drop
the column to a new position.

l To remove a column, hover your cursor over the column and then click the X on the right
side of the column box.

4. Select each drill column and configure the drill properties in the right side of the dialog. See the
following table for information on these properties.

5. Click OK to complete the drill configuration and return to the Report Builder.
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Example drilling configuration dialog

Drill Column Properties

Item Description

Drill column The full Table.Column path of the drill column displays for your reference,
so that you know which column you are configuring.

Header Header text for the column in the drill results. Enter the desired text. The
column name is used by default.

Column width The width of the column in the drill results, in pixels. Enter the desired
column width as a whole integer between 30 and 600.

By default, the width is 300 for all drill columns, regardless of data type.

Alignment The alignment of the column values. Select one of the following: Default,
Left, Right, Center.
The default alignment depends on the column data type. If a column is set
to use Default and the grid-level defaults are changed, the column will
update to use the new default alignment. For more information, see
Configuring grid properties in a web report.
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Item Description

Show description Specifies whether you want descriptions to display for dimension values.
This option only applies to key columns, alternate key columns, and
validated columns that have an associated description column.
l If enabled (default), then descriptions display alongside the dimension

values or instead of the dimension values. For example, if the column
is Acct then you likely want the account descriptions to display along
with the account codes.
When this option is enabled, the Description display format field
becomes available. Select the desired display format from this list. By
default, the format Description (Value) is used.

l If disabled, then only the dimension values display. For example, if the
column is Acct then only the account codes will display.

NOTE: If the dimension table has multiple description columns (meaning
columns where Describes Key is True), then the first description column is
used.

� Using directed drilling
If directed drilling is enabled and configured, you can drill down the predefined drilling paths to view the
underlying data. Directed drilling works as follows:

l When you view the report, you can hover your cursor over a row to show the magnifying glass
icon on the left side of the row.

l Click the magnifying glass to drill to the first level of the drill. This is the column positioned at the
top of the Drill Columns list in the Edit Drilling Configuration dialog. The drill results open in a
new browser tab.

l From here, you can continue to drill by hovering over a row and clicking the magnifying glass to
go to the next level of the drill. All subsequent drills are performed in the same browser tab.

l Once you reach the final level of the drill, no more drilling options are available and the
magnifying glass no longer displays.
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NOTE: If a particular drill level has data that cannot be associated with any grouping values, then the
drill results contain a row labeled <No value>. This row cannot be further drilled. This situation may
occur if the drill level contains records with a blank or empty string value, or if some of the
underlying data in the row being drilled does not have a reference to the current drill level.

� UsingDateParts in drill column configurations
Use directed drilling to configure a datepart in a drill column configuration.

In Grid Properties in the right sidebar, enable drilling and select the Directed drilling type to configure.
Choose the Directed option and click View/Edit Configurationto open the Edit Drilling Configuration
dialog box. This example shows how DEPT.Dept_Date was configured to retrieve by YearMo.

Once configured, the values are shown by the year and month.
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� Using key column drilling
If key column drilling is enabled, you can automatically drill to the key column level to view the
underlying data. The available key columns are determined as follows:

l If the primary table used as the data context is a data table, you can drill to the validated key
columns on the table. However, any key column used as a row dimension will not be available for
drilling, since the report already shows data at that level.

l If the primary table used as the data context is a reference table, you can drill to the key of the
reference table, unless the key is used as the row dimension.

When you view the report, you can hover your cursor over a row to show the magnifying glass icon on
the left side of the row. From here you can drill as follows:

l If there is only one available key for drilling, click the magnifying glass to drill.
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l If multiple keys are available for drilling, click the magnifying glass to show a list of the available
keys, then click on the key you want to drill.

The drill results open in a new browser tab. If multiple keys were available for drilling, you can optionally
drill the drill results to view the other key(s).

If no keys are available for drilling, then the magnifying glass does not display when you hover your
cursor over the row.

� Presentation of drill results
When you drill, the drill results display in the same browser tab, replacing the original report grid. The
data contents of the drill results are as follows:

l The row dimension(s) of the original report are removed from the grid and replaced with the
current drill column. The drill column is either the current column of a directed drilling path, or
the selected key column.

l All other columns of the report are included in the drill results and show data for the current drill
level.

l If the drill results contain multiple rows of data, the grid includes a total row. If the drill results
contain a single row of data, the total row is omitted.

l Drill results are paged if the results contain many rows.

The current drill path displays along the top of the page. The drill path identifies the row that was drilled
and the current drill level. If you have drilled the drill results, the previous drill levels also display in the
drill path. You can click a previous drill level to return to that level, or you can click the X icon to clear
the drill and return to the original report grid.

The drill column displays as follows:
l For key column drilling, the column alignment and width are determined by the column data

type. The header text is the key column name. Key column values are presented as Description
(Value).

l For directed drilling, the column alignment, width, and header text are as configured in the Edit
Drilling Configuration dialog.
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Example drill results with drilling path displayed at the top

Reporting on process information in web reports
You can include process columns in a web report in order to display status information for plan files in a
plan file process. You can display information such as:

l Current process status for a plan file, including the current step name and number
l Process step history per plan file, including the name and number of each step the plan file has

been active in, the plan file's step status, and the time spent in the step
l Step statistics, such as average time spent in each step and number of workbooks in each step

In order to report on process information, the web report must be associated with a file group. The
process columns are then available to be added to the report, and will return information on the
designated plan file process for the file group.

� Configuring a web report to use process columns
Process columns are not available for use in the Report Builder unless the report is associated with a file
group. This association is made in the Report Configuration properties.

Primary table prerequisite
Process reporting will only work if the primary table selected as the Data Context for the report is
compatible with the plan code table for the file group. In the majority of cases you should select the
plan code table itself. For example, if the plan code table is Dept, then you should select Dept as the
primary table for the report. However, if needed you can use a table with a lookup to the plan code
table instead.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 143



To associate a web report with a file group:
1. On the Build tab of the Report Builder, click the gear button at the top of the page to load the

Report Configuration properties.

2. In the Report Configuration properties, click the Edit link above the File group context box.

3. In the Choose File Group Context dialog, select a file group or a file group alias, then click OK.

Use the radio buttons at the top of the list to toggle between viewing file group aliases or file
groups. When viewing file group aliases, the name of the file group that is currently assigned to
the alias displays in parentheses after the alias name.
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Selecting a file group alias means the report will be dynamically associated with the file group
that is currently assigned to the alias. For example, if the Current Budget alias is updated so that it
points to the Budget 2023 file group instead of the Budget 2022 file group, the report will update
to show the process information for the Budget 2023 file group.

NOTE: The selected file group must have a designated Plan File Process in the file group
properties.

Once a file group context has been selected, a new node appears in the Data Panel named Process
Management. The process columns are listed under this node, organized into Process Status Columns
and Process Step Columns. To use a process column in the report, drag and drop it to the setup boxes at
the top of the Report Canvas just like any other column.
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Process columns available in the Data Panel

� Using process columns
The following tables detail what each process column returns, as well as usage and configuration
guidance for each column. Additionally, note the following:

l When a process column is used in a report, the plan code values are automatically filtered to only
return codes that have any activity in the plan file process. It is not necessary to filter the report
by a ShowOnList column in order to suppress plan code values that are not active in the file
group.

l Process columns can be used as row dimensions or as column definitions, however, only certain
process columns make sense to use as row dimensions. See the column details for more
information.
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Process status columns
The process status columns can be used to display current process status information for plan codes in
the file group. These columns are best used if you want to create a report that shows the current step
and status for each plan file.

When using the process status columns, the row dimension for the report should be just the key column
of the plan code table for the file group. For example, if the plan code table is Dept, the row dimension
should be the Dept key column of that table. This means that each row of the report will be a plan code
in the file group, showing the process status for that plan code. Note the following:

Column Name Description

Process Status Returns the current process status for each plan code. For example:
Active, Stalled, Completed, or Aborted.

Current Step Returns the name and/or number of the current step of the plan file.
l By default, the column is configured to show as Value (Description),

where Value is the step number and Description is the step name.
l You can use the Description display format option in the Column

Configuration panel to change the display format—for example, to
display as Description Only or as Value - Description.

l If you want to display just the step number, disable the Show
description option in the Column Configuration panel.

Process Initiator Returns the name of the user who initiated the process for the plan file.
This column is only available if the associated file group is an on-demand
file group.

NOTE: Reports created prior to version 2022.1 may have a column named Current Step Number—
this column has been deprecated but it will continue to work in existing reports.

Process step columns
The process step columns can be used to return process information for each step that a plan file has
been active in. When using process step columns, you should set the row dimension as follows,
depending on the goal of the report:

l If the goal of the report is to see step detail by plan code, then the row dimension should be set
to both the key column of the plan code table and the Process Step column. This means that the
report will contain a separate row for each combination of plan code and step.

l If the goal of the report is to see grouped information about the step, then the sum level for the
query should be set to just the Process Step column. This is useful to see information such as
average time in step, and the count of workbooks that have been active in the step.
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Column Name Description

Process Step Returns the name and/or number of the step. When using process step
columns, this column should be a row dimension for the report.
l By default, the column is configured to show as Value (Description),

where Value is the step number and Description is the step name.
l You can use the Description display format option in the Column

Configuration panel to change the display format—for example, to
display as Description Only or as Value - Description.

l If you want to display just the step number, disable the Show
description option in the Column Configuration panel.

Sub-steps are returned using decimals, such as 2.1 and 2.2. Even though
this column is a string column, if the report is sorted by the Step Number
column the numbers will be sorted in the correct order.

Step Status Returns the status of the step per plan file. This column is only useful
when the row dimension is set to both the key column of the plan code
table and the Process Step column.

Time In Step Returns the time spent in each step per plan file. Although the raw value
for this column is seconds, the total seconds are translated into the
highest useful time value for display in the report—whether that is
seconds, minutes, hours, or days. Therefore, one plan file may list the time
in step as "25 minutes" while another plan file may list the time in step as
"2 days".

If the row dimension for the report is set to just the Process Step column,
then the Aggregation for the Time In Step column should be changed to
Average so that the column returns the average time spent in the step
(for all plan codes that were ever active in the step). Otherwise the
column will return the total time spent by all plan codes in the step, which
is likely not a useful value.

NOTE: If you use this column in a calculation, the calculation will be based
on the raw seconds value. Therefore if you want to return the time in step
using the same time unit for all plan codes, regardless of how long they
have been in the step, you can use a calculation to do so. For example,
divide the time in step by 86400 to convert the seconds to days.
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Column Name Description

Workbook Count Returns the count of workbooks that have been active in the step. This
column is only useful when the row dimension is set to just the Process
Step column, so that you can see the count for all plan codes that have
been active in the step. If the key column of the plan code table is
included as the row dimension, then the Workbook Count will always
return 1 for each plan code / step combination, which is likely not a useful
value.

This column always uses Count aggregation and cannot be changed.

NOTE: Reports created prior to version 2022.1 may have columns named Step Number and Step
Name—these columns have been deprecated but will continue to work in existing reports.

� Filtering based on process columns
When a report uses process columns, the report can be filtered based on these columns.

l End user filtering: If a process column is enabled for end user filtering (Enable filter is enabled for
the column), then users viewing the report can filter it on the fly. For example, a user may want
to filter the Process Status column to only see plan files that are currently stalled in the process.

Example end user filtering on process columns
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l Report filtering: Process columns can be used to define a general report filter or a table-specific
report filter, to limit the data shown in the report. For example, you may want to filter the report
to only show plan files in a certain step or with a certain status. The Process Management
columns are only available in the Filter Wizard dialog when the report is configured to enable use
of process columns.

Example filter using process columns

Process Management columns cannot be used as column filters on columns or calculations, or on
groups. The Process Management columns node is hidden when the Filter Wizard is opened in
these contexts.

NOTES:
o When filtering by process columns, you should base the filter on the same set of

columns that you are using in the report (Process Status Columns or Process Step
Columns). Although it is possible to cross-filter, the results may not be as expected
since these two sets of columns are looking at the process information from two
different angles.

o If you are filtering by Time in Step, input the number as seconds. The Filter Wizard will
then convert that number to the largest relevant time unit for display in the dialog.

� Example process reports
The following screenshots show some of the reports that can be created using process columns. These
examples only use process columns, but the reports could contain additional columns from the plan
code table or from related data tables, in cases where it makes sense to show this additional
information.

The first example shows a report using process status columns, for the purpose of viewing the current
status of each plan code. The row dimension is the key column of the plan code table (CapitalID).

Web report with process status columns
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The second example shows a report using process step columns, for the purpose of viewing process
history for each plan code. The row dimension is set to the step name and the key column of the plan
code table (Dept). The end user could filter the Dept column to view the history for a specific plan code.

Web report with process step columns, grouped by key column and step

The third example shows a report using process step columns, for the purpose of viewing process
statistics. The row dimension is set to the step number only, so that the process data is aggregated at
the step level. The columns show the count of workbooks that have been active in each step, as well as
the average time in step per workbook.

Web report with process step columns, grouped by step
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Displaying date and date-time values in web reports
When using Date or DateTime columns in web reports, you can display the values in a variety of
different ways:

l You can choose to report on the full date or date-time value, or you can choose to report on just
a part of the value by selecting a date part. When you use a date part you are extracting a specific
portion of the date, such as Year, Month, Quarter, and so on.

l You can choose various formatting options for the date or date-time value. For example, you can
display the full date as 10/10/2022 or as October 10, 2022. Many of the date part options also
support various formats. For example, you can display the Month date part as 10 or Oct or
October.

� Using date formatting versus date parts
There is a significant difference between defining a display format for a date or date-time value, versus
using a date part. When you choose a date part, then for the purposes of this report you are effectively
changing the column data type and contents to match the selected date part. For example, if you specify
the date part as Month, the column is now treated as if it contains values from 1 to 12 representing
each month. All of the other information about the date or date-time value is ignored. This means that
you can use the column as a row dimension, and the values will be grouped by month instead of by the
underlying date or date-time value.

Date formatting, on the other hand, is primarily for display only. The display format does not
fundamentally change the way the values are treated. For example, you can choose to format a full date
value as simply October 2022, but in this case the column values in the report are still the full date. If
you use this column as a row dimension, you will likely see multiple instances of October 2022 as rows,
because the underlying column values are different dates in October 2022 such as 10/102022,
10/11/2022, and so on. You are really grouping the report by the full date values and not by the display
format. If instead you want to group the report by month and year (or "yearmo"), then you can select
the YearMo date part. Now the column values are effectively transformed to integer yearmo values for
purposes of the report, enabling the report data to be grouped by unique yearmo combinations.

Other benefits of using date parts include:
l Column values are sorted by the date part and its chosen display format. For example, if the date

part is Month, the column will be sorted as expected whether you choose to display the month as
1-12 or as January-December. Full date or date-time values are always sorted by the full date or
date-time regardless of display format.

l If end-user filtering is enabled for the column, the filtering options match the configured date
part. For example, if the date part is Quarter, the user can filter by selecting from the list of Q1-
Q4 values.
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l Date parts can also be used when defining filters for the report data, such as general filters or
column filters. This makes it easier to construct filters based on a portion of the date or date-time
value. For more information, see Using date part filtering.

l Date parts support the concept of a fiscal year calendar. For example, you can choose to return
the calendar month or the fiscal month, if they are different for your organization.

� Configuring date parts and display formats for Date and DateTime columns
Use the Column Configuration properties to specify the date part and display format for any Date or
DateTime columns in your report.

To configure the date part and display format for a Date or DateTime column:
1. On the Build tab of the Report Builder, in the Report Canvas, click a column name in either the

Row Dimensions box or the Column Definitions box to select that column.

2. Complete the following Column Configuration properties in the Configuration Panel, on the
General tab:

Item Description

Date part to retrieve Specifies the date or date-time part to retrieve for this column. For
example, you can return the full date value, or just the year or
month, or the fiscal year or month.

By default, this property is set to Full Date or Full DateTime, which
means the column will return the full date or date-time value. You
can then use the Date format property to specify how this value
should display in the report.

You can optionally chose a different date part in order to extract and
retrieve a specific aspect of the date or date-time value. When a date
part is selected, the column data is effectively transformed into the
date part values for purposes of this report. For more information on
the available date part options, see Date part and format options.

Date format Specifies the display format for the date or date-time values. The
available formatting options depend on the specified Date part to
retrieve. Some date parts, such as Year, do not have additional
formatting options, in which case this property does not display.

The label of this property varies depending on the selected date part.
For example, if you selectMonth as the date part, then the label for
this setting isMonth format.

For more information on the available formats for each date part, see
Date part and format options.
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Item Description

Custom Date
Format

Specifies the custom format to use for the full date or date-time
value, if the Date format property is set to Custom. For more details
on the available options to define default custom formats, see
Custom formats.

NOTE: The labels for these properties vary depending on whether the column is a Date or
DateTime column. For example, if the column is DateTime, then the properties are labeled
DateTime part to retrieve, DateTime format, and Custom DateTime Format.

Example date part and format properties in the Column Configuration panel

� Date part and format options
You can configure Date and DateTime columns to display in various ways using the date part and format
options:

l Date part: Specify the part of the date or date-time value that you want to display—such as the
full date or date-time, the year or fiscal year of the date, the month or fiscal month of the date, or
the hour or minute from the time.

l Format: Specify the format to display the selected date part. For example, if you select full date,
you can display it as 10/15/2022 or October 2022 or Thursday, October 15, 2022. If you select
Month, you can display it as 10 (the month number), Oct, or October.

The following tables detail the date part and format options. Where multiple formats are available, the
default format is shown in bold. If only one format is available for a particular date part, then the Date
format property does not display.
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Standard date and time options

Date Part Description Format

Full Date Use the full date stored in
the column. Only applies to
Date columns.

This option is the default
date part for Date
columns.

l Default
l Custom
l ShortMonth Year (Oct 2022)
l Month Year (October 2022)
l Month/Date/Year as Date (10/15/2022)
l Day, Month Date, Year (Thursday, October

15,2022)
l YearMonth as Number (202210)
l YearMonthDay as Number (20221015)

Date data types have a configured default that
is set at the grid level. If a column is set to use
Default and the grid-level defaults are changed,
the column will update to use the new default
format. For more information, see Configuring
grid properties in a web report.

Full DateTime Use the full date-time
stored in the column. Only
applies to DateTime
columns.

This option is the default
date part for DateTime
columns.

Same as Full Date, plus the following additional
options:
l Month/Date/Year Hour:Minute as DateTime

(10/15/2022 13:25)
l Month/Date/Year Hour:Minute:Second

DayPeriod as DateTime (10/15/2022 1:25:00
PM)

l Day, Month Date, Year Hour:Minute:Second
DayPeriod (Thursday, October 15, 2022
1:25:00 PM)

l YearMonthDate Hour:Minute as Number
(20221015 13:25)

Date Time data types have a configured default
that is set at the grid level. If a column is set to
use Default and the grid-level defaults are
changed, the column will update to use the new
format. For more information, see Configuring
grid properties in a web report.

Date Only Use the date part of the
date-time. Only applies to
DateTime columns.

Same formats that are available for Full Date.
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Date Part Description Format

YearMo Use the combined year and
month of the date.

Year and Month combined (202210)

Year Use the year part of the
date.

Full year (2022)

Quarter Use the quarter for the
date.

l Number of the Quarter (1-4)
l Number of the Quarter with Prefix (Q1)
l Text Description (1st quarter)

Month Use the month part of the
date.

l Number of the Month (1-12)
l Number of the Month with 2-Digits (01)
l Short Name of the Month (Jan)
l Name of the Month (January)

Week Use the number of the
week for the date, within
the year.

Number of the Week (1-52)

Day of Year Use the day of the year for
the date.

Number of the Day (1-365)

Day of Month Use the day of the month
for the date.

Number of the Date (1-31)

Day of Week Use the day of the week
for the date. The first day
of the week is Sunday.

l Number of the Day (1-7)
l 2-Letter Abbreviation for the Day (Su)
l Short Name of the Day (Sun)
l Name of the Day (Sunday)

Hour Use the hour of the date-
time. Only applies to
DateTime columns.

l 24-Hour Clock Number (0-23)
l 12-Hour Clock with Day Period (1 AM)
l 24-Hour Clock as Hundreds (100)

Minute Use the minute of the
date-time. Only applies to
DateTime columns.

Number of the minute (0-59)
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NOTES:
l If a column is configured to display the full date or date-time, but the selected format only

shows a part of it, the column sorting and filtering remains based on the full date or date-time
value.

l If a DateTime column is configured to display the hour, the column filtering is always based on
0-23, regardless of the display format. For example, if the display format is a 12-hour clock
with day period, filtering by 13 displays values of 1 PM.

l If a Date or DateTime column is configured to use a date part that is not the full date part—
such as Year, Quarter, or Month—the column becomes a Dimension date type for purposes of
inheriting the default alignment and column width.

Fiscal year options
The fiscal year for your system is determined by the system configuration setting
ClientFiscalYearEndMonth. By default, this is set to 12, which means the fiscal year is the same as the
calendar year. If your organization uses a different fiscal year end, your implementation consultant
should adjust this setting accordingly.

For example, if your organization's fiscal year ends in June, the ClientFiscalYearEndMonth setting should
be changed to 6. This means:

l A date of 6/1/2022 is in fiscal year 2022 and represents month 12 of the 2022 fiscal year.
l A date of 7/12022 is in fiscal year 2023 and represents month 1 of the 2023 fiscal year.

When the fiscal year is different than the calendar year, the fiscal year options will return different date
information than the corresponding standard date options. Continuing the example where the fiscal
year end is June, the following return values apply to a date of 7/1/2022:

l The Year part will return 2022, whereas the Fiscal Year part will return 2023.
l The Quarter part will return Q3, whereas the Fiscal Quarter part will return Q1.
l The Month part will return 7, whereas the Fiscal Month part will return 1.

Date Part Description Format

Fiscal YearMo Use the combined fiscal
year and month that the
date belongs to.

Year and Month combined (202310)

Fiscal Year Use the fiscal year that the
date belongs to.

Full year (2023)

Fiscal Quarter Use the fiscal quarter that
the date belongs to.

l Number of the Quarter (1-4)
l Number of the Quarter with Prefix (Q1)
l Text Description (1st quarter)
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Date Part Description Format

Fiscal Month Use the fiscal month that
the date belongs to.

l Number of the Month (1-12)
l Number of the Month with 2-Digits (01)
l Number And Short Name of the Month (1 -

Jan)
l Number And Name of the Month (1-

January)

� Custom formats
When using the Full Date or Full DateTime parts, you can optionally specify a custom format to display
the date or date-time value. When you select Custom as the format, a Custom Date Format box
becomes available so that you can enter the custom format syntax. The following case-sensitive syntax
can be used in the custom format:

Desired
Date/Time Part

Syntax Notes

Day Period a Returns the day period AM or PM.

Day of Month d For the day number (1), use one or two letters (d or dd). dd
enforces 2 digits.

Day of Week E or e l For the abbreviated day name (Sun), use one upper-case
letter (E).

l For the full name (Sunday), use four upper-case letters
(EEEE).

l For the numerical day of the week (1), use one lower-case
letter (e). Sunday is the first day.

Hour H or h l For the hour in the 12-hour clock (1-12), use one or two
lower-case letters (h or hh). hh enforces two digits.

l For the hour in the 24 hour clock (0-23), use one or two
upper-case letters (H or HH). HH enforces two digits.

NOTE: Use k if you want to display the 24 hour clock as 1-24
instead of 0-23.

Minutes m For the minutes number (1), use one or two letters (m or mm).
mm enforces 2 digits.

Month M l For the numerical month (1), use one or two letters (M or
MM). MM enforces 2 digits.

l For the short name (Jan), use three letters (MMM).
l For the wide name (January), use four letters (MMMM).
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Desired
Date/Time Part

Syntax Notes

Seconds s For the seconds number (1), use one or two letters (s or ss). ss
enforces 2 digits.

Quarter Q l For the numerical quarter (1), use one or two letters (Q or
QQ). QQ enforces 2 digits.

l For the abbreviation (Q1), use three letters (QQ).
l For the text description (1st quarter), use four letters

(QQQQ).

Year y l To render the full year (2022), use one letter (y).
l To render a two-digit year (20), use two letters (yy).

For example, to render a date as 2022 Oct 10, you would enter the following into the Custom Date
Format box: y MMM d.

Example custom date format

Displaying hyperlinks in web reports
Web reports can display hyperlinks within a column, so that each row can link to a designated page or
plan file relating to the current row of the report. You can define two different types of links:

l Custom: Link to any page in the Axiom Budgeting and Performance Reporting system by entering
a relative URL. Variables can be used in the URL so that it is unique per row of the report.

l Plan File: Link to any set of plan files in the Axiom Budgeting and Performance Reporting system.
When using this option, Axiom Budgeting and Performance Reporting dynamically generates the
URL to each plan file on a per row basis, given a file group context. The row dimension of the
report must be the key column of the plan code table in order to generate the links.
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Example report with a hyperlink column

To configure a column in a web report to show hyperlinks:
1. On the Build tab of the Report Builder, in the Report Canvas, click a column name in either the

Row Dimensions box or the Column Definitions box to select that column.

You must select the column name in the setup boxes and not the column name in the grid below.
Selecting a column name in the preview grid causes the Grid Configuration to display instead of
the Column Configuration.

NOTE: The ability to display hyperlinks within a column is not available if the report uses fixed
rows. Additionally, the following column types cannot be enabled to display hyperlinks:
dynamic columns and process columns.

2. In the Column Configuration panel, select the Advanced tab.

3. In the Link properties section, select Enable links.

4. Complete the Link properties as needed.
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Example hyperlink properties

Once a column is enabled to show links, the column will display the contents of the Link text property. If
the Link text property is left blank, the normal column contents display. Column contents are styled as
hyperlinks with blue underlined text when the report is viewed in Preview mode or in the report viewer.

NOTES:
l Hyperlinks do not show on the column within the Report Canvas grid. You must view the

report in Preview mode or the report viewer in order to see and interact with the hyperlinks.

l If you click a hyperlink while viewing the report in Preview mode, the link always opens in a
new tab, regardless of the link property configuration. This is done so that clicking the
hyperlink does not cause you to exit the Report Builder.

l Hyperlinks are not preserved when exporting a report. If you export to PDF, the column
displays the link text without an active hyperlink. If you export to Excel or a delimited file, the
link configuration is ignored, and the regular column value is exported (as if the column were
not enabled to show links).

� Link properties
The following properties are available in the Advanced tab of the Column Configuration panel when
Enable links is enabled.
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Item Description

Link
type

Specifies the type of link to display in the column:
l Custom: You specify the relative URL for the hyperlink, including using variables to

dynamically incorporate the current column value in the URL.
l Plan file: Axiom Budgeting and Performance Reporting dynamically generates a

hyperlink to the plan file associated with each row. In order to use this option, the
report must have a specified File group context in the Report Configuration
properties, and the row dimension must be the key column of the plan code table
for that file group. For more information, see Setting up a report for plan file links.

NOTE: This option only displays if the report meets the requirements to support plan
file links. Otherwise, all links are custom links by default, and this option does not
display.
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Item Description

URL The URL to link on each row. The URL must be to a relative location within the Axiom
Budgeting and Performance Reporting system. When the report is viewed, the full URL
will be generated by appending the relative URL to the current Axiom Budgeting and
Performance Reporting system address.

To make the link dynamic, use the Insert Variablemenu above the box to insert a
variable for use within the URL. For more information, see Using variables in the link
properties.

For example, imagine that the report contains the key column of a plan code table (such
as Dept or CapReq), and you want each plan code to link to the Process Routing page
for a particular plan file process. The full URL to the Process Routing page uses the
following syntax:

https://mycompany.axiom.cloud/process/
processdefinitionID/planfile?planvalue=plancode

The process definition ID will be constant for the URL, but the plan code value needs to
be the current row's department value. The {value} variable can be used for this
purpose. The following relative URL with a variable would be entered into the URL field:

/process/16682/planfile?planvalue={value}

NOTE: The relative URL can be entered with or without the beginning forward
slash.

When the report is viewed, the column will resolve to use the full URL with the current
column value. For example, the row showing Dept 22000 will have the following URL:

https://mycompany.axiom.cloud/process/16682/planfile?planval
ue=22000

When the user clicks on the hyperlink in this row, they will be taken to the Process
Routing page for Dept 22000, for the plan file process associated with process definition
ID 16682.

NOTE: The URL property only displays if the specified link type is custom, or if the Link
type option is not present because all links in the report are custom. When using the
plan file link type, the URL to the plan file is automatically generated by Axiom
Budgeting and Performance Reporting.
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Item Description

Link text Optional. Specifies the display text for the hyperlink column. Enter the desired text,
using variables as needed. For more information, see Using variables in the link
properties.
If you want the link text to be the regular column value—meaning the same value that
would display in the report if the column was not enabled as a link column—then you
can leave this field blank. The regular column value is automatically used as the link
text.

Link
tooltip

Optional. Specifies the tooltip to show when a user hovers the cursor over the
hyperlink. Enter the desired text, using variables as needed. For more information, see
Using variables in the link properties.

Open
link in
new tab

Specifies whether the hyperlink opens in the same tab (replacing the report) or in a new
tab. By default, the hyperlink opens in the same tab. Enable this option if you want the
hyperlink to open in a new tab.

NOTE: If the link type is Plan file and the plan files are spreadsheets that will open in
the Axiom Budgeting and Performance Reporting Desktop Client, then you should not
enable this option because it does not apply. The links will work either way, but if you
enable the option to open in a new tab, then Axiom Budgeting and Performance
Reporting will first open an empty browser tab and then launch the Desktop Client.

� Using variables in the link properties
The following variables can be used in the URL, Link text, and Link tooltip properties, so that these
values can be unique per row of the report. To insert a variable, use the Insert Variablemenu above
each field. Once the variable has been inserted into the field, you can enter any additional text as
needed.

Item Description
{value} Resolves as the raw column value for the current row. For

example, if the column is a numeric column, the value will not
have numeric formatting and will show all decimal places.
This variable is most appropriate for use in the URL property,
when the URL contains the column value. For example, the URL to
the Process Routing page contains the plan code value.

{formattedvalue} Resolves as the formatted column value for the current row,
honoring any default formats for the column type and applied
formatting in the Column Configuration properties.
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Item Description
{column:
TableName.ColumnName}

Resolves as the raw value in the specified table column, for the
current row. This can be used if you need to reference a value
from a different column than the current column in any of the
URL properties.

Edit the variable to replace the TableName.ColumnName text
with the desired table column name. For example:
{column:Dept.Description}

{column:
TableName.ColumnName
:format}

Resolves as a formatted value in the specified table column, for
the current row. This can be used if you need to reference a
numeric value from a different column than the current column in
any of the URL properties, and you need to apply formatting to
that numeric value.

Edit the variable as follows:
l Replace the TableName.ColumnName text with the desired

table column name.
l Replace the format text with syntax that indicates the desired

numeric format. See the following table for details on this
syntax.

For example: {column:BGT2022.m1:$#,#}

NOTE: If you use a variable to display values from a different column as the Link text, the total row
will continue to display the total of the actual column values. It is recommended to omit the column
from the total row in this case.

Number format syntax
Number format syntax is case-sensitive. All examples assume the raw value is 1234.5678

Syntax Description Examples

0 (zero) The zero placeholder replaces the zero with the
corresponding digit if such is present.
Otherwise, zero appears in the result string.

0 returns 1234

00000 returns 01234

# (pound) The digit placeholder replaces the pound sign
with the corresponding digit if one is present.
Otherwise, no digit appears in the result string.

# returns 1234

##### returns 1234

. (period) The decimal placeholder determines the
location of the decimal separator in the result
string.

0.00 returns 1234.57

#.## returns 1234.57
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Syntax Description Examples

, (comma) The group separator placeholder inserts a
localized group separator between each group.

0,0 returns 1,234

#,# returns 1,234

% (percent) The percentage placeholder multiplies a
number by 100 and inserts a localized
percentage symbol in the result string.

#% returns 123456%

$ (dollar) The currency placeholder specifies that the
number will be formatted by using the currency
culture settings. The $ symbol is replaced with
the localized currency symbol. $ is interpreted
as a format specifier in the format string.

$#,#.00 returns $1234.57

� Setting up a report for plan file links
You can enable a column to link to plan files in a file group, without needing to manually create the
necessary URLs to the plan files. The application will automatically generate the correct URL syntax to
each plan file.

In order to do this, the report must be set up as follows:
l A file group must be specified as the File group context for the report. The plan file hyperlinks

will open the plan files in the designated file group.
o Click the gear icon to view the Report Configuration panel.

o Click Edit over the File group context field.

o Select a file group or file group alias, then click OK. Selecting a file group alias means the
report will be dynamically associated with the file group that is currently assigned to the
alias. For example, if the Current Budget alias is updated so that it points to the Budget
2023 file group instead of the Budget 2022 file group, the report will update to link to plan
files in the Budget 2023 file group.

l The row dimension for the report must be the key column of the plan code table. For example, if
the plan code table of the file group is Dept, the row dimension for the report must be Dept.Dept.
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Example Report Configuration panel with a designated file group context

Once the report is configured so that plan file links are possible, then the Plan file link type becomes
available as an option in the Link properties. Once this option is selected, the URL field becomes hidden
because Axiom Budgeting and Performance Reporting will automatically generate the necessary URL to
the plan files.

In the following example, the Dept column has been enabled to contain hyperlinks to plan files. The Link
text field has been left blank to use the column values in the Dept column, which have been configured
to show descriptions.
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Example link properties to use plan file links

When the report is viewed, the column enabled for plan file links will contain hyperlinks to the plan files
in the designated file group. If the plan files are web-enabled, the hyperlinks open the plan files in the
browser. If the plan files are spreadsheet-based, the hyperlinks open the plan files in the Axiom
Budgeting and Performance Reporting Desktop Client.
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Example report with a column enabled for plan file links

NOTES:
l If the designated file group has a Show On List column, the row dimension is not

automatically filtered to only show plan codes where the Show On List column is true (1). You
should define a general filter for the report to exclude plan codes where the Show On List
column is false (0). The row dimension will only be filtered automatically if you have also
chosen to include process management columns in the report.

l If a plan file has not been created for a plan code, the row will still contain a hyperlink but the
hyperlink will fail with a "plan file has not been created" error.

l You can select the Plan file link type for any column in the report that you want to link to the
plan files. The column with the hyperlinks does not have to be the key column of the plan
code table.

Using the Filter Wizard in the Report Builder
The Filter Wizard displays when you create or edit a filter in the Report Builder. The same dialog is used
for report filters, column filters, and column group filters. The dialog provides a user-friendly way to
build data filters using your current system's data structures.
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Example Filter Wizard in the Report Builder

Using the Filter Wizard, you can:
l Browse and search table columns to create a new filter, or, use a global filter from the Filter

Library.
l Select the operator for the filter such as equals, not equals, greater than, less than, and so on.
l Select existing column values to filter by, or manually enter values.
l Easily combine and group multiple filter statements using AND and OR.

� Creating a filter
Each filter that you create in the Filter Wizard can consist of one or more filter statements. Multiple
filter statements are combined using OR or AND to create compound filters. Each filter statement
consists of a Table.Column name, an operator, and one or more values. For example, the following are
all filter statements:

Dept.Region='US West'

Acct.Acct IN (1250, 1300, 1400)

Encounter.AdmitDate BETWEEN 1/1/2020 and 12/31/2021

GL2022.M1 > 0
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The following steps describe the general process of creating a new filter from scratch. For more
information on specific aspects of the Filter Wizard, see the other sections in this topic.
To create a filter in the Filter Wizard:

1. In the Filter Wizard dialog, on the Columns tab, use the table tree to find the column that you
want to use for the first column filter statement. Note the following:

l The table tree is automatically filtered to only show tables that are relevant to the current
context. For example, if you are creating a table-specific report-level filter, the table tree is
filtered to only show the selected table.

l You can use the search boxes over the table tree to search for a particular table or column
by name.

2. Select the column and drag it over to the right-hand area of the dialog. This area is known as the
filter canvas. Once you drop the column to the filter canvas, it creates a filter statement "box"
that is structured as follows:

ColumnName Operator Values

3. If the column is a Date or DateTime column, select the date part that you want to use for the
filter. For more information on this choice, see Using date part filtering.

By default, when you drag over a Date or DateTime column, the date part menu automatically
opens. If you press the Escape key or otherwise close the date part menu without making a
selection, the default is Full Date or Full DateTime. If you select a date part from the menu, the
operator menu automatically opens next.

4. From the operator menu, select the operator that you want to use for the filter statement. By
default, when you drag over the column, the operator menu automatically opens. The data type
of the column determines the default operator and the list of available operators. For more
information, see Using operators.

5. Select or input one or more values for the column filter statement. If you selected an operator
from the operator menu, the following occurs:

l If the operator is equals or not equals, the Select Values dialog automatically opens so that
you can select one or more values. If you select multiple values, the operator will
automatically adjust to IN or NOT IN to accommodate the multiple values. For more
information on using this dialog, see Using the Select Values dialog.

l If the operator is anything else, an input box becomes focused so that you can input or
select one or more values. In most cases, this will be a single input box where you can type
the desired value. Note the following:
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o If the column is a String column and you are manually typing in text instead of
selecting values in the column, do not type quotation marks or wildcard characters.
The Filter Wizard will automatically add quotation marks or wildcard characters as
needed.

o If the operator is BETWEEN or NOT BETWEEN, two input boxes become available so
that you can input or select both values.

o If the column is a Boolean column, the input becomes a drop-down menu for
selecting True or False.

o If the column is a Date or Date time column, the input becomes a calendar control
to select a date or date/time from a calendar.

If instead you closed the operator menu without making an explicit selection, then the default
operator is used and the column filter statement is set to <no values>. You can manually click
on the <no values> text to specify one or more values using the same behavior described
previously.

6. Repeat the previous steps as needed to create more filter statements.

NOTE: You can use preexisting global filters instead of creating filter statements, or use global
filters in combination with filter statements. Select the Filter Library tab, locate the desired
filter, and drag and drop it to the filter canvas. For more information, see Using global filters
in the Report Builder.

7. If your filter consists of multiple filter statements and/or global filters, these are combined using
AND or OR. By default, all statements in the filter are combined using AND. You can group
multiple statements together and change the compound operator as needed. For more
information, see Creating compound filters.

8. Review the complete filter as shown at the bottom of the Filter Wizard.

9. Click OK to complete the filter and apply it to the current context.

When building a filter, or when editing an existing filter, you can:
l Change the operator: Click on the operator to open the operator menu and select a different

operator. In most cases your current value or values are preserved and will apply to the new
operator if applicable.

l Change the value(s): Click on the value to select or input a different value or values. You can also
hover your cursor to the right of the filter statement and click the pencil icon to edit the value.

l Add more statements: Drag additional columns or global filters to the canvas, then specify how
these statements are combined. You can group and reorder statements by selecting and dragging
them.
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l Remove statements: Hover your cursor over an existing filter statement or global filter, then click
the trash can icon to remove it from the filter. Note that if you want to clear a filter, this is not
achieved by deleting all the filter statements within the filter. Instead you should delete the filter
from the current context. For example, if the filter is a column filter, click the Clear option for the
filter in the Column Properties.

l

l Add values manually: You can type values manually or paste from other sources, such as
spreadsheets. For pasted content, the filter wizard will recognize most filter delimiters (such as
spaces and semi-colons) and correctly create the SQL statement. However, if you are typing
values manually, use commas. When you enter simple string values, you do not have to place the
quotes around the string because they are added automatically. In this example, the string
contains several countries (France, Italy, US, UK) without quotes. In the case of Costa Rica, you
must add quotes because that country has two words.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 173



l

Filter wizard with manually entered strings

Notes about manual entries:

o If your string has leading or trailing spaces, use quotes that include those spaces (for
example, ' a ').

o If you search for a value in a large table (such as the EDS Encounters table), you can type
the first few characters or numbers in the search field to retrieve those results more
quickly.

o You cannot directly edit the SQL statement for your filter. If you need to make changes or
additions, use the filter options to select or manually enter the values needed.

� Using operators
When you initially drag and drop a column to the filter canvas, it is assigned a default operator based on
the column data type. For example, Integer and String columns default to equals, while Date, DateTime,
and Numeric columns default to greater than. You can accept the default or choose any valid operator
from the operator menu. At any time, you can click the operator to open the operator menu.

The available operators depend on the column data type. Most columns can use the following
operators:

l Equals (=) and not equals (<>)
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l IN and NOT IN

l Greater than (>) and greater than or equals to (>=)

l Less than (<) and less than or equals to (<=)

l BETWEEN and NOT BETWEEN (both inclusive of the specified values)

In addition, Numeric columns has this operator:

l IS NULL AND IS NOT NULL

Additionally, String columns have the following options—all of which generate LIKE or NOT LIKE filter
statements with the appropriate wildcard syntax:

l STARTS WITH and DOES NOT START WITH

l ENDS WITH and DOES NOT END WITH

l CONTAINS and DOES NOT CONTAIN

l IS EMPTY and IS NOT EMPTY

For example, if you select CONTAINS and then specify a value of store, the filter will be created such as
Description LIKE '%store%'. You can see the created filter at the bottom of the Filter Wizard
dialog.

NOTES:
l CONTAINS and ENDS WITH (and the DOES NOT versions) are not available for tables that use

the Large Data index scheme, for performance reasons.

l The operator menu displays equals/not equals or IN/ NOT IN depending on whether multiple
values are currently selected. The operator will be automatically adjusted for single or
multiple values depending on your selections. It is not necessary to manually select the
appropriate operator.

� Using the Select Values dialog
When creating an equals or not equals filter statement, the Select Values dialog is available to select
one or more values in the column. This dialog opens automatically when you initially select the equals or
not equals operator. You can manually open the dialog by clicking the currently selected values (or the
<no values> placeholder text), or by hovering your cursor to the right of the filter statement and
clicking the pencil icon.
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The available values in the column display in the left-hand side of the Select Values dialog, and the
currently selected values for the filter statement display in the right-hand side of the dialog. You can:

l Search for a particular value using the search box over the Available Values list. Only the first 100
column values show in the dialog for performance reasons, but you can find any value in the
column using the search box.

o You can use the filter icon to the right of the search box to change how the search matches
values. The default matching behavior depends on the column type. String columns and
validated columns with descriptions default to "contains" matching, while numeric
columns default to "equals" matching.

o To clear the search text, use the Clear icon to the right of the filter icon. This icon only
displays when search text is present. You can also manually select and delete the search
text.

l Select values by moving them from the Available Values list to the Selected Values list. You can
double-click values to move them between lists, or you can use the arrow keys in the middle to
move values. You can select multiple values in either list using the SHIFT or ALT keys, and then
move those values using the arrow keys.

When you click OK, all values in the Selected Values list are included in the filter statement. The
operator automatically adjusts as needed for single or multiple values—for example, if you selected the
equals operator but then chose multiple values, the operator automatically changes to IN (and vice
versa).

Example Select Values dialog for the Filter Wizard
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NOTES:
l If you want to use an equals operator but the value does not currently exist in the column,

then you must first switch the operator to greater than or less than, manually type the value,
then switch back to equals. It is not currently possible to manually type multiple values for
use with the IN operator.

l If the column is a validated column with descriptions, the descriptions display next to the
column values in parentheses. You can search for values using the actual column values or the
descriptions. However, when you select values, keep in mind that you are selecting the actual
column values and not the descriptions. If you want to create a filter that is based on the
description values, you must base this filter on the actual Description column.

l The Select Values dialog is not available for calculated fields from the database. When the
equals operator is used with a calculated field, you can type the desired value for the filter.
Currently, it is not possible to create an IN filter for multiple values in a calculated field. If
necessary, you can create multiple filter statements and combine them with OR as a
workaround.

� Creating compound filters
You can drag any number of columns over to the filter canvas and create filter statements for each one.
When multiple filter statements are present, they are combined using either AND or OR to create a
compound filter.

l AND means that records must match both filter statements to be included or excluded by the
filter.

l OR means that records must match one of the filter statements to be included or excluded by the
filter.

By default, filter statements are combined using AND. You can change this to OR as needed by using the
drop-down menu on the AND/OR operator to the left of the filter statements.

If the operator change could create an ambiguity in how the statements are combined, you will be
prompted to choose whether to group or split the statements when changing the operator. For
example, if you choose to group the statements, the two statements associated with the operator will
become grouped. If you choose to split the statements, one statement will be separated while the other
statement is grouped with the statement next to it. Grouped statements are the equivalent of using
parentheses in SQL.

Multiple filter statements can be grouped, combined, and reordered by dragging and dropping the
statements, and by changing the AND/OR operator.

NOTE: The Filter Wizard will automatically place parentheses as needed in filters that use multiple
filter statements. There is no way to manually add or remove parentheses.
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� Using date part filtering
When the column used in the filter is a Date or DateTime column, you can filter based on the full date or
date-time as saved in the column, or you can filter based on a date part such as the year or quarter. For
example, you can create a filter statement such as StartDate > 2019, when the StartDate column
contains full date or date-time values. Using date parts makes it easier to construct filters that restrict
data based on a particular aspect of the date or date-time value.

l By default, the filter is based on the full date or date-time.

l You can click the name of the column to open the date part menu and select a specific date part
for filter. The same date part options that are available in the Column Configuration properties
for Date and DateTime columns are available for use in filter statements.

l If you select a date part other than the Full Date or Full DateTime, the selected date part displays
in parentheses next to the column name. For example: StartDate(Year) when Year is the selected
date part.

l If you select a date part with a finite set of available values—such as Quarter or Month—then the
Select Values dialog displays those values.

l If you select a date part with an open-ended set of available values—such as Year or YearMo—
then the Select Values dialog converts the actual dates or date-times in the column into the
selected date part and displays those values. This means that if you want to create an equals or
not equals filter which uses a value that is not currently present in the column, you must first
change the operator to greater than, type the desired value using the correct format for the date
part, and then change the operator back to equals or not equals.

l When using the following date parts, only the equals/not equals and IN/NOT IN operators are
available: Quarter, Fiscal Quarter, Month, and Day of Week. For example, it is not possible to
create a filter such as StartDate(Quarter)>Q2. Instead you would select the specific values of Q3
and Q4, which would create the filter StartDate(Quarter) IN (Q3,Q4). For all other date parts, the
normal set of operators can be used.
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Example date part menu for Date and DateTime columns

� Limitations and known issues
The following limitations and known issues currently apply to the Filter Wizard:

l If a String column has a blank entry (empty string), this displays in the Select Values dialog as a
blank entry. This blank entry cannot be selected, and it is not currently possible to create a filter
statement that includes or excludes empty strings. However, if a report with an empty string filter
statement was created in a previous version, this filter statement will be preserved and will
continue to work.
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l If a column contains null values, this displays in the Select Values dialog as <no value>. This no-
value entry cannot be selected, and it is not currently possible to create a filter statement that
includes or excludes null values. However, if a report with a null value filter statement was
created in a previous version (using operators IS NULL or IS NOT NULL), this filter statement will
be preserved and will continue to work.

l If you want to create a filter statement using equals/not equals or IN/ NOT IN, it is not currently
possible to manually type the desired value or values. You must use the Select Values dialog. For
single values, a workaround is available as follows: you can change the operator to greater than,
type the desired value, then change the operator back to equals or not equals. There is no
equivalent workaround for multiple values.

l Filter statements that directly compare two columns, such as Column1 > Column2, are not
currently supported in the Filter Wizard. However, if a report with a column comparison
statement was created in a previous version, this filter statement will be preserved and will
continue to work.

When viewing reports that were created in previous versions, you may find other filter statements that
use syntax which is not currently supported in the Filter Wizard. Generally speaking, if the report does
not error and the filter statement is not flagged as invalid, these filter statements will continue to work
as they did in previous versions, although you may not be able to edit the filter statement or newly
create it in exactly the same way.

Using global filters in the Report Builder
A global filter is a report filter that is stored in the Filter Library. These filters can be referenced in
various reports as needed. Storing the filters separate from the reports has the following advantages:

l A filter that is commonly used can be defined once and then used in all reports that need it.

l If the filter needs to be modified, you can edit the global filter once, instead of needing to modify
all of the reports that use the filter.

When you are defining filters for a web report, you can use an existing global filter, or you can build a
filter in the report and then save it as a global filter so that it is available for others to use. If a web
report references a global filter, and that filter is modified, the report automatically uses the current
version of the global filter.

Global filters can also be used as starting points to create a local report-level filter. For example, there
may be an existing global filter that is almost exactly what you need to filter the current report. In this
case you can do either of the following:

l Add the global filter to the report, then convert the filter to a local filter. This conversion breaks
the reference with the global filter and copies the filter statement into the current report. You
can then edit the filter as needed for use in the current report.

OR
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l Add the global filter to the report, then combine that filter with additional filter statements in the
report to arrive at the overall desired filter. In this case the global part of the filter will continue
to be linked to the Filter Library and will update as needed, while the rest of the filter provides
the additional context needed in the report. This approach only works if you need to extend the
global filter, not fundamentally change the global filter to use a different operator or values.

All of these global filter actions can be done in the Filter Wizard dialog in web reports. The Filter Wizard
is available when defining report-level filters on the Filters tab, or when defining filters for individual
columns or column groups on the Build tab.

Global filter features in the Filter Wizard

� Using a global filter in a web report
When you are creating or editing a filter in a web report using the Filter Wizard, you can add a global
filter to the filter statement. You can add any of the following filter types that are stored in the Filter
Library:

l Report filters: Filters created in web reports using the new Filter Wizard.

l Legacy standard filters: Filters created using the legacy Filter Wizard (in any location of the
application). Basically, a "standard filter" means any regular Axiom Budgeting and Performance
Reporting filter that is not a limit filter and not a visualization filter.

Limit filters and visualization filters cannot be used as global filters in web reports. Visualization filters
do not display in the Filter Wizard. Limit filter statements display in the Filter Wizard, however, if you
attempt to use one as a global filter, an error will occur regarding the unsupported filter format.

You can use a global filter on its own, or in combination with locally defined filter statements and other
global filters. In order to use a global filter, you must have read-only access to at least one filter in the
Filter Library, as determined by your security permissions.

To add a global filter to a filter statement:
1. In the Filter Wizard, in the left-hand pane, select the Filter Library tab.

2. Locate the global filter that you want to use in the Filter Library. You can use the search box
above the folder tree to search for a specific filter by name.

This area shows all folders and filters that you have permission to access in the Filter Library. If
you do not have access to the Filter Library, then the tab is still present in the dialog but it will be
empty.

3. Drag the desired filter over to the right-hand pane (the filter canvas).
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Before the global filter is added to the filter canvas, it is validated to make sure the contents of
the global filter are valid in the current context.

l If the filter is valid, then the filter is added to the filter canvas. The filter box displays the
filter name with a globe icon. You can see the actual underlying filter statement in the
tooltip, or by viewing the filter shown at the bottom of the dialog.

NOTE: When displaying the filter statement for a global filter in the Filter Wizard, the
statement is always wrapped in parentheses, even if it is the only statement used in
the filter. If the global filter itself is a compound filter statement that is wrapped in
parentheses, you may see double parentheses displayed in the Filter Wizard. These
"extra" parentheses do not cause an issue and only serve to identify the global filter
statement within the overall filter.

l If the filter is not valid, an error message will display and the global filter will not be added
to the canvas. Generally speaking, the global filter must use columns from the same tables
that display on the Columns tab of the Filter Wizard.

Once the global filter is added to the filter canvas, it becomes a filter statement that can be combined
and rearranged just like the locally defined filter statements. The only difference is that you cannot
modify the contents of the global filter, unless you want to break the association with the global filter in
the Filter Library and convert it to a local filter (see the next section).

Although security permissions to the Filter Library are required in order to add a global filter to a report,
once the filter is present in the report it is treated like part of the report and governed by the report's
permissions. It is not necessary to grant filter permissions to users who only need to view or edit the
report.
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� Converting a global filter to a local report filter
Once a global filter has been added to the Filter Wizard, you can optionally convert the filter to a "local"
filter. This will break the association with the global filter and copy the filter statement into the report.
You can then edit the filter statement as needed.

To convert a global filter to a local filter:
1. In the Filter Wizard, locate the global filter that you want to convert.

2. Hover your cursor to the right of the global filter, then click the Convert icon.

3. At the confirmation prompt, click Yes to convert the filter.

The filter statement for the global filter is copied into the report, and now displays like a regular filter
statement created in the Filter Wizard. The filter statement is no longer associated with the global filter,
and will not update if the global filter is changed. You can now edit the filter statement as needed for
use in the report.

� Saving a global filter to the Filter Library
After creating a filter in the Filter Wizard, you can optionally save that filter to the Filter Library. Saving
the filter to the Filter Library allows the filter to be used by other web reports, so that all of the reports
reference the same global filter.

Currently, filters created in the Report Builder's Filter Wizard and saved to the Filter Library can only be
used in web reports. Future releases may expand the use of this Filter Wizard, so that its filters can be
used in other places.

Any filter that can be created in the Filter Wizard can be saved as a global filter. The filter can contain
multiple filter statements, and can even contain references to other global filters. The context where the
filter was created does not matter for purposes of saving it as a global filter. For example, you can create
a filter for use as a General report-level filter, save the filter as a global filter, then later use the global
filter as a column filter in a different report. As long as the filter statement is valid in both contexts, it
does not matter where the global filter was initially created.

In order to save a global filter to the Filter Library, you must have read/write access to at least one
folder in the Filter Library. If you do not have this permission, then the Save as Global Filter option is
not present in the Filter Wizard.

To save a global filter:
1. In the Filter Wizard, create the filter that you want to save to the Filter Library.
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2. Click Save As Global Filter in the bottom left of the dialog.

3. In the Save As Global Filter dialog, complete the following fields and then click Save:

Item Description

File name The name of the filter. This is the name that users will see when
finding filters in the Filter Library, and when editing web reports that
use the global filter.

Keep in mind that when users add the global filter to a report, they
cannot see the actual filter statement—they can only see the filter
name. Because of this, it is recommended to include the table name
used by the filter statement in the filter name, so that users can
understand whether the filter will be valid in the current context.

Description Optional. A description of the filter. Currently, filter descriptions do
not display in Filter Wizard, but they can be viewed in the Axiom
Budgeting and Performance Reporting Desktop Client using Axiom
Explorer.

Save to folder The folder in the Filter Library where you want to save the filter.
l Click the folder icon to the right of the field.
l In the Choose output folder dialog, select a folder in the Filter

Library. You can only select folders where you have read/write
access to the folder. If a folder name displays with a lock icon, this
means you have read-only access to that folder and therefore
cannot save a new report there.

l Click OK to choose the folder and return to the save dialog.
The path to your selected folder now displays in the field.

If you use a name that already exists in the target folder, you will be prompted to choose whether
or not to overwrite the existing filter. If you choose not to overwrite, the save operation is
canceled and you are returned to the Filter Wizard.

4. After the filter is saved to the Filter Library, you are prompted to copy the global filter into the
report to replace the current filter. Click Yes if you want to reference the newly created global
filter in the current report. If you do not want to reference the global filter in this report, click No.

The global filter is saved to the Filter Library and is now available for use in other web reports.
Additionally, if you chose Yes at the prompt after saving, the current filter in the Filter Wizard is replaced
with a reference to this newly created global filter.
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� Editing an existing global filter
If a global filter is edited, all web reports that reference this global filter will now use the updated filter
statement. For example, a healthcare organization may have a filter that limits the report to codes
associated with COVID-19. If later a new code is added, you can edit the filter to include the new code,
and this new code will now be applied to all reports that reference the global filter.

Currently, there is no user interface to edit a global filter directly. Instead, global filters can be edited as
follows:

l Open the Filter Wizard and add the global filter to the filter canvas.

l Convert the global filter to a local filter.

l Edit the local filter as needed.

l Save the local filter as a global filter, using the same name as the existing global filter.

This process will overwrite the existing global filter with the newly saved version of the filter. All reports
that reference the global filter will now use the updated version of the filter statement.

NOTE: If a web report is being viewed or edited when the global filter is changed, the report will not
reflect the changed filter until the report is closed and reopened (or until it is reloaded by refreshing
the browser).

� Deleting a global filter
If a global filter is no longer needed within a particular report, you can delete it from the filter. Hover
your cursor to the right of the global filter and then click the Delete icon. This action simply removes the
reference to the global filter from the current filter. It has no impact on the global filter in the Filter
Library.

If a global filter is no longer needed at all, you can delete it from the Filter Library. Currently, this can
only be done from the Desktop Client. In order to delete a global filter, you must have permission to use
the Windows Client or the Excel Client, and read/write permission to the folder that the global filter
resides in.
To delete a global filter from the Filter Library:

1. From the Areamenu , clickWindows Client or Excel Client to launch the Desktop Client.

2. On the Axiom tab, in the Administration group, clickManage > Axiom Explorer.

NOTE: In systems with installed products, this feature may be accessible from the Admin tab.
Click System Browser to open Axiom Explorer.

TIP: You can also use the Explorer task pane to delete a global filter.
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3. Navigate to the Filter Library, and then locate the filter that you want to delete.

4. Right-click the filter and then select Delete.

If any web reports reference the deleted filter, these reports will display an error about the missing
global filter. You must edit the reports to remove the reference in order to refresh the reports again.

Managing Fixed Row Structures
Fixed row structures can be used to define data sections for a web report, including section headers,
data rows, subtotals, and totals. Fixed row structures are defined separately so that you can reuse them
with different web reports, and so that you can update the row structure in one place and have the
changes propagate to all reports that reference the structure.

Fixed row structures can be used with "custom" web reports created in the Report Builder, and with
web report templates provided by installed Axiom Budgeting and Performance Reporting products. The
fixed row structure defines the data sections in the report, while the web report defines other report
properties such as the data columns, filters, and drilling options.

Example report using a fixed row structure

You can define as many different fixed row structures as you need. A row structure can be used with any
web report where the structure's row dimensions are compatible with the report's columns, filters,
drilling options, and any other report property that impacts queried data. Row structures can be
created, edited, and deleted using the Intelligence Center.
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To access the Intelligence Center:
l Click the Syntellis icon in the Navigation bar. From the Area menu, select Intelligence Center.

Fixed row structures are not file-based—they are stored directly in the database. There is no file type or
library folder for fixed row structures, and you cannot see them in Axiom Explorer. The only place to
view and manage fixed row structures is using the Intelligence Center.

� Creating fixed row structures
You can create new fixed row structures as needed for use in web reports.

In order to create a fixed row structure, you must be an administrator or have the Create Web Reports
security permission. If you do not have permission to create web reports, then the option to create a
new fixed row structure will not be available in the Intelligence Center.

To create a new fixed row structure:
1. In the Intelligence Center, select the Row Structures area from the left-hand panel, then click

Create.
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The row structure editor opens in the current browser tab, showing a new blank row structure.
The row structure starts with just a top-level section header and a grand total row.

Example new blank row structure

2. In the top of the right-hand panel, complete the following required properties for the row
structure:

Item Description

Row Structure
Name

Enter the name of the row structure. The name identifies the row
structure so that users can select it when creating a new fixed report.

Dimension Table Specify the dimension table to use for the Filter Wizard when
defining row data. For example, if rows will be defined using
accounts or account groupings, select the ACCT table.

Use Dimension
Mapping

Enable this toggle switch if you want to map specific items in the
dimension table to specific rows in the structure. When using
dimension mapping, all row data is defined at the key column level of
the dimension table, and each dimension item can only be assigned
to a single row. The toggle switch shows as green when enabled and
as gray when disabled.

If this option is not enabled, then row data is determined by defining
filter criteria statements at the row and section level. For more
information, see Using dimension mapping versus row filters in a
fixed row structure.
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Example required properties with dimension mapping enabled

Once these items are completed, you can use the Save button to save the row structure.

3. In the left-hand row editor, add sections and data rows as desired to create the overall row
structure. Think of the Root Section as the overall "wrapper" in which all row sections are placed.
To create the first row section, click the plus icon on the Root Section header and then select Add
New Section.

Your row structure will now look like this:

You can then continue to add data rows or additional sections:

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 189



l To add a section, select the section header where you want to add the section, then click
the plus icon > Add New Section. The new section is added as a subsection to the current
section. By default, all new sections contain a section header row, three data rows, and a
total row. You can add or remove data rows as needed.

l To add a data row within a section, select the section header where you want to add the
data row, then click the plus icon > Add Data Row. The new data row is added to the
current section.

When you add a new data row or section, it is always added at the bottom of the current section.
You can drag and drop the row or section to a different location within the section as needed (but
not to a different section).

If a data row or a section is not needed, select the row or section header and then click the trash
can icon. The row or section is deleted from the row structure.

NOTE: Header rows and total rows cannot be deleted from a section. The trash can icon on a
section header row is used to delete the entire section, not the header row. If you do not
want a particular section to display a header row or a total row, you can hide these rows on a
per section basis using the Section Properties.

4. For each section in the report—including the Root Section—configure the properties for that
section. To configure a section, select the section header and then complete the Section
Properties in the right-hand panel. The section properties control the following:

l Visibility, text, and style of the section header row
l Visibility, text, placement, and style of the section total row
l Whether data rows are indented from the parent section
l Whether section data is added or subtracted when calculating the parent total
l An optional data filter to apply to all data rows in the section (only available if the structure

does not use dimension mapping)

For more information on all of the section properties, see Section properties.
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In most cases, the row structure immediately updates to reflect section properties that affect the
display. For example, if you define header text, that text is immediately shown on the row
structure. However, if you hide the section header row, the row will continue to display in the
row structure unless you disable the option Show Hidden Items. This option is located at the top
right of the row editor, under the Save button. By default, the row editor continues to show
hidden section headers so that you can use the Add Data Row and Add New Section actions on
the header row.

5. For each data row in the report, configure the properties for that row. To configure a row, select
the row and then complete the Row Properties in the right-hand panel.
At minimum, the row properties define the label text for the row. If the structure does not use
dimension mapping, then the row properties also define a data filter to determine the data to be
shown on the row. For more information on defining the row properties, see Row properties.
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6. If Use Dimension Mapping is enabled for the row structure, click the Dimension Mapping tab to
map dimension elements to each row. This mapping determines the data to be shown on each
row, instead of defining a filter. For more information on mapping dimension elements, see Using
the Dimension Mapping editor.

7. Click Save to save the row structure.

The new row structure can now be used when creating or editing web reports.

� Copying fixed row structures
You can copy existing fixed row structures as needed to create additional fixed row structures.

In order to copy a fixed row structure, you must be an administrator or have the Create Web Reports
security permission. If you do not have permission to create web reports, then the Copy action is
disabled.

To copy a fixed row structure:
1. In the Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to copy, then hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Copy from the menu.

3. In the Copy Fixed Row Structure dialog, enter a Name for the new fixed row structure, then click
OK. By default, the name is Copy of OriginalName.

The fixed row structure is copied with the specified name. You can now open this fixed row structure for
editing.

� Editing fixed row structures
Any user can edit a fixed row structure. The Create Web Reports permission is not required.

Keep in mind that when a row structure is assigned to a report, that report always uses the most current
version of the row structure. Any edits that you make to a row structure are immediately available in
any reports that use the row structure.
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To edit a fixed row structure:
1. In the Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to edit, then click on the row structure name to
open it.

TIP: You can also select Edit from the actions menu (using the three dots icon) to edit the
fixed row structure.

The row structure opens in the row structure editor, in the current browser tab.

3. Using the row structure editor, make changes to the row structure as needed.

4. Click Save to save your changes.

� Changing fixed row structure names and descriptions
You can rename a fixed row structure or change its description. If existing reports use the fixed row
structure, those reports will continue to reference the renamed structure.

To change a fixed row structure name and/or description:
1. In the Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to edit, then hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Info from the menu.

The Information panel opens along the right-hand side of the page.

3. In the Information panel, edit the fixed row structure Name or Description as needed, then click
Apply.

The name can be up to 250 characters, and the description can be up to 2000 characters.

� Deleting fixed row structures
Any user can delete a fixed row structure. The Create Web Reports permission is not required. If the
fixed row structure was used by any web reports, those reports will no longer function correctly until
they are edited to use a different fixed row structure.
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IMPORTANT: If the deleted fixed row structure was used by a web report built from a template, that
report will no longer work. Currently, there is no way to edit the row structure assignment for
template-based reports. If the report is still needed, it must be re-created from template with a
different fixed row structure.

To delete a fixed row structure:
1. In the Intelligence Center, select the Fixed Row Structure area from the left-hand panel.

2. Locate the fixed row structure that you want to delete, then hover your cursor over the Name
column to make the three dots icon visible. Click the icon then select Delete from the menu.

3. When you are prompted to confirm that you want to delete the structure, click OK.

The structure is deleted from the system and no longer displays in the Intelligence Center.

Using the Row Editor
Using the Row Editor, you can define fixed row structures for use in web reports. Fixed row structures
define the following:

l The sections to be displayed in the report, including section titles and subtotal rows
l The data rows to be displayed within each section

When you use the Intelligence Center to create a new fixed row structure or to edit an existing fixed row
structure, it opens in the fixed row structure editor.

� Overview
By default, the Row Editor consists of two primary areas:

l The section editor on the left-hand side, where you can add, reorder, and remove sections and
data rows

l The property editor on the right-hand side, where you can define properties for the overall row
structure, the selected section, or the selected row
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Row structure editor with a selected section

Row structure editor with a selected data row

If the row structure is configured to Use Dimension Mapping to define the row data, then another area
is available via the Dimension Mapping tab. You can use the Dimension Mapping area to map dimension
items to individual data rows. For more information on using dimension mapping, see Using the
Dimension Mapping editor.
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Row structure editor with Dimension Mapping tab

To save the row structure after making changes, use the Save button located at the top right of the
editor.

Certain parts of the row structure can be configured as hidden, such as section header rows or total
rows. By default, these hidden items no longer display in the editor. If you need to view these items so
that you can work with them and configure them, you can toggle the option Show Hidden items at the
top right of the editor.

� Using dimension mapping versus row filters in a fixed row structure
When you build a fixed row structure, there are two different ways to define the data to be shown each
in row:

l Filters: Each row can have a filter criteria statement that defines the data for that row. For
example, Acct.Acct=4100 or Acct.Category='Revenue'.

l Dimension mapping: Each row can be assigned one or more items in a specified dimension. For
example, if Acct is the specified row dimension, then you can view the list of accounts and map
them to specific rows in the report as needed.

The filter option is the most flexible way to build a fixed row structure, because:
l You can use any valid filter criteria statement to define the data in each row, including compound

statements using AND or OR, and referencing any table (not just the specified dimension table).
l You can define filters at the section level, which then combine with all row-level filters in the

section.
l You can repeat dimension elements within the row structure—for example, to create multiple

sections that show revenue for different regions or lines of business.
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However, because the filter option is more flexible, it also requires a more advanced level of knowledge
about your data structures. You must take care not to create invalid or conflicting filters, and make sure
that your filters result in the data that you want to display in the report.

In contrast, the dimension mapping option is the easiest to set up, because:
l You are presented with a full list of all items in the specified dimension, which you can search and

filter as needed.
l To assign an item to a row in the report, you simply select the item and then click the arrow

button to move it over to the row. Each row can be assigned as many items in the dimension as
needed.

l It is very easy to see exactly which dimension items will display on each row, and to see which
items have not yet been assigned to rows.

However, the dimension mapping option is less flexible. Rows can only display data from the specified
row dimension, and each item in the dimension can only be assigned to a single row.

� Row structure properties
The following required properties at the top of the right-hand pane apply to the entire row structure.

Example Row Structure properties area

Item Description

Row Structure
Name

The name of the row structure. The name identifies the row structure so that it
can be selected when creating or editing a web report.
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Item Description

Dimension Table The primary dimension table to be used on the data rows. You can select any
reference table in your system.

This selection is used as follows:
l By default, it determines the table available to the Filter Wizard when

defining filters for sections and data rows. For example, if the dimension
table is Acct, then you can use the Filter Wizard to build filters based on
Acct.
NOTE: When using filters to define the data in sections and rows, the
dimension table is simply a default table. If you want to define a filter using
a different dimension, then you can manually enter a filter criteria
statement using that dimension.

l If Use Dimension Mapping is enabled, then it determines the dimension
table for the row mappings. For example, if the dimension table is Acct,
then you can map one or more accounts to each data row. In this case, data
rows can only use the dimension table.

Use Dimension
Mapping

Specifies whether the data in data rows is defined by using filters or by using
dimension mapping. By default, this is disabled, so data is defined using filters.
If instead you want to use dimension mapping for the rows, click the toggle
switch to enable this option. The toggle switch shows as green when enabled
and as gray when disabled.

If Use Dimension Mapping is enabled, the row structure editor updates as
follows:
l A new tab named Dimension Mapping becomes available next to the Row

Editor tab. You can use this tab to define dimension mappings for the rows.
Typically, you should define the sections and rows in the structure first, then
go to the Dimension Mapping tab to assign mappings to each row.

l The Filter fields in the Section Properties and the Row Properties become
hidden, because they do not apply when using dimension mapping. If a filter
is defined for a section or a row before dimension mapping is enabled, the
filter is retained in the properties (assuming it was saved) but it will be
ignored in reports.

For more information on the differences between using filters or dimension
mapping to define data rows, see Using dimension mapping versus row filters
in a fixed row structure.
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� Adding, removing, and reordering sections
Using the Row Editor tab, you can build your row structure by adding, removing, or reordering sections.
Each row structure starts with a top-level root section that includes an optional header and an optional
grand total.

Row editor with starting root section

To add new sections to the row structure, select the section header row—the Root Section row—and
then click the plus sign and select Add New Section.

Option to add a new section

The new section is added within the root section. You can continue to add as many sections as needed
at this level.
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Row editor with two newly added sections

To add subsections within a section, select the section header row for any section, and then click the
plus sign and select Add New Section. The new subsection is added to the current section. You can nest
as many section levels as you need by adding subsections to sections.
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Row editor with newly added subsection

Newly added sections use default text and styling, which can be configured for each section. Each newly
added section consists of the following by default:

l A header row to display optional header text for the section. If you do not want a header row to
display for a particular section (including the root section), you can hide it by disabling Show
Section Header when configuring the section properties.

l Three data rows to display queried data in the section. You can add or remove data rows as
needed.

l A total row to display the totaled data for the section. If you do not want a total row for this
section (including the root section), you can hide it by disabling Show Section Total Row when
configuring the section properties.

Once you have added sections, you can make further section changes as follows:
l To reorder sections: Select the header row of a section and then drag and drop it to a new

location within the same level of the structure. For example, if you have three sections at the
same level, you can drag and drop these three sections to change their order. But you cannot
drag and drop one of these three sections to a lower level or a higher level.
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l To delete a section: Select the header row of the section and then click the delete icon (trash
can). The section and all of its subsections are deleted. Note that the root section is required and
cannot be deleted.

IMPORTANT: Make sure you no longer need the section before clicking the delete icon. The
section will be deleted immediately with no confirmation prompt. If you deleted a section by
accident, then you can exit the row structure editor without saving, but you will also lose any
other unsaved changes that you have made during the current session.

� Section properties
To configure the properties for a section, select the section header and then complete the Section
Properties in the right-hand pane.

Example Section Properties area

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 202



Section Header Properties

Item Description

Show Section
Header

Specifies whether the section header row is visible when the row structure is
used in a report. By default, this option is enabled, so the section header row is
visible. If you do not want this section to have a header row, disable this
option. The toggle switch shows as green when enabled and as gray when
disabled.

If this option is disabled, then the remaining section header properties become
hidden because they do not apply. Note that you may want to define header
text before disabling the option, to make it easier to identify the section when
working within the row structure editor.

NOTE: If you hide the section header, then you will no longer be able to select
the header row in the editor for purposes of adding rows or subsections,
configuring the section, reordering the section, or removing the section. If you
need to work with the section header row, you can enable the option Show
Hidden Items, located at the top right of the editor. This will cause all hidden
items to show in the row structure, so that they can be selected and
configured.

Header Text The text to display on the section header row. By default, this is set to "Root
Section" for the root section header and "Section" for all other newly added
sections. The header text should be edited to reflect the data shown in this
section.

Header Category The style to use on the section header row. The style determines display
attributes such as font size and font weight. Select one of the following:
l Header1 through Header6: These styles apply specific formatting to the

header row. Although Header1 is designed to be used as the top-level
section header, followed by Header2, and so on, you can assign these styles
to any section header row as needed.

l Default: Axiom Budgeting and Performance Reporting automatically applies
the appropriate header style depending on the section's placement in the
row structure hierarchy. The header row for the root section uses Header1,
sections in the next level use Header2, and so on.

By default, the header category is set to Header1 for the root section header,
and Default for all newly added sections.
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Section Total Properties

Item Description

Show Section
Total Row

Specifies whether the section total row is visible when the row structure is used
in a report. By default, this option is enabled, so the section total row is visible.
If you do not want this section to have a total row, disable this option. The
toggle switch shows as green when enabled and as gray when disabled.

If this option is disabled, then the remaining section total properties become
hidden because they do not apply.

Total Row
Placement

The location of the total row in the section, either Below the data rows or
Above the data rows. The total row is located below the data rows by default.

Total Row Text The text to display on the section total row. By default, this is set to "Grand
Total" for the root section total and "Section Total" for all other newly added
sections.

Total Row
Category

The style to use on the section total row. The style determines display
attributes such as font size, font weight, shading, and borders. Select one of the
following:
l Grand Total or Total: These styles are intended to be used for "final" total

rows. Both styles use shading and top and bottom borders. The bottom
border of the Grand Total is a double border.

l SubTotal1 through SubTotal4: These styles are intended to be used for
subtotal rows. These options provide varying combinations of bold and
regular text, shading or no shading, and border or no border.

By default, the total row category is set to Grand Total for the root section total
row, and Subtotal3 for all newly added sections.

Section Properties

Item Description

Indent Child
Rows

Specifies whether the rows in this section are aligned with the section header
row or indented. By default, this is enabled, so the rows are indented. If instead
you want the rows to be aligned with the section header row, disable this
option. The toggle switch shows as green when enabled and as gray when
disabled.
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Item Description

Parent Total
Row Behavior

Specifies how the data in this section is treated when computing the total row
of the parent section. Select one of the following:
l Add: The data in this section is added when computing the parent total. This

is the default behavior.
l Subtract: The data in this section is subtracted when computing the parent

total.
l Ignored: The data in this section is ignored when computing the parent

total. You might do this if the rows in this section contain supporting detail
that should not impact the overall totals.

Although this option displays on the root section, it does not apply because the
root section does not have a parent section.

For example, imagine that you have a parent section with two subsections.
Subsection A totals 5000, and Subsection B totals 1000.
l If both subsections are set to add, then the total of the parent section is

6000.
l If Subsection A is set to add but Subsection B is set to subtract, then the

total of the parent section is 4000.
l If Subsection A is set to add but Subsection B is set to ignore, then the total

of the parent section is 5000.

Section Data
Filter

Optional. A data filter to apply to all of the data rows in this section, including
any subsections. This is intended to be used when all rows in the section need
to be filtered by a particular dimension or grouping, so that you do not need to
repeat that dimension grouping on each individual data row. Only applies when
Use Dimension Mapping is disabled.

Enter the filter criteria statement to apply to the data rows in this section.
Section data filters use normal filter syntax for Axiom Budgeting and
Performance Reporting. Although you can use the Filter Wizard to create the
filter criteria statement, it is limited to creating filters based on the specified
dimension table for the row structure. In many cases the section data filter
needs to use a different dimension, so you must manually create the filter
criteria statement.

For example, imagine that you want to show revenue accounts in the rows of
your report, but you want to split the data into two sections reflecting two
different sales regions. You can create two sections and define section filters
for each, such as Dept.Region='East' and Dept.Region='West'. All of
the data rows in those sections will be filtered by the specified region in
addition to the specific account filters listed on each row.
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� Adding, removing, and reordering data rows
Using the Row Editor area, you can add data rows to a section, remove unneeded rows, and reorder
rows. Each data row represents a record of data that you want to query from the database and display
within the report.

To add new data rows to a section:
l Select the section header row, then click the plus sign and select Add Data Row.

Option to add a new data row

The new row is added to the bottom of the section. You can continue to add as many new rows to the
section as needed.

Section with a newly added data row
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Once you have added data rows, you can make further row changes as follows:
l To reorder rows: Select the data row that you want to move, and then drag and drop it to a new

location within the same section. For example, if you want a newly added row to be at the top of
the section instead of the bottom, then you can drag and drop it to that location. But you cannot
drag and drop the row to a different section, not even to subsections of the current section.

l To delete a row: Select the data row that you want to delete and then click the delete icon (trash
can). The row is deleted.

IMPORTANT: Make sure you no longer need the row before clicking the delete icon. The row
will be deleted immediately with no confirmation prompt. If you deleted a row by accident,
then you can exit the row structure editor without saving, but you will also lose any other
unsaved changes that you have made during the current session.

Only data rows can be individually added, deleted, and reordered. Section header rows and section total
rows are not considered to be data rows and are managed as part of the section. Note the following:

l The delete icon on section header rows does not delete the header row; it deletes the entire
section. If you do not want a particular section to have a header row, you can configure the
section to hide the header row.

l Section total rows do not have delete icons. If you do not want a particular section to have a total
row, you can configure the section to hide the total row.

l Section header rows are always located at the top of the section. When you drag and drop a
section header row you are moving the entire section, not just the header row. It is not possible
to move just the header row.

l Section total rows can be located at either the top or bottom of the section, but not by dragging
and dropping. When you configure the section, you can specify the location of the total row.

� Row properties
To configure the properties for a data row, select the row and then complete the Row Properties in the
right-hand pane.

Example Row Properties area

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 207



Item Description

Row Text The text to display on the data row. By default, this is set to "New Data Row".
The row text should be edited to reflect the data shown on this row.

For example, if this row is going to display data for the Travel account, the row
text should be something like "Travel" or "Account 5000 - Travel".

Data Filter A filter criteria statement to define the data to query into this row. Only applies
when Use Dimension Mapping is disabled. If dimension mapping is enabled,
then use the Dimension Mapping tab to map the data for this row.

Row filters use normal filter syntax for Axiom Budgeting and Performance
Reporting. You can type the filter, or you can use the Filter Wizard to create a
filter based on the specified Dimension Table for the row structure.

For example, if the data filter is Acct.Category='Revenue', then this row
will display data for all revenue accounts when this row structure is used in a
report. The specific data returned will depend on the data columns used in the
report, and any other filters applied to the report.

Each row's data filter is independent from any other row, and does not need to
use the same grouping level or even the same dimension as other rows. For
example, one row can be Acct.Acct=4000, while another row is
Acct.Category='Marketing', and a third row is Fcst.Acct=670.
However, keep in mind the following:
l If you use the Filter Wizard to make the filter, it is limited to the table

selected as the Dimension Table for the row structure. If you want to use a
different table for a particular row, you must manually write the filter.

l Although there are no restrictions on the individual row filters, all of the
filters used must be compatible with the eventual primary table selected for
the report, when the fixed row structure is used in a report.

If the row uses a data filter, then the row's data filter will be combined with any upstream section data
filters (using AND). For example, imagine the row structure has sections and rows configured as follows:

Parent Section Filter Dept.Company='Company A'

Current Section Filter Dept.Region='US West'

Row Filter Acct.Acct=4000

Then the data for this row is determined as follows:

Dept.Company='Company A' AND Dept.Region='US West' AND Acct.Acct=4000
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Using the Dimension Mapping editor
Using the Dimension Mapping editor, you can assign dimension items to specific rows of a fixed row
structure. When the row structure is used in a web report, the rows will display data for the assigned
dimension items.

For example, if the row dimension is Acct, you can assign one or more accounts to each row in the row
structure. If a row is assigned Acct 4000, then that row will display data for Acct 4000, for each of the
columns used in the report.

� Dimension Mapping editor overview
The Dimension Mapping editor is only accessible when creating or editing a row structure. If Use
Dimension Mapping is enabled for the row structure, then a Dimension Mapping tab displays next to
the Row Editor tab. You can click this tab to open the Dimension Mapping editor and assign dimension
items to each row.

Dimension Mapping tab available in row structure when Use Dimension Mapping is enabled
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Example Dimension Mapping editor

l The left side of the Dimension Mapping editor displays a simplified view of the row structure
defined on the Row Editor tab. You can select a data row in the row structure in order to map
dimension items to that row.

o Each data row must be assigned at least one dimension item when using dimension
mapping. It is not possible to mix use of data filters and dimension mappings.

o The number to the left of the row label shows how many dimension items have been
assigned to that row.

l The two columns on the right side of the Dimension Mapping editor are used to map dimension
items.

o The Current Mappings column in the middle of the page shows the dimension items
mapped to the currently selected data row.

o The dimension column on the right side of the page shows the remaining unmapped
dimension items. The dimension used for the mappings is determined by the specified
Dimension Table in the Row Editor tab. In this example, the dimension table is Acct and
the column shows the list of accounts defined in that table.

o You can use the arrow buttons between the columns to move dimension items from the
dimension column to the Current Mappings column and vice versa.

Each dimension item can only be assigned to a single row in the row structure. Once a dimension item is
moved to the Current Mappings column, it is removed from the list of unmapped dimension items and
cannot be assigned to another row.
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NOTE: When building a fixed row structure with large tables (such as the EDS Encounter table)
dimension mapping is disabled, as it can cause performance issues. Instead, you can use the filter
wizard to define that row in a report. See Specifying the row dimension for a web report for more
information.

� Assigning dimension items to data rows
Each data row in the row structure must be assigned at least one dimension item. When the row
structure is used in a report, the dimension mappings determine what data displays in each row.

To assign one or more dimension items to a data row:
1. In the row structure on the left side of the page, select the data row that you want to map. If any

dimension items are already mapped to this row, those dimension items display in the Current
Mappings column.

2. In the dimension column on the right side of the page, select the dimension item or items that
you want to map to the data row.

l Click a dimension item once to select it. If you select a dimension item by accident, click it
again to de-select it.

l Note that using the Shift key or the CTRL key to select multiple dimension items at once
does not work here. You must individually click on each dimension item that you want to
assign.

You can search and filter the dimension list to help find the desired dimension items.

3. Once all of the dimension items that you want to assign are highlighted, click the left arrow to
move the selected dimension items to the Current Mappings column.

If you want to remove a mapped dimension item from a data row, you can select the item in the Current
Mappings column and then click the right arrow to move it back to the dimension column.

In the following example, two accounts have been mapped to the Expenses Line 1 data row. When this
row structure is used in a report, this row will display summed data for the Software Expense and
Computer Expense accounts. (In a real report, the label text for this data row would likely be defined as
"Software and Computer Expenses" or something similar.)
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Example data row with mapped dimension items

The two accounts that are mapped to this data row no longer display in the dimension column and
cannot be mapped to any other row. You can optionally enable Show Mapped Dimension Items to see
all items in the dimension column, but mapped items will display as grayed out and cannot be selected.

� Searching and filtering the dimension column
You can search and filter the dimension column to more easily find the dimension items that you want
to map.

l You can type into the search box at the top of the column to find items by dimension value. The
search matches any dimension value that contains the search text. Currently, the description text
is not included in the search.

l You can select a grouping column so that the dimension column is filtered to only show values for
a particular grouping. For example, you may have a grouping column of Category, which you can
use to show accounts within a particular category—such as Revenue, Capital, or Marketing.

If you use Select All when the list is filtered by a search or by a grouping value, then only the currently
visible items are selected. This can be a convenient way to find, select, and map multiple dimension
items at a time.

To filter the dimension column by a grouping value:
1. Click the down arrow icon in the column header, and then click Choose Grouping Column.
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2. In the Choose a Grouping Column dialog, select the grouping column that you want to use, and
then click OK.

The dimension column becomes filtered by the first value in the selected grouping column. This
value displays in the column header.

3. To filter the dimension column by a different value in the grouping column, click the down arrow
icon in the column header, and select the desired value.

In the following example, "Balance Sheet" was the automatically-selected value from the
grouping column, and we are now going to select "Marketing" instead.

The dimension column is now filtered to only show accounts that belong to the Marketing
category.
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If you want to clear the grouping column filter, click the down arrow icon in the column header, and
select Clear Grouping Column.

Using the Filter Wizard in the Fixed Row Structure editor
The Filter Wizard is available in the Fixed Row Structure editor to assist you in building a valid filter
criteria statement.
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Example Filter Wizard

The tables available in the wizard depend on the table specified as the dimension table for the fixed row
structure.

To create a filter:
1. In the left-hand side of the dialog, select the table column on which you want to base the filter.

For example, if you want to create a filter such as DEPT.DEPT>=5000, then you must select the
DEPT column from the DEPT table.

To find the desired table and column, you can filter the list by typing into the Search box. The
filter matches based on table and column names.

Once you select a table column, the values in that column display in the right-hand side of the
dialog.
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TIP: Alternatively, you can use the folder icon to the right of the Preview box to load a
previously saved filter from the Filters Library. If you do this, your selected filter is placed in
the Preview box, overwriting any current content in the preview. Skip to step 4.

2. In the right-hand side of the dialog, select the value(s) on which you want to base the filter. You
can type into the filter box above the list of values to filter the list.

3. In the space between the two selection boxes, select the operator to use for the filter criteria
statement, such as equals, not equals, greater than, or less than. By default, the filter statement
uses equals (=).

Note the following about filter operators:
l Greater than / less than options are only available if the column data type holds numbers

or dates.

l If multiple items are selected, then IN and NOT IN syntax is automatically used for equals
and not equals respectively.

l If the column is a string column and the value contains an apostrophe (such as O'Connor),
the wizard automatically converts this value to double apostrophes so that it is valid for
use in the filter (O''Connor). Apostrophes in string values must be escaped this way so that
they are not interpreted as the closing apostrophe for the filter criteria statement.

l The LIKE operator is supported, but is not available for selection in the Filter Wizard. You
must manually edit the filter criteria statement if you want to use it. Only advanced users
with knowledge of valid SQL LIKE syntax should do this.

4. Review the filter criteria statement in the Preview box to ensure that it is as intended. If you need
to make changes, you can manually edit the statement, or you can start again with a new
statement. If you want to clear the statement, click the X icon to the right of the Preview box.

5. If no filter is currently present in the Filter box, click Apply to move the filter down to the Filter
box. If a filter is currently present in the Filter box, you can do one of the following:

l Click Replace to overwrite the current filter with the preview filter.
l Click AND or OR to add the preview filter to the current filter. This creates a compound

criteria statement.
You can repeat the filter creation process as many times as necessary to create the desired
statement. You can also manually modify the filter in the Filter box as needed, such as to add
parentheses to group statements.

6. When the filter in the Filter box is complete, click OK.

TIP: If you want to save the filter you have created for future use, click the save icon to the
right of the Filter box. You can select a folder location in the Filters Library (or My Documents
if applicable), and specify a name for the filter. This option is only available if you have
read/write access to at least one location where filters can be stored.
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Opening web reports
In order to open an existing web report, you must have at least read-only access to the report, as
defined in Axiom Budgeting and Performance Reporting security. Web reports can be opened from
either the Web Client or the Desktop Client.

This topic discusses the default ways to access and view web reports. Your system may be designed so
that you can open web reports in other ways, such as:

l Using the Navigation menu in the Web Client
l Using links within your home page or product pages
l Using links within a task pane or ribbon tab in the Desktop Client

� Opening web reports from the Intelligence Center
The Intelligence Center in the Web Client is a hub where you can access all of your available reports,
regardless of the report type. The Intelligence Center is automatically filtered to show only the reports
that you have access to.

To open a web report from the Intelligence Center:

1. Click the Syntellis icon in the Navigation bar. From the Area menu, select Intelligence Center.

2. In the left-hand panel, select the Reports tab if it is not already selected.

3. Do one of the following to locate the report that you want to open:

l Use the folder tree in the left-hand panel to navigate to the folder where the report is
located.

OR

l Use the Search box to search for the report by name.
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For more information on how to search, filter, and sort the Intelligence Center, see Intelligence
Center overview.

4. Once the report displays in the Intelligence Center grid, click on the report name to open it.

The report opens in the current browser tab. You can now view and explore the data using various
features. For more information, see Viewing and exploring data in web reports.

� Opening web reports from the Desktop Client
You can open a web report from the Reports Library in the Desktop Client (Excel Client or Windows
Client). You can differentiate web reports from other types of Axiom Budgeting and Performance
Reporting reports using the following icons:

Web report

Visualization report

Axiom form

Spreadsheet Axiom file

To open a web report from the Desktop Client:
1. On the Axiom tab, in the Reports group, click Reports to bring up the Reports menu.

NOTE: In systems with installed products, this feature may be present on a different ribbon
tab, such as theMain tab.

TIP: You can also open reports from the Explorer task pane or Axiom Explorer.

2. Use the Reports Library folders at the bottom of the menu to navigate to the specific web report
that you want to open, and then click on it.

The web report opens in the Web Client using your default browser. You can now view and explore the
data using various features. For more information, see Viewing and exploring data in web reports.

Viewing and exploring data in web reports
Once a web report is opened, you may have access to a variety of features to view and explore the data
in the report, including filtering, sorting, and drilling. Additionally, web reports may be configured with
report parameters, which can be used to dynamically change the data shown in the report.
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NOTE: The features described in this topic apply to web reports created in the Report Builder. Web
reports created from template may have similar features, but do not work in exactly the same way.
For more information on viewing and exploring data in a web report created from template, consult
the product documentation for the product that provided the template.

� Drilling data
If the web report has been configured to enable drilling, you can drill any data row in the report. Total
rows, subtotal rows, and section header rows are not drillable.

To drill a data row:
1. Hover your cursor over the far left column in the report so that a magnifying glass icon appears

on the row.

The tooltip for the magnifying glass will be either "Drill" (if multiple drill paths are available) or
"Drill to <path>" (if a single drill path is available). For example, the tooltip will say "Drill to Acct" if
the Acct drill path is the only available drill path.

2. Click the icon to drill the row.
l If multiple drill paths are available, these paths display in a menu when you click the icon.

Click the drilling path that you want to view.

l If a single drill path is available, that path is automatically used when you click the icon to
drill.

Hover and click to drill

The drill results are presented within the current tab, replacing the original report. The current row
being drilled and the current drill level display at the top of the drill results.
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Example drill results with drilling path displayed at the top

You can continue drilling the drill results if additional drill paths are available. You can return to a
previous path by clicking on that path name in the header. When you are finished viewing the drill
results, you can click the X icon in the drill path to clear the drill and return to the original report.

� Using report parameters
If the web report is configured with report parameters, you can use the Report Parameters panel along
the left-hand side of the report to dynamically change the data shown in the report.

Example report with report parameters

The Report Parameters panel contains one or more parameters that you can set as needed. If the report
requires you to select a parameter value in order to refresh data in the report, then when you open the
report the message "Waiting for input" displays in the report grid. Otherwise, the report opens and
refreshes data using default values defined for report parameters as needed.
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You can interact with report parameters as follows:
l You can select one or multiple values for each parameter, depending on the parameter type and

configuration. If a parameter allows multiple values to be selected, the parameter box shows text
such as "3 items selected". You can hover your cursor over this text to view the selected values in
a tooltip.

If the parameter allows selection of multiple values, and some values are already selected, then
using the drop-down list to select more items will add to the current list of items. If instead you
want to clear the list of items and start over, click the X icon in the selection text.

l A parameter may start out blank (unset), or it may start with a default value, depending on the
parameter type and configuration.

l Some parameters may be dependent on other parameters. In this case, the dependent parameter
will not become available for use until its parent parameter has a selected value.

l Parameters may be required or optional:

o If a parameter is optional, then you can leave it unset, or you can clear its value using the X
icon to the right of it.

o If a parameter is required, then it cannot be cleared. You can select a different value, but
you cannot fully clear the parameter. Exception: If the parameter allows selection of
multiple values, then you can click the X icon in the selection text to clear the current
selections.

Once you have made selections for the parameters, you can apply and clear them as follows:
l Click Apply to refresh the report using your parameter selections. The Apply button is not active

until all required parameters have selected values.

l Click Clear to clear all optional parameters. You can then click Apply to refresh the report with the
optional parameters unset.
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NOTES:
l When you share or export a report, it does not honor the report parameter selections, with

one exception. If the report parameter determines the row dimensions of the report, and the
parameter has a default value, the exported report will use that default value.

l The specific parameters available and how they impact the report depends on the report
configuration. Contact your system administrator or the report designer if you have any
questions about how the parameters affect the report data.

� Adjusting column width and order
You can make minor adjustments to the column display as follows:

l To change the column width, hover your cursor along the right edge of the column header, then
drag to make the column thinner or wider.

l To reorder columns, click on a column header and then drag it to a new location. Note that
columns cannot be moved in or out of a column group (meaning a set of columns grouped under
header text). If a column belongs to a column group, you can change its order within the group
but you cannot drag it out of the group.

� Sorting data
If the web report uses a data grid with dynamic rows, then you can sort the data by any column in the
grid. To sort the grid by a column, click on the column header. Each click toggles between ascending
sort, descending sort, and no sort. If the grid is currently sorted by a column, the sort direction is
indicated by an arrow on the column header (up for ascending, down for descending).

The web report may only allow sorting by a single column, or it may allow sorting by multiple columns.
This is configured by the report designer. If the grid uses single-column sorting, then it is not possible to
clear the sort on a column. Instead you must click on a different column to change the sort to use that
column.

If the web report uses a fixed row structure, then the row values are fixed in position and cannot be
sorted.

� Filtering by column data
If the web report uses a data grid with dynamic rows, you may be able to filter the report by the column
data. For example, you might want to filter a column to hide zero-value records, or to show all records
above or below a certain value. You might want to filter a dimension column to hide or show certain
dimensions (such as departments, accounts, and so on). The report designer determines whether a
column is enabled for filtering.

If a column allows filtering, the filter icon displays in the column header when you hover your cursor
over the column header.
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Filter icon for a column with filtering enabled

To filter the report based on a column:
1. Click the filter icon in the column header to show the filter options.

2. Set the filter options as desired. The options vary depending on the column type.

Example filtering options

3. Click Filter.

The report updates to only show records that meet the filter. Additionally, the filter icon in the column
header remains visible to indicate that the grid is filtered by this column.

The filter is retained until you clear it, or until the report is refreshed with new data.

To clear a filter:
1. Click the filter icon in the column header to show the filter options.

2. Click Clear.

The grid updates to clear the filter. The filter icon is now only visible when hovering over the column
header.
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� Viewing paged data
If the web report uses dynamic rows, the data is paged to show a specified number of records per page.
If the data in the grid exceeds the page limit, you can move between pages using the page controls at
the bottom left of the grid.

Page controls for data grids

l Click a page number to move directly to that page.
l Click the single arrow buttons to move one page back or forward.
l Click the double arrow buttons to move to the first page or the last page.

By default, the data grid shows 25 records per page. You can use the drop-down list next to the page
controls to change this to 50, 100, or 500 as needed.

Web report sharing, export, and distribution
The information in web reports can be distributed throughout the organization using a variety of
features:

l You can export a web report as a PDF, Excel, or delimited file, and save it locally or to the Axiom
Budgeting and Performance Reporting repository.

l You can share a web report via email to other users, by sending a link to the live file in the
system, or by attaching a PDF or Excel file.

l You can process web reports iteratively over a dimension, and then automatically save and/or
email the report to designated recipients.

Exporting a PDF copy of a web report
You can export a web report as a PDF file, and save the file locally or to the Axiom Budgeting and
Performance Reporting repository. The export can be performed while viewing the report, or from the
Reports Library in the Intelligence Center.

l When exporting the report from the Intelligence Center, it is exported using default settings. If
the report requires user input to return data, you should instead open the report and export from
the report viewer.

l When exporting the report from the report viewer, the export honors the current report state
such as sorting, filtering, and drilling.

Any user who can view the report can export to PDF and save it to a local folder location. In order to
save a PDF copy to the Axiom Budgeting and Performance Reporting repository, you must have
read/write access to at least one folder in the Reports Library.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 224



To export a web report as a PDF file:
1. In the Intelligence Center, locate the report in the folder tree, or search to find it.

2. Do one of the following:

l Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon then select Export > PDF from the menu.

l Click the report name to open the report. In the top right corner of the report, click Export
> PDF.

3. In the Export Report dialog, enter a file name into the File name field. By default, the file name is
the same as the web report file name.

4. Select the export destination from the Export to drop-down:
l My computer: Save the PDF to your computer.
l Axiom repository: Save the PDF to a folder in the Axiom Budgeting and Performance

Reporting Reports Library, or to your My Documents folder.
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NOTES:
l If you save the PDF to a folder in the Reports Library, any user with at least read-only

access to that folder will be able to view the PDF. You should be sure that it is
acceptable for users with permission to the target folder to view the data in the PDF.

l If you do not have read/write access to any folders in the Axiom repository, then the
Export to option is not available and does not display in the dialog. The PDF will be
automatically saved to your computer.

l If you save the PDF to your computer, keep in mind that Axiom Budgeting and
Performance Reporting does not enforce any security on the exported file.

5. If you are saving to the Axiom repository, select an Output folder:

l Click the folder icon to the right of the field.

l In the Choose output folder dialog, select a folder in the Reports Library. The dialog only
shows folders where you have read/write access to that folder or a child folder.

NOTE: If you have access to the My Documents folder, then you can also save reports
to that location for your personal use.

l Click OK to choose the folder and return to the Export to PDF dialog.

The path to your selected folder now displays in the Output folder field.

6. In the Configuration Settings section, select the following:
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Item Description

Pages If you are exporting from the report viewer and the report has paged
data, select one of the following:
l Current Page: The export will contain the current page of data only.

For example, if you are currently viewing page 2 of the data in the
report, the export will contain that data only.

l All Pages: The export will contain all pages of data, up to 10 pages
maximum.

A "page" refers to a page of data as displayed in the report, not PDF
pages. Report pages can be configured to show 25 (default), 50, or 100
rows. For example, if you select to export the current page and the page
size is 100, the PDF will contain those 100 rows which may span several
PDF pages.

NOTES:
l If you are exporting from the Intelligence Center, this option does not

display and the PDF will contain all data pages (up to the maximum).
l If the report uses a fixed row structure, data is not paged and this

option does not apply. The PDF will contain the full contents of the
report.

Layout Select the page size for the PDF. You can choose from the following
standard page sizes: A3, A4, A5, Legal, Letter, or Tabloid. Letter is the
default size.

Orientation Select the orientation for the PDF, either Portrait or Landscape. Portrait is
the default orientation.

Margin Specifies the PDF page margins. Select one of the following:
l None: No margin
l Narrow: 0.5 inch margins all around
l Normal: 1 inch margins all around (default)

Header

Footer

Specify optional header and footer text. The variables {page_number}
and {total_pages} can be used in the header or footer.

You can select from several predefined header and footer options using
variables, or you can type text into the Header or Footer box.

NOTE: If the margin is set to None, then the Header, Footer, and
Alignment options are not available because there is no room to display a
header or footer.

Alignment Specify the alignment of the header and footer text, if defined: Left,
Center (default), or Right.
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7. Click Export to create the PDF.

l If you are saving to the Axiom repository, and you used a file name that already exists in
the target folder, you are prompted to choose whether or not to overwrite the existing file.
If you choose not to overwrite, you are returned to the Export to PDF dialog so that you
can use a different name and/or output folder.

l If you are saving to your computer, the exact behavior is determined by your browser
settings. The default behavior for most browsers is to save the file to the Downloads folder
on your computer.

l In either case, a notification message displays at the top of the page to indicate whether
the PDF creation succeeded or failed.

� Export behavior
When you create the PDF, the web report contents are handled as follows:

l If the grid in the web report has paged data, the PDF will contain either all rows shown on the
current page, or all rows in the report up to 10 pages of data. The number of rows in a page of
data depends on the paging selection in the report (25, 50, or 100).

o Column headers are present on the first PDF page only; headers do not repeat on PDF
pages.

o If the report has a total row, that row is always included in the PDF and always displays the
full total, even if the PDF only contains a partial set of data.

o If exporting from the Intelligence Center, the PDF contains all data pages up to the
maximum, using the default of 25 rows per page.

l If you have sorted, filtered, or drilled the data displayed in the report, these changes are reflected
in the PDF. The exception is if you have reordered columns—columns display in their original
order.

NOTE: Drill results can only be saved as a PDF if the report was created in the Report Builder.
Web reports created from template display drill results slightly differently, and these results
cannot be saved to PDF.

l If the report uses report parameters, those parameter selections are not reflected in the export.
Exception: If the report uses a dynamic column tied to a Column List report parameter, the
default value for that parameter will be used for the export.

NOTE: For reports created from template, refresh variable selections are applied to the
export.

l If the report contains a column with links, the column displays the link text without an active
hyperlink.
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Exporting grid data in a web report to Excel
You can export grid data in a web report to a spreadsheet, so that you can further examine the data
using spreadsheet features. You can save the spreadsheet locally, or save it to the Axiom Budgeting and
Performance Reporting repository.

The export can be performed while viewing the report, or from the Reports Library in the Intelligence
Center.

l When exporting the report from the Intelligence Center, it is exported using default settings. If
the report requires user input to return data, you should instead open the report and export from
the report viewer.

l When exporting the report from the report viewer, the export honors the current report state
such as sorting, filtering, and drilling.

Any user who can view the report can save the spreadsheet export locally. In order to save the
spreadsheet export to the Axiom Budgeting and Performance Reporting repository, you must have
read/write access to at least one folder in the Reports Library.

To export grid data to an Excel spreadsheet:
1. In the Intelligence Center, locate the report in the folder tree, or search to find it.

2. Do one of the following:

l Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon then select Export > Excel from the menu.

l Click the report name to open the report. In the top right corner of the report, click Export
> Excel.
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3. In the Export to Excel dialog, enter a file name into the File name field. By default, the file name
is the same as the web report file name.

4. Select the export destination from the Export to drop-down:
l My computer: Save the spreadsheet to your computer.
l Axiom repository: Save the spreadsheet to a folder in the Axiom Budgeting and

Performance Reporting Reports Library, or to your My Documents folder.

NOTES:
l If you save the spreadsheet to a folder in the Reports Library, then any user with at

least read-only access to that folder will be able to view the spreadsheet. You should
be sure that it is acceptable for users with permission to the target folder to view the
data in the spreadsheet.

l If you do not have read/write access to any folders in the Axiom repository, then the
Export to option is not available and does not display in the dialog. The spreadsheet
will be automatically saved to your computer.

l If you save the spreadsheet to your computer, keep in mind that Axiom Budgeting and
Performance Reporting does not enforce any security on the exported file.

5. If you are saving to the Axiom repository, select an Output folder:

l Click the folder icon to the right of the field.

l In the Choose output folder dialog, select a folder in the Reports Library. The dialog only
shows folders where you have read/write access to that folder or a child folder.

NOTE: If you have access to the My Documents folder, then you can also save reports
to that location for your personal use.

l Click OK to choose the folder and return to the Export to Excel dialog.

The path to your selected folder now displays in the Output folder field.
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6. If the current report is enabled for directed drilling, you can optionally choose to Export all drill
levels. If this option is enabled, then the report data is "flattened" using all drill levels. For
example, if the report is currently showing rows by Acct, and the report has configured drilling
levels of Region and Dept, then the exported report contains data rows by unique combination of
Acct/Region/Dept.

NOTES:
l If this option is enabled, the export ignores any sorting, filtering, or drilling in the

report. The directed drilling columns are added to the report as row dimensions, and
all data is exported at this level.

l This option is not available if the report uses a fixed row structure, or if the report is
built from template.

7. Click Export to create the spreadsheet.

l If you are saving to the Axiom repository, and you used a file name that already exists in
the target folder, you are prompted to choose whether or not to overwrite the existing file.
If you choose not to overwrite, you are returned to the Export to Excel dialog so that you
can use a different name and/or output folder.

l If you are saving to your computer, the exact behavior is determined by your browser
settings. The default behavior for most browsers is to save the file to the Downloads folder
on your computer.

l In either case, a notification message displays at the top of the page to indicate whether
the spreadsheet creation succeeded or failed.

� Export behavior
When the grid data is exported, the behavior is as follows:

l If the data is paged in the report, the export contains all pages of data.

l By default, the basic number format applied to the column is preserved in the export. The
exception is negative numbers, which will always be shown using a minus sign regardless of the
configured format. Other formats such as background colors and borders are not applied to the
exported data.

l Date and DateTime columns are exported as follows:

o Columns configured to display the full date part are exported using the default date or
date-time format, regardless of the format configured to display in the report.

o Columns configured to display other date parts display the numeric value of the date part
only. For example, if the column is configured to display the Quarter part as Q1 format, the
value is exported as only the number (1 for Q1).
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l If you have sorted, filtered, or drilled the data displayed in the report, these changes are reflected
in the export. The following exceptions apply:

o Reordered columns are ignored. Columns are exported in their original order.

o Drill results can only be exported to Excel if the report was created in the Report Builder.
Web reports created from template display drill results slightly differently, and these
results cannot be exported.

o If Export all drill levels is enabled, the export ignores any sorting, filtering, or drilling in the
report. The directed drilling columns are added to the report as row dimensions, and all
data is exported at this level.

l If the report uses report parameters, those parameter selections are not reflected in the export.
Exception: If the report uses a dynamic column tied to a Column List report parameter, the
default value for that parameter will be used for the export.

NOTE: For reports created from template, refresh variable selections are applied to the
export.

l Column group headers are omitted from the export. Additionally, if a column has a 2-row header,
only the first row of that header is exported.

l If the report contains a column with links, the link configuration is ignored, and the regular
column value is exported (as if the column were not enabled to show links).

l Export to Excel is capped at 150,000 rows. If a report contains over 150,000 rows, only partial
data is exported, and the total row is omitted.

Exporting grid data in a web report to a delimited file
You can export grid data in a web report to a delimited file such as comma-separated (CSV). You can
save the delimited file locally, or save it to the Axiom Budgeting and Performance Reporting repository.

The export can be performed while viewing the report, or from the Reports Library in the Intelligence
Center.

l When exporting the report from the Intelligence Center, it is exported using default settings. If
the report requires user input to return data, you should instead open the report and export from
the report viewer.

l When exporting the report from the report viewer, the export honors the current report state
such as sorting, filtering, and drilling.

Any user who can view the report can save the delimited file locally. In order to save the delimited file to
the Axiom Budgeting and Performance Reporting repository, you must have read/write access to at least
one folder in the Reports Library.
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To export grid data to a delimited file:
1. In the Intelligence Center, locate the report in the folder tree, or search to find it.

2. Do one of the following:

l Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon then select Export > Excel from the menu.

l Click the report name to open the report. In the top right corner of the report, click Export
> Excel.

3. In the Export Report dialog, enter a file name into the File name box. By default, the file name is
the same as the web report file name.

4. For Export to, select the export destination:
l My computer: Save the delimited file to your computer.
l Axiom repository: Save the delimited file to a folder in the Axiom Budgeting and

Performance Reporting Reports Library, or to your My Documents folder.
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NOTES:
l If you save the delimited file to a folder in the Reports Library, then any user with at

least read-only access to that folder will be able to view the file. You should be sure
that it is acceptable for users with permission to the target folder to view the data in
the file.

l If you do not have read/write access to any folders in the Axiom repository, then the
Export to option is not available and does not display in the dialog. The file will be
automatically saved to your computer.

l If you save the file to your computer, keep in mind that Axiom Budgeting and
Performance Reporting does not enforce any security on the exported file.

5. If you are saving to the Axiom repository, select an Output folder:

l Click the folder icon to the right of the field.

l In the Choose output folder dialog, select a folder in the Reports Library. The dialog only
shows folders where you have read/write access to that folder or a child folder.

NOTE: If you have access to the My Documents folder, then you can also save reports
to that location for your personal use.

l Click OK to choose the folder and return to the Export to Excel dialog.

The path to your selected folder now displays in the Output folder field.

6. In the Configuration options section, select the desired Delimiter. You can select any of the
following: Comma (default), Space, Period, Pipe, Tab, Semi-Colon, Colon.

If the delimiter is a comma, the file format for the exported file is CSV. For any other delimiter,
the file format is TXT.

7. If the current report is enabled for directed drilling, you can optionally choose to Export all drill
levels. If this option is enabled, then the report data is "flattened" using all drill levels. For
example, if the report is currently showing rows by Acct, and the report has configured drilling
levels of Region and Dept, then the exported report contains data rows by unique combination of
Acct/Region/Dept.

NOTES:
l If this option is enabled, the export ignores any sorting, filtering, or drilling in the

report. The directed drilling columns are added to the report as row dimensions, and
all data is exported at this level.

l This option is not available if the report uses a fixed row structure, or if the report is
built from template.
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8. Click Export to create the delimited file.

l If you are saving to the Axiom repository, and you used a file name that already exists in
the target folder, you are prompted to choose whether or not to overwrite the existing file.
If you choose not to overwrite, you are returned to the Export Report dialog so that you
can use a different name and/or output folder.

l If you are saving to your computer, the exact behavior is determined by your browser
settings. The default behavior for most browsers is to save the file to the Downloads folder
on your computer.

l In either case, a notification message displays at the top of the page to indicate whether
the file creation succeeded or failed.

� Export behavior
When the grid data is exported, the behavior is as follows:

l If the data is paged in the report, the export contains all pages of data.

l If the report uses row dimensions, then the first row of data in the file contains the column
headers. Group headers are omitted from the export. Additionally, if a column has a 2-row
header, only the first row of that header is exported. The total row is excluded from the export.

l If the report uses a fixed row structure, all rows are included in the delimited file, including
header rows and subtotal rows.

l The raw data is exported to the delimited file. No formatting is applied. For example, this means
number formats are not applied, date formats are not applied, and the Show Description option
is not applied. The Description will only display if you click the Show description toggle in the
Formatting Properties area of your report's column configuration settings.

l If a data value in the export contains the delimiter, that value is escaped in double quotation
marks. For example, if the delimiter is a space character, then values with spaces are wrapped in
double quotation marks (such as "Finance Department").

l If the report contains a column with links, the link configuration is ignored, and the regular
column value is exported (as if the column were not enabled to show links).
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l If you have sorted, filtered, or drilled the data displayed in the report, these changes are reflected
in the export. The following exceptions apply:

o Reordered columns are ignored. Columns are exported in their original order.

o Drill results can only be exported to file if the report was created in the Report Builder.
Web reports created from template display drill results slightly differently, and these
results cannot be exported.

o If Export all drill levels is enabled, the export ignores any sorting, filtering, or drilling in the
report. The directed drilling columns are added to the report as row dimensions, and all
data is exported at this level.

l If the report uses report parameters, those parameter selections are not reflected in the export.
Exception: If the report uses a dynamic column tied to a Column List report parameter, the
default value for that parameter will be used for the export.

NOTE: For reports created from template, refresh variable selections are applied to the
export.

Sharing a web report via email
You can share a web report with other Axiom Budgeting and Performance Reporting users via email. The
report can be shared as a link to the live report, or as a PDF or Excel attachment. Sharing can be done
while viewing the report, or from the Reports Library in the Intelligence Center.

l When sharing the report from the Intelligence Center as a PDF or Excel attachment, the
attachment is generated using default settings. If the report requires user input to return data,
you should instead open the report and share from the report viewer.

l When sharing the report from the report viewer as a PDF or Excel attachment, the attachment
honors the current report state such as sorting, filtering, and drilling. Exception: report parameter
selections are not honored unless the report is built from template.

l When sharing the report as a link, the email recipient can click the link to log in to Axiom
Budgeting and Performance Reporting and view the report within the application. The recipient
must have at least read-only security permission to the report in order to view it. When using the
link, the report is opened in its default state, and the user can explore the report as needed.

Any user who can view the report can share it. The report can be shared with any user in Axiom
Budgeting and Performance Reporting, or any email address that the Axiom Budgeting and Performance
Reporting system can send email to.

NOTE: When sharing a web report as a PDF or Excel attachment, keep in mind that Axiom Budgeting
and Performance Reporting does not enforce any security on these attachments. Any user who
receives the email can view the attachment.
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To share a web report via email:
1. In the Intelligence Center, locate the report in the folder tree, or search to find it.

2. Do one of the following:

l Hover your cursor over the Name column to make the three-dots icon visible. Click the
icon and select Share from the menu, then select either Excel, Link, or PDF.

l Click the report name to open the report. In the top right corner of the report, click Share,
then select either Excel, Link, or PDF.

3. If you selected to share as either Excel or PDF, then complete the settings in the Share Report
dialog, and then click Share. The settings are the same as when exporting to Excel or PDF, except
that you do not specify a location to save the exported file—the file will be attached to the
sharing email. For example:

l For PDF, you can specify the file name, layout, orientation, margin size, and header/footer
content.

l For Excel, you can specify the file name and whether to export all drilling levels.
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NOTES:
l The Share Report dialog for Excel only displays if you are sharing from within the report

viewer, and only if the report is configured for directed drilling. Otherwise, the dialog
does not display and the file name of the Excel attachment will always be the report
file name.

l The PDF or Excel attachment is generated using the same behavior as when exporting
the file to PDF or Excel. For more information, see Exporting grid data in a web report
to Excel or Exporting a PDF copy of a web report.

l If you selected to share as a link, this dialog does not display and you are taken directly
to the E-mail dialog.

4. In the E-Mail dialog, select the recipients of the email. You can type email addresses into the To,
CC, and BCC boxes, or you can click the plus icon next to the recipient box to look up email
addresses for Axiom Budgeting and Performance Reporting users:

l In the Select Users dialog, select the check boxes next to the users that you want to share
the report with.

l You can search on the user first or last name to find users.

l Once you have selected one or more users, click OK. The recipient box is populated with
the email addresses for the selected users. If the box already contained one or more email
addresses, the newly selected addresses will be added to the existing list.

If you are manually typing email addresses, separate multiple addresses with semicolons.
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Example E-mail dialog

5. In the E-Mail dialog, complete the Subject and body text as needed.
l By default, the subject is set to "Sharing FileName".
l If you are sharing a link, the link is pre-populated into the body text.

6. Click Share to share the report and send the email.

l If you are sharing the report as a PDF or Excel file, the attachment is generated at this
point. If the report is large, there may be a delay while the attachment is generated.

l A notification message displays at the top of the page to indicate whether the email and its
attachment (if applicable) was generated successfully. Once the email is generated, it will
sent by the Axiom Budgeting and Performance Reporting server using the standard
System.SMTPMessageDelivery job.
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Production reporting for web reports
Using production reporting features with web reports, you can generate and deliver report "snapshots"
to various audiences as needed.

l You can perform multipass processing on a web report over a specified dimension, such as by
department, region, or entity. The report is iteratively refreshed—one "pass" for each value of
the dimension—and during each pass a filter is automatically applied to limit the data to the
current dimension value.

l The output of each pass is a filtered PDF or Excel "snapshot" of the report. This static snapshot is
then saved to a target folder location—either a local folder in your network or the Axiom
repository—and/or emailed to a specified recipient. Folder locations and email recipients can be
determined dynamically so that the location and recipient changes as needed for each pass.

l Multiple PDF or Excel snapshots can be optionally collected into larger "report books" and then
dynamically saved and/or emailed as needed. For example, you might process three different
web reports by entity, and then collect the three resulting entity snapshots into a single file per
entity.

To perform multipass processing on a web report, use the Scheduler taskWeb Report Processing. This
task will process a target report by a specified dimension, and then save and/or email the output files as
configured in the task.

To collect output files into report books, use the File Collect option of File Processing. To do this, you
must create a spreadsheet report, enable it for file processing, and then configure file collect options.
Once it is configured, file collect processing can be run manually in the Desktop Client, or can be run
using the Scheduler task File Processing.

IMPORTANT: In phase one of production reporting for web reports, processing is only supported for
web reports created from product-delivered templates. Ad hoc web reports created in the Report
Builder cannot be processed yet. Support for ad hoc report processing may be added in a future
release.

Setting up web report processing

You can perform production reporting for web reports using multipass processing. The report can be
processed multiple times over a dimension, generating a filtered PDF or Excel copy of the report for
each value of the dimension. The report copies can be saved to a designated location and/or emailed to
designated recipients.

To perform multipass processing on a web report, use the Scheduler taskWeb Report Processing. When
you set up this task, you configure the following:

l The web report to process. You can process any web report created from a product-delivered
template.
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l The output format of the processing. Each pass will generate a filtered PDF or Excel output file.
The name of the file can be set dynamically using processing variables and job variables.

l The delivery option for the processing. Each output file can be saved to a folder location, emailed
to a recipient, or both.

o If the output is saved, you specify the location of the target folder (local or Axiom
repository) and the folder path. The folder path can be set dynamically using processing
variables and job variables.

o If the output is emailed, you specify the recipients of the email, and the email subject and
body text. The recipients can be manually entered into the task settings (and can
optionally use job variables), or you can specify a table column to dynamically look up the
recipients. Recipients can be email addresses, or you can list user and role names to look
up email addresses from Axiom security. The email subject and body text can be set
dynamically using processing variables and job variables.

l The dimension to process. You can specify any dimension that will be compatible against the data
queried in the target web report. The web report will be processed once for each value in the
dimension. If desired, you can define a filter to limit the dimension values to process.

� Configuring a web report processing task
In order to create a Scheduler job with a Web Report Processing task, you must be an administrator or a
user with the Scheduled Jobs User permission. You must also have read/write access to at least one
folder in the Scheduler Jobs Library to save the job. Scheduler jobs can only be created in the Desktop
Client.

To create a Scheduler job with a web report processing task:
1. On the Axiom tab, in the Administration group, clickManage > Scheduler.

NOTE: In systems with installed products, this feature may be located on the Admin tab. In
the System Management group, click Scheduler.

2. In the Scheduler dialog, on the Job tab, click New.
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3. Select the Tasks section of the job, then on the Job tab, click Add > Web Report Processing.
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4. Select theWeb Report to Process. This is the report that will be processed by the task.
l Click the Browse button to open the Axiom Explorer dialog.
l Navigate to the web report that you want to process, then select the report and then click

Open.
The selected report is listed in the Web Report to Process box.

IMPORTANT: Remember, only web reports that are created from a product-delivered
template can be processed. The Axiom Explorer dialog is filtered to only show reports that
were created from template.
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Example task with report selected for processing

5. Complete the general processing properties that determine the processing type and the output:

Item Description

Processing
Type

Select one of the following to determine the output format of each pass:
l Export to Excel (default): The contents of the report are exported to a

spreadsheet (XLSX) file. The output uses the same behavior as when
you export to spreadsheet while viewing the web report.

l Export to PDF: The report is saved as a PDF file. The output uses the
same behavior as when you save to PDF while viewing the web report.

Save or Email
Files

Select one of the following to determine the delivery method for the
output:
l Save Files (default): The output files are saved to the specified output

folder.
l Email Files: The output files are emailed to the specified recipients.

The output files are not saved anywhere on the file system.
l Save and Email Files: The output files are both saved and emailed.
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Item Description

File Generation Select one of the following to determine whether the output is saved as a
single file or multiple files:
l Multiple Output files (default): The results of each pass are saved as

individual output files. For example, if the multipass settings result in
10 passes, then 10 output files are created (one file for each pass).

l Single Output File: The results of each pass are collected into a single
output file. For example, if the multipass settings result in 10 passes,
then the results of all 10 passes are placed in a single output file.
If the output type is Excel, then each pass is a separate sheet in the
Excel file. If the output type is PDF, then the PDF for each pass is
combined into one large PDF file.

File Name Specify how the output file (or files) should be named. You can do the
following:
l You can use processing variables and/or Scheduler job variables to

generate dynamic file names.
l You can type a "hard-coded" file name.
If the task will generate multiple output files, then the file name (or the
output folder path) must use a processing variable so that the output of
each pass is unique. If the task will generate a single output file, then
variables are not required.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select
the variable that you want to use.

For example, you could set the file name to Income Statement
[Current_Value]. If the report is being processed by region to multiple
output files, this will generate file names such as Income Statement
West, Income Statement East, and so on (where "East" and "West"
are region names).

NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job
variables are enclosed in curly brackets.
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Item Description

Sheet Name Specify how the sheet for each pass should be named. This property only
applies when the processing type is Export to Excel. You can do the
following:
l You can use processing variables and/or Scheduler job variables to

generate dynamic sheet names.
l You can type a "hard-coded" sheet name.
If the task will collect all of the output into a single spreadsheet file, then
the sheet name must use a processing variable so that the output of each
pass is unique. If the task will generate multiple output files, then
variables are not required.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select
the variable that you want to use.

For example, you could set the sheet name to [Current_Value]. If the
report is being processed by region, this will generate sheet names such
as West, East, and so on (where "East" and "West" are region names).

NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job
variables are enclosed in curly brackets.

Example task with general processing properties configured

6. Depending on the selected processing type (PDF or Excel), complete the properties specific to
that processing type:
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Export to PDF Settings

Item Description

PDF
Orientation

Select the orientation for the PDF, either Portrait or Landscape. Portrait is
the default orientation.

Page Size Select the page size for the PDF. You can choose from the following
standard page sizes: A3, A4, A5, Legal, Letter, or Tabloid. Letter is the
default size.

Export to Excel Settings

Item Description

Include Column
Headers

Specifies whether column headers are included in the file output. By
default this is set to On, which means column header text is included in
the first row of the spreadsheet. Column grouping headers and multi-row
headers are not included.

If this option is set to Off, then column headers are omitted from the file
output and the data starts in the first row of the spreadsheet.

Include total
row

Specifies whether the total row is included in the file output. By default
this is set to On, which means that the total row is included in the
spreadsheet.

If this option is set to Off, then the total row is omitted from the file
output.

NOTE: This option only applies when the web report being processed is a
dynamic row report with the total row enabled. If the web report being
processed uses a fixed row structure, then the total and subtotal rows
defined in the fixed row structure are always included in the spreadsheet.
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Example task with PDF-specific settings

7. If the processing is set to Save Files or Save and Email Files, complete the Output File Settings:

Item Description

Output To Select one of the following:
l Local File System (default): The output location is outside of Axiom

Budgeting and Performance Reporting, to a location on your local
network share. The specific path is detailed in the Output Folder
setting. Access to output files is not controlled by Axiom Budgeting and
Performance Reporting.

l Axiom Repository: The output location is the Axiom Budgeting and
Performance Reporting file system, within the Reports Library. The
specific path is detailed in the Output Folder setting. Access to output
files is controlled by security access to the designated folder within
Axiom Budgeting and Performance Reporting.
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Item Description

Output Folder Specify the folder location for the file output. You can type a folder path,
or you can click the folder icon to browse to the folder location. The
browse dialog will display either your local file system or the Axiom file
system, depending on what you selected for Output To.

The output folder can be made dynamic as follows:
l If File Generation is set toMultiple Output Files, then processing

variables can be used in the output folder path. For example, you can
include [Current_Value] in the output folder path, and this will be
replaced with the current multipass value. Processing variables are not
valid in the output folder path if the task is configured to generate a
single output file.

l Scheduler job variables can be used in the output folder path.
NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job
variables are enclosed in curly brackets.

Local file system
The output folder location must be entered as a UNC path, and must be
accessible by the Scheduler service user account (for on-premise systems)
or the Axiom Cloud Integration Service (for cloud systems).

The ability to save files to the specified location and access them after
saving is controlled by local network security.

Axiom repository
The specified location in the Axiom file system must be within the Reports
Library, and the location must use the full path (meaning:
\Axiom\Reports Library\...). The ability to save files to the
specified location and to create new folders (if necessary) depends on the
Axiom Budgeting and Performance Reporting security permissions for the
user processing the file. Users can only create new folders if they have
read/write permissions to the parent folder, and they can only create new
files if they have read/write permissions to the target folder.

Once the files are created within the Axiom file system, access to those
files is dependent on the user's permissions to the output folder. Typically
you should create the output folder in advance (or if you want to create
output folders on-the-fly, create a parent folder to hold the output
folders), and then set permissions for that folder as appropriate in Axiom
Budgeting and Performance Reporting security, so that the appropriate
users will be able to access the files after they are created.
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Item Description

Remote Data
Connection

This option only applies when the file output is being saved to your local
file system, and only for Axiom Cloud systems that are using remote data
connections.

Select the name of the remote data connection to use for the file
processing operation. The designated remote data connection will be
used to access the local file system and save output file(s) to the
designated location.

A remote data connection is required to save files locally from an Axiom
Cloud system. For more information, see the section on remote data
connections in the Scheduler Guide.

Purge Setting This option only applies when the file output is being saved to the Axiom
Repository.

If you want the file output to be automatically deleted after a specified
period of time, then click the pencil icon to open the Choose Date
dialog.
l No purge date (default): File output is not automatically deleted.
l Static purge date: Select a specific date, after which the output will be

deleted.
l Relative purge date: Specify a number of days to keep the output after

it has been generated. The output will be deleted after the specified
number of days have passed.
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Example task saving output to the Axiom Repository

8. If the processing is set to Email Files or Save and Email Files, complete the Email Settings:
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Item Description

Recipient
column

Optional. Specify a table column that holds the desired email recipients
for each pass. This option only applies if File Generation is set toMultiple
Output Files, so that each pass will be sent a separate email.

You can type the name of a table column, or click the column button to
select a column from the multipass table or a lookup table. (You must
select a multipass column first before you can use the column button to
select a column.) For example, if the multipass column is Dept.VP, the
recipient column might be Dept.VP.Email.

The specified column can contain any of the following: email addresses,
user login names, and/or role names. The column can contain multiple
values separated by a semicolon. The recipients listed in the column will
be used as the To address for the email (in addition to any recipients
listed directly in the To field). If the column contains a user login name,
that user's email address as defined in security will be used. If the column
contains a role name, the email will be sent to all users in the role.

To verify that the recipient column will resolve as you expect for each
pass, you can click the Preview Multipass List button in theMultipass
Data Settings section. The specified recipient column displays in this
preview so that you can see the recipient column values associated with
the multipass column values.

NOTE: The recipient column must have a one-to-one relationship with the
values in the specified multipass column.

To Specify the To recipient(s) for the email. This is required if a recipient
column is not specified. If a recipient column is specified, the recipients
listed here will be added to the recipients listed in the column for each
pass.

You can type one or more email addresses, user login names, and/or role
names. Separate multiple recipients with semicolons. If a user login name
is listed, that user's email address as defined in security will be used. If a
role name is listed, the email will be sent to all users in the role.

NOTE: If File Generation is set toMultiple Output Files, the recipients in
the To field will receive a separate email for each pass. The only way to
dynamically send the emails to different recipients per pass is to use the
Recipient Column option.

CC Optional. Specify the CC recipient(s) for the email. This field follows the
same rules as the To field.
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Item Description

BCC Optional. Specify the BCC recipient(s) for the email. This field follows the
same rules as the To field.

From Select one of the following to specify the From address for the email:
l Current User: The email will be sent from the user who executes the

Scheduler job.
l System User: The email will be sent from the designated From user for

Scheduler. This is the same value returned by the
{Scheduler.FromEmailAddress} job variable.

Subject Line Enter the subject line for the email. Processing variables can be used in
the subject line when File Generation is set toMultiple Output Files.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select
the variable that you want to use.

For example, you could set the subject line to Monthly report for
[Current_Value] in order to include the current pass value in the
subject line.

Body Text Enter the body text for the email. Processing variables can be used in the
body text when File Generation is set toMultiple Output Files.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select
the variable that you want to use.

Scheduler job variables can be used in any of the email settings except the From setting.
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Example task looking up email addresses from a recipient column

9. Complete the multipass settings for processing:
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Item Description

Multipass
Column

Specify the column to use for multipass processing. You can type a
Table.Column name, or click the column icon to select the column from
a dialog. You can select any column on a data or reference table, though
typically processing is performed by a dimension such as Dept.Dept, or a
grouping such as Dept.Region.

The report will be processed once for each unique value in the specified
column (except for any values excluded by the Source Filter). A filter is
applied to the data query in the report so that the data is limited to the
current pass value. For example, if you are processing by Dept.Dept, then
the report will be processed once for each department, and the report
data will be limited to only the data for that department.

Keep in mind the difference between processing by a data table column
such as GL2022.Dept, versus a dimension table column such as Dept.Dept.
When processing by GL2022.Dept, the report will be processed by each
department with data in the GL2022 table. When processing by
Dept.Dept, the report will be processed by each department in the Dept
table.

To verify the list of values for processing, click the Preview Multipass List
button to view the list of items. The first 100 values are shown, in the
order they will be processed. If the task configuration includes a Recipient
Column (in the email settings) or a Sort By column, these columns are
also shown in the preview.
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Item Description

Current Pass
Header

Optional. Define a header to display in the report output file. This option
only applies if the processing type is Export to PDF.

The current pass header should use processing variables to display
information about the current pass. To use a processing variable, you can
type the variable or you can click the pencil icon to open a text editor.
From the Insert Variable list, select the variable that you want to use.

For example, you can define a header such as:

Processed by [MULTIPASS_COLUMN] [CURRENT_VALUE]

When processing by Dept.Dept, this would resolve such as
Processed by Dept 22000

By default, if the current pass header is left blank, then the PDF output
will not include a header to indicate the current pass information.
However, it is possible that the template used to create the report may
have been designed with a dynamic header that will display this
information.

Sort By Optional. Specify one or more sort columns for the list of multipass
values. You can type a Table.Column name, or click the column icon to
select the column from a dialog. You can also optionally specify Asc or
Desc after the column name (ascending order is used if not specified). For
example: Dept.Dept Desc. Separate multiple values with semicolons.

By default, the values are sorted by the multipass column in ascending
order. The Sort By field only needs to be used if you want the values to be
sorted in descending order instead, or if you want the values sorted by a
different column in the same table.

The processing order is only relevant when File Generation is set to Single
Output File, since it determines the order of each individual pass within
the single file. When outputting toMultiple Output Files, the order is still
used during processing but it has no useful impact on the outcome.

Source Filter Optional. Specify a filter to limit the multipass list of items. You can type a
filter, or you can click the filter icon to use the Filter Wizard.

When the multipass list of values is generated, any value that does not
meet the source filter will be excluded from processing.

By default, all values in the specified multipass column are processed if
the source filter is left blank.

Scheduler job variables can be used in any of the multipass settings.
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10. Complete the remaining task and job settings as desired. For more information, see the Scheduler
documentation. Note the following:

l Generally speaking, the Advanced Options displayed at the top of the Web Report
Processing task should only be modified as advised by Axiom Support.

l If you want to schedule the job for execution at a later date and/or time, including setting
up recurring execution, use the Scheduling Rules section of the job.

l If you want to use Scheduler job variables in any task settings, these variables should be
defined in the Variables section of the job.

l It is recommended to review the Notification settings for the job and adjust them as
needed. By default, Scheduler jobs are configured to send an email to the user who
executed the job when the job completes, regardless of the job status.

11. On the Job tab, click Save to save the job.

12. In the Axiom Explorer dialog, select a folder location in the Scheduler Jobs Library and define a
name for the job, then click Save.

If the job settings included an active scheduling rule, this rule is evaluated when the job is saved and the
next scheduled execution is added to the Scheduler job queue.
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� Executing web report processing
Once you have set up a Scheduler job with a Web Report Processing task, you can execute the web
report processing by executing the Scheduler job. Scheduler jobs can be executed on demand by using
the Run Once feature within Scheduler, or you can schedule the job for future execution by defining and
saving a scheduling rule in the job. Scheduler jobs can also be executed on demand using RunEvent,
such as to kick off the Scheduler job from a custom task pane, Axiom form, or spreadsheet Axiom
report.

When web report processing is executed, the following occurs:
l The list of multipass values to process is obtained using the Multipass Column limited by the

Source Filter, sorted in the default or specified sort order.
l The specified report is processed once for each value in the multipass list.

o The report data query is filtered by the current pass value and the report data is refreshed.
o A PDF or Excel copy of the report is generated, depending on the specified Processing

Type.

l If the File Generation is Multiple Output Files, then the output file for each pass is saved and/or
emailed according to the task configuration.

l If the File Generation is Single Output File, then the result of each pass is saved in temporary
storage and then merged into a single file once all passes are complete. This single file is then
saved and/or emailed according to the task configuration.

Each pass of multipass processing can succeed or fail independently without affecting the other passes.
For example, imagine the multipass list has 10 items. Pass 1 fails because the specified recipient column
does not contain a valid email address, user name, or role for the pass 1 value. This pass-level failure
does not stop passes 2-10 from being processed. The job status will report partial success in this case.

A Scheduler job can contain multiple Web Report Processing tasks, followed by a File Processing task to
collect the various output files into "report books", and then save and/or deliver the collected books.
For more information, see Setting up file collect with web report processing.

� Using processing variables
The following processing variables can be used in various settings within the Web Report Processing
task, in order to dynamically change the setting using information for the current pass.
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Item Description

[CURRENT_VALUE] This variable returns the current multipass processing value. For
example, if you are processing by Dept.Dept, and the current pass is
for department 20000, the variable will be replaced by the value
"20000" for this pass.

This variable is typically used in settings such the file name, sheet
name (when generating Excel output), and folder path.

[CURRENT_PASSNUMBER] This variable returns the current pass number. For example, if the
current pass is number 20 of 35 passes, the variable will be replaced
by the value "20" for this pass.

[MULTIPASS_COLUMN] This variable returns the name of the multipass column. For example,
if you are processing by Dept.Dept, the variable will be replaced by
the value "Dept" for all passes.

This variable could be used whenever you want to reference the
name of the dimension processed. For example, instead of just
referencing the current value in the file name, you might want to
reference the column name and the value. A variable construction
like [MULTIPASS_COLUMN] [CURRENT_VALUE] would resolve to
"Dept 20000" when processing by Dept.Dept and the current pass is
for department 20000.

Processing variables can only be used in certain settings, and sometimes only when the output is
multiple files (versus a single file). See the documentation for each individual setting to see if processing
variables are supported in that setting.

NOTE: Processing variables and Scheduler variables use different syntax. Processing variables are
enclosed in square brackets. Scheduler job variables are enclosed in curly brackets.

� Using Scheduler job variables in task settings
Scheduler job variables can be used in any Web Report Processing task setting that you can directly type
into, such as the file name, sheet name, folder path, and various email settings. To use a Scheduler job
variable, you first define the variable on the Variables tab of the job, then you enter the variable in the
desired setting using curly brackets. For example, if the variable name as defined on the Variables tab is
columnname, then enter {columnname} in the task setting. When the job is executed, the variable in
curly brackets will be replaced by the current value of the variable.

Scheduler job variables are useful when you want a task setting to change dynamically based on a
variable value that gets passed to the Scheduler job. Various processes in Axiom Budgeting and
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Performance Reporting can trigger a Scheduler job for execution and pass variable values to the job.
Additionally, previous tasks in the job can set a variable value that is then passed to subsequent tasks in
the job.

NOTE: Processing variables and Scheduler variables use different syntax. Processing variables are
enclosed in square brackets. Scheduler job variables are enclosed in curly brackets.

� Using Scheduler job variables to pass refresh variable values
If the web report uses refresh variables, Scheduler job variables can be used to pass variables to these
variables. For example, in some cases the report may require certain refresh variables to be set before
data can be queried. In this case, the Scheduler job must pass values for these required refresh
variables. The refresh variables will be used to refresh data for each pass, in addition to the multipass
filter for the current pass.

In order to pass a Scheduler job variable value to the report as a refresh variable value, special syntax is
used for the job variable:

ReportVariable.VariableID

Where ReportVariable is a dedicated keyword that tells processing to apply the variable as a
report parameter, and VariableID is the name of the specific report parameter.

For example, the report may contain a refresh variable that specifies the grouping level (row dimension)
of the report. This refresh variable takes values such as Dept, WorldRegion, Country, and so on.

Example refresh variable

In this example, the ID of this refresh variable is groupingColumnVar. Therefore to pass a value to this
refresh variable, a Scheduler job variable named ReportVariable.groupingColumnVar can be
used. This variable must be assigned a value that exactly corresponds to a value that can be selected for
the refresh variable within the Refresh Variables panel.
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When this report is processed, the value for this refresh variable will be set to Region.

NOTES:
l The processing variable [Current_Value] can be used as the variable value, if it will resolve

to a valid value for the refresh variable. In this case, the value of the variable will change
dynamically for each pass.

l Because the variable IDs are not exposed on the report, this feature is primarily useful for
product developers to deliver a pre-configured Scheduler job with a product.

Setting up file collect with web report processing

You can combine web report processing with the File Collect feature to create and deliver "report
books". For example, you may have three different reports that you want to process by region, then you
want to collect the output into region-specific report books to deliver to each regional manager.

This process works as follows:
l You set up multiple Web Report Processing tasks in Scheduler to process the web reports and

save the output to a designated location. The output can be PDF or Excel.
l You set up File Collect in a separate spreadsheet utility to collect the output from the Web Report

Processing tasks. This configuration specifies:
o The type of files to collect, PDF or Excel.
o The source folder(s) from which to gather the files to collect.
o The file filter to specify the files to collect.
o The file name of the output file, and the file type if applicable—PDF files can only be

collected as PDF, but Excel files can be collected as either PDF or Excel.
o The delivery method of the output file—save only, email only, or save and email—as well

as the output folder and email settings (as applicable).
o Optional common files to include in each output file, such as a cover page.
o Optional multipass column to perform the file collect operation iteratively over a

dimension

l You set up a File Processing task in Scheduler and configure it to run the File Collect report utility.
Typically all of the tasks would be in a single Scheduler job, so that the Web Report Processing
tasks are run first, then the File Processing task runs afterward to perform the final collect
operation.
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File Collect is an option of File Processing. It can be used to collect any PDF or Excel files, regardless of
how they are generated. For more information on how to configure file collect, see the File Collect
documentation.

The following example shows a Scheduler job with three Web Report Processing tasks and one File
Processing task. The three Web Report Processing tasks are used to process three different web reports
by region and then save the output files to a designated folder in the Axiom Budgeting and Performance
Reporting repository.

Example Scheduler job with multiple Web Report Processing tasks

The File Processing task is used to run the File Collect report utility once all of the Web Report
Processing tasks are completed. Note that the File Processing task simply points to the spreadsheet
report that contains the File Collect configuration; the settings are not defined within the Scheduler job.
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Example Scheduler job with File Processing task to run the File Collect operation

The following screenshot shows an example of how the File Collect settings could be configured within
the spreadsheet report. The File Collect operation will be performed using multipass processing by
region. The file filter will collect all files in the source folder location based on the current pass region
name, then save and email the output file. The email address and file name settings use a formula with
a GetCurrentValue function in order to dynamically set the email address and file name for each pass.
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Example File Collect configuration to collect the PDF output into a PDF report book
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Budgeting reports
Axiom Budgeting and Performance Reporting 2022.3 comes with a variety of standard budget reports,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Budgeting Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Analysis
reports.

Report Description

Budget Account Analysis Use to analyze the proposed budget compared to last year
actual, current year budget, and current year projected for
an individual account by department. Comments entered
into the budget plan files also show on the report to assist
with the analysis.

Budget FTE Comparison Use to analyze the proposed budget for FTE compared to
last year actual, current year budget, year-to-date actual,
and current year projected by department.

Budget Key Statistics By Department Use to view highlighted key statistic trends across multiple
fiscal years.

Budget Per Unit Analysis Use to analyze per-unit amounts by comparing the current
year projection to next year’s budget for Patient Revenue,
Salaries, Supplies, and Other Expenses.

Budget Plan Questions Use to report on inputs from the Plan tab in plan files.

4
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Report Description

Budget Red Flag Analysis Use to review the comments and explanations for
accounts flagged in the budget plan files because they
exceeded the defined red-flag threshold. The report shows
year-to-date actual and current year projection compared
to the proposed budget request. The report also includes
fields for the adjustments and comments posted from the
budget workbook for each account.

Budget Salary Comparison Use to analyze salary variances for the proposed budget
compared to the current year projection. The report also
includes prior year and current year actual history to use
for comparison.

Budget Salary Rate Analysis Use to analyze departmental average hourly-rate
variances in the proposed budget. The report shows prior
year and current year actual history and projection
compared to the new budget. The variance is broken out
into two different categories—FTE and Rate Effect.

Budget Summary by Department Use to analyze total-expense variances by department,
comparing the proposed budget to the current-year
projection. The report shows prior-year actual, current-
year actual, and current-year budget history.

Budget Threshold Analysis Use to analyze account categories by applying a low and
high threshold for variances. Historical data for last-year
actual and current-year budget are also included.

Budget Workbook Changes for CYB
and NYB

Use to view highlighted areas where users made inputs in
the yellow cells in budget plan files.

� Budgeting Statement reports
The following reports are designed for budget analysis. For examples of these reports, see Statement
reports.

Report Description

Budget Income Detail Use to analyze the proposed budget-by-income statement
category compared to last-year actual, current-year
budget, current-year projected, year-to-date actual, and
current-year annualized. Each category shows all values
for all accounts in that category.

Budget Income Financial Plan Use to view annuals income statement comparisons
across multiple scenarios.
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Report Description

Budget Income Scenarios Use to analyze the proposed budget by FSDetail category
compared to the Baseline Budget, NYBScenario1, and
NYBScenario2. BudScenario1 and BudScenario2 are fields
in the database used to store the results of different sets
of driver files. You can use this report to compare passes
of the budget (BudPass1, BudPass2).

Budget Income Summary Use to summarize the proposed budget by FSDetail
category compared to last-year actual, current-year
budget, current-year annualized, and current-year
projected.

Budget Monthly Dept P&L Use to review the monthly spread by account for the
proposed budget by Budget Type category for an
individual department. This report is often used to provide
the department manager with a final copy of their month-
by-month budget.

� Initiative Analysis reports
The following reports are designed for budget analysis of new initiatives. For examples of these reports,
see Initiative Analysis reports.

Report Description

Budget Income Summary-Initiative Use to review new initiatives by Income Statement
category.

Budget Income Summary-Initiative
Monthly

Use to review new initiatives by Income Statement
category by month.

Income Statement by Initiative ID Use to review new initiatives side-by-side for multiple
initiatives.

Initiative Summary Use to review new initiatives by department by category,
with monthly FTEs.

� Payroll Analysis reports
The following reports are designed for payroll budget analysis. For examples of these reports, see
Payroll Analysis reports.
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Report Description

FTE Additions and Changes by
JobCode

Use to review the FTE summary by department by
JobCode, highlighting changes made to the projected year
and budget in the plan files.

FTEs by Department Use to review the FTE summary by department, including
prior-year actual, current-year budget, and year-to-date
actual. The proposed budget is compared to year-to-date
actual as well as the current-year budget.

FTEs by Department by JobCode Use to review FTE report by department by job code,
including prior-year actual, current-year budget, and year-
to-date actual. The proposed budget is compared to year-
to-date actual as well as the current-year budget.

FTEs by JobCode Use to review the FTE report by job code, including prior-
year actual, current-year budget, and year-to-date actual.
The proposed budget is compared to year-to-date actual
as well as the current-year budget.

Monthly FICA by Department Use to show monthly total FICA expense by department
for both current-year projected and next-year budget.
Monthly expense shows for next-year budget. Designed
for use by clients who budget FICA in a central department
or to review the overall monthly spread of FICA expense.

Monthly FTE Target Variance by
Department

Use to review a department summary of the FTE variance
by month for next year’s budget to the department target.

Monthly FTEs by Department Use to review a department summary of total FTEs by
month for next year’s budget. Designed to be used to
review the monthly spread of total FTEs as well as by
department.

NYB Hours and Dollars by Employee Use to review hours and dollars by employee, job code,
paytype, and department. To use this report, the
department must use the employee labor option in plan
files.

Worked Hours Per Unit by
Department by JobCode

Use to compare the projected and NY Budget by Provider
to the current year by selected DataType.

� Provider Budget Analysis reports (optional feature)
The following reports are designed for physician analysis. For examples of these reports, see Provider
Analysis reports.
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NOTE: You can also find these same reports in the Financial Reporting section > Financial Reporting
> Provider Analysis.

Report Description

Current Period vs Previous
Comparison

Use to compare current period vs previous period
information by provider as well as last year actual. You can
select the data type to analyze in the report.

Current Period vs Previous
Comparison_CPT

Use to compare current period vs previous period
information by CPT or CPT Summary category and last year
actual. You can select the data type to analyze in the
report.

CY Actual vs Budget Comparison Use to compare current period and year-to-date actual vs
budget information by provider and last year actual. You
can select the data type to analyze in the report.

CY Actual vs Budget Comparison_CPT Use to compare current period and year-to-date actual vs
budget information by CPT or CPT Summary code and last
year actual. You can select the data type to analyze in the
report.

NY Budget Comparison Use to compare current year projections with next year's
budget.

NY Budget Comparison_CPT Use to compare current year projections with next year's
budget by CPT or CPT Summary category.

Provider Key Indicators By Month Use to compare month-by-month values for last year,
current year, and target by data type.

Provider Key Indicators By Month_
Rolling 12

Use to compare month-by-month values for the most
recent 12 months by data type.

Provider Revenue Per Encounter Use to compare the current month to the prior three-
month average for different years for revenue per
encounter.

Provider Revenue Per RVU Use to compare the current month to the prior three-
month average for different years for revenue per RVU.

Provider Revenue Per WRVU Use to compare the current month to the prior three-
month average for different years for revenue per WRVU.

Provider Volume by Specialty Use to compare actual vs budget volume by data type for
the current period and year-to-date, subtotaled by
provider specialty.
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Report Description

Provider Volume by Specialty_
Monthly

Use to show monthly totals by provider, for a chosen data
type and year, subtotaled by provider specialty.

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.

Provider Compensation Comparison Use to compare the calculated budget salary under each
of the available compensation methods, by provider, to
evaluate the cost of moving providers to another model or
standardizing the compensation model. There is also a
comparison of the current year vs proposed budget salary
cost per work RVU to test if the compensation is changing
+\- the Hold Harmless percentage.

� Provider Budget Compensation reports (optional feature)
The following reports are designed for payroll/provider budget analysis. For examples of these reports,
see .

Report Description

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.

Provider Compensation Comparison Use to compare the calculated budget salary under each
of the available compensation methods, by provider, to
evaluate the cost of moving providers to another model or
standardizing the compensation model.

Analysis reports
These reports are designed for budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Budget
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Budget Analysis.
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� Budget Income Detail
Use to analyze the proposed budget compared to last year actual, current year budget, and current year
projected for an individual account by department. Comments entered into the budget plan files also
show on the report to assist with the analysis.

� Budget FTE Comparison
Use to analyze the proposed budget for FTE compared to last year actual, current year budget, year-to-
date actual, and current year projected by department.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 271



� Budget Key Statistics By Department
Use to view highlighted key statistic trends across multiple fiscal years.

� Budget Per Unit Analysis
Use to analyze per-unit amounts by comparing the current year projection to next year’s budget for
Patient Revenue, Salaries, Supplies, and Other Expenses.
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� Budget Plan Questions
Use to report on inputs from the Plan tab in plan files.

� Budget Red Flag Analysis
Use to review the comments and explanations for accounts flagged in the budget plan files because they
exceeded the defined red-flag threshold. The report shows year-to-date actual and current year
projection compared to the proposed budget request. The report also includes fields for the
adjustments and comments posted from the budget workbook for each account.

� Budget Salary Comparison
Use to analyze salary variances for the proposed budget compared to the current year projection. The
report also includes prior year and current year actual history to use for comparison.
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� Budget Salary Rate Analysis
Use to analyze departmental average hourly-rate variances in the proposed budget. The report shows
prior year and current year actual history and projection compared to the new budget. The variance is
broken out into two different categories—FTE and Rate Effect.

� Budget Summary by Department
Use to analyze total-expense variances by department, comparing the proposed budget to the current-
year projection. The report shows prior-year actual, current-year actual, and current-year budget
history.
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� Budget Threshold Analysis
Use to analyze account categories by applying a low and high threshold for variances. Historical data for
last-year actual and current-year budget are also included.

� Budget Workbook Changes for CYB and NYB
Use to view highlighted areas where users made inputs in the yellow cells in budget plan files.
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Statement reports
These reports are designed for budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Budget
Statements. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Budget Statements.
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� Budget Income Detail
Use to analyze the proposed budget-by-income statement category compared to last-year actual,
current-year budget, current-year projected, year-to-date actual, and current-year annualized. Each
category shows all values for all accounts in that category.

� Budget Income Financial Plan
Use to view annuals income statement comparisons across multiple scenarios.

� Budget Income Scenarios
Use to analyze the proposed budget by FSDetail category compared to the Baseline Budget,
NYBScenario1, and NYBScenario2. BudScenario1 and BudScenario2 are fields in the database used to
store the results of different sets of driver files. You can use this report to compare passes of the budget
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(BudPass1, BudPass2).

� Budget Income Summary
Use to summarize the proposed budget by FSDetail category compared to last-year actual, current-year
budget, current-year annualized, and current-year projected.

� Budget Monthly Dept P&L
Use to review the monthly spread by account for the proposed budget by Budget Type category for an
individual department. This report is often used to provide the department manager with a final copy of
their month-by-month budget.
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Initiative Analysis reports
These reports are designed for budget analysis of new initiatives.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Initiatives
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Initiatives Analysis.

� Budget Income Summary - Initiative
Use to review new initiatives by Income Statement category.
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� Budget Income Summary - Initiative Monthly
Use to review new initiatives by Income Statement category by month.
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� Income Statement by Initiative ID
Use to review new initiatives side-by-side for multiple initiatives.
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� Initiative Summary
Use to review new initiatives by department by category, with monthly FTEs.

Payroll Analysis reports
These reports are designed for payroll budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Payroll
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Payroll Analysis.
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� FTE Additions and Changes by Jobcode
Use to review the FTE summary by department by JobCode, highlighting changes made to the projected
year and budget in the plan files.

� FTEs by Department
Use to review the FTE summary by department, including prior-year actual, current-year budget, and
year-to-date actual. The proposed budget is compared to year-to-date actual as well as the current-year
budget.
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� FTEs by Department by Jobcode
Use to review FTE report by department by job code, including prior-year actual, current-year budget,
and year-to-date actual. The proposed budget is compared to year-to-date actual as well as the current-
year budget.

� FTEs by Jobcode
Use to review the FTE report by job code, including prior-year actual, current-year budget, and year-to-
date actual. The proposed budget is compared to year-to-date actual as well as the current-year budget.

� Monthly FICA by Department
Use to show monthly total FICA expense by department for both current-year projected and next-year
budget. Monthly expense shows for next-year budget. Designed for use by clients who budget FICA in a
central department or to review the overall monthly spread of FICA expense.
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� Monthly FTE Target Variance by Department
Use to review a department summary of the FTE variance by month for next year’s budget to the
department target.

� Monthly FTEs by Department
Use to review a department summary of total FTEs by month for next year’s budget. Designed to be
used to review the monthly spread of total FTEs as well as by department.
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� NYB Hours and Dollars by Employee
Use to review hours and dollars by employee, job code, pay type, and department. To use this report,
the department must use the employee labor option in plan files.

� Worked Hours Per Unit By Department by Jobcode
Use to compare the projected and NY Budget by Provider to the current year by selected DataType.
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Provider Analysis reports
These reports are designed for provider budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Provider
Budgeting\Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Provider Budget > Analysis.

� NY Budget Comparison
Use to compare the projected and NY budget by provider to the current year by selected data type.
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� NY Budget Comparison_CPT
Use to compare the projected and NY budget by CPT Code to the current year by selected data type.

Running Provider Budget Compensation reports
These reports are designed for payroll/provider budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Provider
Budget\Compensation.For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Provider Budget > Compensation.
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� Provider Compensation Benchmark
Use to compare the proposed budget salary to a salary target for each provider. The target is factored
for the budget FTE.
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� Provider Compensation Comparison
Use to compare the calculated budget salary under each of the available compensation methods, by
provider, to evaluate the cost of moving providers to another model or standardizing the compensation
model. There is also a comparison of the current year vs proposed budget salary cost per work RVU to
test if the compensation is changing +\- the Hold Harmless percentage.
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Budgeting Utilities
Axiom Budgeting and Performance Reporting 2022.3 comes with a variety of standard budget utilites,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Balance Sheet and Deductions
The following utilities are designed for budget balance sheet calculation and deductions modeling to
post the results to the database. For examples of these reports, see Balance Sheet and Deductions
utilities.

Report Description

Budget Balance Sheet and Cash Flow Use this save-to-database report to project the balance
sheet for the remainder of the current year and next
year’s budget by category.

Budget Deductions All statistics, revenues and deductions are broken out by
payer. You can make assumptions for the projection and
budget in each payer section.

NYB_Deductions_FSDetail Use this deductions model to project deductions using the
historical relationship to gross revenue for each deduction
category.

NYB_Deductions_FSPayor Use this deductions model to project deductions using the
historical relationship to gross revenue by payer.

� Budget Reconciliation utilities
The following utilities are designed for budget balance sheet calculation and deductions modeling to
post the results to the database. For examples of these reports, see Reconciliation utilities.

5
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Report Description

Budget Department Audit Report Use to resolve possible mapping errors at the department
level by highlighting mapping and process management
inconsistencies in the DEPT dimension table before
building plan files and starting process management.

Budget Process Management Report Use to show what stage each budget plan file is in when
using process management for budget staging.

Budget Workbook Reconciliation Use to compare check totals from different columns in the
budget workbooks to the summary fields in the database
to make sure they are in balance. If the budgets are all in
balance, then this report returns no data, which is the
desired outcome of this report.

Global Depreciation Reconciliation
Report

Use to show the variance between the budgeted
depreciation accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Global Expense Reconciliation Report Use to show the variance between the budgeted
depreciation accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Global Revenue Reconciliation Report Use to show the variance between the budgeted global
revenue accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Labor Non-Matched Use to identify the JobCode/PayType combinations that
have dollars but have no FTE hours for the year.

New Department Utility Use to create default records for a new department. You
can save records to the Financial, Payroll, Provider, or
RevUsage tables.

Payroll12 Hours Reconciliation Use to highlight job codes saved in the Payroll12 data
source from the budget workbooks that have hours but no
dollars in the budget.

Payroll12 Negative Hours Use to highlight job codes and pay types that have any
negative FTEs budgeted in any month. The report returns
all job codes in the database, but only the ones with the
Review flag need to be investigated and changed, if
necessary.

PayType Mapping Analysis Use during budget set up for payroll budgeting to show
what PayTypes map to which payroll budget category.
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Report Description

Reconcile NYBDetail to Financial Reconcile values saved in NYBDetail table to those values
saved in the Budget Table which could indicate that values
in your budget plan files are not saving properly.

Reconcile Payroll12 to Financial-
Dollars

Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.

Reconcile Payroll12 to Financial-FICA Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.

Reconcile Payroll12 to Financial-
Hours

Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.

Salaries Do Not Match Use to identify accounts on the Labors tabs in the plan
files that do not have history on the Expense tab and
would cause a balancing mismatch.

� Budget Setup utilities
The following utility is designed to help set up security. For examples of these reports, see Setup
utilities.

Report Description

PayrollGLMapping To allow mapping of GL accounts and Hours accounts
different from the Jobcode dimensions table or Paytype
dimensions table as a result of various combinations to
match GL accounts.

� Budget Extract from EPM utilities
The following utility is designed to extract budget data from the Axiom database. For examples of this
reports, see Extract from EPM utilities.

Report Description

PayrollGLMapping To allow mapping of GL accounts and Hours accounts
different from the Jobcode Dimensions Table or Paytype
Dimensions Table as a result of various combinations to
match GL accounts.

� Budget Provider Utilities - Reconciliation utilities
These utilities are designed to reconcile data to support physician analysis. For examples of these
reports, see Provider Reconciliation utilities.
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Report Description

Matching Provider Dept Revenue to
Dept Salaries

Use to determine if there are situations where the
provider revenue and salaries do not match by
department.

Matching Provider Revenue to
Salaries

Use to check the net difference between revenue and
salaries by provider.

ProviderComp JobCodes Use to compare the coding in global assumptions to the
information in the Payroll27 tables before creating budget
plan files.

Reconcile GL Revenue to Provider Use to reconcile the gross charges in the Financial data
source to the gross charges in the Provider data source for
both the current period as well as year-to-date.

Review Provider Data Use to identify situations where there is revenue without
matching volume in the historical data that is used for
projection and budget purposes.

� Budget Provider – Statistics utilities (optional feature)
This utility is designed to reconcile data to support physician analysis. For examples of this reports, see
Provider Statistics utilities.

Report Description

Summarize Provider Statistics to
Financial

Use this save-to-database report to summarize provider
data into monthly statistics to be used in Financial data
tables and reports.

� Budget Provider – System Setup utilities
This utility is designed to reconcile data to support physician analysis. For examples of this reports, see
Provider System Setup utilities.

Report Description

ProvBenchmark This table may be used for reports to compare provider
compensation to benchmarks.

� Budget Report Batch utilities
This utility is designed to run multiple reports together. For examples of this report, see Report Batch
utilities.
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Report Description

Budget Reconciliation Reports Batch Use to run multiple budget reconciliation reports for
distribution.

� Budget Security utilities
This utility is designed to run multiple reports together. For examples of this report, see Security utilities.

Report Description

Budget Driver Security Update Use to update the Driver security settings and filters for
Admin users who have access to update Driver files.

Budget Security Update Use to update security settings and filters for all users.

Balance Sheet and Deductions utilities
These reports are designed for budget balance sheet calculation and deductions modeling to post the
results to the database.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Balance
Sheet & Deductions. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, and click
Budget Utilities > Balance Sheet & Deductions.
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� Budget Balance Sheet and Cash Flow
Use this save-to-database report to project the balance sheet for the remainder of the current year and
next year’s budget, by category.

The Budget Balance Sheet and Cash Flow utility allows you to project the remainder of the current year
and next year budget balance sheet and cash flow numbers. This utility integrates with the budgeted
income statement numbers and allows for frequent updates to the budgeted balance sheet and cash
flow numbers, if the income statement is updated. The utility’s results save back to the database and
then become available in the budget data tables and reports for budget analysis.

Running the Budget Balance Sheet and Cash Flow utility
1. Open the report.

2. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes or No to
determine whether to add net income to the fund balance.

l To select the default departments, where you would like the budget balance sheet
numbers to be saved back to, click Choose Value, and select a department.

l In the Create a Save Tag Value box, type a save tag (max of 100 characters). This save tag
ensures that the data saving back to the database is saved with a save tag that is unique to
a specific entity/group that you may want to filter this report for. It also avoids having to
create multiple Balance Sheet reports for different entities/groups.

3. After the report populates, do the following:
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l At the top of the spreadsheet, make sure that the data in the Net Income row matches the
balance sheet to be prepared.

l Verify historical information for Two Years Ago, Last Year, and Current YTD all balance.

l In the header section, review to the Balance Check row to confirm that the model is in
balance.

TIP: If the model appears to be out of balance, we recommend that you refresh the report
and verify that the Add Net Income to Fund Balance setting was configured properly per your
organization’s accounting practice.

4. In column AD, in the blue input cells, enter the default accounts numbers that you would like the
balance sheet numbers to save back to. For example, you may choose to save back the numbers
for Board Designated Investments and Other Assets to the same default asset account OR you
may choose to use accounts specific to each of these categories.

5. Complete the following sections of the utility, as needed:
l Balance Sheet Assumptions – Use this section to enter key balance sheet metrics to

calculate various balance sheet numbers. Values for balance sheet categories can be
adjusted or keyed in directly in the detailed schedules / inputs section.

l Assets
l Liabilities and Net Assets
l Detailed Schedules - Use this section to input detailed schedules for each category.
l Statement and Cash Flows

TIP: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and
not 56.

NOTE: The Budget Balance Sheet utility is configured to always stay in balance. As a result,
inputs/adjustments to Balance Sheet metrics will result in the out of balance difference being
plugged to either the other assets/other liabilities section.

6. To save your changes to the database, in theMain ribbon tab, click Save.
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The Summary tab of the Budget Balance Sheet utility will populate with next year’s budgeted balance
sheet and cash flow numbers by month for budget analysis purposes.

� Budget Deductions
This is a deductions modeling tool that is similar to the deductions modeling in Syntellis Financial
Planning. All statistics, revenues and deductions are broken out by payer. You can make assumptions for
the projection and budget in each payer section. The resulting calculated values post to the database.
When using this model, do not create budget workbooks for your deduction department(s).

GL Accounts are summarized by balance sheet categories, and the resulting summary data can be
posted back to the database for both the Current Year Projection and Next Year Budget as well as
inclusion in all related Budget Analysis reports. If necessary, values for balance sheet categories can be
adjusted or keyed in directly.

As budgets and assumptions change, simply refresh data in the Budget Balance Sheet to update and
post newly computed balance sheet information for calculating metrics driven by income statement
parameters (assuming the balance sheet assumptions remain unchanged).

The Budget Balance Sheet report assigns GL accounts to balance sheet categories per the FSSummary,
FSDetail, and FPCode grouping columns in the ACCT dimension table.

The Balance Sheet and Cash Flow Report includes the following sections:

l Balance Sheet Assumptions – Key metrics used to drive various balance sheet calculations. Valid
entries are listed in the Balance Sheet Assumptions Inputs section.

l Assets
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l Liabilities and Net Assets
l Detailed Schedules – Contains rows to input detailed schedules for each category.
l Statement of Cash Flows
l Summary Income Statement

You can filter the report by Entity or group, as defined in dimensions by using the Quick Filter option in
the Main ribbon tab. You may make adjustments to the values in any blue cells in the report. After
making your changes, review the cash flow statement to make sure it balances to total cash and make
sure the summaries match your expectations on the summary tab.

To run the Budget Sheet and Cash Flow report:
1. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes or No to
determine whether to add net income to the fund balance.

l To select the default departments to include in the report, click Choose Value, select a
department, and click OK.

2. Add or enter information in the blue cell, as appropriate.

3. After the report populates, verify the following:
l At the top of the spreadsheet, make sure that the data in the Net Income row matches the

balance sheet to be prepared.
l Historical information for Two Years Ago, Last Year, and Current YTD all balance.
l In the header section, review to the Balance Check row to confirm that the model is in

balance.

NOTE: If the model appears to be out of balance, you might want to refresh the report
and verify that the Add Net Income to Fund Balance setting was configured properly
per your organization’s accounting practice

4. To save your changes back to the database, in theMain ribbon tab, click Save.

Balance Sheet assumption inputs

NOTE: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and not
56.
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Asset inputs (All inputs should be in whole dollars)

Cash and cash
equivalents

Computed through days of
operating cash

Short-term cash
investments

Input Schedule

Current assets limited as
to use

Input Schedule

Patient Accounts
Receivable

Computed from Gross A\R days in
gross patient receivables

Configurable sections are
netted from the total
calculation on the first row.

Physician Accounts
Receivable

Input Schedule

Allowance for
Uncollectibles

Calculated from Net A\R Days less
Gross receivables

Configurable sections are
netted from the total
calculation on the first row

Third Party Settlements Computed from 3rd Party days in
Net Patient Receivables

Configurable sections are
netted from the total
calculation on the first row.

Current Receivables Input Schedule

Supply Inventories, at
cost

Computed from Days in Supply
inventories

Configurable sections are
netted from the total
calculation on the first row.

Driven by total supplies
expense from the income
statement

Prepaid Expenses Computed from Days in Prepaid
Expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Current Assets Input Schedule

Assets Limited as to use
– Trusteed Assets

Input Schedule

Assets Limited as to use
– Board Designated
Investments

Computed
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PPE – Land Input Schedule Net Capital Acquisitions

Revaluation amount

PPE – Property and
Equipment

Input Schedule Net Capital Acquisitions

+\- Revaluation amount

PPE – Accumulated
Depreciation

Input Schedule Depreciation Expense –
Automatic flow from Income
Statement

+\- Disposals

PPE – Construction in
Progress

Net Capital Acquisitions +\- Revaluation amount

Unamortized Financing
Fees

Input Schedule

Amortization of existing
fees

Input Schedule

Investment in
subsidiaries

Input Schedule

Notes Receivable Input Schedule

Other Long-Term Assets Input Schedule Liability Inputs (All inputs
should be in whole dollars)

Line of credit Calculated

Current maturity of long-
term debt

Input Schedule Est. current portion of long-
term debt

Adj of current portion of long-
term debt

Accounts Payable Computed from A\P days in other
expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Accrued Payroll Computed from Acc Payroll days in
salary expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement
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Accrued Expenses Computed from Accrued Exp days
in other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Third Party Settlements Computed from 3rd party days in
other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Accrued Liabilities Input Schedule

Other Long Term
Liabilities 1

Input Schedule

Other Long Term
Liabilities 2

Input Schedule

Long-Term Debt Input Schedule Net new loans

Regular principal payments

Equity inputs (All inputs should be in thousands)

Fund Balance Input Schedule Net Income – Computed and
included in projection if
Instructions tab diaplsy Yes to
include in Fund Balance. Net
Income is automatically added
to fund balance for budget.

Temporarily restricted
net assets

Input Schedule

Permanently restricted
net assets

Input Schedule

� NYB_Deductions_FSDetail
Use this deductions model to project deductions using the historical relationship to gross revenue for
each deduction category. This report summarizes categories using the Acct-FSDetail column in
dimensions. The resulting calculated values posts to the database. If you are using this model, do not
create budget workbooks for your deduction department(s).
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� NYB_Deductions_FSPayor
Use this deductions model to project deductions using the historical relationship to gross revenue by
payer. This report summarizes categories using the Acct-FSPayor column in dimensions. The resulting
calculated values post to the database. If you are using this model, do not create budget workbooks for
your deduction department(s).
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Reconciliation utilities
These utilities are designed for budget reconciliation to the database.

� Accessing these reports
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Budget
Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Budget Reconciliation.

� Budget Department Audit report
Use to resolve possible mapping errors at the department level by highlighting mapping and process
management inconsistencies in the DEPT dimension table before building plan files and starting process
management.
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� Budget Process Management report
Use to show what stage each budget plan file is in when using process management for budget staging.

� Budget Workbook Reconciliation
Use to compare check totals from different columns in the budget workbooks to the summary fields in
the database to make sure they are in balance. If the budgets are all in balance, then this report returns
no data, which is the desired outcome of this report.
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� Global Depreciation Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Global Expense Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.
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� Global Revenue Reconciliation report
Use to show the variance between the budgeted global revenue accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Labor Non-Matched
Use to identify the JobCode/PayType combinations that have dollars but have no FTE hours for the year.
This causes a matching issue because to create a JobCode block on the labor tabs, that JobCode needs to
have YTD FTE related hours. This report identifies those mismatches and posts a 1 to the NYBKHA field
so that the JobCode interfaces into that labor tab.
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� Payroll12 Hours Reconciliation
Use to highlight job codes saved in the Payroll12 data source from the budget workbooks that have
hours but no dollars in the budget.
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� Payroll12 Negative Hours
Use to highlight job codes and pay types that have any negative FTEs budgeted in any month. The report
returns all job codes in the database, but only the ones with the Review flag need to be investigated and
changed, if necessary.

� PayType Mapping Analysis
Use during budget set up for payroll budgeting to show what PayTypes map to which payroll budget
category.

NOTE: Prior to reviewing the report, your organization needs to load and reconcile the payroll data
as well as complete the Labor Configuration driver. To understand this report, the user needs to
have knowledge of the Labor Configuration Driver.

Running the PayType Mapping Analysis report
Use the following instructions to run and review the report.
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1. Open the report.

2. Press F9, and select the proper Refresh Variables to review based on organizational needs.

3. Review the following in the report:
l In the top section of the report, which provides an overall summary, ensure that all the pay

types are loaded and map to a specific grouping. The variance should be zero. If not,
review your PAYTYPE dimension table to see what pay type is not mapped.

l The remaining sections of the report correspond to the Labor Configuration driver set up
and how the pay types are grouped/mapped in the PAYTYPE dimension table. These
sections give you an overall summary of what pay types are grouped together, the overall
hours and dollars, the FTE status, as well as the GL accounts if the GL is structured by pay
type.

l Review the overall groupings to make sure they are grouped as expected. The bottom
section shows what is not interfaced or coming into the plan files. Confirm that these are
accurate prior to beginning the budget cycle. If you need to make changes, update the
PAYTYPE dimension table and rerun the report to review.

� Reconcile NYBDetail to Financial
Reconcile values saved in NYBDetail table to those values saved in the Budget Table which could indicate
that values in your budget plan files are not saving properly.

� Reconcile Payroll12 to Financial-Dollars
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Reconcile Payroll12 to Financial-FICA
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the FICA dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Reconcile Payroll12 to Financial-Hours
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the hours saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Salaries Do Not Match
Use to identify accounts on the Labors tabs in the plan files that do not have history on the Expense tab
and would cause a balancing mismatch. This utility posts a 1 to the NYBKHA fields so those accounts
interface in the plan files.
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Setup utilities
These reports are designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Budget Set
Up. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Budget Setup.
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� PayrollGLMapping
To allow mapping of GL accounts and Hours accounts different from the Jobcode Dimensions Table or
Paytype Dimensions Table as a result of various combinations to match GL accounts.

Extract from EPM utilities
These reports are designed to extract budget data from the Axiom database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Extract
from EPM. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Extract from EPM.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 315

../../../../../../Content/Reports/Browsing the Report Library.htm


� Budget Extract Utility
Use to extract budget data from Axiom EPM to upload into GL systems such as Meditech, for example.

Provider Reconciliation utilities
These reports are designed Designed to reconcile data to support physician analysis.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > Reconciliation.
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� Matching Provider Dept Revenue to Dept Salaries
Use to determine if there are situations where the provider revenue and salaries do not match by
department.

� Matching Provider Revenue to Salaries
Use to check the net difference between revenue and salaries by provider.
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� ProviderComp JobCodes
Use to compare the coding in global assumptions to the information in the Payroll27 tables before
creating budget plan files.
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� Reconcile GL Revenue to Provider
Use to reconcile the gross charges in the Financial data source to the gross charges in the Provider data
source for both the current period as well as year-to-date.

� Review Provider Data
Use to identify situations where there is revenue without matching volume in the historical data that is
used for projection and budget purposes.
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Provider Statistics utilities
These reports are designed to reconcile data to support physician analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\Statistics. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > Statistics.
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� Summarize Provider Statistics to Financial
Use this save-to-database report to summarize provider data into monthly statistics to be used in
Financial data tables and reports.

Provider System Setup utilities
This report is designed to reconcile data to support physician analysis.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\System Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > System Setup.
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� ProvBenchmark
This table may be used for reports to compare provider compensation to benchmarks.

Report Batch utilities
These utilities are designed for budget reconciliation to the database.

� Accessing these reports
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Report
Batches. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Report Batches.
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� Budget Reconciliation Reports Batch
Use to run multiple budget reconciliation reports for distribution.

Security utilities
These reports are designed for budget balance sheet calculation and deductions modeling to post the
results to the database.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Security.
For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Security.
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� Budget Driver Security Update
Use to update the Driver security settings and filters for Admin users who have access to update driver
files.

� Budget Security Update
Use to update security settings and filters for all users.
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Financial Reports
Axiom Budgeting and Performance Reporting 2022.3 comes with a variety of standard financial reports,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Financial Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Analysis
reports.

Report Description

Account Analysis Use to analyze the current month- and year-to-date
variances for an individual account by department.

Current Year Actual (CYA) Per Unit
Analysis

Use to analyze year-to-date (current) per-unit amounts for
Patient Revenue, Salaries, Supplies, and Other Expenses
compared to current-year budget (Budget).

Expense Summary by Department Use to analyze expense variances by department.

Key Dept Ratios Use to analyze current month and year-to-date salary
variances for an individual department. The salary
variance is broken into categories for Price, Volume, and
Efficiency. A summary section is also provided to show the
components of the total variance.

Labor Price, Volume, & Efficiency
Variances

Use to quickly analyze salaries to determine if the
variances are related to rate or volume.

Labor Summary by Department Use to analyze labor variances by department.

6
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Report Description

MultiYear Statistic Review Use to show key and non-key statistical accounts for the
current-year actual and budget, prior year, and two years
ago. You can run this report for a single department or
combined for multiple departments. If is often used to
confirm that the statistical basis across different years is
consistent.

Threshold Analysis Use to analyze current month values compared to the
average of the previous three month. You can enter a
dollar threshold. After the report is populated, you can
change the view to only show the departments that
exceed the threshold. The purpose of this report is to
show unusual activity or possible missing entries in the
current month.

� Financial Statement reports
The following reports are designed for month-end financial analysis. For examples of these reports, see
Running Financial Statement reports.

Report Description

Balance Sheet Use to review and analyze the Balance Sheet values by
FSDetail category across multiple years.

Balance Sheet and Cash Flow Use to review and analyze the Balance Sheet and Cash
Flow across multiple years.

Balance Sheet By Entity Use to show by entity for one fiscal year across the
balance sheet categories in FSDetail. You can update the
report to run for any fiscal year in the database.

Balance Sheet Detail Use to show the detail accounts within each balance sheet
category of FSDetail, showing last-year actual and current-
year actual.

Forecast Income Summary Use to show the Current Year Forecast by FSDetail
category compared to Current Year Budget and Current
Year Annualized.

Forecast Scenario Comparison Use to show the Current Year To Date, Current Year
Annualized compared to the Current Year Forecast and
Alternate Forecast.

Income Statement By Entity Use to show the Income Statement categories by entity
for the current fiscal year.
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Report Description

Income Statement Detail Use to show the detail accounts within each income
statement category of FSDetail showing current-year
detail and last-year actual.

Income Statement Multi-Year Use to review the Income Statement totals by FSDetail
category across multiple fiscal years.

Income Statement Projection Use to review the Income Statement totals by FSDetail
category by month. For the remaining months of the year,
it projects using the current-year budget or current-year
forecast, which you can then compare to the annual
budget.

Income Statement Summary Use to review the Income Statement totals by FSDetail
category for the current period and year-to-date
compared to budget and prior year.

Income Statement Summary-12
Month

Use to view the Income Statement totals by FSDetail
category, by month. You can also update the report to
process for any fiscal year in the database.

Income Statement Summary-Drill Use to view review the Income Statement totals by
FSDetail category for the current period and year-to-date
actual compared to budget and prior year. You can drill
down to the detail transactions for revenue, expense,
payroll data, or show a trend for each category.

Provider Income Statement Summary Use to show the Income Statement totals by FSProvider
category for the current period and year-to-date
compared to budget and prior year.

� Payroll reports
The following reports are designed for bi-weekly payroll analysis. For examples of these reports, see
Payroll reports.

Report Description

Employee Roster Use to show employee-related information for a single
department by job code. This information is used for
budget-labor budgets.

Employee Roster – Position Control Use to show employee-related information by job code
and by employee.

Labor Distribution Use to show bi-weekly paid hours and dollars by job code,
employee, and pay category for a single pay period.
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Report Description

Labor Distribution Detail Use to show hours and dollars by a department, by job
code for multiple pay period, and by category of pay.

Overtime Alert Use to show highlights of overtime trends by pay period
and department.

Overtime Analysis Use to show overtime FTE-related hours by department
trended for multiple pay periods. This report is normally
processed by VP or Director.

� Provider Analysis reports (optional feature)
The following reports are designed for physician analysis.

NOTE: You can also find these same reports in the Budget Reporting section > Provider Budget >
Analysis.

For a description of each report, see Provider Budget reports.

� Report Packages
The following reports are designed for month-end or payroll electronic reporting.

Executive
For examples of these reports, see .

Report Description

Budget Variance Rollup Use to show the current month and year-to-date Actual,
Flexible, or Fixed Budget and Prior Year values by category
in detail. This report can be processed at a rolled-up level
by Entity, VP, Director, and so on. You can use any
grouping column in dimensions for summarization.

Budget Variance Summary Use to show the expense, cost-per-unit of service, and
hours-per-unit of service variances for each department.
This report is typically run by VP to give them a summary
of the departments that have variances for the current
month.

Cover_Executive Use as the cover page for monthly Executive report
package. You can customize this report to meet your
reporting needs.
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Report Description

Dept Variance Rollup Use to show department variances over a chosen
threshold by category for revenue and expenses for the
current period and year-to-date. This report also contains
a monthly variance output and projection for the rest of
the fiscal year.

Executive Monthly Package Use to speed up report processing and distribution by
running all of the individual executive reports and
including them in one report package.

Pay Summary by Department Use to show bi-weekly paid hours by department, by
payroll summary category trended over multiple pay
periods. This report is normally processed by VP but can
also be processed by Director, Division, and so on.

Statistic Variance Summary Use to show key statistics by department for the past four
months to show statistical trends and variances.

Top 10 Variances Use to show top and bottom ten department variances for
salaries, supplies, and other expenses.

Variance Overview Use to show monthly variances by department, by account
that exceed the thresholds set by the system
administrator.

Manager
For examples of these reports, see.

Report Description

AP Distribution Report (optional
feature)

Use to show the monthly Accounts Payable (AP) detail by
general ledger account by vendor, check number, and
check date.

AR Distribution Report (optional
feature)

Use to show the monthly Accrued Receipts (PO Received
Not Invoiced) detail by vendor, PO Number, line item
description, and receipt date subtotaled by general ledger
account.

Budget Variance By Department Use to show the current month and year-to-date actual,
which are then compared to the Flexible or Fixed Budget
as well as Prior Year values by category and in detail.

Cover_Manager Use to generate a cover page for monthly Manager report
package. You can customize this report to meet your
reporting needs.
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Report Description

Dept Monthly Package Use to run all of the individual manager reports and
distribute them in one report package

GL Distribution Report (optional
feature)

Use to show the monthly journal entry detail for each
general ledger account.

MM Distribution Report (optional
feature)

Use to show the monthly materials management issues,
including the location of issue, unit of issue, unit price,
quantity, and the amount subtotaled by general ledger
account.

Pay By Employee ID Use to show the biweekly paid hours by employee, by
payroll summary category trended over multiple pay
periods.

Pay By JobCode Use to show the biweekly paid hours by job code, by
payroll summary category trended over multiple pay
periods.

RU Report (optional feature) Use to show the current month and year-to-date Revenue
and Usage units and gross revenue by CDMCode. Units for
specific CDM can be RVU weighted to use for monthly
statistics summarization.

RU Report_Budget (optional feature) Use to show the current-month actual, budget, and year-
to-date Revenue and Usage units and gross revenue by
CDMCode. Units for specific CDM can be RVU weighted to
use for monthly statistics summarization.

Scorecard Use to show financial and ratio indicators for the chosen
department compared to budget and trend.

Variance Alert Use to show accounts that exceed variance thresholds for
the month.

Package Utilities
For examples of these reports, see Report Packages - Utilities.

Report Description

Monthly All in One VP Package Use to automatically build a report packaging batch using
the database and dimensions. You may build a batch to
distribute reports based on a single dimension grouping by
another dimension grouping (For example, Dept by VP,
Manager by Director, etc.).
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Report Description

Monthly Manager Package Use to package and email monthly reporting packages to
managers. Each column in the report represents a
recipient, with the reports listed under each person as the
reports they receive in their monthly package.

Monthly VP Package Use to package and email monthly reporting packages to
VPs. Each column in the report represents a recipient, with
the reports listed under each person as the reports they
receive in their monthly package.

Analysis reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Analysis.

� Account Analysis
Use to analyze the current month- and year-to-date variances for an individual account by department.
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� Current Year Actual (CYA) Per Unit Analysis
Use to analyze year-to-date (current) per-unit amounts for Patient Revenue, Salaries, Supplies, and
Other Expenses compared to current-year budget (Budget).

� Expense Summary by Department
Use to analyze expense variances by department.
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� Key Dept Ratios
Use to analyze current month and year-to-date salary variances for an individual department. The salary
variance is broken into categories for Price, Volume, and Efficiency. A summary section is also provided
to show the components of the total variance.

� Labor Price, Volume, and Efficiency Variances
Use to quickly analyze salaries to determine if the variances are related to rate or volume.
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� Labor Summary by Department
Use to analyze labor variances by department.

� MultiYear Statistic Review
Use to show key and non-key statistical accounts for the current-year actual and budget, prior year, and
two years ago. You can run this report for a single department or combined for multiple departments. If
is often used to confirm that the statistical basis across different years is consistent.
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� Threshold Analysis
Use to analyze current month values compared to the average of the previous three month. You can
enter a dollar threshold. After the report is populated, you can change the view to only show the
departments that exceed the threshold. The purpose of this report is to show unusual activity or
possible missing entries in the current month.

Balance Sheet and Cash Flow reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Balance Sheet & Cash Flow. For instructions, see Browsing the Report
Library.
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You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Balance Sheet & Cash Flow.

� Balance Sheet
Use to review and analyze the Balance Sheet values by FSDetail category across multiple years.
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� Balance Sheet and Cash Flow
Use to review and analyze the Balance Sheet and Cash Flow across multiple year
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� Balance Sheet by Entity
Use to show by entity for one fiscal year across the balance sheet categories in FSDetail. You can update
the report to run for any fiscal year in the database.
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� Balance Sheet Detail
Use to show the detail accounts within each balance sheet category of FSDetail, showing last-year actual
and current-year actual.
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Reports in the DepartmentMonthly Package
These reports are designed for month-end or payroll electronic reporting. For more information on
setting up and configuring this report package, see Configuring the Department Monthly Package report.

� AP Distribution Report (optional feature)
Use to show the monthly Accounts Payable (AP) detail by general ledger account by vendor, check
number, and check date.
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� AR Distribution Report (optional feature)
Use to show the monthly Accrued Receipts (PO Received Not Invoiced) detail by vendor, PO Number,
line item description, and receipt date subtotaled by general ledger account.

� Budget Variance By Department
Use to show the current month and year-to-date actual, which are then compared to the Flexible or
Fixed Budget as well as Prior Year values by category and in detail.

The Budget Variance by Department report also shows the monthly values by category and account. It
will fill in the remainder of the year with last year actual, current year budget, or forecast data to
calculate a year-end projection.
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� Cover_Manager
Use to generate a cover page for monthly Manager report package. You can customize this report to
meet your reporting needs.

� GL Distribution Report (optional feature)
Use to show the monthly journal entry detail for each general ledger account.
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� MM Distribution Report (optional feature)
Use to show the monthly materials management issues, including the location of issue, unit of issue,
unit price, quantity, and the amount subtotaled by general ledger account.
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� Pay By Employee ID
Use to show the biweekly paid hours by employee, by payroll summary category trended over multiple
pay periods.

� Pay By JobCode
Use to show the biweekly paid hours by job code, by payroll summary category trended over multiple
pay periods.

� RU Report (optional feature)
Use to show the current month and year-to-date Revenue and Usage units and gross revenue by
CDMCode. Units for specific CDM can be RVU weighted to use for monthly statistics summarization.
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� Scorecard
Use to show financial and ratio indicators for the chosen department compared to budget and trend.

� Variance Alert
Use to show accounts that exceed variance thresholds for the month.
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Reports in the ExecutiveMonthly Package
These reports are designed for month-end or payroll electronic reporting. For more information on
setting up and configuring this report package, see Configuring the Executive Monthly Package report.

� Budget Variance Rollup
Use to show the current month and year-to-date Actual, Flexible, or Fixed Budget and Prior Year values
by category in detail. This report can be processed at a rolled-up level by Entity, VP, Director, and so on.
You can use any grouping column in dimensions for summarization.

The Budget Variance Rollup report also shows the monthly values by category and account. It will fill in
the remainder of the year with budget last year or forecast data to show a year end projection.
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� Budget Variance Summary
Use to show the expense, cost-per-unit of service, and hours-per-unit of service variances for each
department. This report is typically run by VP to give them a summary of the departments that have
variances for the current month.

� Cover_Executive
Use as the cover page for monthly Executive report package. You can customize this report to meet your
reporting needs.
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� Dept Variance Rollup
Use to show department variances over a chosen threshold by category for revenue and expenses for
the current period and year-to-date. This report also contains a monthly variance output and projection
for the rest of the fiscal year.

The Budget Variance Rollup report also shows the monthly values by category and account. It will fill in
the remainder of the year with budget last year or forecast data to show a year end projection.
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� Pay Summary by Department
Use to show bi-weekly paid hours by department, by payroll summary category trended over multiple
pay periods. This report is normally processed by VP but can also be processed by Director, Division, and
so on.

� Statistic Variance Summary
Use to show key statistics by department for the past four months to show statistical trends and
variances.
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� Top 10 Variances
Use to show top and bottom ten department variances for salaries, supplies, and other expenses.

� Variance Overview
Use to show monthly variances by department, by account that exceed the thresholds set by the system
administrator.
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Income Statement reports
These reports are designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Income Statement. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Income Statement.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 351

Browsing the Report Library.htm


� Forecast Income Summary
Use to show the Current Year Forecast by FSDetail category compared to Current Year Budget and
Current Year Annualized.
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� Forecast Scenario Comparison
Use to show the Current Year To Date, Current Year Annualized compared to the Current Year Forecast
and Alternate Forecast.

� Income Statement By Entity
Use to show the Income Statement categories by entity for the current fiscal year.
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� Income Statement Detail
Use to show the detail accounts within each income statement category of FSDetail showing current-
year detail and last-year actual.
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� Income Statement Multi-Year
Use to review the Income Statement totals by FSDetail category across multiple fiscal years.

� Income Statement Projection
Use to review the Income Statement totals by FSDetail category by month. For the remaining months of
the year, it projects using the current-year budget or current-year forecast, which you can then compare
to the annual budget.
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� Income Statement Summary
Use to review the Income Statement totals by FSDetail category for the current period and year-to-date
compared to budget and prior year.

� Income Statement Summary-12 Month
Use to view the Income Statement totals by FSDetail category, by month. You can also update the report
to process for any fiscal year in the database.

� Income Statement Summary - Detail
Use to view review the Income Statement totals by FSDetail category for the current period and year-to-
date actual compared to budget and prior year. You can drill down to the detail transactions for
revenue, expense, payroll data, or show a trend for each category.
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Provider Income Statement reports
These reports are designed for month-end financial analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Provider. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Provider.
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� Provider Income Statement Summary
Use to show the Income Statement totals by FSProvider category for the current period and year-to-
date compared to budget and prior year.

Payroll reports
These reports are designed for bi-weekly payroll analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Payroll. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Payroll.
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� Employee Roster
Use to show employee-related information for a single department by job code. This information is used
for budget-labor budgets.

� Employee Roster - Position Control
Use to show employee-related information by job code and by employee.
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� Labor Distribution
Use to show bi-weekly paid hours and dollars by job code, employee, and pay category for a single pay
period.

� Labor Distribution Detail
Use to show hours and dollars by a department, by job code for multiple pay period, and by category of
pay.

� Overtime Alert
Use to show highlights of overtime trends by pay period and department.
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� Overtime Analysis
Use to show overtime FTE-related hours by department trended for multiple pay periods. This report is
normally processed by VP or Director.

Provider Analysis reports
These reports are designed for physician analysis.

NOTE: These reports are optional reports that you can purchase as an add on to your current
license.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Provider Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Provider Analysis.

� Current Period vs Previous Comparison
Use to compare current period vs previous period information by provider as well as last year actual.
You can select the data type to analyze in the report.
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� Current Period vs Previous Comparison_CPT
Use to compare current period vs previous period information by CPT or CPT Summary category and last
year actual. You can select the data type to analyze in the report.

� CY Actual vs Budget Comparison
Use to compare current period and year-to-date actual vs budget information by provider and last year
actual. You can select the data type to analyze in the report.
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� CY Actual vs Budget Comparison_CPT
Use to compare current period and year-to-date actual vs budget information by CPT or CPT Summary
code and last year actual. You can select the data type to analyze in the report.

� NY Budget Comparison
Use to compare current year projections with next year's budget.

� NY Budget Comparison_CPT
Use to compare current year projections with next year's budget by CPT or CPT Summary category.
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� Provider Key Indicators By Month
Use to compare month-by-month values for last year, current year, and target by data type.

� Provider Key Indicators By Month_Rolling 12
Use to compare month-by-month values for the most recent 12 months by data type
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� Provider Practice Summary
Use to analyze by provider, by practice the worked vs target productivity by provider.

� Provider Productivity
Use to analyze by provider worked vs target productivity.
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� Provider Revenue Per Encounter
Use to compare the current month to the prior three-month average for different years for revenue per
encounter.

� Provider Revenue Per RVU
Use to compare the current month to the prior three-month average for different years for revenue per
RVU.
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� Provider Revenue Per WRVU
Use to compare the current month to the prior three-month average for different years for revenue per
WRVU.

� Provider Volume by Specialty
Use to compare actual vs budget volume by data type for the current period and year-to-date,
subtotaled by provider specialty.
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� Provider Volume by Specialty_Monthly
Use to show monthly totals by provider, for a chosen data type and year, subtotaled by provider
specialty.

Report Packages - Utilities
These reports are designed for month-end or payroll electronic packaging for distribution.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting\Report
Packages\Package Utilities. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Report Packages > Package Utilities.
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� DeptMonthlyPackage_FileCollect
Use this utility to combine all of the Monthly Manager Package reports into one file, configure the file
source and output settings and delivery method (email and/or save as a file to a directory location) for
the . If sending the report by email, you can configure the email subject line and body text, the recipient
type, and file attachment options. For more information, see Processing and distributing the
Department Monthly Package report.

� ExecutiveMonthlyPackage_FileCollect
Use this utility to combine all of the Executive Monthly Package reports into one file, configure the file
source and output settings and delivery method (email and/or save as a file to a directory location) for
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the . If sending the report by email, you can configure the email subject line and body text, the recipient
type, and file attachment options. For more information, see Processing and distributing the Executive
Monthly Package report .

Running the Revenue Usage - Budget report
This reports shows the current-month actual, budget, and year-to-date Revenue and Usage units and
gross revenue by CDMCode. Units for specific CDM can be RVU weighted to use for monthly statistics
summarization.

� Accessing this report
The report is located in \Axiom\Reports Library\Management Reporting\Report Packages\Manager.
For instructions, see Browsing the Report Library.
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You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Report Packages > Manager.
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Financial Utilities
Axiom Budgeting and Performance Reporting 2022.3 comes with a variety of standard financial reports,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Financial Current Year Forecast – Forecast Adjustment utilities
These reports are designed to post calculated values to the database. For examples of these reports, see
Current Year Forecast – Forecast Adjustment Utilities.

Report Description

Dept Specific Forecast Adjustments This is a save-to-database report used to make
adjustments to the current-year forecast at a specific
department and account level.

Monthly Forecast Adjustments This is a save-to-database report used to make
adjustments to the current-year forecast at an income-
statement level.

� Current Year Forecast – Forecast Processing utilities
This report is designed to post calculated values to the database. For examples of these reports, see
Current Year Forecast – Forecast Processing Utilities.

Report Description

Monthly Forecast Utility Use to calculate and post a monthly forecast for the
remaining months of the fiscal year to the database using
a variety of forecast methods.

� Financial Data Audit
This report is designed to improve the quality of data. For examples of these reports, see Data Audit.

7
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Report Description

Standard Data Assessment Use to improve the quality of your data, keep you
compliant with Syntellis standards, and save time
preparing for monthly reporting and annual budgeting.

� Financial Data Input utilities
These reports are designed as save-to-database reports for statistics and contract labor hours. For
examples of these reports, see Data Input utilities.

Report Description

Input Biweekly Contract Labor Use as an input report for biweekly contract labor hours
data collection. You enter biweekly hours and then post
them to the database from this report.

Input Monthly Contract Labor Use as an input report for monthly contract labor hours
data collection. You enter monthly hours and then post
them to the database from this report.

Input Monthly Statistics Use to input monthly statistics data collection or
calculations. You enter the monthly statistics and then
post to the database from this report.

� Financial Data Reconciliation utilities
These reports are designed for designed for month-end close analysis. For examples of these reports,
see Data Reconciliation utilities.

Report Description

Acct Standards Review Use this report to map standardized data for accounts in
your organization to KHA Standard Class codes.

BiWeekly Payroll Reconciliation
report

After the payroll file is loaded, run the Biweekly Payroll
Reconciliation report.

Consolidations and Eliminations This is a save to database report that allows you to input
eliminations for your Financial database.

Dept Standards Review Use this report to map standardized data for departments
in your organization to KHA Standard Class codes.

Entity Standards Review Use this report to map standardized data for entities in
your organization to KHA Standard Class codes.

Jobcode Standards Review Use this report to map standardized data for job codes in
your organization to KHA Standard Class codes.
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Report Description

Monthly RevUsage Reconciliation After all data is loaded, run the Monthly RevUsage
Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for
each month.

Paytype Standards Review Use this report to map standardized data for pay types in
your organization to KHA Standard Class codes.

Provider Standards Review *Only available with a Comparative Analytics Provider.

Use this report to map standard data for providers in your
organization, such as NPI and Standard Specialty Code.

Reconcile GL to GL Transactions
report

If you load subledger detail into Axiom, such as Accounts
Payable (AP), Accrued Receipts (AR), Materials
Management (MM) and Journal Entries (JE), we have a
reconciliation utility that ties the subledger data back to
the ledger data (ACT20XX). This report confirms that the
data loaded to the GL matches the data loaded to Journal
Entry (JE) detail.

Reconcile GL to Pay12 to Pay27
report

Use this report to compare the Current Year Gross
Revenue in the Financial tables to the RevUsage tables.

Reconcile GL to Rev Usage report Use to reconcile GL revenue data in the Financial tables to
the Revenue and Usage data imported into the database
on a monthly and year-to-date basis.

� Financial Dimensions System Structure reports
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct. For examples of these reports, see Dimensions System Structure reports.

Report Description

System Structure Accounts Use to show the current mapping in the ACCT dimension
table.

System Structure Departments Use to show the current mapping in the DEPT dimension
table.

System Structure JobCodes Use to show the current mapping in the JOBCODE
dimension table.

System Structure PayTypes Use to show the current mapping in the PAYTYPE
dimension table.
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� Financial Dimensions Flex Budget utilities
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct. For examples of these reports, see Flex Budget utilities.

Report Description

FlexBudgetSetup Use configure options for the Flex Calculator utility.

FlexCalculator by Month Use this save-to-database report to post flexible budget
calculations to the database.

� Financial Payroll utilities
These utilities are designed to post calculated values to the database. For examples of these reports, see
Payroll utilities.

Report Description

BiWeekly To Monthly Use this utility to accrue for both hours and dollars from
your biweekly payroll load (Payroll26) into the monthly
data tables (Payroll12).

BiWeekly to Monthly with LY Use this utility to post accrued biweekly hours or dollars
from the Payroll27 tables to the Payroll12 tables.

Monthly to BiWeekly Use this utility to post reverse-accrued budgeted monthly
hours from the Payroll12 tables to biweekly amounts and
post them to the Payroll27 tables for labor or productivity
reporting.

Monthly to GL If payroll hours are not coming through your GL Import,
you can move your hours from the Payroll12 data tables
created from the previous process to your Financial tables
by running the Monthly to GL accrual utility.

� Financial Report Batches
These reports are designed to process multiple reports for multiple outputs. For examples of these
reports, see Report Batches.

Report Description

Monthly All in One Executive
Reporting Batch

Use to run the Executive Monthly Package report for
distribution.
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Report Description

Monthly All in One Manager
Reporting Batch

Use to run the Department Monthly Package report for
distribution.

Monthly Financial Statements Batch Use to run the monthly Financial Statements for
distribution.

Monthly Hours Accrual Batch Use to run the monthly the Hours accrual reports.

� Financial RevUsage utilities
These reports are designed to process multiple reports for multiple outputs. For examples of these
reports, see RevUsage utilities.

Report Description

Summarize CDM Statistics (optional
feature)

Use to summarize CDM values to department-level
statistics and post them to the Financial database to use as
key statistics for monthly reporting as well as budgeting.

� Financial Security Setup utilities
These reports are designed to manage user roles and permissions. For examples of these reports, see
System Setup utilities.

Report Description

Performance Reporting Security
Update

Use to configure security.

� Financial Statistic Transfer utilities
These reports are designed as save-to-database reports for statistics. For examples of these reports, see
Statistic Transfer utilities.

Report Description

Transfer Key Stats from Fin to PR12 Use this save-to-database report to transfer statistics from
the Financial tables to the Payroll12 tables at the end of
the budget process.

Transfer Key Stats for Fin to PR26 Use this save-to-database report to transfer statistics from
the Financial tables to the Payroll27 tables at the end of
the budget process.
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� Financial System Setup utilities
These reports are designed as utility reports to help you set up the system. For examples of these
reports, see System Setup utilities.

Report Description

Benchmark Used as factors in productivity reports.

CalDate Update Utility Use as a utility to help you fill out the necessary columns
in the CALDATE dimensions table. Only needed if licensed
for Daily Productivity.

FP Payor Use to assign the payors for use in the Axiom Financial
Planning product.

Names Use this table in reports or FileCollect process to look up
email, names, titles, and login information.

Payroll_Dates Used in reports to look up the pay period end date and
pay date for current year and last year. There are two
sections if your organization uses two pay cycles.

VCC_Payroll_Mapping Used by Variance Comments and other payroll utilities to
map GL accounts to job codes and/or pay types.

VCC_Threshold Used to set configure how much an account can vary from
budget before department managers are required to enter
comments explaining the variance

YearPeriod Used in configure the first year and month of the fiscal
year, number of work days in the current, last, and next
year, and the standard FTE hours worked by employees in
a year.

Current Year Forecast – Forecast Adjustment Utilities
These reports are designed to post calculated values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Current Year Forecast\Forecast Adjustments. For instructions, see Browsing the Report
Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Current Year Forecast > Forecast Adjustments.
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� Dept Specific Forecast Adjustments
This is a save-to-database report used to make adjustments to the current-year forecast at a specific
department and account level.

� Monthly Forecast Adjustments
This is a save-to-database report used to make adjustments to the current-year forecast at an income-
statement level.
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Current Year Forecast – Forecast Processing Utilities
This report is designed to post calculated values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Current Year Forecast\Forecast Processing. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Current Year Forecast > Forecast Processing.
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� Monthly Forecast Utility
This is a save-to-database report used to calculate and post a monthly forecast for the remaining
months of the fiscal year to the database using a variety of forecast methods.

Data Audit
This report is designed to improve the quality of data.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
ReportingUtilities\Data Audit. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Audit.

� Standard Data Assessment
Use to improve the quality of your data, keep you compliant with Syntellis standards, and save time
preparing for monthly reporting and annual budgeting. For more information, see Standardizing data.
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Standardizing data
Syntellis leverages artificial intelligence to review and categorize your key dimension elements to a pre-
defined Syntellis taxonomy system. The artificial intelligence method leverages descriptions and key
characteristics to derive suggested classifications. These classifications provide a required level of
standardization and structure to enable comparative analysis as well as key integration points.

The purpose of this section is to explain the data integrity compliance features for your Axiom products
and the reasons for using them. Standardizing your data includes the following steps:

1. Map KHA Standard Class codes - To standardize data across accounts, departments, and so on in
your organization, you first need to map them to KHA Standard Class codes using a series of
reports that allow you to review and modify your data classification taxonomy.

2. Review codes for standards compliance - To help keep your organization compliant with Syntellis
standards, the Standard Data Assessment dashboard uses a series of icons to provide a clear and
easy way to see if your accounts, departments, and so on meet the Syntellis standards criteria.

3. Assign KHAStandardClass by department and account - The Statistic Identification Update utility
allows you to map ACCT.KHAStandardClass values by account/department or
department/account combinations.

4. Review YTD statistics by KHAStandardClass classification - The Statistic Classification Review
report allows you to review YTD data for the statistic accounts to ensure they correctly tie out
from the department summed up to the entity level.

About machine learning classifications
If your organization uses the cloud-based version of Axiom Budgeting and Performance Reporting, the
system has access to a machine learning process that analyzes and determines the best suggested
classification code for the account. You can use this pre-determined classification or assign your own,
depending on how well the machine learned classifications meet your needs. We suggest you review
each assignment and correct where you deem necessary using the following reports:

l Entity Standards Review
l Dept Standards Review
l Acct Standards Review
l Jobcode Standards Review
l Paytype Standards Review
l Provider Standards Review *Only available with a Comparative Analytics Provider license

Each one is similar in structure. Within each, you will review the assignment and, where needed, change
the standard assignment in the override column.
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As part of the development of future report tools and utilities, data needs to be standardized across
accounts, departments, and so on. Part of this process includes mapping these items in your
organization to KHA Standard Class codes.

NOTE: This process will benefit your organization in the future by providing more detailed data and
reporting capabilities. Once complete, you should only need to update these reports when you add
new accounts, departments, etc.

If you feel there are missing categories or identifiers to accurately classify our key elements, please
contact DataScienceTeam@syntellis.net. We will continue to expand and adapt this taxonomy structure
to give you quality insights through comparative elements and planning process integration.

� Mapping KHA Standard Class codes
To map KHA Standard Class codes:

1. In theMgmt Admin task pane, in the Data Maintenance section, click Data Reconciliation, and
double-click one of the following:

NOTE: The results returned depend on the user’s write filter on the dimension table as
established when using the Dimension Maintenance Security utility.

l Acct Standards Review
l Dept Standards Review
l Entity Standards Review
l Jodcode Standards Review
l Paytype Standards Review

2. In the Refresh Variables dialog, you can optionally filter the data in the report by KHA Standard
Class and/or State by clicking Choose Value, select the values to filter by, and click OK.

NOTE: To view all of the items (accounts, departments, etc.) in the report, click OK.

3. In the KHA Standard Classification column, do one of the following.

a. To use the machine learning classification as determined by the system, copy the
classification from theML Classification column, and paste it into the KHA Standard
Classification column.

NOTE: At this time, the ML Classification is only used if your organization has a cloud-
based system. If your system is located on premise, the column will be blank.

b. To select a different classification, double-click the folder next to the KHA Standard
Classification column, select a classification, and click OK.

4. In the Entity Standards Review report, do the following:
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a. In theMedicare Provider Number column, type the MPN number, as needed.

b. In the Active column, identify which entity is active by doing one of the following:
i. In theMedicare Provider Number column, type the MPN number, as needed.

ii. In the Active column, identify which entity is active by doing one of the following:
l To activate the code, click TRUE.
l To deactivate the code, click FALSE.

5. After making your changes, in theMain ribbon tab, click Save.

The information you enter saves back to the corresponding dimension table. For example, after mapping
your accounts, the system saves your changes to the ACCT dimension table.

� Mapping standard specialty data for providers

NOTE: The Provider Standards Review report is only available with a Comparative Analytics Provider
license. To acquire this license, contact your sales representative or Client Relations Executive (CRE).

The Provider Standards Review report allows you to map standard specialty data for providers in your
organization to the Provider dimension table.

To use the Provider Standards Review report:
1. In theMgmt Admin task pane, in the Data Maintenance section, click Data Reconciliation, and

double-click Provider Standards Review.

2. In the Refresh Variables dialog, you can optionally filter the data in the report by standard
specialty, provider, and/or the active state of the provide by clicking Choose Value, selecting the
values to filter by, and clicking OK.

3. Complete the following columns:

Column Description

ML Classification
ID and Name

To activate and configure this column, contact Syntellis Support.

NOTE: These columns are used primarily by the Syntellis machine
learning feature. To activate these columns, contact Syntellis Support.

Standard
Specialty Code

To the right of the column, click the folder icon. From the Choose Value
dialog, select the Standard Specialty Code, and click OK.

NPI Type the National Provider Identifier (NPI) for the provider.

Active To indicate that a provider is currently practicing, type True. To indicate
the providers is no longer practicing, type False.

Birth Year Type the provider's birth date using the MM/DD/YYYY format.
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Column Description

Hire Year Type the year the provider was hired using the YYYY format.

Contract
Renewal Date

Type the date the provider's contract was renewed using the
MM/DD/YYYY format.

4. After making your changes, in theMain ribbon tab, click Save.

Reviewing codes for standards compliance
The Standard Data Assessment dashboard provides several benefits:

l Helps improve the quality of your data
l Ensures that you use standard Syntellis codes to keep you compliant with Syntellis standards
l Helps save time in preparing for monthly reporting and annual budgeting

NOTE: The dashboard includes the KHAStandardClass column in the ACCT, DEPT, ENTITY, JOBCODE,
and PAYTYPE dimensions to help standardize reporting across the organization. Currently, the
column populates with a default value of NotMapped. These columns will be populated at a later
date, but until then they will be out of compliance.

To work with the Standard Data Assessment dashboard:

l To refresh the data in the dashboard, click Refresh.
l To include the net income in the fund balance, click the toggle to Yes; otherwise, click the toggle

to No.
l From the View drop-down, select to view all of the entities or just warnings and failures.

To navigate to the Standard Data Assessment dashboard, in the Data Maintenance section of theMgmt
Admin task pane, double-click Standard Data Assessment.
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� Icon definitions

Balanced BS Actual and Budget
Shows if the balance sheet is in balance for both the actuals and budget. The icons in these columns
represent the following:

Balance sheet does not balance. Run a Balance Sheet report, and review it for accuracy. Update the
data using the Load GL 12 Months import, and then review the data for accuracy.

Balance sheet balances correctly. No action is required.

Standard FSDetail
Shows if the values from the FSDetail column (located in the ACCT dimension table) comply with the
standard values established by Kaufman Hall. The icons in this column represent the following:

The codes do not comply with the standard Kaufman Hall values. To view the accounts with FSDetail
codes that do not comply, click , and update the ACCT dimension table with the standard Kaufman
Hall codes.

The codes comply with the standard Kaufman Hall values. No action is required.

Standard FSSummary
Shows if the values from the FSSummary column (located in the ACCT dimension table) comply with the
standard values established by Kaufman Hall. The icons in this column represent the following:

The codes do not comply with the standard Kaufman Hall values. To view the accounts with
FSSummary codes that do not comply, click , and update the ACCT dimension table with the standard
Kaufman Hall codes.
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The codes comply with the standard Kaufman Hall values. No action is required.

KHA Standard Class
Shows if the values from the KHA Standard Class column (located in the ENTITY, DEPT, ACCT, JOBCODE,
and PAYTYPE dimension tables) are mapped.

The value of Not Mapped exits for any record in the ENTITY, DEPT, ACCT, JOBCODE, and PAYTYPE
dimension tables. To view the records that are not mapped, click , and map the record in the
dimension table with the standard Kaufman Hall code.

All records have been mapped. No action is required.

Actual GL
Shows if the actual GL data has been loaded for the entity. The icons in this column represent the
following:

A zero YTD value exists for the entity. If incorrect, update the data using the Load GL 12 Months
import, and review the data for accuracy. If you purposely did not import GL data, no action is required.

GL data has been loaded for the entity. No action is required.

Budget GL
Shows if the budget GL data has been loaded for the entity. The icons in this column represent the
following:

A zero YTD value exists for the entity. If incorrect, review the budget GL data for accuracy. If correct,
no action is required.

GL data has been loaded for the entity. No action is required.

Actual Bal Sheet
Shows if the actual balance sheet data has been loaded for the entity.

TIP: If you currently do not import your balance sheet data into Axiom Management Reporting, we
recommend you do so to provide better information to use in the system. For help on loading this
data, contact Kaufman Hall Support.

The icons in this column represent the following:

A zero value exists in the current month for the entity. If incorrect, import your actual GL and check it
for accuracy. If correct, no action is required.

Actual balance sheet data has been loaded for the entity. No action is required.
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Budget Bal Sheet
Shows if the budget balance sheet data has been loaded for the entity.

TIP: If you do not budget your balance sheet data in Axiom Budgeting, we recommend that you
implement a budget for your balance sheet during the next budget cycle. This will provide better
information to use in Axiom Budgeting and Performance Reporting going forward.

The icons in this column represent the following:

A zero budget value exists in the current month for the entity. If incorrect, review your budgeted
balance sheet for accuracy. If correct, no action is required.

Budget balance sheet data has been loaded for the entity. No action is required.

Actual Rev/Usasge
Shows if the actual Revenue Usage data has been loaded for the entity.

NOTE: Revenue Usage data is only loaded if patient revenue exists in the GL. If you do not currently
load Revenue Usage data, we recommend that you do so to take full advantage of Axiom
Management Reporting. For help on loading this data, contact Kaufman Hall Support.

The icons in this column represent the following:

A zero value exists for the entity for the current month. If incorrect, load the data using the Load
RevUsage import, and review the data for accuracy. If correct, no action is required.

Revenue Usage data has been loaded for the entity. No action is required.

Cur Month Volatility
Shows if the total expense in the current period compared to the percentage change from the mean is
more or less than ten percent. The icons in this column represent the following:

The percentage change of expenses in the current period compared to the mean is greater than ten
percent. If correct, no further action is required. If not correct, update the data using the Load GL12
Months import, and review the data for accuracy.

The percentage change is less than ten percent. No action is required.

Financial Current
Shows if the financial data has been loaded for the most recent closed period in your ACTYYYY table.
Kaufman Hall defines the most recent closed period as the month and year 60 days prior to today’s
date. The icons in this column represent the following:
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The data loaded is older than 60 days from today. Update the data for the most recently closed
period using the Load GL 12 Months import, and then review the data for accuracy.

The data has been loaded for the entity. No action is required.

Payroll Current
Shows if the payroll data has been loaded for the most recent closed period in your Pay_12_YYYY table.
Kaufman Hall defines the most recent closed period as the month and year 60 days prior to today’s
date.

TIP: If you do not process the BiWeekly to Monthly utility, we recommend that you include this step
monthly going forward to take full advantage of Axiom Management Reporting. For help on
processing this data, contact Kaufman Hall Support.

The icons in this column represent the following:

The data loaded is older than 60 days from today. Update the data for the most recently closed
period using the Load Biweekly Payroll import and processing the BiWeekly to Monthly utility to accrue
the biweekly payroll data to the monthly payroll tables.

The data has been loaded for the entity. No action is required.

Assigning KHAStandardClass by department and account
The Statistic Identification Update utility allows you to map ACCT.KHAStandardClass values by
account/department or department/account combinations. You can use this utility to filter the list of
accounts or departments in several different ways so that you can narrow the list down to only those
accounts/departments that you need to classify.

After you filter the accounts/departments, the utility then displays the list and populates the column
values based on the ACCT.KHAStandardClass column in the ACCT dimension. The system displays
unmapped items as NotMapped.

IMPORTANT: For updated or new accounts/departments, you will need to reclassify them.

To assign KHAStandardClass by department and account:
1. Update ACCT.KHAStandardClass using the Acct Standard Review utility. For instructions, see

About machine learning classifications.

NOTE: Depending upon the volume of data that is loaded, the performance may be slow.

2. In the Mgmt Admin task pane, in Data Maintenance > Data Reconciliation, double-click Statistic
Identification Update.
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NOTE: The utility opens in a separate web browser.

3. From the Filters panel, configure any of the following criteria, and click Apply:

Option Description

Filter by ACCT.Type Select to review KeyStat and/or Statistic accounts, and click OK.

Entity Filter To refine the results even further, you can create or select an
advanced Entity filter to select accounts using other grouping
columns. For instructions, see Using the Advanced Filter Wizard.

Select Entity Select one or more entities, and click OK.

Select Dept.RptMap
(ACT20XX)

Select one or more departments, and click OK.

NOTE: The system refers to the system period to determine the
ACT table in which to display the list of departments.

Standard Sort Order Select to sort the list by account and department (default) or
department and account.

Select Additional Display
Column(s)

Select an additional grouping column from the ACCT dimension.

NOTE: Only string data type columns display in the list.

4. Above the table, configure the following options, as needed:

Option Description

Show YTD Value? To view the YTD values for each account/department
combination, click the toggle to Yes.

Show
ACCT.KHAStandardClass?

To view the ACCT.KHAStandardClass defined in the ACCT
dimension, click the toggle to Yes.

Unlock All Records? To unlock all the records for editing, click the toggle to Yes.
If the list is long and you unlock all the records, you can edit
the values in spreadsheet mode by clicking Edit in
Spreadsheet in the upper-right corner of the page. Any
changes you make in spreadsheet mode will automatically
update the values in the list after you save.

NOTE: You may encounter performance issues if you unlock
all records.

5. If not using the Unlock All Records option, to edit individual item, click the lock icon next to the
Department or Account column (depending on how you selected to display the list).
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TIP: The lock/unlock functionality simply provides a way for the system to update only those
items that have changed. This helps maintain better system performance while working with
the utility.

6. Select values in the following columns:

l Statistic Type
l Patient Type
l Function
l Direct/Indirect
l DEPT/ACCT KHAStandardClass
l Conversion Factor

NOTE: The exclamation point icon in the last column indicates there is a difference between
the default KHAStandardClass code and the assignment selected using this utility.

7. After making your edits, click Save.

After the account/departments are mapped, you can use the Statistic Classification Review report to tie
out YTD values by entity based on KHAStandardClass classification.

� Deleting department/account classification assignments
Deleting a department/account does not delete it form the ACCT table. This action simply allows you to
"reset" the record by removing it from the classification identification table. After you delete an item,
the record will return with the original defaults assigned in ACCT.KHAStandardClass.

To delete department/account classification assignments:
1. Open the Statistic Identification Update utility.

2. Click the delete check box next to the lock/unlock column.
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3. Click Save.

Review YTD statistics by KHAStandardClass classification
After you complete the classification process, you can use the Statistic Classification Review report to
review statistics to ensure the correct YTD values tie out from the department summed up to the entity
level.

To Review YTD statistics by KHAStandardClass classification:
1. In the Mgmt Admin task pane, in Data Maintenance > Data Reconciliation, double-click Statistic

Classification Review.

NOTE: The report opens in a separate web browser.

2. From the Filters panel, configure any of the following criteria, and click Apply:

Option Description

Entity Filter To refine the results even further, you can create or select an
advanced Entity filter to select accounts using other grouping
columns. For instructions, see Using the Advanced Filter Wizard.

Entity Selection Select one or more entities, and click OK.

Limit by Entity.Summary Select to limit the list to only specified entities, and click OK.

3. Review the YTD statistics in the report to determine that they are correctly summing and rolling
up from the department to the entity level. If needed, return to the Statistic Identification Update
utility to make the appropriate adjustments. You can then return to this report, where the
changes are automatically refreshed.
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Data Input utilities
These reports are designed as save-to-database reports for statistics and contract labor hours.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
ReportingUtilities\Data Input. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Input.
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� Input Biweekly Contract Labor
Use as an input report for biweekly contract labor hours data collection. You enter biweekly hours and
then post them to the database from this report.

� Input Monthly Contract Labor
Use as an input report for monthly contract labor hours data collection. You enter monthly hours and
then post them to the database from this report.
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� Input Monthly Statistics
Use to input monthly statistics data collection or calculations. You enter the monthly statistics and then
post to the database from this report. In some cases, there may be an import for statistics that already
loads statistics on a monthly basis. You can use this report as a replacement for an import or in addition
to the statistics import.

Data Reconciliation utilities
These reports are designed for designed for month-end close analysis and standardizing data.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Data Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the following:

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 396

../../../../../../Content/Reports/Browsing the Report Library.htm


l Bud Admin task pane: In the Financial Reporting section, click Financial Utilities > Data
Reconciliation.

l Mgmt Admin task pane: In the Data Maintenance section, click Data Reconciliation.

� Acct Standards Review
Use this report to map standardized data for accounts in your organization to KHA Standard Class codes.

NOTE: For instructions, see About machine learning classifications.

� BiWeekly Payroll Reconciliation report
After the payroll file is loaded, run the Biweekly Payroll Reconciliation report.

Using the loaded import file, total the dollars and hours from the import file, and enter the totals into
the BiWeekly Payroll Reconciliation report to see if your check totals from your import file match what
was loaded in to Axiom.
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If your dollars and hours for the loaded period matches the Grand Total, the data is reconciled, and you
can move on to either loading another payroll for the current month or running the Payroll Accrual
utility to accrue your biweekly payroll to a monthly payroll.

� Consolidations and Eliminations
This is a save to database report that allows you to input eliminations for your financial database.

� Dept Standards Review
Use this report to map standardized data for departments in your organization to KHA Standard Class
codes.

NOTE: For instructions, see About machine learning classifications.
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� Entity Standards Review
Use this report to map standardized data for entities in your organization to KHA Standard Class codes.

NOTE: For instructions, see About machine learning classifications.

� Jobcode Standards Review
Use this report to map standardized data for job codes in your organization to KHA Standard Class
codes.

NOTE: For instructions, see About machine learning classifications.
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� Monthly RevUsage Reconciliation
After all data is loaded, run the Monthly RevUsage Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for each month.

Using the import file that was loaded, total the Volumes and Revenue dollars from the import file, and
key the totals into the Monthly RevUsage Reconciliation report to see if your check totals from your
import file match what was loaded in to Axiom.

If your dollars and volumes for the period loaded matches the Grand Total, the data is reconciled. If you
use RevUsage volumes to calculate statistics for productivity, you can move forward to summarize your
IP\OP volumes from your RevUsage data table (ACT_RU_20XX) to your Financial data table (ACT20XX)
using the Summarize CDM Statistics utility.

� Paytype Standards Review
Use this report to map standardized data for pay types in your organization to KHA Standard Class
codes.

NOTE: For instructions, see About machine learning classifications.
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� Provider Standards Review

NOTE: The Provider Standards Review report is only available with a Comparative Analytics Provider
license. To acquire this license, contact your sales representative or Client Relations Executive (CRE).

Use this report to map standard specialty data for providers in your organization.

NOTE: For instructions, see Mapping provider standard specialty data.

� Reconcile GL to GLTransactions report
If you load subledger detail into Axiom, such as Accounts Payable (AP), Accrued Receipts (AR), Materials
Management (MM) and Journal Entries (JE), we have a reconciliation utility that ties the subledger data
back to the ledger data (ACT20XX). This report confirms that the data loaded to the GL matches the data
loaded to Journal Entry (JE) detail. It also compares the JE Detail to AP, MM, AR transactions to make
sure the data is in balance.

TIP: Your Syntellis Implementation Consultant will help you set up this report during
implementation.
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NOTE: Use the Reconcile GL to RevUsage report to reconcile your charge master data for Inpatient
and Outpatient between the Financial data source (ACT20XX) and the RevUsage data set (ACT_RU_
20XX). Manual adjusting journal entries outside of the source system will cause reconciling variances
to the General Ledger RevUsage data so do not use this report regularly. The report is located in the
Reports Library in the Management Reporting Utilities > Data Reconciliation folder.

� Reconcile GL to Pay12 to Pay27 report
Use this report to compare the Current Year Gross Revenue in the Financial tables to the RevUsage
tables.

� Reconcile GL to Rev Usage report
Use to reconcile GL revenue data in the Financial tables to the Revenue and Usage data imported into
the database on a monthly and year-to-date basis. The desired result for this report is to show a zero
variance.
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Dimensions System Structure reports
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Dimension System Structure Reports. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Dimension System Structure Reports.
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� System Structure Accounts
Use to show the current mapping in the ACCT dimension table.

� System Structure Departments
Use to show the current mapping in the DEPT dimension table.
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� System Structure JobCodes
Use to show the current mapping in the JOBCODE dimension table.

� System Structure PayTypes
Use to show the current mapping in the PAYTYPE dimension table.
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Dimension Update utilities
These reports are designed to help you update dimension table coding.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Dimension Update Utilities. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Dimension Update Utilities.
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� Update DIM - CALDATE
Use to update the CDM dimension table.

� Update DIM - GLPERIOD
Use to update the GLPERIOD dimension table.
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� Update DIM - INITIATIVEID
Use to update the INITIATIVEID dimension table.

Flex Budget utilities
These reports are designed to post calculated values to the database.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Flex Budget. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Flex Budget.

� Flex Budget Setup
Use configure options for the Flex Calculator utility.
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� FlexCalculator by Month
Use this save-to-database report to post flexible budget calculations to the database. The calculations
are based upon default assignments in the department and account dimensions as well as exceptions
that can be defined in custom tables.

Payroll utilities
These utilities are designed to post calculated values to the database.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Payroll. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Payroll.

� BiWeekly to Monthly
Use this utility to accrue for both hours and dollars from your biweekly payroll load (Payroll26) into the
monthly data tables (Payroll12).

Depending on how many years of biweekly payroll data are stored in your Axiom system, you have two
utility options:

l Biweekly to Monthly – Your organization is in their first year in Axiom and have no prior year
payroll data utilize this utility.

l Biweekly to Monthly with LY – Your organization has more than one year of historical payroll
data to capture the days of the year-end biweekly payroll that may cross over their fiscal year
utilize this utility.

In the Refresh Variables dialog, select from the following drop-downs options, and click OK:
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Option Description

Choose Year (Current Year
or Last Year

Depending on what biweekly payrolls you want to accrue, select CYA
(Current Year) or LYA (Last Year) .

Choose Payroll Sequence
(Hours, Dllrs, Stats)

Select Hours or Dllrs.

NOTE: These need to be run individually so once you run one (Hours)
you will have to then run the other (Dllrs).

Post results to the
database?

To post the results to the Axiom database, select Yes; otherwise,
select No.

TIP: Ensure that the number of FY days in First Pay Period are correct. If they are not, review the pay
period dates on the Custom Tables > Payroll tab.

In the File Processing task pane, click Process file multipass to run the utility by department and post
the values to the database. Repeat this step for the Hours by refreshing the report variables, select
Hours from the refresh variable, and then Process File multipass. If you also load statistics into you
biweekly payroll tables, you can also run this utility to move the statistics to your financial data source.
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� BiWeekly to Monthly with LY
Use this utility to post accrued biweekly hours or dollars from the Payroll27 tables to the Payroll12
tables. The first period of the year is calculated using the final LY pay period.

� Monthly to BiWeekly
Use this utility to post reverse-accrued budgeted monthly hours from the Payroll12 tables to biweekly
amounts and post them to the Payroll27 tables for labor or productivity reporting.
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� Monthly to GL
If payroll hours are not coming through your GL Import, you can move your hours from the Payroll12
data tables created from the previous process to your Financial tables by running the Monthly to GL
accrual utility.

IMPORTANT: Only run this utility if you are not loading hours from your GL via the GL12Month or
Monthly Statistics imports.
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NOTE: Use the Monthly to BiWeekly utility to take budgeted Payroll12 data and reverse accrue it to
a biweekly data set.

Report Batches
These reports are designed to process multiple reports for multiple outputs.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Report Batches. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Report Batches.

� Monthly All in One Executive Reporting Batch
Use to run the Executive Monthly Package report for distribution.
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� Monthly All in One Manager Reporting Batch
Use to run the Department Monthly Package report for distribution.

� Monthly Financial Statements Batch
Use to run the monthly Financial Statements for distribution.

� Monthly Hours Accrual Batch
Use to run the monthly the Hours accrual reports.

RevUsage utilities
This report is designed to calculate and post values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\RevUsage. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > RevUsage.
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� Summarize CDM Statistics (optional feature)
Use to summarize CDM values to department-level statistics and post them to the Financial database to
use as key statistics for monthly reporting as well as budgeting.

Security Setup utilities
These utilities are designed to manage user roles and permissions.
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� Accessing these reports
The utilities listed in this section are located in \Axiom > Reports Library > Management Reporting
Utilities > Security Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Security Setup.

Managing Performance Reporting user security
Use this utility to configure security for Axiom Performance Reporting users.

NOTE: This tool is intended only for adding users, subsystems, and roles. You cannot use this utility
to remove a user from a system or role; instead, you must use the Security Manager. However, be
aware that removing users from roles or subsystems in the Security Manager will not remove the
associated filters or revoke access in most cases.

� About the utility
This utility has the following sections:

l EXISTING PERFORMANCE REPORTING USERS – Lists existing users of the Management Reporting
subsystem
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l EXISTING OTHER USERS – Lists users that exist in security but are not members of the
Management Reporting subsystem

l NEW USERS – Allows you to add new users to the Management Reporting subsystem

NOTE: Please note the following about changes and saving:
l Changed rows are indicated by a green [Save] tag, as shown in the following example. This tag

indicates a change was made or an unexpected previous parameter was found and modified,
thereby creating a change.

l Changes to a username, email, or password may not trigger a save unless accompanied by
other changes, such as a change to filters, subsystems, or roles, that trigger the [Save] tag. If a
[Save] tag does not appear at the beginning of a row to which you made a change, the change
is not saved. Make the changes in the Security Manager if you are unable to make them in the
update utility.

l If a user is assigned to a product subsystem but not a role, this tool automatically assigns
them to the user role, thereby, creating a change.

l Executing the Process file option does not cause a refresh after save, so you will continue to
see the newly added record in the NEW USERS section until you perform a refresh. Additional
changes made to the record in this section will NOT be saved, even if you click the Save
button in the Main ribbon tab to save subsequent changes unless you first refresh the utility,
make additional changes, and then save.

To configure security:
1. In the Bud Admin task pane under Financial Reporting, expand Security Setup, and then double-

click Performance Reporting Security Update.
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2. In the utility, moving from left to right, edit the data in the columns as needed. Use the following
table as a guide. You can enter data into blue cells and select data from drop-downs in green
cells.

NOTE: To add new users, enter them into the NEW USERS section at the bottom of the
worksheet.

Field Steps

LoginName The login name for the user.

If your organization uses the login information supplied by your
IT department, then the login name is auto generated.

NOTE: If you attempt to add an existing user in the NEW USERS
section, the name and row become highlighted to let you know
that the user is already in the system. Delete the name, then
locate the user in the sections above and make changes there.

PrincipalID This entry is auto generated by the system. Do not make
changes to this cell.

FirstName Type the user’s first name.

LastName Type the user’s last name.

EmailAddress Type the user’s email address.

AuthenticationType Click the drop-down to select how the user is authenticated to
use the system.

Only Axiom Prompt
Password

If the user uses Windows authentication, then this field remains
blank. If this user uses the Axiom Prompt, then type in the user's
password.

IsSyncEnabled This information is imported from Security Manager. Do not
make changes to this cell.

UserLicenseType This information is imported from Security Manager. Do not
make changes to this cell.

IsEnabled This information is imported from Security Manager. Do not
make changes to this cell.

IsAdmin This information is imported from Security Manager. Do not
make changes to this cell.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 420



Field Steps

Management Reporting
System

Do one of the following:

l To give a user access to Axiom Performance Reporting, select
TRUE.

l To rescind or deny access to a user, select FALSE.

Productivity System Do one of the following:

l To give access to the Productivity system, select TRUE.
l To rescind or deny access, select FALSE.

Mgmt Reporting Role To give access to Management Reporting, from the drop-down,
select one of the following:

l Management Reporting Admin – Provides access to
Management reports, Management utilities, Dimension
maintenance, imports, scheduled jobs, and Process
Management.

l Management Reporting Analyst – In addition to user role
permissions, provides access to Axiom Explorer, scheduled
jobs, Axiom Windows Client, and User Documents folder.

l Management Reporting User – Provides access to
Management reports.

Productivity Role To give access to the Productivity module, from the drop-down,
select one of the following:

l Productivity User – Provides access to Productivity reports.
l Productivity Admin – Provides access to Productivity reports

and Productivity utilities.

Management Reporting
Physician Role

To give access, from the drop-down, selectManagement
Reporting Physician.

3. Before saving, be sure you understand how saving works in this utility. In theMain ribbon tab,
click Save.

IMPORTANT: DO NOT execute a save-as or open in a read/write mode. Structural
modifications to this tool could negatively impact your security setup.

4. In theMain ribbon tab, click Refresh Data.

Statistic Transfer utilities
These reports are designed as save-to-database reports for statistics.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Statistic Transfers. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Statistic Transfers.

� Transfer Key Stats from Fin to PR12
Use this save-to-database report to transfer statistics from the Financial tables to the Payroll12 tables at
the end of the budget process. The statistics can then be used once they are reverse accrued into
biweekly periods for biweekly productivity.
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� Transfer Key Stats from Fin to PR26
Use this save-to-database report to transfer statistics from the Financial tables to the Payroll27 tables at
the end of the budget process. The statistics can then be used once they are reverse accrued into
biweekly periods for biweekly productivity.

System Setup utilities
These reports are designed as utility reports to help you set up the system.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\System Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > System Setup.
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� Benchmark
Used as factors in productivity reports.
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� CalDate Update Utility
Use as a utility to help you fill out the necessary columns in the CALDATE dimensions table. Only needed
if licensed for Daily Productivity.

� FP Payor
Use to assign the payors for use in the Axiom Financial Planning product.
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� Names
Use this table in reports or FileCollect process to look up email, names, titles, and login information.

� Payroll_Dates
Used in reports to look up the pay period end date and pay date for current year and last year. There are
two sections if your organization uses two pay cycles.
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� VCC_Payroll_Mapping
Used by Variance Comments and other payroll utilities to map GL accounts to job codes and/or pay
types.

� VCC_Threshold
Used to set configure how much an account can vary from budget before department managers are
required to enter comments explaining the variance

� YearPeriod
Used in configure the first year and month of the fiscal year, number of work days in the current, last,
and next year, and the standard FTE hours worked by employees in a year.
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Working with Variance Reporting
Variance Comments Collection automates the process of managers submitting explanations for
variances between monthly budgets and actuals. In addition to collecting manager comments, Variance
Comments Collection also prompts managers to submit proposed action plans for bringing their
department's actuals in line with targets.

The Variance Comments Collection feature is implemented as an optional tab that you can include in the
Month End Review Dashboard. This tab allows the following:

l Collect variance explanations and action plans for correction on a monthly basis.
l Enables one-stop shopping for the department manager by providing drill-downs.
l Provides a way to input variance explanations and actions plans for multiple departments at the

same time.

Configuring Variance Comments Collection
Before you can collect variance comments for a new month, you must do the following:

1. Set variance thresholds and alert flags.

2. Set VCC Payroll mapping.

3. Set additional data requirements

Confirm that all necessary monthly data has been loaded, the payroll accrual process has been
completed, and that periods have been set properly for the following data sources:

Datasource Definition

Financial Monthly GL & Statistics loaded and proper period set

8
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Datasource Definition

Payroll12 Biweekly payroll (Payroll27) accrued to Payroll12 with EMPLOYEE
NAME

l PP26to12_Hours– Act_Pay27_YYYY to Act_Pay12_YYYYHours
sequence

l PP26to12_Dollars – Act_Pay27_YYYY to Act_Pay12_YYYY Dollars
sequence

l EmpIDDesc

Use the PP27to12 utility report to filter hours properly as well as transfer employee names from
Payroll27 tables to Payroll12 tables.

Drilling Down to Detail

The following data is necessary to enable the corresponding drill-downs to detail.

l GLDetail – Journal entry transaction data imported for current period.
l GLTransactions - AP/MM/AR transaction data imported for current period.
l RevUsage – Monthly Gross Charges and Volumes by patient type (IP and OP) by CDM Code

Setting variance thresholds
The threshold level determines how much an account can vary from budget before department
managers are required to enter comments explaining the variance.

To configure the threshold level, navigate to one of the following:

l In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > System
Setup, and double-click VCC_Threshold.

l In theMgmt Admin task pane, in the Dimension & Reference Maintenance section, click System
Setup, and double-click VCC_Threshold.

NOTE: In the ACCT dimension table, you need to create or include Variance Comments accounts for
the Summary selection where ACCT.Type=’Comments’.
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� General settings

In the top section of the sheet, you may select the following options:

1. To only view thresholds for particular departments, type criteria in the Custom Filter for Alert
Processing cell (e.g., "(Dept.Manager='Chris Sparks' or Dept=101010)").

IMPORTANT: Do not remove the "Acct.Statement <>'NI'" criteria, otherwise new, approved
initiatives will be included.

IMPORTANT: Custom filters will not be applied to the optional Variance Comments Collection
tab in the Month End Reporting dashboard.

2. In the Comparison Time Series cell, select one of the following options in which to base the
variance in the reports:

l For regular current year budget variances, select CYB.
l For flexible budget variances, select FLX.
l For three-month average variances, select 3MthAvg.
l For prior month variances, select LastMth.
l For the same month last year variances, select SameMthLY.

3. In the Revenue & Usage Comparison field, do one of the following:

l To enable drilling in the statistic section down to CDMCode, select Budget.
l If unsure which option to select, select Budget.

4. In the Flag Max Positive Variance as Required cell, do one of the following:
l To be alerted to variances in a favorable direction as well as variances in an unfavorable

direction, select Yes.
l To not be alerted to variances, select No.
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5. If your organization uses H_JCHours for Paid Hours, do the following:
l In the Use H_JCHours for Paid Hours filter (Default is H_Hours) cell, select Yes.
l If you are not sure, select No.

6. In the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down, select one of the following options:

l To create a Variance Comment Collections in the Month End Review dashboard where you
will manage variance comments, select Yes.

l To manage variance comments in the Excel Client, especially if you already have
customized filters, select No.

� Comment level settings
In the Summary portion of the General Threshold Levels section of the page, you may decide whether to
collect comments at a summary level or account detail level.

IMPORTANT: Valid account codes are needed if reporting at the Summary level.

This setting is reflected in the Comment Input reports. If you select Summary, a single comment input
field displays at the summary level. If you select Detail, individual comment input fields display for each
account.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 432



If using the summary level, you need to create a dummy account to accept comment input. You need to
add the dummy accounts to the ACCT dimension table, and then indicated in the Summary Account
column on the ThresholdLevel sheet.

IMPORTANT: Do not assign any new account to an existing FSSummary category, otherwise the next
month that account will show up in detail. Use Summary instead.

You can define exceptions for summary level (and all other Threshold settings by Entity) in the sections
further down the worksheet.

� Flag alert settings
For each account, you may define ranges at which various flags are set:
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For each summary and/or detail account, you may set thresholds that will trigger flags with different
color coding in the variance reports.

Color Description

Green Displays on the report if the variance is below the value in theMin Yellow
column.

Yellow Displays on the report if the variance exceed theMin Yellow amount but
remains below the Red Threshold.

Red Displays on the report if the variance is greater thanMax Red but
comments are not required.

Red w/Yellow Box Displays in the yellow cell if variance is greater thanMax Red and
comments are required.

Setting VCC Payroll mapping
Variance Comments and other payroll utilities use specific rules to map GL accounts to job codes and
pay types.

Use the VCC Payroll Mapping table to identify JobCode/PayType combinations for each salary GL
account number.

Any unmapped accounts display in the Unmapped Accounts section under the Mapped Accounts
section. Click the Unmapped Accounts header to expand or contract the list. When you map any
unmapped accounts, the system automatically moves it to the list of mapped accounts.
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To map VCC Payroll:
1. In the Mgmt Admin task pane, in the Data Maintenance section, and double-click Update

VCC Payroll Mapping Table.

2. In the VCC Payroll Mapping utility, find the Salary GL Account to map to, and from the GLAcct
Dimension column drop-down, select JobCode or PayType for each salary account. To disable
drilling, select NA.
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TIP: Previously mapped accounts display at the top of the list.

3. To remove any mapped accounts, click the check box in Delete column (the first column indicated
with a trash can icon). When you click Save, the account is removed.

4. After you finish making changes, click Save in the upper right corner of the page.

The filter column computes the required filter based on the GLAcct mapping in the GLAcct grouping
column in the respective JobCode or PayType dimension.

Activating Variance Comments Collection
When activating Variance Comments Collection, you are adding the Variance Comments Collection tab
to the Month End Review dashboard. This allows you to easily manage variance comments from one
location. After you activate the tab, see Using the Variance Comments Collection tab in the Month End
Review dashboard.

NOTE: Before you can activate the tab, you must complete the setup steps. For more information,
see Configuring Variance Comments Collection.

To activate Variance Comments Collection:
1. Navigate to one of the following:

a. In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities >
System Setup, and double-click VCC_Threshold.
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b. In theMgmt Admin task pane, in the Dimension & Reference Maintenance section, click
System Setup, and double-click VCC_Threshold.

2. Click the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down and click Yes.

3. Click Save.

Using the Variance Comments Collection tab in the
Month End Review dashboard

The Variance Comments Collection tab in the Month End Review dashboard allows you to manage
variance comments. The tab displays as a sub-tab of the Operational Overview section within the
dashboard. For instructions on activating the tab, see Activating Variance Comments Collection.

� Applying filters
You must filter accounts before data will display.
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To apply filters:
1. Click the filter icon in the upper-left toolbar.

2. In the drop-down menus that display, click options to set your time period, target, category, filter,
and department. For more information on these filters, see Viewing and filtering the Month End
Review dashboard.

3. In the Variance Comments Collection section, complete the following options, as needed:

Option Description

Which items do you want
to see? drop-down

Click one of the following options:

l All Items: displays all accounts.
l Show Required Comments Only: displays only the accounts

where variance comments are required based on threshold
settings.

Action Plan checkbox When checked, the tab displays the Action Plan column. The
Action Plan column displays a text box for each account where
comments are required. Use this text box to describe your
action plan in regard to the variance.

Rate Volume Variance
checkbox

This box is checked by default. When checked, the tab displays
the following columns: Rate, Volume, Efficiency, and 12 mo.
Alert. The alerts are based on threshold settings.

Year-To-Date checkbox When checked, the tab displays the following columns: Current
year Actual, Last Year, Variance, Variance %, and Last Year Alert.
The alerts are based on threshold settings.
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4. Click Apply.

5. In the Variance Explanation column, type a description that explains the variance from the
previous year.

TIP: You can enter information in this column specific to the period you selected in Step 2.

6. In the Action Plan column, type the actions your organization plans on taking to address the
variance.

NOTE: This column only displays if you select the Action Plan check box in Step 3.

TIP: You can enter information in this column specific to the period you selected in Step 2.

7. After you finish making changes, click Save in the upper right corner of the page.

� Drilling down to detail
Once you apply the filters, you can drill-down to greater levels of detail. To drill down, click the blue
magnifying glass icon to see greater detail regarding the account in that row.

In the example below, we drill-down on Salaries - Overtime > all associated job codes > all associated
employees.
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NOTE: You can only access drill-downs for data that you have loaded already. For example, the
JobCode Variance drill-down will not be available if you have not loaded job code data.

� Viewing document images
AP and AR transactions may include links to supporting documentation that you can view directly in the
Variance Comments Collection tab. To view the document links, drill down to the appropriate
transaction, and click and drag the scroll bar until the Link to Image column displays. Click the icon to
open the document image.
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Running the Monthly Reporting
Process

Complete the following steps to generate a monthly report for your organization:

1. Load GL 12-month data.

2. Run the Income Statement Summary report.

3. Load Monthly Statistics data.

4. Load GL Detail data.

5. Load AP Detail data.

6. Load MM Detail data.

7. Load Accrued Receipts data.

8. Reconcile GL to GL Transactions.

9. Load Revenue and Usage data.

10. Reconcile monthly RevUsage reconciliation.

11. Summarize CDM statistics to financial.

12. Load Biweekly Payroll data.

13. Reconcile Biweekly Payroll.

14. Run Biweekly to Monthly Payroll Accrual report.

15. Run Monthly to GL Accrual utility.

16. Remove reporting source files.

17. View the Month End Review dashboard.

18. Configure the Department Monthly Package report.

19. Process and distribute the Department Monthly Package report.

9
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Loading GL12Month data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a GL_ prefix.

To load GL12 Month data:
1. To change the current period, in the Admin ribbon tab, in the Database group, click Imports &

Utilities > System Period/Year.

2. In the System Current Period dialog, in the New Value field, type the new month value, and click
OK.

IMPORTANT: Do not change the System Current Year field unless changing over a new fiscal
year. Setting the system period and year could affect other Axiom Healthcare Suite products.

3. In the Admin ribbon tab, in the Database group, click Imports & Data Utilities > Imports,
Management Reporting> 01-Load GL 12 Months, and click Execute.

4. Click Execute.

5. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection:
Input Year (YYYY)

Type the year to load.

6. In the Choose the import source file dialog, select the source file to load.-

If the import encounters validation errors, see Resolving import validation errors.

7. After you load the data, run the Income Statement Summary report in Explorer in Reports Library
> Management Reporting > Income Statement > Income Statement Summary to reconcile to
your GL income statement.

LoadingMonthly Statistic data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a ST_prefix.

To load Monthly Statistic data:
1. In the Admin ribbon tab, in the Database group, click Imports & Data Utilities > Imports >

Management Reporting > 02-Load Monthly Stats, and click Execute.

2. Click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection:
Input Year (YYYY)

Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a ST_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. If you are not loading your statistics through an import set up by your Syntellis Implementation
Consultant, then you can also load statistics using a Save to Database report. There are standard
reports delivered with your system for this, which you can find in Explorer in Management
Reporting Utilities > Data Input > Input Monthly Statistics.

6. Use the top section of the report, labeled Add New Stats, when entering a new Dept-Acct
combination into the database.
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If needed, you can copy additional rows by copying the entire row, and then using the Insert
Entire Row option in Excel. If you Refresh the report, it will bring in all existing statistic
combinations from the database, and you can then update any monthly value in the blue cells in
the Change Existing Stats section.

7. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading AP Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an AP_prefix.

To load AP Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 06-

Load AP Detail > Execute.

2. In the Execute Import: 06-Load AP Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year
(YYYY)

Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading GL Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a JE_prefix.

To load GL Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 05-

Load GL Detail > Execute.

2. In the Execute Import: 05-Load GL Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year
(YYYY)

Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

LoadingMMDetail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an MM_prefix.

To load MM Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 07-

Load Materials Issues> Execute.

2. In the Execute Import: 07-Load Materials Issues dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year
(YYYY)

Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Accrued Receipts data
Make sure the import file is created and saved to a directory accessible by the Axiom Application server.
We recommend naming the file with an AR_prefix.

To load Accrued Receipts data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 08-

Load Accrued Receipts > Execute.
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2. In the Execute Import: 08-Load Accrued Receipts dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year
(YYYY)

Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Revenue and Usage data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a RU_prefix.

To load Revenue and Usage data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 09-

Load RevUsage > Execute.
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2. In the Execute Import: 09-Load RevUsage dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year
(YYYY)

Type the year to load.

Month: Select
Current Month

In the drop-down, select the month to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Loading GL12
Month data.

Summarizing CDM statistics to financial
To use your Charge Master (CDMCODE) to create your statistics, we offer a save-to-database utility that
summarizes the Inpatient and Outpatient volumes in the RevUsage database (ACT_RU_20XX) into
statistic accounts that can be stored in the Financial database (ACT20XX). For this utility to work, your
Syntellis consultant will help you design your CDMCODE table during the implementation.

To summarize CDM statistics to financial:
1. To run this Save to Database utility, navigate to In the Explorer task pane, in the Libraries section,

click the Reports Library > Management Reporting Utilities > RevUsage folder, and double-click
Summarize CDM Statistics.

2. In the drop down box in cell M19, select whether you are running the process for Current Year or
Last Year.
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3. Refresh the data by doing one of the following:

l In theMain ribbon tab, click Refresh Data.

l Press F9.

4. In the File Processing task pane, click Process file.
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NOTE: You do not need to run this utility using Multipass unless you are a large health system and
are noting performance issues when previously running.

Loading Biweekly Payroll data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
The file should be saved as LD_MMDDYY_PP. For example, LD_100418_1

To load Biweekly Payroll data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Table Current Periods.
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2. Filter using the Table Type, and select Payroll.

3. Change the period for all of the payroll tables where the Uses System checkbox is not selected.
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4. In the Table Current Periods dialog, double-click the current period for the table, and type the
new period.

5. When you have finished all the tables, click OK.
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6. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 03-
Load Biweekly Payroll > Execute.

7. In the Execute Import: 03-Load Biweekly Payroll dialog, click Execute.

8. In the Variables dialog, do the following, and click OK:

Field Steps

Year Selection:
Input Year (YYYY)

Type the year to load.

PayPeriod: Input
Period (1 – 27)

In the drop-down, select the pay period to load to.

9. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

10. If there are any import exceptions, follow the import exceptions remediation from .

Resolving import validation errors
If the import experiences import validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12 Month data.

The CSV file is located in Explorer in the Imports Library > Management Reporting > Import Errors
folder.
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The CSV file shows you which rows of data were invalid within the context of the import data. This error
file includes the following:

l Look up validation errors from Syntellis's Software's built-in validation against lookup columns.

l Validation errors from any Custom Data Validation steps in the transforms.

l Key validation errors such as blank keys or duplicate keys.

You can also open the file from the Execute Import dialog by clicking the link the Status area. The status
displays either "failed" or "warning," followed by "click here to open errors in a spreadsheet." The status
type depends on whether the option to Ignore lookup and key errors is selected.
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Each execution of an import that results in a lookup error generates a unique error file (differentiated by
a date/time stamp). These error files are not automatically deleted; you must manually delete them
when you finish investigating the error.

The CSV file contains the import data, followed by one or more validation columns. Validation columns
are labeled as follows:

l LookupColumnName Lookup Error column – Contains lookup and key validation messages. For
example, Acct Lookup Error"\ when looking up against the ACCT column.

l AXTRANSFORM_StepNumber column – Contains Custom Data Validation messages where
StepNumber is the number of the associated transformation step. For example, AXTRANSFORM_
5 when the associated transform is step 5 in the list.

If there are errors (most commonly new codes in Dimensions), add those codes to dimensions, and re-
run the import.
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Working with the Month End Review
dashboard

The Month End Review dashboard allows executives and managers to easily view variances between the
month/YTD plan versus actual for all of your organization all the way down to the department level. It
provides a visual summary of performance, including trends by month and Key Performance Indicators
(KPIs). Use the filter function to specify the information to display in the dashboard.

TIP: The rolling 12 month charts actually display 13 months of data so that you can compare the
current period with the same period last year.

� Summary tab
The Summary tab is the first tab that displays in the dashboard. It provides a visual representation of
actuals versus target, grouped into Revenue, Labor, and Expense categories. This tab provides KPI
visibility into all of your departments for the current period and year.

NOTE: The page will only include those departments in which you have permissions to view.

To view the statistic and per-unit KPI information at the department-level, go to the Operational
Overview tab.

To see a chart of rolling 12 months actuals, click the chart icon in the upper left corner of each box.

10
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� Executive Overview
The Executive Overview tab displays summary-level revenue, expense, and statistics information for all
the departments in your organization.

To see a chart of rolling 12 months actuals, click the chart icon in the upper left corner of each box.

You can also toggle between viewing the data for the period or YTD.
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� Revenue Overview and Expense Overview tabs
The Revenue Overview and Expense Overview tabs work similarly by displaying the following sections
for revenue and expenses:

l Income Statement Summary – Shows the actuals, targets, variance, and variance percentage for
inpatient revenue, outpatient revenue, other patient revenue, other revenue, and non-revenue
categories. As you click each category, the Top 10 Favorable and Unfavorable sections list the
departments that make up those values. For example, if you click Inpatient Revenue, the Top 10
Favorable and Unfavorable inpatient departments display.

l Top 10 Favorable Variances – Shows the top ten departments with the highest positive variance
(actuals minus target) by department, actual, target, and variance.
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l Top 10 Unfavorable Variances - Shows the top ten departments with highest negative variance
(actuals minus target) by department, actual, target, and variance.

For each department in the Top 10 Favorable and Unfavorable sections, click the department
chart icon to see a rolling 12 months of actuals as well as the actuals, target, and variance listed
by account.

You can also access the Executive Monthly Package from either tab.

� Statistical Overview tab
The Statistical Overview tab shows a list of key statistics by department for the selected month and year.
This tab shows:

l Prior month, two month, and three month data
l Four month average
l Variance to the prior month
l Variance to the four month average
l Current target (3 Month Average, Last Month, or Same Month Last Year)
l Variance to target

By using the filter function, you can filter the data by:
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l Target - Select the target of either Budget, 3 Month Average, Last Month, or Same Month Last
Year

l Category - Select VP, Director, Manager, Budget Group, Division, Dept (RPTMap).
l Time Period - Select a month and year.

You can also sort the data by either the Variance to Prior Month, Variance 4 month Average, or Variance
to Target column as well as export the data to Excel.

� Operational Overview
The Operational Overview tab allows you to view the details regarding how a department is performing
by providing data regarding KPIs, patient revenue, expenses, labor, and benefits. This tab includes the
following sub-tabs:

� KPI tab
The KPI tab displays a visual representation of actuals versus target, grouped into Revenue, Labor, and
Expense categories. This tab provides KPI visibility into a department for the current period and year.
You can also access the Dept Monthly Package from this tab.
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� Patient Revenue tab
The Revenue tab displays inpatient and outpatient revenue, broken out by rate and volume variance.

To view the 12-month revenue trend and details, click the Inpatient Revenue and Outpatient Revenue
boxes.

To view actuals for the period or Year to Date, click the Period/YTD toggle in the upper right corner of
the page.
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� Other Revenue
The Other Revenue displays other patient, operating, and non-operating revenue. Click the boxes to
view the 12-month revenue trend for the associated revenue category.

� Labor tab
The Labor tab displays an overview of labor expenses excluding benefits. This tab shows salaries, the
average hourly rate, FTEs, and the paid hours per unit. The tab also shows the salary and hour details as
well as KPIs.
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� Benefits tab
The Benefits tab displays benefit information including benefits, percentage of salaries, rate per FTE, and
benefits per unit. The tab also displays details for each benefit type as well as KPIs.
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� Other Expenses tab

Supplies view

Other Expenses view
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Variance Comments Collection

� Drilling data
Some line items display a magnifying glass icon next to them. This indicates that you can drill for more
information regarding that line item. Some drills include multiple layer of drills, depending on the types
of data available.

To open a drill, double-click the magnifying glass icon. The system opens a separate tab with the drill
information. Click the X in the tab to close the drill.
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Viewing and filtering theMonth End Review dashboard
To view the Month End Review dashboard:

1. In theMgmt Reporting orMgmt Admin task pane, in the Performance Reporting section,
double-clickMonth End Review.

2. To filter the data for the dashboard, in the upper left tool bar, click the funnel icon.

3. Complete the following filter options, as needed:

Option Description

Time Period Select the period and year.
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Option Description

Target (All Except
Statistical)

Select one of the following target types:

l Budget
l Flex
l 3 Month Average
l Last Month
l Same Month LY
NOTE: This filter does not apply to the Executive Overview >
Statistical Overview tab.

Category & Filter
(Summary &
Executive)

a. From the Select Category drop-down, select the organization
level in which to view data. For example, to view all of the
departments and accounts at the VP level, select VP.

b. From the Select Filter drop-down, select the filter created by
your organization.

NOTE: This filter only applies to the Summary and Executive
Overview tabs.

Target (Only
Statistical)

Select one of the following target types to filter the data in the
Executive Overview > Statistical Overview tab:

l Budget
l 3 Month Average
l Last Month
l Same Month LY

Dept (Only
Operational)

Select the department to filter the data in the Operational Overview
tab.

NOTE: The drop-down list includes more departments than what the
system displays. To include a specific department, we recommend
just typing the department number into the field. Also, note that the
list only includes those departments assigned to you.

4. Click Apply.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 471



Working with the Budget Assessment
Dashboard

The Budget Assessment dashboard allows you to compare a department's proposed budget for next
year with internal and external peer groups.

NOTE: This feature requires a license for Axiom Comparative Analytics.

� Opening the dashboard
Users must be assigned either the Budget Admin or Budget User role plus the Comparative Analytics -
Dept role to use the dashboard.

To open the dashboard:
In the Budgeting or Bud Admin task pane, in the Budget Reporting section, double-click Budget
Assessment.

Location of dashboard in Budgeting task pane

11
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Location of dashboard in Bud Admin task pane

� Using the dashboard
The dashboard is comprised of the following areas:

Filters
Do any of the following:

l Configure the criteria to include in the dashboard by selecting the filter criteria options in the
drop-downs, and click Apply.

l To clear a filter criteria option, click the X next to the drop-down.
l To clear all the filter criteria options, click Clear All.

The filter criteria detail you select also display above the tabs.
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Tabs
Budget comparison data is segmented into four areas: Summary, Labor, Non-Labor, and Other Expenses.
Click any of the tabs to view the data comparison charts and KPIs.

Data Controls
The section below the tabs and above the data charts includes controls that allow you to customize the
report data.

Graph and data view

Toggle between viewing graphical and detailed data.

These categories listed are the same for both the graph view and the data view.

Period

Select the period in which to view data.

Percentiles

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 474



Select the percentiles to use to display the dollar variance between each of the percentiles in the KPI
section of the dashboard and determine what data displays in the charts.

External and internal comparison

Select to compare data against peers outside of your organization (External) or your department
(Internal). This only applies to the KPI section.

Graphs
The graph view displays by default and compares the budget areas against performance of peers
(external) and your department (internal) across percentiles. The horizontal bars show how the
department selected in the filter and the peer data compare to the current, 3-month, and next year
budget's percentages.

To view the detailed data behind this graph, click the magnifying glass icon in the upper right corner of
the screen. This opens the Metric Explorer dashboard. For more information, see Working with the
Metric Explorer dashboard.
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Key Performance Indicators (KPIs)
The KPI boxes, to the right of the graphs, display the dollar variance between each of the percentiles
selected at the top of the report. You can customize the percentiles and the time period used for
calculations using those drop-down menus.

NOTE: The system shows the variance between the actuals (rather than budget) and each of the
percentiles.

Click the graph icon in the upper-right corner of the KPI card to display a detailed graph of the
percentiles and actuals over the last year.

Working with theMetric Explorer dashboard
The Metric Explorer dashboard allows you to evaluate monthly and annual performance of key metric
areas for business segments and provides a deeper analysis of data that displays in the Budget
Assessment dashboard.

� Using the dashboard
The dashboard is comprised of the following areas:
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Filters
Do any of the following:

l Configure the criteria to include in the dashboard by selecting the filter criteria options in the
drop-downs, and click Apply.

l To clear a filter criteria option, click the X next to the drop-down.
l To clear all the filter criteria options, click Clear All.

The filter criteria detail you select also display above the tabs.

Tabs
Data metrics are segmented into several categories and sub-categories. Click a drop-down menu
category, and click a sub-category to display the data for that element.
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Key Performance Indicators (KPIs)
The Metric Explorer dashboard displays Key Performance Indicators (KPI) data in the form of cards,
which includes the following visual indicators and data points:

An arrow communicates month-over-month change. An up arrow indicates that the current
month has improved over the previous month. A down arrow indicates that the current
month worsened over the previous month. The large text next to the arrow displays the title
of the metric title and the text below displays the metric description.

An alert icon indicates a visual representation of budget variance performance.

- Favorable variance to budget

- Within a 0%-5% threshold of budget

- Unfavorable variance by >5% to budget

The first line in this section details the actuals for the period selected. The second line
displays the percentile rank for the selected period. The text indicates if the percentile is
rising (higher rank than the previous period), steady, or falling (lower rank than the previous
period).

Click the icon to view more information comparing your organization's KPI ranking among
your peer group.

A graph displays a 12-month trend from the most recent period of data available.

This area displays the budget variance percentage.

The indicator in the lower-right corner of the KPI provides you with the year-over-year (YoY)
percentage change value. An up arrow indicates that the current year has improved over the
previous year. A down arrow indicates the current year has worsened over the previous year.
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Click the KPI card to view different charts associated with the data. When the chart view is activated, the
card displays a black background. Beneath the cards, the dashboard provides three different chart view
options in which to view the card data. Hover your cursor over each dot in any of the graphs to view the
percentage details. To exit the chart view, click the card again.
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Understanding the Executive Monthly
Package

To help speed up report processing and distribution, you can generate executive-level reports by using
the Executive Monthly Package, which combines all of the individual reports into one file. Each tab in
the workbook represents a different report.

You can then process and email the report to the appropriate management personnel and attach the
report file or a link to a directory. You can run the report generation process manually or set up a
Scheduler job to process the reports automatically at certain times of the month.

For descriptions of each report included in the Executive Monthly Package, see Reports in the Executive
Monthly Package.

Configuring the ExecutiveMonthly Package report
Use this utility to select and combine the multiple executive reports into a single report, which you can
then distribute multiple ways - including sending an email with the attached report or a link to the
directory where the report is stored. For a description of each report included in this package, see
Reports in the Executive Monthly Package.

12
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To configure the Executive Monthly Package report:
1. Navigate to one of the following:

l In theMgmt Admin task pane, in theManagement Reporting section, click Executive, and
double-click Executive Monthly Package.

l In theMgmt Report task pane, in the Performance Reporting section, click Executive, and
double-click Executive Monthly Package.

2. Refresh the data by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

3. Complete the following refresh variables, and click OK:

Option Description

Select Time Comparison Select Budget , Flex, 3 Mth Avg, Last Month, or Last Year.

Select Method for
Projection Option in
Trend Reports

Select to populate the projection months by Budget, Current
Year Forecast, or Last Year Actuals.

Choose Rollup Level Select to run the report by VP or Director.

Pick Director/VP Select a Director or VP, depending on the option selected from
the Choose Rollup Level drop-down. To return the data for all,
leave the field blank. Leave the field blank to view all data.

Fiscal Year (optional) Select the fiscal year to include in the report.

Fiscal Period (optional) Select the month to include in the report (based on the year you
selected in the Fiscal Year field).

Pay Period (optional) Select the pay period to include in the report (based on the year
you selected in the Fiscal Year field).

4. To specify the reports to output data in this batch report, do the following:
l To output data for a report when processing, type an X in the cell next to the report name.

By default, an X displays next to each report name.
l To exclude a report from generating data when processing, clear the X from the cell.
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IMPORTANT: When you run the batch report on your screen, the system processes the
data for the reports and displays each report as a tab—even those where you have
removed the X. However, when you actually process the batch report, the system will
not include any data in those reports where you have removed the X, though the tab
still displays.

5. In the Configuration section, do the following:

Option Description

File Prefix Displays the year and month selected in the refresh variables
selected in Step 3. You can edit this field, as needed. The prefix
name is followed by the executive level and name. For example,
Feb-2017VPSallyKlein.

Dept Variance Threshold Type the variance percentage to use in the trend-based reports.

Select Hours Code for
Dept_Variance and
Dept_Trend

Select the code used for hours accounts.
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6. There are multiple ways to generate and distribute the report package, depending on your need.
For more information and instructions, see Processing and distributing the Executive Monthly
Package report.

Processing and distributing the ExecutiveMonthly
Package report

This topic covers the ways in which you can process and distribute the Executive Monthly Package
report to executive personnel. To configure the reports to include in the package and the reporting
variables, see Configuring the Executive Monthly Package report.

NOTE: Before processing this report package, you may consider removing the reports from last
month. For instructions, see Removing reporting source files.

� File collect
The ExecutiveMonthlyPackage_FileCollect utility allows you to process and distribute multiple Executive
Monthly Package reports to multiple people using one tool. You can configure the file source and output
settings and delivery method (email and/or save as a file to a directory location). If sending the report by
email, you can configure the email subject line and body text, the recipient type, and file attachment
options.

TIP: If you use file collect, you can add it to the Monthly All in One Executive Reporting batch control
sheet, which allows you to automate the process of

To process and distribute package reports using the file collect:
1. From Axiom Explorer, in the Libraries section, click Reports > Management Reporting > Report

Packages > Package Utilities, and double-click ExecutiveMonthlyPackage_FileCollect.
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2. Complete the following options in the Source and Output Settings section:

Option Description

Source file name prefix Edit the source file name prefix, if needed.
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Option Description

Output file name suffix
(no extension)

Edit the file name for report.

Output file location Enter the location in which to save the generated report file(s).

3. Complete the following options in the Delivery Methods section:

Option Description

Assemble by Select the executive level in which to generate and distribute
the report package.

Save or email generated
files

Select one of the following:

l To save the report file(s) to a directory, select Save File.
l To include the report file(s) as attachment(s) or a link to a

directory where the files are stored in an email, select Email
File.

l To save the report file(s) to a directory and send an email,
select Save File and Send Email.

4. If you select email or save file and send email as the output option, complete the Email Settings
section:

Option Description

Subject text Type the subject line text for the email.

Body text Type the body text to include in the email.
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Option Description

Recipient Select the recipient type in which to send the reports.

Attach file to email Select one of the following:

l To attach the report file(s) to the email, select Yes.
l To include a link to the directory location for the report file

instead of attaching a file, click No.

Attach each file
separately

NOTE: This option does not display if you select the Save File
and Send Email option in step 3.

Select one of the following:

l To include the packaged reports into a single report file with
tabs for each report, click Off.

l To generate the packaged reports as individual report files,
click On.

5. After making your changes, in theMain ribbon tab, click Save.

NOTE: The system will prompt you to save your settings as a new file. This allows you to
create multiple setting versions, if needed.

6. In the Save As dialog, type a name for the file, and click Save.

7. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Executive Monthly Package utility
You can also process and distribute the report package directly from the Executive Monthly Package
utility. This option is useful when generating one-off packages to just a few people or for someone
wants a variant of the reporting package outside of your normal regularly scheduled process.

To process and distribute package reports using the Executive Monthly Package utility:
1. Open the Executive Monthly Package utility, and make any necessary report or variable

configuration changes, including selecting the executive-level personnel to receive the report.

2. From the Select How To Process the Files drop-down, select one of the following:

l To save the report, select Save Files. By default, the file saves to the following output
folder: \Axiom\Reports Library\Management Reporting Utilities

l To email the files, select Email Files. The report outputs to the recipient email addresses
listed in the Email Settings/Groupings section of this report.

l To save and email the report, select Save and Email files.
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3. If emailing the files, in the Email Settings/Groupings section, do the following:

Option Description

Recipient Email Address Displays the email addresses the report will be sent to.

NOTE: Email addresses are derived from the security profile for
the user.

Subject Line Edit the content for the email subject line, as needed.

Body Text Edit the content for the email body text, as needed.

4. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Batch processing and Scheduler
Another way to process the report package is to use a report batch control sheet, which allows you to
process multiple reports simultaneously. The system comes preloaded with the Monthly All in One
Executive Reporting Batch control sheet, which is pre-configured with the settings needed to run the
Executive Monthly Package for both the VP-level and Director-level reports, but you can change these
settings if needed. After you have set up the batch control sheet, you can then perform a file process.

TIP: To make generating the report package even easier, you can configure a Scheduler job to
process the batch control sheet for a specific date and time. By default, the Monthly All in One
Executive Reporting batch control sheet does not include the ExecutiveMonthlyPackage_FileCollect
utility because not all organizations use file collect. However, you can also automate the process of
distributing the report by adding the file collect utility to the batch control sheet.

To process and distribute package reports using batch processing and Scheduler:
1. Open the Executive Monthly Package utility, and make any necessary report or variable

configuration changes.

2. To include the file collect in the batch control sheet, open the file collect utility, and make any
necessary changes.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 487

../../../../../../Content/Working_Desktop/processing_axiom_files.htm


3. In theMgmt Admin task pane, in the Financial Reporting Batches section, click Report Batches,
and double-clickMonthly All in One Executive Reporting Batch.

4. Update the batch control sheet, as needed, including adding the file collect utility location to
generate multiple reports for multiple people. For more information, see the following:

l For configuring the Batch tab, see Batch Control Sheet.
l For an overview of file processing and how it works, see File processingFile Processing.

5. To process the batch, you can do one of the following:
l In the batch control sheet, click File Processing > Process File.
l Create a Scheduler job to process the report the package, if desired. For more information,

see Batch processing using Scheduler.
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Understanding the Department
Monthly Package

To help speed up report processing and distribution, you can generate manager-level reports by using
the Department Monthly Package, which combines all of the individual reports into one file. The
Department Monthly Package allows management personnel to view department performance against
a static or flexible budget and against prior year’s performance and Enables one-stop shopping for the
department manager by providing the department’s overall performance as well as reports with the
detail transactions that support the expenses on the Summary reports. Each tab in the workbook
represents a different report.

The purpose of the this package is to understand financial performance and find opportunities for
improvement where possible. In this section, we describe the financial review process in two steps and,
in each section, provide an overview of the reports available in the Department Monthly Package to
complete the analysis:

l Analysis of Monthly General Ledger (Account-level) data
l Additional Analysis of Labor (Salary Expenses and FTE amounts)

13

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 489



You can then process and email the report to the appropriate management personnel and attach the
report file or a link to a directory. You can run the report generation process manually or set up a
Scheduler job to process the reports automatically at certain times of the month.

For descriptions of each report included in the Department Monthly Package, see Reports in the
Department Monthly Package.

NOTE: Before running the report package, you may need to update the imported data used in the
reports. For more information, see Preparing data for budget go-live.

Configuring the DepartmentMonthly Package report
Use this utility to select and combine the multiple management reports into a single report, which you
can then distribute multiple ways - including sending an email with the attached report or a link to the
directory where the report is stored. For a description of each report included in this package, see
Reports in the Department Monthly Package.

Before generating this report package, you may consider removing the reports from last month. For
instructions, see Removing reporting source files.

To configure the Department Monthly Package report:
1. Navigate to one of the following:

l In theMgmt Admin task pane, in theManagement Reporting section, clickManager, and
double-click Dept Monthly Package.

l In theMgmt Report task pane, in the Performance Reporting section, clickManager, and
double-click Dept Monthly Package.

2. Refresh the data by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

3. Complete the following refresh variables, and click OK:
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Option Description

BudVar Report ONLY - Select Comparison
Time Series

For comparing to actual amounts within the
reports, select either Budget (Static Budget)
or Flex (Flex Budget).

BudVar Report ONLY - Populate Remaining
Months with...

To populate remaining months in your trend
report, select Budget (Static Budget),
Current Year Forecast, or Last Year Actuals
(Flex Budget).

Choose Department Rollup Select the department to include in the
report.

Fiscal Year (optional) Select the fiscal year to include in the report.

Fiscal Period (optional) Select the month to include in the report
(based on the year you selected in the Fiscal
Year field).

Pay Period (optional) Select the pay period to include in the report
(based on the year you selected in the Fiscal
Year field).

4. To specify the reports to output data in this batch report, do the following:
l To output data for a report when processing, type an X in the cell next to the report name.

By default, an X displays next to each report name.
l To exclude a report from generating data when processing, clear the X from the cell.

IMPORTANT: When you run the batch report on your screen, the system processes the
data for the reports and displays each report as a tab—even those where you have
removed the X. However, when you actually process the batch report, the system will
not include any data in those reports where you have removed the X, though the tab
still displays.

Reporting Guide 2022.3 Axiom Budgeting and Performance Reporting │ 491



5. In the Configuration section, do the following:

Option Description

File Prefix Displays the year and month selected in the
refresh variables selected in Step 3. You can
edit this field, as needed. The prefix name is
followed by the executive level and name.
For example, Feb-2017SallyKlein.

Configured Comparison Period for BudVar
Tab

Select one of the following:

l Current Year Budget (CYB)
l Flex Budget (FLX)

Select Other Comparison Period for BudVar
Tab

Select one of the following:

l Last Year Actuals (LYA)
l Current Year Budget (CYB)

Trend - Remaining Yr Months for BudVar Tab Select one of the following:

l Current Year Forecast (CYF)
l Current Budget (BUD)
l Last Year Actuals (LYACT)

6. There are multiple ways to generate and distribute the report package, depending on your need.
For more information and instructions, see Processing and distributing the Department Monthly
Package report.

Processing and distributing the DepartmentMonthly
Package report

This topic covers the ways in which you can process and distribute the Department Monthly Package
report to executive personnel. To configure the reports to include in the package and the reporting
variables, see Configuring the Department Monthly Package report. The Department Monthly Package
report may also be referred to as the Manager Monthly Report.

NOTE: Before processing this report package, you may consider removing the reports from last
month. For instructions, see Removing reporting source files.
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� File collect
The DeptMonthlyPackage_FileCollect utility allows you to process and distribute multiple Department
Monthly Package reports to multiple people using one tool. You can configure the file source and output
settings and delivery method (email and/or save as a file to a directory location). If sending the report by
email, you can configure the email subject line and body text, the recipient type, and file attachment
options.

TIP: If you use file collect, you can add it to the Monthly All in One Manager Reporting batch control
sheet, which allows you to automate the process of

To process and distribute package reports using the file collect:
1. From Axiom Explorer, in the Libraries section, click Reports > Management Reporting > Report

Packages > Package Utilities, and double-click DeptMonthlyPackage_FileCollect.

2. Complete the following options in the Source and Output Settings section:
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Option Description

Source file name prefix Edit the source location, if needed.

Output file name suffix
(no extension)

Edit the file name for report.

Output file location Enter the location in which to save the generated report file(s).

3. Complete the following options in the Delivery Methods section:

Option Description

Assemble by Select the management level in which to generate and distribute
the report package.

Save or email generated
files

Select one of the following:

l To save the report file(s) to a directory, select Save File.
l To include the report file(s) as attachment(s) or a link to a

directory where the files are stored in an email, select Email
File.

l To save the report file(s) to a directory and send an email,
select Save File and Send Email.

4. If you select email or save file and send email as the output option, complete the Email Settings
section:
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Option Description

Subject text Type the subject line text for the email.

Body text Type the body text to include in the email.

Recipient Select the recipient type in which to send the reports.

Attach file to email Select one of the following:

l To attach the report file(s) to the email, select Yes.
l To include a link to the directory location for the report file

instead of attaching a file, click No.

Attach each file
separately

NOTE: This option does not display if you select the Save File
and Send Email option in step 3.

Select one of the following:

l To include the packaged reports into a single report file with
tabs for each report, click Off.

l To generate the packaged reports as individual report files,
click On.

5. After making your changes, in theMain ribbon tab, click Save.

NOTE: The system will prompt you to save your settings as a new file. This allows you to
create multiple setting versions, if needed.

6. In the Save As dialog, type a name for the file, and click Save.

7. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.
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� Dept Monthly Package utility
You can also process and distribute the report package directly from the Dept Monthly Package utility.
This option is useful when generating one-off packages to just a few people or for someone wants a
variant of the reporting package outside of your normal regularly scheduled process.

To process and distribute package reports using the Dept Monthly Package utility:
1. Open the Dept Monthly Package utility, and make any necessary report or variable configuration

changes, including selecting the management-level personnel to receive the report.

2. From the Select How To Process the Files drop-down, select one of the following:

l To save the report, select Save Files. By default, the file saves to the following output
folder: \Axiom\Reports Library\Management Reporting Utilities

l To email the files, select Email Files. The report outputs to the recipient email addresses
listed in the Email Settings/Groupings section of this report.

l To save and email the report, select Save and Email files.

3. If emailing the files, in the Email Settings/Groupings section, do the following:

Option Description

Select the Recipient Role Select the role type of the email recipient.

Recipient Email Address Displays the email addresses the report will be sent to.

NOTE: Email addresses are derived from the security profile for
the user.

Subject Line Edit the content for the email subject line, as needed.

Body Text Edit the content for the email body text, as needed.

4. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.
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� Batch processing and Scheduler
Another way to process the report package is to use a report batch control sheet, which allows you to
process multiple reports simultaneously. The system comes preloaded with the Monthly All in One
Manager Reporting Batch control sheet, which is pre-configured with the settings needed to run the
Department Monthly Package for multiple management-level reports, but you can change these settings
if needed. After you have set up the batch control sheet, you can then perform a file process.

TIP: To make generating the report package even easier, you can configure a Scheduler job to
process the batch control sheet for a specific date and time. By default, the Monthly All in One
Manager Reporting batch control sheet does not include the DeptMonthlyPackage_FileCollect utility
because not all organizations use file collect. However, you can also automate the process of
distributing the report by adding the file collect utility to the batch control sheet.

To process and distribute package reports using batch processing and Scheduler:
1. Open the Dept Monthly Package utility, and make any necessary report or variable configuration

changes.

2. To include the file collect in the batch control sheet, open the file collect utility, and make any
necessary changes.

3. In theMgmt Admin task pane, in the Financial Reporting Batches section, click Report Batches,
and double-clickMonthly All in One Executive Reporting Batch.

4. Update the batch control sheet, as needed, including adding the file collect utility location to
generate multiple reports for multiple people. For more information, see the following:

l For configuring the Batch tab, see Batch Control Sheet.
l For an overview of file processing and how it works, see File Processing.

5. To process the batch, you can do one of the following:
l In the batch control sheet, click File Processing > Process File.
l Create a Scheduler job to process the report the package, if desired. For more information,

see Batch processing using Scheduler.
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OpeningManager reports
To open Manager reports:

1. In theMain ribbon tab, click Open App Menus, and clickManagement Reporting.

2. In theMgmt Report task pane, click Department Manager:
l Mgmt Report displays on the task bar tab to indicate that the Management Reporting task

pane is open.
l The term Performance Reporting is used synonymously with Management Reporting.
l The task pane lists all of the reports listed within the Department Management folder.
l The Dept Monthly Package includes each individual report as a tab for a selected

department.
l To open a report, double-click the report name.

Understanding financial performance
The purpose of the monthly financial package is to understand financial performance and find
opportunities for improvement where possible. In this guide, we describe the financial review process in
two steps and, in each section, provide an overview of the reports available in the Manager Monthly
Report Package to complete the analysis:

l Analysis of Monthly General Ledger (Account-level) data
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l Additional Analysis of Labor (Salary Expenses and FTE amounts)

UnderstandingMonthly Variance Analysis
Monthly Variance Analysis is focused on departmental volumes and all expenses. While this also
includes Salary related expenses and FTEs, further analysis is often completed for these items by
reviewing the bi-weekly the reports in the Labor Analysis section.

Steps and questions for reviewing monthly general ledger data:

1. Review monthly financial data for variances and determine cause of variances. Then, analyze
whether variances will continue, could have been prevented, or were strategic (such as “bulk buy
to reduce total costs”).

2. Review monthly financial data for positive and negative trends.

A focus on expense per unit (also known as per key statistic) values in volume-sensitive areas is
particularly useful to determine if any expense variances are caused by a volume variance, a rate or cost
variance, or related to efficiency. For example, if an expense line item is showing a variance and the
actual expense per unit equals the budgeted expense per unit, this situation is considered a Volume
variance. However, if the line item’s actual expense per unit is higher than the budgeted expense per
unit, volume cannot be the cause of the variance. In this case, you would determine the following:

l Is the price we are paying for the supply or service higher than budgeted causing a Rate variance?
If so are there ways to lower the price? Or was this an unexpected cost increase that will cause a
budget variance for the rest of the year?

l Are we using more of the supply or service on a per unit basis than planned causing an Efficiency
variance, or

l Is there a combination of the circumstances above causing the variance to be attributed to both
Rate and Efficiency?

In each case, why is this occurring and can we get a lower price or use the resource more efficiently?

The following tools in the Manager Monthly Package can be used for this review:

� Cover
The Cover tab is the first sheet that displays within the Dept Monthly Package. It is also included as part
of the Manager’s month-end distributed package.

This sheet provides general information such as the current reporting period and type of information
provided within each report.
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� Scorecard
The Scorecard report shows Key Financial and Ratio Indicators. It provides an overview of departmental
performance, and highlights areas requiring further review.
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� Scorecard Detail report (SCDetail)
The Scorecard Detail report (SCDetail) shows actual versus budget information and flags the areas
requiring variance comment input explanations within the Axiom Variance Comments Collection
module.

Note that some additional details can be derived from this report, we can now answer some of the
questions posed within the Variance Items to Note box from the previous Scorecard section:

l Salaries are over due to Contract Labor; only benefits were budgeted in this department.

l In Other Expenses, the $6,000 unfavorable variance was spent on Recruitment.
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� Variance Alert report (VarAlert)
The Variance Alert (VarAlert) report provides the following:

l Variance by individual account lines provide further detail. If your organization uses the Variance
Comments Collection (VCC) tool, this report highlights which accounts require a variance
explanation entry.

l Displays any Variance Comments and Action Plans previously entered within the VCC tool.

� Budget Variance report (BudVar)
The Budget Variance report (BudVar) includes the following information:

l Key and supplemental statistics information
l Operating revenue and expenses
l Key per-unit calculations
l Staffing information

The Budget Variance Report is broken out into four sections:

l Income Statement Summary - Current Month and Year-to-Date
l Income Statement Account detail - Current Month and Year-to-Date
l Current Year Forecast Summary
l Current Year Forecast Account detail

If opened within the Axiom system, all four sections display on the same tab. If the report is delivered
through email or saved on a network drive, the four sections may be presented on a single sheet or
separated on four individual tabs.
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Review the Summary Level information, then look to the detail for further explanation regarding
variances. Determining the account numbers with variances will provide the link to the detailed
information on the AP, AR, MM, etc. reports that support the expense. As in our example above, Salaries
and Other Expenses resulted in a Red Flag Variance, specifically within accounts 60600 Salaries-Contract
Labor and 69230-Recruitment.

The first section of the report contains Current Month and Year to Date information at a Summary level.

Below the first section is Current Month and Year to Date information, detailed by Account Number.

To the right of the first section is Monthly Trend information at a Summary Level.
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To the right of the Detail for Current and Year to Date is Monthly Trend information by Account
Number.

� Charts
The Charts report provides an overview of comparative trends across periods for Volume, Total Expense
per unit, Worked Hours per unit, and Salary Expense per unit.
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Similar to the Scorecard, this report can be used to review performance trends that may require further
research.

l Volume chart - Compares the department’s key statistic amounts by month for current year
actual, current year budget, and last year actual

l Total Expense Per Unit chart - Compares the department’s total expense per key statistic
amounts by month for current year actual, current year budget, last year actual, and current year
flex budget (if used)

l Worked Hours Per Unit chart - Compares the department’s total worked (productive) hours per
key statistic amounts by month for current year actual, current year budget, last year actual, and
current year flex budget (if used)

l Salary Expense Per Unit chart - Compares the department’s total salary expense per key statistic
amounts by month for current year actual, current year budget, last year actual, and current year
flex budget (if used)

For example, when reviewing the Volume and Total Expense Per Unit charts within the screen shot
below, you will notice the following:

l The department’s current year actual key statistic volume represented by the red line has been
moving in a positive direction since December, and is above the current year budget’s blue line
and is equal to last year actual’s yellow line for the current month of February.

l The department’s actual total expenses per unit (key statistic volume) represented by the red line
is moving in the right direction with the downward trend since December. For the current month
of February the actual is slightly below the current year static budget’s blue line, and slightly
above the current year flex budget’s green line.

These trends provide a couple of positive observations for the current month of February—
departmental volume is above budget expectations, and total expenses per key stat are below the static
budget and in line with the flex budget. The details behind these trends can be explained by reviewing
the pertinent reports within this package.
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� General Ledger report (GL)
The General Ledger report (GL) contains every transaction that makes up the total dollar amount for
each expense account. This report, combined with the AP, MM, and AR reports described below, helps
you understand the nature of the expenses. In other words, they help you recall items purchased or
services utilized for each account.

The standard JE Source codes of each GL transaction are categorized as follows (individual company
source codes may vary slightly):

l Salaries and wages come from the payroll source system and usually have a PR in the JE Source.
To ensure the JE Salary dollars are in line with FTE amounts, the JC and EmpID tabs included in
the reporting package allow you to review payroll hours by Jobcode and individual Employee.

l Invoices have a JE Source of AP or accounts payable if the invoice has already been processed for
payment, click the AP tab.

l Invoices have a JE Source of AR or accrued receipts for purchase order acquisitions that have
been received but have not been invoiced. For further detail of an AR expense, click the AR tab.

l Inventory items coming from supply chain or your materials management department
customarily have aMM in the JE Source. For further detail of an MM expense, click the MM tab.
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l A journal entry or JE code are expenses processed by the Accounting department. An example of
a JE item would be an annual prepaid subscription. Even though the invoice for the subscription
was paid in full with a single payment to the vendor, Accounting would hold the total amount and
book one month’s worth of the expense to your department for each of the 12 months covered
under the subscription. For further details related to JE expense transactions, please contact your
assigned Finance representative.

� Accounts Payable Distribution report (AP)
The Accounts Payable Distribution report (AP) comes directly from the Accounts Payable Source System
and provides individual invoice information for purchases made including Description, Vendor Name, PO
Number, and Amount.
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AP transactions may include links to supporting documentation. In the Link to Image column, click the
folder to open the document image.

� Materials Management Distribution report (MM)
The Materials Management Distribution report (MM) comes directly from the inventory system (store
room) and provides transaction detail items pulled from inventory including Item Description, Quantity,
and Amount.
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� Accounts Receipts Distribution report (AR)
The Accrued Receipts Distribution report (AR) comes directly from the purchasing system and provides
purchase order detail. Items on this report have been received in your purchasing system, however,
your organization has not received an invoice for the purchases. Information provided on this report
includes Vendor Name, PO Number, Item Description, Invoice Number, and Amount.
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AR transactions may include links to supporting documentation. In the Link to Image column, click the
folder to open the document image.

� Labor Analysis
Labor is typically the largest expense in healthcare organizations and thus a key component to
understanding and potentially improving your department’s financial performance.

Steps and questions for reviewing labor (salaries and hours) data:

1. In the previous section you may have identified variances in salary and/or hours at a general
ledger account level. The expense per unit data on those reports would let you know if the
variance is related to volume. If not volume, more detail is helpful in determining whether the
cause is efficiency (using more labor hours than budgeted) or rate (paying more labor dollars per
unit). If the variance is due to paying more labor dollars per unit, the cause could be an issue
related to:

l Staffing Mix where higher paid positions are used more than the budgeted profile (an
unplanned higher use of RNs instead of LPNs); or

l Salary Rates where the individuals within the budgeted positions earning more dollars per
hour than planned.

2. Review payroll data to identify variances, their causes and trend data. Useful questions include:

Overtime:

l Is overtime usage value-added or resulting from undisciplined employee clocking habits?
l Is overtime usage approved?
l Is overtime the most efficient way to leverage departmental staff vs. float employees, or

could a different staffing mix be used (are there other staff members available for
scheduling who would not incur overtime in given period)?

Productivity:

l Are productive hours per unit consistent with budget? If not, what is cause? Are there
opportunities to flex or increase/decrease staffing with an increase/decrease in
departmental volumes?

l Are salary rates per productive hour consistent with budget? If not, is staffing mix a factor
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(using more high cost positions than lower cost)?

Use the following reports in the Manager Monthly Package to complete the Labor Analysis:

Pay by Employee ID report (EmpID)
The Pay by Employee ID (EmpID) report contains Hour and FTE information by individual Employee ,
including recent individual pay periods and year-to-date.

Hours are categorized by Productive, Overtime, and Non Productive categories.

Pay by Job Code (JC) report
The Pay by Job Code (JC) report contains Hour and FTE information by individual Jobcode , including
recent individual pay periods and year-to-date.

Hours are categorized by Productive, Overtime, and Non Productive categories.
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Revenue and Usage report
This report displays actual Volume and Revenue by individual Inpatient/Outpatient CDM code for the
appropriate departments.

Please note the detailed lines shown here will sum up to the actual key stat volume totals displayed
within the other financial reports of this package. For example, the screen shot below provides the CDM
details related to the sample department’s current period key stat volume of 514 previously shown
within the Scorecard section of this guide.

CDM Codes Included in Department Statistics:

l Included to determine key stat volume totals for driving variable items for Budgeting, also used as
the denominator for departmental per unit calculations including Gross Revenue per unit, Salaries
per unit, etc.

CDM Codes Not Included in Department Statistics:

l CDM Charges that are billed and included as revenue, but not included in the departmental key
stat volume totals. For example, Supply related codes are captured and billed as revenue, but any
related volume is not included or counted as a key statistic.
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Understanding file output options
Axiom Budgeting and Performance Reporting provides a variety of file output options to share data with
people throughout your organization. This section explains the file setup to use these features.

l Print view setup: You can set up one or more custom print views for each sheet in an Axiom file.
You can associate these print views with sheet views to automatically hide and/or format rows
and columns in the print copy.

l Snapshot setup: Users can take snapshot copies of Axiom files without requiring any advance
setup. However, if desired, you can flag certain rows and columns in the sheet to be deleted in
the snapshot copy. The primary use for this would be to delete work areas or Axiom query
artifacts that are no longer necessary in the snapshot copy.

Printing an Axiom file
You can print an Axiom file on a per sheet basis by using the Print command. Each sheet can have one or
more defined print views. You can use the print views to print different views of the sheet, and to set
certain standard print options such as the print orientation. For example, for a plan file, you might have
one print view that prints a summary view of the sheet with certain columns and rows hidden for
printing, and another print view that prints a detail view of the sheet with all columns and rows visible.

If a sheet has no predefined print views, then you can print the sheet using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see the Microsoft Excel Help. In the Windows Client, the spreadsheet print settings are
defined in the Workbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
print views have been defined.

To print an Axiom file:
1. On theMain ribbon tab, in the File Output group, click Publish to do one of the following:

l To select the sheets to print, click Print > Print This Sheet.

14
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The Print Sheets dialog opens. This dialog lists the available print views for the entire
workbook or for the current sheet, depending on how you entered the dialog. To sort this
list by the Sheet Name or Print View Name, click the column header.

Note the following:

o If a sheet does not have a defined print view, then it is listed with a print view name
of Default, and uses the print settings defined for the spreadsheet.

o Control Sheets cannot be printed using the Axiom Budgeting and Performance
Reporting printing feature, whether they are visible or hidden. To print a Control
Sheet, use the standard spreadsheet printing features.

2. In the Print Sheets dialog, select the sheet / print view combinations to print.
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To print all print views for all sheets, select the checkbox in the column header to select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, then that view is selected by default.

3. You can also do any of the following before printing:

l View and edit the print settings. To view and potentially change the print settings for a
selected view, click the View/Edit link. In the Print Options dialog, you can change any of
the print settings for the current print job only (the changes are not saved in the file). For
more information, see Print Options dialog.

l Preview a print view. To preview a print view, click the Print Preview link. The native
spreadsheet Print Preview feature opens to preview the print job. You can only view one
preview at a time.

l Select a printer. To print to a different printer than your default printer, click Choose
Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer to use,
and then click OK.
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4. Click Print.

The selected items print.

Print Options dialog
The Print Options dialog displays the print settings for the current print view. If desired, you can edit
settings for the current print job only. Any changes you make are not saved in the file.

NOTE: Print options are read-only when using the Print Plan Files option to print multiple plan files.

This dialog displays all of the settings that will be applied to the print job, whether the setting is defined
in the associated Print tag or inherited from the spreadsheet settings. If a setting is blank, then that print
option is not defined and is not applied to the print job.

� Print View Options

Item Description

Print View Name The name of the current print view.

View Name The name of the sheet view to be applied when printing. These are
the same sheet views that are available from the Change View
menu. For example, if the sheet view is configured to hide columns
or rows, those columns and rows are hidden in the print copy. Row
and column sizing are also applied.

Paper Size The paper size for the print job, either Letter or Legal.

Orientation The print orientation for the print view, either Portrait or Landscape.

Repeat Rows The rows to repeat at the top of the page. Rows must be specified as
a range; for example: 1:3.

Repeat Columns The columns to repeat at the left of the page. Columns must be
specified as a range; for example: A:C.

� Scaling

Item Description

Fit To Pages Wide The number of pages on which to fit the print area. For example, if
you want the print area to fit on one page, specify 1.

Percent Zoom The percent zoom to apply to the print range. Specify the number
without a percent sign. For example, to zoom by 90%, specify 90.
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� Headers and Footers

Item Description

Left Header Header text to display in the left-hand side of the header.

Center Header Header text to display in the center of the header.

Right Header Header text to display in the right-hand side of the header.

Left Footer Footer text to display in the left-hand side of the footer.

Center Footer Footer text to display in the center of the footer.

Right Footer Footer text to display in the right of the footer.

Emailing a hyperlink to an Axiom file
You can email a hyperlink to an Axiom Budgeting and Performance Reporting file using the E-mail
feature on the Main tab. Axiom Budgeting and Performance Reporting creates a URL hyperlink to the file
and includes it in an email. The email recipient can click on the link to launch the system and open the
file directly, assuming that the recipient is an Axiom Budgeting and Performance Reporting user who has
rights to access the file.

NOTE: The email hyperlink feature is not supported for use with the Axiom Budgeting and
Performance Reporting shared client.

You can send the email using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Budgeting and Performance Reporting Scheduler email service. For example, you
may be using Axiom Budgeting and Performance Reporting on a shared client server where you do not
have access to a local email client, and therefore you would use the system's email service to send the
email.

NOTE: The Scheduler email service does not support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

Note the following:

l Alternatively, you can obtain a URL to an Axiom file using a variety of ways and then paste it into
an email that you create manually. For example, you can use GetDocumentHyperlink or right-click
a file in Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a convenience
to quickly send a hyperlink to the current file.
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l The email hyperlink feature cannot be used to send a hyperlink to open a form-enabled file as a
form; the source file is always opened as a spreadsheet.

l The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using SAML or OpenID
Authentication.

To email a hyperlink to an Axiom file:
1. Open the file in Axiom Budgeting and Performance Reporting.

2. On theMain ribbon tab, in the File Output group, click Publish > E-mail Workbook.

3. In the Email Active Workbook dialog, for Send As, select Document Link.
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4. For Send using, select one of the following::

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

NOTE: This option is not available if you use Axiom Budgeting and Performance
Reporting on a shared client server.

l Axiom Mail Service: Send the email using the Axiom Budgeting and Performance
Reporting Scheduler email service.

5. Optional. Complete the following Document Link Options in the dialog:
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Option Description

Sheet Filter If desired, enter a filter to apply to the file when it is opened. You can type
the filter statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the file.
For example, Dept.Region='West' means that all data queried is limited to
the West region.

If desired, you can specify a table or table type to apply the filter to, using
the same filter syntax that is available for the GetDocumentHyperlink
function. In this case you must manually type the filter syntax because the
Filter Wizard does not account for this type of syntax.

Cell Address If desired, specify the cell to be made active when the document is opened.

For example: Sheet1!D22

If the specified location would not be in view normally then the file will be
scrolled to that location; otherwise the file will open in its default view with
the cursor placed at that location.

6. Click OK.

If you selected to send the hyperlink using your default email client, then a new email message opens,
with the hyperlink included in the body text. You can then specify the recipient, subject, and additional
body text for the email, and then send it.

If you selected to send the hyperlink using the Axiom email service, then an E-Mail dialog opens so that
you can specify the recipient, subject, and additional body text for the email. In the Address fields (To
,CC , and BCC fields, you can type an email address or click the button to select an Axiom Budgeting and
Performance Reporting user. If you select a user, the email will be sent using the user's email address as
defined in Axiom security. When you click OK, the email settings are saved to the database, to be sent
the next time the Scheduler SMTP Email Delivery task is run.

Emailing a snapshot of an Axiom file
You can email a snapshot of an Axiom file using the E-mail feature on the Main ribbon tab. Axiom
Budgeting and Performance Reporting creates a snapshot copy of the file and attaches it to an email.
The copy can then be viewed outside of Axiom Budgeting and Performance Reporting by someone who
may have no access to the system. When you use this feature, the system creates a snapshot copy of
the file just like it would if you used the Snapshot feature.

You can send the email using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Budgeting and Performance Reporting Scheduler email service. For example, you
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may be using the software on a shared client server where you do not have access to a local email client,
and therefore you would use the Axiom Budgeting and Performance Reporting email service to send the
email.

NOTE: The Scheduler email service does not support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

Note the following:

l The name of the emailed file is Sheetname_snapshot (if the snapshot contains only one sheet) or
FileName_snapshot (if the snapshot has multiple sheets). You cannot change the name.

l You can also email snapshot copies using the File Processing feature. File processing is typically
used when you want to automate the process and employ Multipass processing to send the same
file to different people using different data. The E-mail feature is best used to send one-off
snapshots as needed.

To email a snapshot copy of an Axiom file:
1. Open the file in Axiom Budgeting and Performance Reporting.

2. On theMain ribbon tab, in the File Output group, click Publish > E-mail Workbook.

3. In the Email Active Workbook dialog, for Send As, select Snapshot.
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4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

NOTE: This option is not available if you use Axiom Budgeting and Performance
Reporting on a shared client server.

l Axiom Mail Service: Send the email using the Axiom Budgeting and Performance
Reporting Scheduler email service.

5. Complete the following Snapshot Options in the dialog:
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Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

NOTE: PDF is not available in the Axiom Budgeting and Performance
Reporting Windows Client.

Include Select one of the following:

l Entire Workbook: All sheets are included in the snapshot (except Control
Sheets and hidden sheets, which are always removed).

l Active Worksheet Only (default): Only the active worksheet is included
in the snapshot.

Formulas l Convert All Formulas (default): All formulas are converted to values.
l Retain Excel Native Formulas: Axiom formulas are converted to values,

but Excel formulas are left as is.
If an Excel formula references a sheet that is not included in the snapshot,
that formula will be converted to a value.

NOTE: If the file contains a pivot table, this option must be selected in order
for the pivot table to work in the snapshot copy. This option does not apply
if PDF is the selected file type.

6. Click OK.

If you selected to send the file using your default email client, then a new email message opens, with
the snapshot file attached. You can then specify the recipient, subject, and body text for the email, and
then send it.

If you selected to send the file using the Axiom mail service, then an E-Mail dialog opens so that you can
specify the recipient, subject, and body text for the email. In the address fields (To, Cc, and BCC), you
can type an email address or click the button to select an Axiom Budgeting and Performance Reporting
user. If you select a user, the email is sent using the user's email address as defined in Axiom security.
When you click OK, the email settings are saved to the database, to be sent the next time the Scheduler
SMTP Email Delivery task is run.
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